ACCOUNTANCY

COMPUTERISED ACCOUNTING SYSTEM

Textbook for Class XII

Government of Kerala

DEPARTMENT OF EDUCATION

State Council of Educational Research and Training (SCERT) Kerala

2018
THE NATIONAL ANTHEM

Jana-gana-mana adhinayaka, jaya he
Bharatha-bhagya-vidhata.
Punjab-Sindh-Gujarat-Maratha
Dravida-Utkala-Banga
Vindhya-Himachala-Yamuna-Ganga
Uchchala-Jaladhi-taranga
Tava subha name jage,
Tava subha asisa mage,
Gahe tava jaya gatha.
Jana-gana-mangala-dayaka jaya he
Bharatha-bhagya-vidhata.
Jaya he, jaya he, jaya he,
Jaya jaya jaya, jaya he!

PLEDGE

India is my country. All Indians are my brothers and sisters.

I love my country and I am proud of its rich and varied heritage. I shall always strive to be worthy of it.

I shall give my parents, teachers and all elders respect and treat everyone with courtesy.

To my country and my people, I pledge my devotion. In their well-being and prosperity alone lies my happiness.

Prepared by:

State Council of Educational Research and Training (SCERT)
Poojappura, Thiruvananthapuram 695012, Kerala
Website : www.scertkerala.gov.in  e-mail : scertkerala@gmail.com
Phone : 0471 - 2341883, Fax : 0471 - 2341869
Typesetting and Layout : SCERT
© Department of Education, Government of Kerala

To be printed in quality paper - 80gsm map litho (snow-white)
Contents

Unit 1
OVERVIEW OF COMPUTERISED ACCOUNTING SYSTEM .................................................. 05

Unit 2
SPREADSHEET ......................................................... 19

Unit 3
USE OF SPREADSHEET IN BUSINESS APPLICATIONS .................................................. 113

Unit 4
GRAPHS AND CHARTS FOR BUSINESS DATA ..... 143

Unit 5
ACCOUNTING SOFTWARE PACKAGE - GNUKhata ......................................................... 161

Unit 6
DATABASE MANAGEMENT SYSTEM .............. 203
Textbook Development Team

Abdul Hakeem C.P
Master Trainer, KITE Malappuram

Ajith P P
SKMJ HSS, Kalpetta, Wayanad

C.H. Arunkumar
KKMHSS, Vandithavalam, Palakkad

Biju Thankappan
SNHSS, Nankicity, Kanjikuzhy, Idukki

Devadas Chettiyar
GHSS, Vechoochira Colony, Pathanamthitta

Husain. E. K
PTMYHSS Edappalam, Palakkad

Rajendran M.K
GHSS Meenangadi, Wayanad

Sakkeer Hussain. N
GHSS Kunnakkavu, Malappuram

Dr. Shanavas. K
Master Trainer, KITE Malappuram

Sasidharan. E
Karimpuzha HSS, Thottara, Palakkad

Shivi M K
GHSS, Meenangadi, Wayanad

Sulaiman. T. P
GJHSS Naduvattam, Palakkad

Suku S
GHSS, Ala, Alappuzha

Thomas P.V
Govt. HSS, Aralam, Kannur

Experts

K. Anvar Sadath
Vice Chairman & Executive Director
KITE

C.A. Arun Kelkar
Domain Expert, GNUKhaba

Umanahesh R
Head Accountant ICFOSS
Thiruvananthapuram

Dr. Simon Thattil
Professor, Dept. of Commerce
School of Business Management and
Legal Studies, University of Kerala

Dr. P. S. Devakumar
Asst. Professor, Dept. of Commerce,
Govt. College for Women,
Thiruvananthapuram

Dr. Bino Joy
Asst. Professor, Dept. of Commerce,
Govt. College, Kottayam

Academic Co-ordinators

Dr. S. Jayalekshmi
Assistant Professor, SCERT Kerala

Renjith S
Research Officer, SCERT Kerala
FOREWORD

Dear Learners

The State Council of Educational Research and Training (SCERT Kerala) is extremely delighted to bring out a textbook for Computerised Accounting System based on Free and Open Source Software (FOSS) package for the Higher Secondary Second Year learners of Commerce Stream.

Equipping learners with the skills that are required in the digital age we live in, was sensed well in advance and sufficient input was made in the higher secondary curriculum. Hence use of Free and Open Source Software provides freedom to the users for accessing, modifying and redistributing the software.

As accounting is taught in the higher secondary level as a life skill subject which is also a basic and important business discipline, Computerised Accounting is introduced as a part of accountancy. It prepares the learners to analyse and evaluate the accounting procedures used in practice. It provides opportunities to learn accounting through the software - GNUKhata, Spreadsheet and Database applications based on LibreOffice software package. Hands-on activities and assessment slots are provided wherever needed to help the learners to actively look for the solutions in a co-operative and collaborative classroom, access information from various sources, analyse these information and make interpretations.

The SCERT is grateful to the team of practising teachers and experts who have contributed in the preparation of this textbook. We welcome creative and constructive suggestions and feedback about this book for improving the quality of the content and design of the textbook.

Wish you all success.

Dr. J. Prasad
Director
SCERT, Kerala
1. **Computerised Accounting System (CAS)**
2. **Components of Computerised Accounting System**
3. **Data and Information**
4. **Accounting cycle**
5. **Grouping of accounts**
6. **Security Features of CAS**
7. **Merits and Demerits of CAS**
8. **Accounting Information System**

---

**Introduction**

The advancement of Information Technology has brought enormous possibilities in the field of accounting. Usage of computers and accounting software packages help business men to carry out accounting process quickly and accurately. We have already learnt about the Manual Accounting System under which transactions are physically entered in the books of accounts. Computerised Accounting System processes voluminous data and variety of transactions with the help of computers. Both manual and computerised accounting system follow same principles and concepts of accounting.

1.1 **Computerised Accounting System (CAS)**

The computerised accounting system facilitates timely production of management information reports, which will help management to monitor and control the business effectively. Computerised accounting makes use of computers and accounting software packages to record, store and analyse financial data. The need for this system arises from advantages of speed and accuracy in recording and retrieval of data and lower cost of handling business transactions.
A computerised accounting system is a system used by businesses for recording and manipulating financial data with the help of computers and various accounting software.

Today, accounting software packages are in abundance to help us to process accounting data and come up with reports instantly.

**Features of CAS**

Computer assisted accounting programmes have been widely used in the field of accounting.

- Can you imagine the purpose of using computer in accounting system?

Let us see this by narrating the features of CAS

1. **Simple and Integrated**

   Computerised accounting system is integrated to provide accurate and up-to-date business information instantly. It is designed to automate and integrate all the business operations such as sales, finance, purchase, inventory and manufacturing.

2. **Transparency and Control**

   Computerised accounting system provides sufficient time to plan, increases data accessibility and provides user satisfaction. It provides greater transparency for day-to-day business operations.

3. **Accuracy and Speed**

   The accuracy of computer is very high. Each and every calculation is performed with same accuracy. Computer can also process data millions of times faster than human beings.

4. **Scalability**

   The requirement of additional manpower is confined only to data entry operators and it costs almost nothing for processing additional transaction. Hence the cost of processing additional transactions is almost negligible.

5. **Reliability**

   Since computer system is well adapted to performing repetitive operations, the generated financial information is more accurate and reliable in comparison with manual accounting systems.

**1.2 Components of Computerised Accounting System**

Computerised accounting system has five components, namely procedure, data, people, hardware and software. They are regarded as five pillars of computerised accounting system (Figure 1.1).
1.3 **Data and Information**

See figure 1.2 and try to understand how data is transformed into information.

In accounting, data comprises of one or more elements/items relating to a transaction. A data item or data element means the smallest unit or segment of data. When data is processed, it becomes information. Computerised accounting system is based on the concept of database wherein data is stored and processed with the help of software. The user can take various accounting reports such as Income Statement, Balance Sheet etc. Thus CAS converts the data into information.

Let’s make this clear with the help of an example.

Think of a data that is created when the business makes a credit sale. This include

- Name of Account (Debtor)
- Account code (1.3.7)
- Date of transaction (1\(^{st}\) June 2017)
- Amount (₹25,000)

This data needs processing at the point of sale inorder to issue a valid receipt (information). The data would be useful to the Sales Manager for preparing reports showing the total sales (information) during a particular period of time.

**Let’s assess**

1. Describe how computerised accounting helps in keeping of systematic records in a business organisation.
2. Which among the following is not a component of CAS?
   a. data  
   b. Software  
   c. Procedure  
   d. Decisions
3. Distinguish between Data and Information with an example.
4. Describe the features of computerised Accounting System.
1.4 Accounting Cycle

The term accounting cycle refers to the specific steps that are involved in the completion of accounting process. We have learnt about different stages of accounting process in Plus One classes. The different stages of accounting cycle starts with recording of business transactions and ends with the preparation of financial statements which is given as follows:

1. Recording of transactions in journal
2. Posting of journal entries to ledger accounts
3. Preparation of Trial Balance from balance of accounts
4. Passing adjusting entries
5. Preparation of adjusted Trial Balance
6. Passing closing entries
7. Preparation of Financial Statements

In computerised accounting, the various stages of accounting cycle mentioned above are carried out with the help of computers.

1.5 Grouping of Accounts

In business, large number of transactions with varying nature is to be stored, processed and retrieved. Therefore it becomes necessary to have proper classification of data. Grouping of accounts in computerised accounting is based on accounting equation. We know that accounts are classified into assets, liabilities, income, expense and capital. You can recollect that the accounting equation can be expressed as;

Assets = Equities (A = E)

Where

Equities = Liabilities + Capital (E = L + C)

Thus

Assets = Liabilities + Capital (A = L + C)

The amount of capital may be increased by profits or decreased by losses. Thus the basic accounting equation can be re-written as;

Assets = Liabilities + Capital + (Revenues – Expenses)

*Revenue means inflow of resources, which results from the sale of goods or services in the normal course of business and increase in capital. Expenses imply consumption of resources in generating revenues and results in reduction of capital.*

We can divide and group each component of the above equation as follows:

1. Assets
   - Fixed Assets
     - Land
     - Buildings
• Plant and Machinery
• Furniture and Fixtures

• Current Assets
  • Cash
  • Bank
  • Debtors
  • Inventories

2. **Liabilities**
  • Secured loans
  • Unsecured loans
  • Creditors
  • Provisions

3. **Capital**
  • Share capital
  • Reserve and Surplus
    • Capital reserve
    • General reserve
    • Balance of Profit and Loss account

4. **Revenues**
  • Sales
  • Other Income

5. **Expenses**
  • Material consumed
  • Salary and wages
  • Manufacturing expenses
  • Administrative expenses

**1.5.1 Codification of accounts**

Systematic grouping is a pre-condition for proper codification, since each ledger under a group will have similar coding patterns. There is a hierarchical relationship between the groups and its components. Codification will help to ensure neatness of classification.

The term ‘code’ literally means a system of symbols or figures with arbitrary meaning for brevity and for machine processing of information. It is an identification mark. Codification refers to allotting code numbers to accounts in a hierarchical structure. The codes are classified into each section and grouping of accounts can be done effectively. The grouping and codification depend upon the type of organisation and the extent of subdivision required for reporting on the basis of profit centres or product lines.

Codification is the essence of computerised accounting system. Here codes are necessary because the computer cannot understand that whether the item is an expense,
income, asset or liability. When it is coded, computer can easily identify them.

Methods of codification

The coding scheme of account-heads should be such that it leads to grouping of accounts at various levels so as to generate Balance Sheet and Profit and Loss Account. The codes so used shall be simple, understandable, concise and expandable. For example, we may allot numeric codes for the major account groups, their sub groups, next level sub groups and so on.

1. **Assets**
   1.1 Fixed Assets
      1.1.1 Land
      1.1.3 Building
      1.1.5 Plant and Machinery
      1.1.7 Equipments
      1.1.9 Furniture and fittings
   1.3 Current Assets
      1.3.1 Cash
      1.3.3 Bank
      1.3.5 Bills Receivable
      1.3.7 Debtors
      1.3.9 Stock in hand

2. **Liabilities**
   2.1 Long term liabilities
   2.3 Current Liabilities

3. **Capital**
   3.1 Share capital
   3.3 Reserve and Surplus
      3.3.1 Capital reserve
      3.3.3 General reserve

4. **Revenues**
   4.1 Direct Income
      4.1.1 Sales
   4.3 Indirect income
      4.3.1 Rent received
      4.3.3 Commission received

5. **Expenses**
   5.1 Capital expenditure
   5.3 Revenue expenditure
      5.3.1 Direct expenses
         5.3.1.1 Wages
         5.3.1.2 Carriage inwards
      5.3.3 Indirect expenses
         5.3.3.1 Salary
         5.3.3.2 Rent
The codification given above is not rigid. The code numbers of sub groups are not given consecutively (see the above example) so as to provide flexibility. i.e., we can add new sub groups in future, if necessary.

**Types of codes**

Codes can be classified in the following manner:

1. Sequential codes
2. Block codes
3. Mnemonic codes

**1. Sequential codes**

In sequential code, numbers and/or letters are assigned in consecutive order. They are applied primarily to source documents such as cheques, invoices etc.

For example:

- CM001 – Excel Company Limited
- CM002 – Premium Company Limited
- CM003 – Modern Company Limited

This method of codification is simple, easy and concise. Here it is easy to identify the missing codes if any.

**2. Block codes**

In block code, a range of numbers is partitioned into a desired number of sub ranges and each sub range is allotted to a specific group.

For example:

- 1001 – 1999 Televisions
- 2001 – 2999 Mobile phones
- 3001 – 3999 Refrigerators

Sub blocks can also be allotted inside a range of number. For example, in case of 1001 – 1999 Televisions, mentioned above the codes can be allotted in the following manner:

- 1001 – 1099 LED Televisions
- 1100 – 1199 LCD Televisions
- 1200 – 1299 Plasma Televisions

**3. Mnemonic codes**

It consists of alphabets or abbreviations as symbols to codify a piece of information. For example, Railway station codes – PGT for Palakkad, TVC for Trivandrum, TCR for Thrissur, etc.
Similarly, in accounting Codes may be assigned for day books as:

- SJ  Sales Journal
- PJ  Purchase Journal
- CB  Cash book
- JP  Journal Proper
- SRJ Sales Return Journal
- PRJ Purchase Return Journal

We can conclude here that it is convenient to code account heads, departments, places or locations. It is simple, meaningful and easy to remember but when size is increasing, grouping will become difficult.

1.5.2 Methodology to develop coding structure and coding

The coding system should be pre-planned by considering the scope and features of the piece of information. The codes should be designed to accommodate future additions. The hierarchy of data names should be strictly observed while developing codes.

The methodology can be explained with an example of assigning register number to a student. Register numbers are the individual codes allotted to students. Here the hierarchy of the schooling system should be identified first. The other relevant facts associated with the identification of a student are also taken.

The hierarchy may be decided as follows.

School → Course → Class → Second Language → Class number of Student.

Coding structure will be as follows.

- School  →  4 digits
- Course →  2 digits
- Class  →  1 digit
- Second Language  →  1 digit
- Class number of student →  2 digit

Thus, every student will get a 10 digit code which helps to get the following details of a student from the code itself (e.g. the school in which he/she is studying, the course for which he/she is studying, the second language of the student, the class number of the student etc).

Once the coding structure is decided, allotment of codes becomes easy. For example, the code number of a student with class number ‘15’, with second language ‘Malayalam’ in class ‘XI’ ‘Commerce’ stream of School Code ‘1202’ will be ‘1202381115’. Its coding is shown as follows:

```
   1202  38  1  1  15
   \   / \   / \   / \   / \
School code Course Class Second Language Class number
```
1. **Range of numbers are used for codification in .................**
   (Block codes, Mnemonic codes, Sequential codes, All of these)
2. **Grouping of accounts should be done basically by considering .............**
   (The rules of debit and credit, Accounting equation, Capital investment, Method of codification)
3. **Codification of accounts is required for the purpose of ............**
   (a) Hierarchical relationship between groups and components.
   (b) Faster data processing.
   (c) Keeping data secured.
   (d) Easy preparation of final accounts.
4. **Explain various types of codes with suitable examples.**

### 1.6 Security Features of CAS

Imagine the security features you have installed or made use of in your mobile phone:

- Pattern locking
- Biometric fingerprint scanning
- PIN

Why do you use such security features in your phone?

Ensuring data security, preventing unauthorised access etc. will be your answer. Think in terms of the level of security features an organisation must use to safeguard its accounting data when compared to a mobile phone.

It is necessary that all accounting information must be kept safe and secure for all the time. Any unauthorised access to this information may have adverse effects. Possibility of theft, deletion, and alteration in accounting data will affect its reliability and accuracy. All accounting software must ensure data security, safety and confidentiality. Therefore, the software usually provides the following.

- Password security
- Data audit
- Data vault

**Password security**

Password is a mechanism which restricts the access to the computer system and data to the user only. The system facilitates defining the user rights according to organisation policy. By setting passwords, a person in an organisation may be given access to a particular set of data, while he may be denied access to another set of data. Password is the key or code to allow the access to the system.
Data Audit

This feature enables us to know as to who and what changes have been made in the original data. This facility helps to fix responsibility to the person who has manipulated the data and thereby answers data integrity. In most software this is a separate menu available to the administrator to track unauthorised changes that have taken place in the data following his previous review.

Data vault

Accounting software provides additional security through data vault. Vaulting will save data in encrypted form to ensure its security. Encryption essentially scrambles the information so as to make its interpretation extremely difficult or impossible.

Encryption ensures security of data even if it lands in wrong hands, because the receiver of data will not be able to decode and interpret it.

1.7 Merits and Demerits of CAS

The merits of CAS include:

1. Timely generation of desired reports.
2. Efficiency in record keeping
3. Saves time and money
4. Confidentiality of data is maintained
5. Automated document preparation
6. Transparency and reliability
7. Accurate and updated information

The demerits of CAS include:

1. Danger of hawkers and stealing of data
2. Problems with technology
3. Non-availability of skilled personnel
4. Chances of data loss due to various reasons
5. Faster obsolescence of technology which leads to scrapping of heavy investment
6. Huge training cost of employees
7. Unprogrammed and unspecified reports that cannot be generated from the system.

Let’s assess

1. Develop a coding structure suitable to assets with its different subgroups.
2. Explain the methodology to develop coding.
3. Mention the internal controlling methods in CAS.
1.8 **Accounting Information System (AIS)**

Accounting Information System (AIS) and its various sub-systems may be implemented through computerised accounting system. Accounting is a huge information system for any organisation. CAS integrates the entire sub systems of the organisation and provides a sound accounting information system. The major sub-systems are depicted in figure 1.4.

![Diagram of sub-systems of AIS](image)

**Fig 1.4 sub-systems of AIS**

The sub systems of AIS are briefly explained below.

**Cash and Bank Sub-system**

It deals with the receipts and payments of cash (both physical and electronic). It includes electronic fund transfer, digital cash dealing etc.

**Sales and Accounts Receivable Sub-system**

It deals with recording of sales, maintaining of sales ledger and managing receivables. It generates periodic reports about sales, collections made, overdue accounts and receivables position.

**Inventory Sub-system**

It deals with the recording of purchases and issues of sale of products specifying the price, quantity and date. It generates the inventory position and valuation report.
Purchase and Accounts Payable Sub-system

It deals with recording of purchases and managing payables. It also generates periodic reports about the performance of suppliers, payment schedule and position of the creditors.

Payroll Accounting Sub-system

It deals with payment of wages and salary to employees. It gives information about basic pay, dearness allowance, and other allowances and deductions from salary and wages on account of provident fund, taxes, loans, advances and other charges. The system generates reports showing total pay of the employees.

Fixed Assets Accounting Sub-system

It deals with the recording of purchases, additions, deletions, usage of fixed assets such as land and buildings, machinery and equipments, etc. It also generates reports about the cost, depreciation, and book value of different assets.

Tax Accounting Sub-system

This sub-system deals with compliance requirement of various taxes. This sub-system used in large size organisation.

Final Accounts Sub-system

This subsystem deals with the preparation of Profit and Loss account / Balance Sheet and other statements for reporting purposes.

Costing Sub-system

It deals with recording of cost of materials, labour and other expenses with a view to ascertain cost of goods produced.

Budget Sub-system

It deals with the preparation of budget for the coming financial year as well as comparison of actual performances with the current budget.
Summary

- CAS is a system used by businesses for recording the financial information using computers and various accounting software.
- The features of CAS include;
  - Simple and integrated, transparency and control, accuracy and speed, scalability and reliability
- CAS has five components namely procedure, data, people, hardware and software.
- Data element is the smallest unit of data. Data when processed become information.
- The term accounting cycle refers to the specific steps that are involved in the completion of accounting process.
- There is a hierarchical relationship between the groups and its components.
- Codification of accounts refers to allotting code numbers to accounts in a hierarchical structure. The grouping and codification depend upon the type of organisation and the extent of sub-divisions required.
- Codes can be of sequential codes, block codes and mnemonic codes.
- Every accounting software ensures data security, safety and confidentiality.
- The merits of CAS include;
  - Timely generation of reports, efficient record keeping, less time and cost, confidentiality of data, transparency, reliability, and updated information
- The demerits of CAS include;
  - Danger of Hawkers, technological problems, skilled employees are required, chance of data loss, huge training costs of employees and obsolescence of technology.
- CAS integrates the entire sub systems of the organisation and provides a sound accounting information system.

I can

- describe the need of computerized accounting
- identify the various components of Computerised Accounting System (CAS)
- explain the need, importance and methodology of grouping and codification of accounts
- describe the uses of a software for CAS
- list out the merits and demerits of CAS
- list out the various sub systems of accounting information system and their functions
TE QUESTIONS

1. The code 301-399 for cosmetics is an example of .............. code.

2. Find the odd one out.
   a. Data   b. People   c. Hardware   d. Virus

3. Mention the name of any two coding methods with examples.

4. Classify the following into mnemonic codes, sequential codes and block codes.
   a. CA, CL – for current assets and current liabilities.
   b. 001, 002 for customer A and B.
   c. 001 to 099 – soaps, 100 to 199 - face powder.

5. Computerised accounting has several merits over manual accounting. Describe any four.

6. Write a coding structure for a higher secondary school having Science, Commerce and Humanities batches of 1 each. Duration of course is 2 years maximum students in the class is 50. Second language available there are Hindi, Malayalam and Sanskrit.

7. Describe the accounting information system and its sub systems.
Key Concepts

2.1 Electronic Spread Sheets
2.2 Components of the Spreadsheet
2.3 Spreadsheet Operations
2.4 Types of Worksheet Data
2.5 Components of a Formula
2.6 Classification of Functions
2.7 Data Entry, Text Management And Cell Formatting
2.8 Output Reports
2.9 Common Error Codes (Messages) in LibreOffice Calc

Introduction

One of your friends - Lakshmi approaches you and asks your help with a project she is working on. Lakshmi wants to prepare a list of scores obtained by the students of a higher secondary school in Palakkad town. There are 60 students each in three streams namely Commerce, Science and Humanities. The list must include the name of student, batch, sex, and scores obtained by them in the final examination. She also needs to identify the top scorer and percentage for each batch. Lakshmi knows that it is difficult to do this work with pen and paper.

- She seeks your help. Suggest the best software for doing this task.
- What are the calculations we can do with this software?

From your earlier experiences, you know that spreadsheet is particularly a handsome choice of application software when a task involves working with numerical data. Anyone can use a spreadsheet for their work in office, school, personal projects or other purposes. This is regarded as one of the most commonly used analysis and reporting tools. People are using spreadsheet at home for keeping track of their finances, calculation of income tax and even for recording important events chronologically. Its in-built formulae and functions hold the key to analyse data - that is digging out nuggets of important information on various aspects. All these have made spreadsheet an essential tool for
many business professionals in the fields of presentation, illustration, budgeting, and payroll preparations. From the above discussion, can you list down some uses of spreadsheet in accounting other than the above?

- Sales report preparation
- Inventory analysis

Several spreadsheet softwares like Gnumeric, Calligra Sheets, Lotus-123, Microsoft Excel, OpenOffice Calc, LibreOffice Calc etc. are available to perform the above functions. In this unit we shall discuss about the various aspects of LibreOffice Calc which is included in LibreOffice package.

Let’s know more ...

**History of Spreadsheets**

The word 'spreadsheet' came from 'spread', to refer to a newspaper or magazine item that covers two facing pages. Daniel Bricklin is regarded as the 'Father of electronic spreadsheet'. In 1978, Harvard Business School student, Daniel Bricklin came up with the idea for an interactive visible calculator. Bricklin and Bob Frankston then co-invented or co-created the software program VisiCalc. The name 'VisiCalc' is a compressed form of the phrase 'visible calculator'. VisiCalc is considered as the first spreadsheet program that combined all essential features of a modern spreadsheet. Later, Mitch Kapor developed Lotus and his spreadsheet program quickly became the new industry spreadsheet standard. Lotus 1-2-3 is the first spreadsheet software established as a major data presentation.

**2.1 Electronic Spreadsheets**

Electronic spreadsheet is a computer application software that provides interactive pages similar to a calculator, which allows the user to arrange and organise huge volume of data in a tabular form. Spreadsheets facilitate arithmetic calculations, arrange and analyse data and provide easy correction of errors.

A file in spreadsheet is known as a 'Workbook'. A workbook is a collection of a number of 'Worksheets'. At a time, only one worksheet can be made as active worksheet and that worksheet is available to a user for carrying out operations. Worksheet names will be shown in the 'Sheet Tab' at the bottom left of the window. Additional sheets can be added and its name can be changed, if required.
Free and Open-Source Software (FOSS)

Free and open-source software (FOSS) is the computer software that can be classified as both free software and open-source software. That is, anyone is freely licensed to use, copy, study, and change the software. The source code is openly shared so that people are encouraged to voluntarily improve the design of the software. This is in contrast to proprietary software, (like Windows) where the software is under restrictive copyright and the source code is usually hidden from the users. The benefits of using FOSS include lower software costs, enhanced security and stability (especially with regard to Malware), protecting privacy and giving users more control over their own hardware. Free, open-source operating systems such as Linux are widely utilized today, powering millions of servers, desktops, smartphones (eg. Android) and other devices.

2.1.1 LibreOffice Calc

LibreOffice Calc is a spreadsheet application that we can use to calculate, analyse, and manage data. It is included in LibreOffice Package, which is Free and Open Source software under the General Public Licence (GPL). LibreOffice Calc is available for a variety of platforms, including Linux, OS X, Microsoft Windows, and FreeBSD.

2.1.2 Features of LibreOffice Calc

As a spreadsheet, LibreOffice Calc has the following features:-

1. **Easy Calculations**
   The software provides a lot of tools with which one can perform even complex calculations on different data spread across sheets with ease.

2. **What-If Calculations**
   This lets users to predict what will happen if certain condition changes. For instance, you can see how change in interest rate affects the installment of a loan.

3. **Serves as a database**
   A spreadsheet also performs the functions of a database. Even huge volume of data can be organised, stored and filtered without much efforts. This programme allows storing any number of data in different sheets.

4. **Arranging Data**
   The data stored in a spreadsheet can be organised or reorganised according to the needs of the users. We can also apply formatting, sorting and filtering functions to customise as per the requirements.

5. **Dynamic Charts**
   The inbuilt charts and graphs provide versatility in presenting the data in an appealing manner. Different types of charts are available in the application which cater to the various needs of the users.
2.2 Components of LibreOffice Calc

When LibreOffice Calc opens, the programme window displays a blank worksheet as shown in figure 2.1.

![Blank Worksheet](image)

Fig. 2.1 Blank Worksheet

Navigating through the figure 2.1 will give a clear picture of the various components of a spreadsheet. Let us discuss some of the major components.

1. **Rows and Columns**

The Worksheet in LibreOffice Calc contains Rows and Columns in Table format. Rows are named numerically (1,2,........) from top to bottom while Columns are referred by alpha characters (A,B,C,D,....) from left to right.

### Let’s know more ...

**Inserting new Rows or Columns**

We can add or delete Rows and columns in a Spreadsheet. To add column, click at the column header (right click on the mouse), there we get an option to add columns. In similar manner, we can add rows also by clicking on the row header. Delete option is also available in the pop up menu by right clicking on column or row header.

![Add new columns](image)

Fig. 2.2 Add new columns

![Add new rows](image)

Fig. 2.3 Add new rows
2. **Cell**

In a spreadsheet, data are recorded in cells. The intersection of a Row and a Column is called a cell. A cell is identified by a combination of a letter (column header) and a number (row header). For example, the first cell of a worksheet is identified as A1. From the figure 2.4 can you name the cell? The cell name is 'C4'. Each cell thus has a unique identification known as 'Cell Address'.

3. **Range**

Range is a group or block of cells that are highlighted in a worksheet. A range may contain just a single cell or many cells.

*How can we express a range of cells?*

This is specified by giving the address for first cell in the range and the last cell in the range. For example, B2:D8 represents the range starting from B2 to D8. We use colon (:) as the range operator. Refer the figure 2.5.

**Naming Ranges**

This means giving a name to a specific range. For example, scores obtained by the students of your class in Accounting is given in the range C2:C15. You can name this range as "Score". Now this range name can be used in various formulae or functions instead of quoting cell range. This enables us to save time and avoid complexity while framing formulae. For example, to calculate the 'Average Score', use the formula as =AVERAGE(Score), instead of =AVERAGE(C2:C15).

The procedure for 'Naming ranges' and its use in formula is illustrated below:

- Enter the scores of each student in a worksheet as shown in figure 2.6.
Select the cells which are to be named. Here, select C2:C15 and go to

**Insert → Names → Define...**

Then, the window 'Define Name' appears in the screen as shown in figure 2.7.

![Define Name Window](image)

**Fig. 2.7 Define Name Window**

- Enter the name of range (Score) in the window appeared and click ‘Add’.
- Now this range name - ‘Score’ can be used in various formulae or functions.
- Use the name of the range in each formula by inserting it from the 'Names' option available in 'Insert' menu.

**Insert → Names → Insert....**

Then, the window 'Paste Names' appears as shown in figure 2.8.

![Paste Names Window](image)

**Fig. 2.8 Paste Names Window**

- Select the name ‘Score’ and click on ‘Paste’ button.
- Then, the name 'Score' will appear in the formula. Pressing 'Enter' key will return the result. See the figure 2.9.
Let's assess

1. LibreOffice Calc is a ......................................... software.
   (a) Presentation (b) Database
   (c) Text document (d) Spreadsheet

2. The intersection of rows and columns in a worksheet is called ............

3. A spreadsheet file is called ..................
   (a) Worksheet (b) Workbook
   (c) Range (d) Pop-up menu

4. A group of adjacent cells that forms a rectangular area is called ............

2.3 Spreadsheet Operations

Some useful spreadsheet operations are discussed below:

1. Open Worksheet

While being on the Calc, you can open a new workbook by choosing 'New' option or by clicking the respective icon from the 'File' menu.

An existing workbook can be opened by choosing 'Open' option in the File menu or by clicking the 'icon' on the standard tool bar.

2. Save a Worksheet

You know that all the files need to be saved in the computer once your work is completed, if you want them to be used in future. 'Save' option in the File menu enables you to save a workbook to the computer. 'Save' icon on the standard tool bar can also be used to save a file. The 'Save As' option is used to save the same file in a different name, location or format.

3. Close worksheet

After you finish working in a workbook, you can close the workbook with 'Close' option from the 'File' menu. Then another workbook can be opened without closing the Calc.
4. **Quit LibreOffice Calc**

Quitting the Calc is different from closing a workbook. On closing the workbook, that particular file will be closed, but Calc application will be still working. On quitting, the entire application will be unloaded from the active memory of the computer. For this, use 'Exit LibreOffice' option from the file menu. To protect our files, always quit Calc before turning off the computer.

![Fig. 2.10 Basic Spreadsheet Operations](image)

5. **Add worksheet**

By default only one worksheet is available. What needs to be done if you want additional worksheets? You can follow any of these steps.

(a) Right click the mouse at sheet tab area and select 'insert Sheet' from the popup menu.

(b) Alternatively, by clicking on the 'Plus mark' near the sheet tab you can insert as many sheets as you need.

6. **Delete worksheet**

To delete an unwanted worksheet, right click the mouse on the sheet tab to be deleted and select the 'Delete Sheet' option from the popup menu.
7. Rename worksheet

By default, worksheets are named as Sheet 1, Sheet 2, and Sheet 3 etc. A worksheet can be renamed by selecting the option 'Rename Sheet' from the popup menu on a right-click of sheet tab. Give the name desired and click OK. New name will appear on the sheet tab.

![Image](image.png)

Fig. 2.11 Insert, Delete and Rename sheet

2.3.1 Spreadsheet Navigation

How can you move rapidly with in a worksheet?

Following navigation methods are available here:

a. **Using Mouse**: You can place the mouse pointer over the cell and click on it.

b. **Using a cell reference**: Click on the little inverted black triangle just to the right of the Name Box on the formula bar. Type the cell reference of the cell you want to go to and press Enter. You may also just click into the Name Box, backspace over the existing cell reference, and type in the cell reference you want.

c. **Using the Navigator**: Click on the Navigator button in the Vertical scrollbar (or press F5) to display the Navigator. Type the cell reference in the Column and Row fields, and press Enter. The navigation window appears as in figure 2.12.

![Image](image.png)

Fig. 2.12 Navigation window
### Keyboard short-cuts for navigating around Spreadsheet

<table>
<thead>
<tr>
<th>Movement</th>
<th>Key Stroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>One cell down</td>
<td>Down arrow key or Enter key</td>
</tr>
<tr>
<td>One cell up</td>
<td>Up arrow key or Shift + Enter key</td>
</tr>
<tr>
<td>One cell right</td>
<td>Right arrow key or Tab key</td>
</tr>
<tr>
<td>One cell left</td>
<td>Left arrow key or Shift + Tab key</td>
</tr>
<tr>
<td>Top of Sheet (cell A1)</td>
<td><strong>CTRL + HOME</strong></td>
</tr>
</tbody>
</table>

The cell at the intersection of the last row and last column containing data

**CTRL + END keys**

Moves the cursor to the right most cell with data in the current row. If there is no data in the current row, the cursor moves to the last cell in that row.

**CTRL + Right arrow key**

Moves the cursor to the bottom cell with data in the current column. If there is no data, the cursor moves to the last cell in the current column.

**CTRL + Down arrow key**

Beginning of the Row

**HOME key**

Moves the cursor to the extreme left cell with data in the current row. If the current row is empty, the cursor moves to the first cell in that row.

**CTRL + Left arrow key**

Moves the cursor to the top most cell with data in the current column. If the current column is empty, the cursor moves to the first cell in that column.

**CTRL + Up arrow key**

Moves cursor to the last cell in the column with data in the current row.

**END key**

### 2.4 Types of Worksheet Data

In the cell of a worksheet usually three types of data are entered:

(a) Value

(b) Label

(c) Formula

(a) **Value**: Value is a number that you enter in a cell. Thus, numerical data is called a value. It also includes currency symbol, minus sign (-), plus sign (+),
decimal point (.) and comma (,). The worksheet accepts positive values and negative
values. By default values are right-aligned. Calculations can be done using the values
only. For example: Age of employee, Salary of employee etc.

(b) **Label:** The text data is called label. It includes alphabets and symbols. They are
non-numeric data but may include digits also. By default, labels are left-aligned. For
example: Name of Employee, Sex, Designation etc.

(c) **Formula:** The worksheet cells also contains formula to perform calculations. When
a formula is entered in a cell the result of the formula will be displayed on pressing the
'Enter' key. The actual formula is displayed on the 'input line' of the spreadsheet.
Formula should always begin with an equal sign (=). Even if a formula begins with
mathematical symbols + (plus) or - (minus), the software will prefix = (equal to) sign
in the formula.

### 2.5 Components of a Formula

Formulae are Calc’s most powerful aid for getting your work done. Formulae usually
speed up the creation of your worksheet. You don’t need to worry about whether the
calculation is correct because Calc doesn’t make mistakes. Best of all, if you change any
value in a formula, Calc automatically update the results.

Now it’s time to think in terms of what constitutes a formula?

A standard formula may have three components:

(a) Cell References

(b) Mathematical operators

(c) Functions

#### 2.5.1 Cell References

The cell co-ordinates in a formula are called cell reference. A cell reference identifies the
location of a cell or group of cells in the spreadsheet. In other words, the cell address
used in a formula is called cell reference. A cell reference may be relative, absolute and
mixed.

(i) **Relative Cell Reference**

Let us see how relative reference works.....

Suppose in E5 you enter a formula =C5+D5 and press enter key the result will be
displayed in cell E5. If you copy the above formula to cell E6 the new formula will read
as = C6+D6. With relative referencing you can create a formula in one column and then
just copy this formula to other columns.

By default cell reference is relative. Here when a formula is copied to a new location in a
worksheet, cell references in the formula change in relation to the new location of the
formula.
(ii) **Absolute cell reference**

When you copy a formula or function, absolute reference is used to keep a cell reference constant. The cell references in a formula remain the same even when the formula is copied to a new location. For absolute cell referencing, you need to use the $ (dollar) symbol as prefix before the column and row names in a formula. $A$5 is example an for absolute reference.

(iii) **Mixed cell reference**

You know that a cell address has two parts- first part denotes column letter and second row number.

If any one part is prefixed with a dollar ($) sign leaving the other part plain then it is termed as mixed reference. For example, $B4$ or $B$4 is mixed reference. This is a combination of relative and absolute cell references.

### 2.5.2 Mathematical operators

If you need to create a formula, you must include a mathematical operator. The following table tells you about various types of operators -

- a. Arithmetic
- b. Comparison
- c. Reference

<table>
<thead>
<tr>
<th>Operation performed</th>
<th>Operator symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Arithmetic Operators</strong></td>
<td></td>
</tr>
<tr>
<td>Addition</td>
<td>+</td>
</tr>
<tr>
<td>Subtraction</td>
<td>-</td>
</tr>
<tr>
<td>Multiplication</td>
<td>*</td>
</tr>
<tr>
<td>Division</td>
<td>/</td>
</tr>
<tr>
<td>Percent</td>
<td>%</td>
</tr>
<tr>
<td>Exponential</td>
<td>^</td>
</tr>
<tr>
<td><strong>Comparison Operators</strong></td>
<td></td>
</tr>
<tr>
<td>Equal to</td>
<td>=</td>
</tr>
<tr>
<td>Greater than</td>
<td>&gt;</td>
</tr>
<tr>
<td>Less than</td>
<td>&lt;</td>
</tr>
<tr>
<td>Greater than or Equal to</td>
<td>&gt;=</td>
</tr>
<tr>
<td>Less than or Equal to</td>
<td>&lt;=</td>
</tr>
<tr>
<td>Not equal to</td>
<td>&lt;&gt;</td>
</tr>
<tr>
<td><strong>Reference Operators</strong></td>
<td></td>
</tr>
<tr>
<td>Range operator</td>
<td>:</td>
</tr>
<tr>
<td>Union operator</td>
<td>,</td>
</tr>
</tbody>
</table>
2.5.3 Functions

We have already discussed about formula. How is it different from a function? The following discussion will make it clear.

Functions are the pre-defined formulae in spreadsheet that return a specific result. It is built in set of formulae which starts with an 'equal to sign' (=). It is a special key word which can be entered into a cell in order to perform and process the data which is appended within brackets. A function differs from a formula in the sense that the former is designed by the software, but the latter is user designed. In a function we should give only the cell references, but not the arithmetic operators. Functions perform calculations by using specific values called 'arguments', in a particular order called 'syntax'.

You should remember the following while using a function:

- Use an equal sign (=) to begin the function.
- Specify the function name. (Example : SUM)
- Enclose all the arguments within brackets.
- Use comma to separate the individual arguments in a function.
- Strictly follow the syntax of the function.

You might have noticed this button $f(x)$' (called as function wizard) on the formula bar. (see fig 2.14). When we click it, function offers assistance and prompts into a spreadsheet cell. Alternatively, we can enter the function directly into the formula bar. We can also select any function by clicking 'function' at the Insert tab or by pressing Ctrl+F2.

AVERAGE, COUNT, MIN, MAX, SUM etc. are some of the commonly used functions which are relatively easy to understand. These functions with its results are shown in figure 2.13.

**Autosum ($\Sigma$)**

The AUTOSUM ($\Sigma$) function is the most basic and one of the commonly used functions. It is used to get the total (sum) of various numbers. For example if you need to get the sum of cells A2:C2 in Cells D2, select the cell D2 and click on sum button in the formula bar and then press enter key. To get the result in any other cell in the worksheet, select the required cell, click on SUM button and highlight the range A2:C2 and then press Enter key. (See Fig 2.14).
2.6 Classification of Functions

Numerous inbuilt functions are available in LibreOffice Calc, but for the time being our study is limited to the following.

1. Date & Time Functions
2. Statistical Functions
3. Logical Functions
4. Mathematical Functions
5. Text Functions
6. Spreadsheet Functions
7. Financial Functions

2.6.1 Date & Time Functions

This function is used to perform operations on date and time values. This includes fetching today’s date, current time, calculating number of days between two given dates etc.

In effect Date and Time functions are used for inserting, editing and manipulating date and time. LibreOffice calc internally handles a date/time as a numerical value. If you assign the format "Number" to a date or time, it is converted to a number. For example, the date 01/01/2017 is converted to 42736. This number can be converted in to date format by changing the format as date or time.

You may change the default date format from the tools option (see figure 2.15). The path is:

Tools → Options → LibreOffice Calc → Calculate
The use of " / " or " - " in date may be interpreted as arithmetic operators. So date values used in Calc's function must be entered in double quotes.

For example "01/01/2017".

The most commonly used Date & Time functions are:

- **TODAY**

  This function returns the current computer system date in the cell. The current date is automatically returned when we open the document on a future date. TODAY is a function without arguments.

  Syntax: =TODAY()

  Example:

  Suppose today is 16th December 2017 and if we enter TODAY( ) function in a cell =TODAY( ), it will return 16/12/2017 as current date.

- **NOW**

  NOW function displays the current system date and time. It differs from the TODAY function in the sense that it returns current time along with current date. It is also a function without arguments.

  Syntax: =NOW()

  Example: If you enter NOW() function in cell B1 on 20th July 2017 at 04.39 PM, it will return 20/07/17 16:39 in B1.
- **YEAR**
  
  YEAR function returns the 'year' from the date or date value given in the brackets.

  Syntax: =YEAR("Date")

  Example: =YEAR("01/05/2016") returns 2016 as shown in figure 2.16

- **MONTH**
  
  MONTH function returns the month of a given date as an integer between 1 and 12.

  Syntax: =MONTH("date")

  Examples: =MONTH("05/08/2016") returns the result 8 as shown in figure 2.17

- **DAY**
  
  DAY function returns integer value of a given date (between 1 and 31).

  Syntax: =DAY("date")

  Examples: =DAY("25/05/2016") return 25

- **DATE VALUE**
  
  LibreOffice Calc considers 30/12/1899 as the base date with date value zero (0). Based upon this, DATEVALUE function converts the given date and return its corresponding date value number.

  Syntax: =DATEVALUE("Text")

  The 'Text' parameter implies that date must be given as text. Giving date in double quotes will consider the date as text. Date without quotes will return an error message (Err502)

  Example:- =DATEVALUE("31/01/2017") - Display 42766 as shown in figure 2.18

<table>
<thead>
<tr>
<th>Formula Used</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>=DATEVALUE(&quot;30/12/1899&quot;)</td>
<td>0</td>
</tr>
<tr>
<td>=DATEVALUE(&quot;31/12/1899&quot;)</td>
<td>1</td>
</tr>
<tr>
<td>=DATEVALUE(&quot;01/01/1900&quot;)</td>
<td>2</td>
</tr>
<tr>
<td>=DATEVALUE(&quot;01/01/2000&quot;)</td>
<td>36526</td>
</tr>
<tr>
<td>=DATEVALUE(&quot;01/12/2015&quot;)</td>
<td>42339</td>
</tr>
<tr>
<td>=DATEVALUE(&quot;01/01/2018&quot;)</td>
<td>43101</td>
</tr>
</tbody>
</table>

*In LibreOffice Calc 30/12/1899 has been set as the default date with date value zero (0). The number is determined by date settings in the Tools menu. We can change the default date to 01/01/1900 or 01/01/1904 as shown in figure 2.15.*

Fig. 2.16 Example of YEAR function

Fig. 2.17 Example of MONTH function

Fig. 2.18 Example of DATEVALUE function
For ascertaining year, month and day, we may use datevalue instead of date while using YEAR, MONTH and DAY functions. Their syntax are:

=YEAR(datevalue)
=MONTH(datevalue)
=DAY(datevalue)

Let us calculate the year and month of datevalue 42766 (Date “31/01/2017”) by using YEAR and MONTH functions:

=YEAR(42766) returns 2017 as shown in Fig 2.19
=MONTH(42766) returns 1 as shown in Fig 2.20.

- **DATE**

This function returns a date, when the year, month and day parameters are given as integer separated by commas.

Syntax : =DATE(Year, Month, Day)

Example: =DATE(2017,12,08), it is displayed as - 08/12/17 as shown in Figure 2.21

### Various date formats available in Calc

<table>
<thead>
<tr>
<th>DATE Function</th>
<th>Cell Format</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>=DATE(2017,12,23)</td>
<td>DD/MM/YYY</td>
<td>23-12-2017</td>
</tr>
<tr>
<td>=DATE(2017,12,23)</td>
<td>Number – General</td>
<td>43092</td>
</tr>
<tr>
<td>=DATE(2017,12,23)</td>
<td>DD/MM/YY</td>
<td>23-12-17</td>
</tr>
<tr>
<td>=DATE(2017,12,23)</td>
<td>D MMMM YYYY</td>
<td>23 December 2017</td>
</tr>
<tr>
<td>=DATE(2017,12,23)</td>
<td>NNNNND MMMM YYYY</td>
<td>Saturday, 23 December 2017</td>
</tr>
</tbody>
</table>

### Try Yourself

Show the following:

(a) Display Current system date in Cell B2
(b) Display Current system date and time in Cell B3
(c) Display Year from the given date 31/12/2017 in Cell B4
(d) Display Month from the given date 31/12/2017 in Cell B5
(e) Display Date from the given date 31/12/2017 in Cell B6
(f) Display Numerical value corresponding to the date 31/12/2017 in cell B7
(g) Calculate your age by using DATEVALUE() function.

**Let's assess**

1. Identify the function which converts date into the corresponding internal date number.
   (a) TODAY  (b) DATEVALUE  (c) NOW  (d) DATE
2. Identify the function which displays the current system date.
   (a) TODAY  (b) DATEVALUE  (c) NOW  (d) DATE
3. Which function returns the system date and time?

### 2.6.2 Statistical Functions

Statistical function operates on a set of data and gives summarised results. LibreOffice Calc provides a number of statistical functions, such as AVERAGE, MIN, MAX, COUNT etc. A few of them are discussed in this section.

- **COUNT**

This function returns the count of numeric value used in a given range of cells. Only numbers, dates and time are counted here. Empty cells, logical values, text and error codes are not considered.

For example, the Fig 2.22 contains some values from cells A1 to D3. If you apply the formula =COUNT(A:D3) in cell E3, Calc returns the value as 5. Here you can see that blank columns, text values etc. are not considered.

Syntax : = COUNT(Value1, Value2.....)

= COUNT (Range )

![Fig. 2.22 - Example of COUNT function](image)

- **COUNTA**

The COUNTA function counts the total number of cells which contain any value. It will count numbers, text, date, time, logical values, and error codes in the specified range or list of arguments. But empty cells are not counted here.
If you apply the formula =COUNTA(A1:D3) in the example shown in figure 2.22, it returns the result as ‘8’ in cell E3 by avoiding the blank cells in that range specified.

Syntax:  
=COUNTA(Value1,Value2.......)

=COUNTA(Range)

- **COUNTBLANK**

COUNTBLANK function counts the number of empty cell in the given range. It is the opposite function of COUNTA.

Syntax:  
=COUNTBLANK(Range)

Example:  
=COUNTBLANK(A1:E1) gives the result as shown in figure 2.23 as there is only one blank cell.

![Fig. 2.23: Example of COUNTBLANK function](image)

- **COUNTIF**

This function counts the number of cells within a given range that meets the user defined criteria or condition.

Syntax:  
=COUNTIF(Range,Criteria)

Where,

Range - It is the set of cells to which the criteria are to be applied.

Criteria - it can be a number, an expression, cell reference or a character string. For example, criteria can be expressed as 5000, ">32", "Commerce", or C4. If you search for literal text enclose the text in double quotes.

For example, see the given Fig. 2.24 in which A2:A11 contains numbers from 2000 to 2009 and in cell B2 the number 2006 is also included. The table shows clearly how COUNTIF function can be used with different criteria in column 'C' and its output is shown in the next column.

![Fig. 2.24 Example of COUNTIF function](image)
### Statistical Functions at a glance

<table>
<thead>
<tr>
<th>Function</th>
<th>Syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>COUNT</td>
<td>=COUNT(Range)</td>
<td>Counts the number of cells in a range that contain numbers</td>
</tr>
<tr>
<td>COUNTA</td>
<td>=COUNTA(Range)</td>
<td>Counts the number of cells which contain any value including text</td>
</tr>
<tr>
<td>COUNTBLANK</td>
<td>=COUNTBLANK(Range)</td>
<td>Counts the number of empty cells in the given range</td>
</tr>
<tr>
<td>COUNTIF</td>
<td>=COUNTIF(Range,Criteria)</td>
<td>Counts the number of cells within a given range that meet the given criteria</td>
</tr>
</tbody>
</table>

#### 2.6.3 Logical functions

Logical functions are used to compare two values or statements. The commonly used logical functions are IF, AND and OR. All logical functions return either logical True or logical False when their functions are evaluated.

- **IF**

  When we need to test a condition, whether it is true or false, then usually IF function is used. This function will analyse a logical test that you define and give a certain result based on the given condition. You are also able to determine exactly what happens if logical test is true or if the logical test is false.

  Syntax: \( =IF(\text{Test, Then\_Value, Otherwise\_Value}) \)

  Where,

  Test is any value or expression that can be TRUE or FALSE. This requires the use of a logical operator such as \( =, >, <, >=, <=, <> \).

  Then\_Value is the value that is returned if the logical test is TRUE.

  Otherwise\_Value is the value that is returned if the logical test is FALSE.

  Example: \( =IF(C2>40, "PASSED", "FAILED") \)

  Here, if the value given in C2 is greater than or equal to 40, the function gives the result "PASSED", Otherwise returns the result "FAILED".

  Consider the following example:

  Names and scores of few students in an examination are given in Fig 2.25. Insert your argument as students who scored above 40 as "PASS" and otherwise "FAIL.". You can enter the formula as:

  ![Fig. 2.25 - Using IF functions](image)
=IF(C2>40,"PASS", "FAIL"), press enter key and copy the formula to other cells.

The results are also shown in the figure 2.25

The procedure for using IF function with the help of function wizard is as follows.

1. Activate the cell where the function is to be used (E2)
2. Select Function from the Insert menu
3. Select "Logical" from the category option followed with IF function from the left pane of the wizard
4. Then enter C2>40 in the Test field, followed by "PASS" and "FAIL" in the next two fields, as shown in Fig. 2.26. The Formula will show up in the column provided as
   =IF (C2>40, "PASS", "FAIL"")
5. Click on OK tab and the result will be displayed in cell E2. Copy the function from E3 to E9.

- Nested IF

From the above discussion you might have understood that, IF function which tests single criteria is very simple and straight forward. But, what is to be done if your data requires more logical tests with multiple conditions?

In such a situation you can include several IF conditions in one formula, and these multiple IF statements are called 'NESTED IF'. The biggest advantage here is that you can test more than one condition and return different values in a single formula.

Syntax :

=IF(Test_1, ThenValue_1, IF(Test_2, ThenValue_2, IF(..............................)))

Let us explain the concept with the help of the following example.

The name and scores obtained by some students are given. You are required to ascertain their grades on the basis of the criteria specified.

Grade Criteria : A+ (90-100); A (80-89); B+(70-79); B(60-69); C+(50-59); C(40-49); D+ (30-39); D - below 30.

Try this given formula in D2. In this case, if the first condition tested is FALSE, the application will test the next condition and so on. (See figure 2.27)

(Note that in a formula brackets should be used in pairs)

**Fig. 2.27 - Nested IF**

- **AND**

AND function is used to determine whether the output will be TRUE or FALSE. It comes in handy when all the conditions are to be tested and made sure that all are met. It returns TRUE if all the arguments evaluated are TRUE. If any argument is FALSE, this function returns the FALSE value.

Syntax: =AND(LogicalValue1, LogicalValue2, ......LogicalValue30)

**The outcomes of AND function in various cases**

<table>
<thead>
<tr>
<th>Formula</th>
<th>Description</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>=AND(10&lt;13,14&gt;12,7&gt;6)</td>
<td>All arguments are true</td>
<td>TRUE</td>
</tr>
<tr>
<td>=AND(10&gt;13,14&gt;12,7&gt;6)</td>
<td>One Argument is false</td>
<td>FALSE</td>
</tr>
<tr>
<td>=AND(10&gt;13,14=12,7&lt;6)</td>
<td>All Arguments are false</td>
<td>FALSE</td>
</tr>
<tr>
<td>=AND(2+2=4,5+3=8)</td>
<td>All arguments are true</td>
<td>TRUE</td>
</tr>
<tr>
<td>=AND(2+2=5,5+3=8)</td>
<td>One Argument is false</td>
<td>FALSE</td>
</tr>
<tr>
<td>=AND(2+2=5,4+3=8)</td>
<td>All Arguments are false</td>
<td>FALSE</td>
</tr>
</tbody>
</table>

AND function in combination with other functions, provides enormous possibilities to a worksheet.

Consider the given example:

The scores of students in two subjects Accountancy and Business Studies are given below. Find the students who satisfy the arguments given in the last column using AND function.
Score sheet of students

<table>
<thead>
<tr>
<th>Name</th>
<th>Scores</th>
<th>Argument</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Accountancy</td>
<td>Business studies</td>
</tr>
<tr>
<td>Reshmi</td>
<td>50</td>
<td>45</td>
</tr>
<tr>
<td>Manohar</td>
<td>35</td>
<td>60</td>
</tr>
<tr>
<td>Preeja</td>
<td>72</td>
<td>39</td>
</tr>
<tr>
<td>Latheef</td>
<td>46</td>
<td>38</td>
</tr>
<tr>
<td>Stephen</td>
<td>60</td>
<td>85</td>
</tr>
<tr>
<td>Elizabeth</td>
<td>75</td>
<td>79</td>
</tr>
</tbody>
</table>

Let us see the formula that was given to satisfy the given argument using AND function in the Fig 2.28.

![Fig. 2.28 Example of AND and IF function](image)

- **OR**

OR function is used to compare two values or statements. The difference between OR and AND is that OR will return ‘TRUE’ if at least one argument is correct and ‘FALSE’ if all the arguments are wrong. But in AND all the arguments must be correct for giving a ‘TRUE’ value.

Syntax: =OR(LogicalValue1, LogicalValue2, ....LogicalValue30)

Consider the given example:

The scores of students in two subjects Accountancy and Business Studies are listed below. Ascertain how the arguments given are met or not using OR function.
Score sheet of students

<table>
<thead>
<tr>
<th>Name</th>
<th>Accountancy</th>
<th>Business studies</th>
<th>Argument</th>
</tr>
</thead>
<tbody>
<tr>
<td>Priya</td>
<td>50</td>
<td>45</td>
<td>Accountancy score more than 50 OR Business Studies score more than 40</td>
</tr>
<tr>
<td>Smitha</td>
<td>35</td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>Preeja</td>
<td>72</td>
<td>39</td>
<td></td>
</tr>
<tr>
<td>Lijja</td>
<td>46</td>
<td>38</td>
<td></td>
</tr>
<tr>
<td>Reena</td>
<td>60</td>
<td>85</td>
<td>Accountancy score more than 80 OR Business Studies score more than 80 will be “SELECTED” else “REJECTED”</td>
</tr>
<tr>
<td>Shyma</td>
<td>87</td>
<td>57</td>
<td></td>
</tr>
<tr>
<td>Vineetha</td>
<td>82</td>
<td>81</td>
<td></td>
</tr>
<tr>
<td>Elizabeth</td>
<td>75</td>
<td>79</td>
<td></td>
</tr>
</tbody>
</table>

Observe the table given to see the formula used and the output generated:

<table>
<thead>
<tr>
<th>Name</th>
<th>Scores</th>
<th>Result</th>
<th>Formula Used</th>
<th>Argument TRUE or FALSE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Priya</td>
<td>50</td>
<td>TRUE</td>
<td>=OR(B3&gt;=50,C3&gt;=40)</td>
<td>All arguments are True</td>
</tr>
<tr>
<td>Smitha</td>
<td>35</td>
<td>TRUE</td>
<td>=OR(B4&gt;=50,C4&gt;=40)</td>
<td>One Argument is True</td>
</tr>
<tr>
<td>Preeja</td>
<td>72</td>
<td>TRUE</td>
<td>=OR(B3&gt;=50,C3&gt;=40)</td>
<td>One Argument is True</td>
</tr>
<tr>
<td>Lijja</td>
<td>46</td>
<td>FALSE</td>
<td>=OR(B6&gt;=50,C6&gt;=40)</td>
<td>All arguments are False</td>
</tr>
<tr>
<td>Reena</td>
<td>60</td>
<td>SELECTED</td>
<td>=IF(OR(B7&gt;=80,C7&gt;=80),”SELECTED”,”REJECTED”)</td>
<td>One Argument is True</td>
</tr>
<tr>
<td>Shyma</td>
<td>87</td>
<td>SELECTED</td>
<td>=IF(OR(B8&gt;=80,C8&gt;=80),”SELECTED”,”REJECTED”)</td>
<td>One Argument is True</td>
</tr>
<tr>
<td>Vineetha</td>
<td>82</td>
<td>SELECTED</td>
<td>=IF(OR(B9&gt;=80,C9&gt;=80),”SELECTED”,”REJECTED”)</td>
<td>All arguments are True</td>
</tr>
<tr>
<td>Elizabeth</td>
<td>75</td>
<td>REJECTED</td>
<td>=IF(OR(B10&gt;=80,C10&gt;=80),”SELECTED”,”REJECTED”)</td>
<td>All arguments are False</td>
</tr>
</tbody>
</table>

2.6.4 Mathematical functions

Calc provides several mathematical functions which help us to expedite analysis. Here you will get a chance to practice using some of these functions more commonly needed in spreadsheets for business applications. They are SUM and ROUND.

- **SUM**

This function is used to get the sum of the given numbers, cells or range of cells. This was already discussed in the beginning of this unit.

Syntax: 

- =SUM(number1, number2,...........) 
- =SUM(cell1, cell2,..................) 
- =SUM(Range1,Range2,..................)
**SUMIF**

This function is little different from the SUM function. It only sums its values when a particular condition or criteria is met. That is, SUMIF will add only those figures from a particular range which satisfies the conditions.

Syntax: ```=SUMIF(range,"criteria", sum_range)```  

Where,

- **Range** means the range of cells to which the criteria are to be applied.
- **Criteria** are the condition to be fulfilled for totalling cells.
- **Sum-range** means the range of cells considered for totalling which matches the given criteria. If this parameter is not indicated, the values found in the range are summed.

Let us see an example:

The table given shows the values of Assets owned by M/s. Santhi Associates and its depreciation for the year ending 31st December 2017.

Compute the following by using SUMIF Function.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Name of Asset</td>
<td>Value of Asset ₹</td>
<td>Depreciation ₹</td>
</tr>
<tr>
<td>2</td>
<td>Land</td>
<td>750000</td>
<td>90000</td>
</tr>
<tr>
<td>3</td>
<td>Buildings</td>
<td>300000</td>
<td>45000</td>
</tr>
<tr>
<td>4</td>
<td>Plant</td>
<td>500000</td>
<td>60000</td>
</tr>
<tr>
<td>5</td>
<td>Machinery</td>
<td>250000</td>
<td>30000</td>
</tr>
<tr>
<td>6</td>
<td>Furniture</td>
<td>100000</td>
<td>20000</td>
</tr>
</tbody>
</table>

(a) Total depreciation of those assets which is more than ₹ 4,00,000  
(b) Total depreciation of those assets which is less than ₹ 3,50,000  
(c) Total depreciation of those assets which is exactly ₹ 3,00,000  
(d) Total value of Assets which is less than or equal to ₹ 3,00,000  
(e) Total value of Assets which is more than or equal to ₹ 5,00,000

The following table will help you to understand how the formula will work in different situations.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Name of</td>
<td>Value of</td>
<td>Depreciation</td>
<td>Total depreciation of assets</td>
<td>RESULT</td>
<td>Function Used</td>
</tr>
<tr>
<td></td>
<td>Asset</td>
<td>Asset ₹</td>
<td>₹</td>
<td>which is more than Rs 4,00,000</td>
<td>150000</td>
<td>=SUMIF(B2:B6,&quot;&gt;400000&quot;,C2:C6)</td>
</tr>
<tr>
<td>2</td>
<td>Land</td>
<td>750000</td>
<td>90000</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Buildings</td>
<td>300000</td>
<td>45000</td>
<td>Total depreciation of assets which is less than Rs 3,50,000</td>
<td>95000</td>
<td>=SUMIF(B2:B6,&quot;&lt;350000&quot;,C2:C6)</td>
</tr>
<tr>
<td>4</td>
<td>Plant</td>
<td>500000</td>
<td>60000</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Machinery</td>
<td>250000</td>
<td>30000</td>
<td>Total value of Assets which is less than or equal to Rs 3,00,000</td>
<td>650000</td>
<td>=SUMIF(B2:B6,&quot;&lt;=300000&quot;)</td>
</tr>
<tr>
<td>6</td>
<td>Furniture</td>
<td>100000</td>
<td>20000</td>
<td>Total value of Assets which is more than or equal to Rs 5,00,000</td>
<td>1250000</td>
<td>=SUMIF(B2:B6,&quot;&gt;=500000&quot;)</td>
</tr>
</tbody>
</table>
• **ROUND**

Often while carrying out division of numbers, calculating interest, preparing pay roll etc., the end result may be in fraction. Calc provides ‘ROUND’ function to round-off a number to a certain number of decimal places.

Syntax: `=ROUND(Number,Count)`

Where:

- **Number** - Number to round to specified number of digits
- **Count** - It specifies the number of digits to round the number

Suppose, number 128.758 is given and is asked to round it to 2 decimal places, doing this manually is very easy. But if huge volume of data is given and you need to round off some digits then this spreadsheet application comes in handy. Let us see how this can be done:

`=ROUND(128.758,2)` and the result will be 128.76

In the above example the ‘Count’ is given as 2. So the given number is rounded to the second decimal place. The table will give you an idea about the effect on the results, if the count is changed to 0, 1, -1, -2 etc.

**Examples of Round Function**

<table>
<thead>
<tr>
<th>FORMULA</th>
<th>DESCRIPTION</th>
<th>RESULT</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>=ROUND(25431.2572,2)</code></td>
<td>Rounds 25431.2572 to 2 decimal place</td>
<td>25431.26</td>
</tr>
<tr>
<td><code>=ROUND(25431.2572,1)</code></td>
<td>Rounds 25431.2572 to 1 decimal place</td>
<td>25431.3</td>
</tr>
<tr>
<td><code>=ROUND(45431.725,0)</code></td>
<td>Rounds 45431.725 to 0 decimal place to nearest integer</td>
<td>45432</td>
</tr>
<tr>
<td><code>=ROUND(25431.2572,-1)</code></td>
<td>Rounds 25431.2572 to nearest 10 (left of the decimal)</td>
<td>25430</td>
</tr>
<tr>
<td><code>=ROUND(25431.2572,-2)</code></td>
<td>Rounds 25431.2572 to nearest 100 (left of the decimal)</td>
<td>25400</td>
</tr>
</tbody>
</table>

- If count is greater than zero, then number is rounded to the specified number of decimal places.
- If count is zero, then number is rounded to the nearest integer.
- If count is less than zero, then number is rounded to the left of the decimal point.

• **ROUNDDUP**

This function is similar to ROUND function. This function rounds a number up away from zero, without considering the value next to the rounding digit.

Syntax: `=ROUNDDUP(number,count)`
The following example given in the table put you in better position to understand the ROUNDDUP function.

**Examples of Roundup function**

<table>
<thead>
<tr>
<th>FORMULA</th>
<th>DESCRIPTION</th>
<th>RESULT</th>
</tr>
</thead>
<tbody>
<tr>
<td>=ROUNDDUP(45321.7354,2)</td>
<td>Rounds 45321.7354 UP to 2 decimal place</td>
<td>45321.74</td>
</tr>
<tr>
<td>=ROUNDDUP(45321.7354,1)</td>
<td>Rounds 45321.7354 UP to 1 decimal place</td>
<td>45321.8</td>
</tr>
<tr>
<td>=ROUNDDUP(45321.7354,0)</td>
<td>Rounds 45321.7354 UP to 0 decimal place</td>
<td>45322</td>
</tr>
<tr>
<td>=ROUNDDUP(45321.7354,-1)</td>
<td>Rounds 45321.7354 UP to the left of the decimal (Rounds UP to the next 10)</td>
<td>45330</td>
</tr>
<tr>
<td>=ROUNDDUP(45321.7354,-2)</td>
<td>Rounds 45321.7354 UP to 2 decimal place to the left of the decimal (Rounds UP to the next 100)</td>
<td>45400</td>
</tr>
</tbody>
</table>

**ROUNDDOWN**

This function does the opposite of ROUNDDUP. It rounds a number down towards zero.

Syntax: =ROUNDDOWN(Number,Count)

The listed examples generate an idea on ROUNDDOWN function.

**Examples of Rounndown function**

<table>
<thead>
<tr>
<th>FORMULA</th>
<th>DESCRIPTION</th>
<th>RESULT</th>
</tr>
</thead>
<tbody>
<tr>
<td>=ROUNDDOWN(45321.7354,2)</td>
<td>Rounds 45321.7354 down to 2 decimal place</td>
<td>45321.73</td>
</tr>
<tr>
<td>=ROUNDDOWN(45321.7354,1)</td>
<td>Rounds 45321.7354 down to 1 decimal place</td>
<td>45321.7</td>
</tr>
<tr>
<td>=ROUNDDOWN(45321.7354,0)</td>
<td>Rounds 45321.7354 down to 0 decimal place</td>
<td>45321</td>
</tr>
<tr>
<td>=ROUNDDOWN(45321.7354,-1)</td>
<td>Rounds 45321.7354 down to the left of the decimal (Rounds down to the next 10)</td>
<td>45320</td>
</tr>
<tr>
<td>=ROUNDDOWN(45321.7354,-2)</td>
<td>Rounds 45321.7354 down to 2 decimal place to the left of the decimal (Rounds down to the next 100)</td>
<td>45300</td>
</tr>
</tbody>
</table>

2.6.5 Text Functions

Text functions are used for creating or modifying the data entered in cells to a required text format to same cell or another cell. Commonly used text functions are TEXT and CONCATENATE.

**TEXT**

You have already learnt about different types of data to be inserted in a cell. This can be number or text. Is it possible for us to convert a number into a text format in Calc?

TEXT converts a number or numerical value into text according to a user given format. This function is useful in situations where we want to display numbers in a more readable format, or want to combine numbers with text or symbols.

Syntax: TEXT(Number,Format)
Where,

Number - numerical value to be converted.

Format - is the text, which defines the format.

Consider the given example:

Cell A2 contains the number 123.45. How can we format this number by adding currency symbol " ₹ " and convert using TEXT function. (See Fig.2.29)

Examples of TEXT Function on various occasions are given in the following table:

<table>
<thead>
<tr>
<th>Sl No</th>
<th>Values</th>
<th>Text Function</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>123.45</td>
<td>=TEXT(A1,&quot;?000.00&quot;)</td>
<td>₹123.45</td>
</tr>
<tr>
<td>2</td>
<td>123.34567</td>
<td>=TEXT(B24,&quot;?###.##&quot;)</td>
<td>₹123.35</td>
</tr>
<tr>
<td>3</td>
<td>1122017</td>
<td>=TEXT(B25,&quot;00-00-0000&quot;)</td>
<td>01/12/2017</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>=TEXT(TODAY(),&quot;DD/MM/YYYY&quot;)</td>
<td>27/11/2017</td>
</tr>
<tr>
<td>5</td>
<td></td>
<td>=TEXT(TODAY(),&quot;DD&quot;)</td>
<td>27</td>
</tr>
<tr>
<td>6</td>
<td></td>
<td>=TEXT(TODAY(),&quot;DDDD&quot;)</td>
<td>Monday</td>
</tr>
<tr>
<td>7</td>
<td></td>
<td>=TEXT(TODAY(),&quot;MM&quot;)</td>
<td>11</td>
</tr>
<tr>
<td>8</td>
<td></td>
<td>=TEXT(TODAY(),&quot;MMMM&quot;)</td>
<td>November</td>
</tr>
<tr>
<td>9</td>
<td></td>
<td>=TEXT(TODAY(),&quot;YYYY&quot;)</td>
<td>2017</td>
</tr>
<tr>
<td>10</td>
<td></td>
<td>=TEXT(NOW(),&quot;H:MM AM/PM&quot;)</td>
<td>9:40PM</td>
</tr>
<tr>
<td>11</td>
<td>0.285</td>
<td>=TEXT(A3,&quot;0.0%&quot;)</td>
<td>28.5%</td>
</tr>
<tr>
<td>12</td>
<td>4567549812</td>
<td>=TEXT(A4,&quot;00 00 00 00 00&quot;)</td>
<td>45 67 54 98 12</td>
</tr>
</tbody>
</table>

**CONCATENATE**

This function combines several text strings of different cells into one string. A maximum of 30 passages can be combined into one string. The text items can be text strings, numbers, or single-cell references. Space between strings are given in inverted comma (" ").

Syntax : =CONCATENATE("Text1","Text2",......"Text30")

Example : The address slip of an employee from his personal details by using concatenate function is narrated below.

<table>
<thead>
<tr>
<th></th>
<th>A Name</th>
<th>B House Name</th>
<th>C Post Office</th>
<th>D District</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>DILEEP.S</td>
<td>Rose Villa</td>
<td>Cheriyanad</td>
<td>Alappuzha</td>
</tr>
</tbody>
</table>
The function to join the different text items of different cells into one cell is as follows.

=CONCATENATE(A2, "","B2","","C2","","D2). See figure 2.30.

![Fig. 2.30 - Concatenate function](image)

Let's assess

1. =COUNT(45,24,Ab,55,72,Ab,47) returns ________
2. COUNTBLANK function count the number of ________ cells in the given range.
3. The function used to combine several text strings in different cells into one string is ______.
4. Assume cell contains values - A1 = 10000, A2 =15000, A3 = 12000, A4 = 14000. What is the result of
   SUMIF statement: =SUMIF (A1:A4, "<14000")
   a. 15000  b. 24000  c. 27000  d. 22000
5. What is the result of the following? =ROUNDUP(45321.4354,0)
   a. 45322  b. 45321  c. 45321.4  d. 45320
6. The function which counts the number of cells of any value.
   a. COUNT   b. COUNTA   c. COUNTBLANK   d. COUNTIF

2.6.6 Spreadsheet Functions

Calc also provides the following functions -

- LOOKUP

Suppose a list containing the names and basic pay of 100 employees of a firm is given in a worksheet. Can you find out the basic pay of a particular employee with in a flash?

LOOKUP function is used for searching certain values from a particular table. It is used when we need to look in a single row or column range (known as a vector or from an array) and find a value from the same position in a second row or column.

If LOOKUP cannot find the search criterion, it matches the largest value in the search vector that is less than or equal to the search criterion.

Lookup function has two syntax forms. They are:

i) Vector form and ii) Array form.
- **LOOKUP (Vector form)**

Syntax

\[ = \text{LOOKUP} (\text{SearchCriterion, SearchVector, ResultVector}) \]

Where,

**Search Criterion**: The value to be searched for; entered either directly or as a reference. Search criterion can be a number, text or a logical value.

**Search Vector**: The single-row or single-column area to be searched. The search vector for the LOOKUP must be sorted in ascending order for getting proper results.

**Result Vector**: The single-row or single-column range from which the result of the function is taken.

Go through the example given below:

Details of employees and their basic pay are given in the following table.

(a) Find the name of employee with employee code 2004

(b) Find the basic pay of employee with employee code 2008

(c) Look up the name of employee with employee code 2010

(d) Look up the name of employee with employee code 2000

The excerpts of worksheet, details the LOOKUP function.

<table>
<thead>
<tr>
<th>Employee Number</th>
<th>Employee Name</th>
<th>Basic Pay</th>
<th>Lookup Result</th>
<th>Function</th>
<th>Q No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>2002</td>
<td>Vivek</td>
<td>64000</td>
<td>62500</td>
<td>=LOOKUP(2008,A2:A9,C2:C9)</td>
<td>(b)</td>
</tr>
<tr>
<td>2003</td>
<td>Deepa</td>
<td>43000</td>
<td>Krishnapriya</td>
<td>=LOOKUP(2010,A2:A9,B2:B9)</td>
<td>(c)</td>
</tr>
<tr>
<td>2004</td>
<td>Vincent</td>
<td>56000</td>
<td>#N/A</td>
<td>= LOOKUP(2000,A2:A9,B2:B9)</td>
<td>(d)</td>
</tr>
<tr>
<td>2005</td>
<td>Hameed</td>
<td>51500</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2006</td>
<td>Anupama</td>
<td>43000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2007</td>
<td>Haridas</td>
<td>53000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2008</td>
<td>Krishnapriya</td>
<td>62500</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

(Looks up 2000 in column A and finds it is less than the smallest value in column A and the result generated is #N/A)
• **LOOKUP (Array form)**

Syntax:

\[ =\text{LOOKUP}(\text{lookup\_value, array}) \]

Example:

Name of the students, their scores and grades are given.

<table>
<thead>
<tr>
<th>Name</th>
<th>Scores</th>
<th>Grade</th>
</tr>
</thead>
<tbody>
<tr>
<td>Priya</td>
<td>52</td>
<td>C+</td>
</tr>
<tr>
<td>Smitha</td>
<td>35</td>
<td>D+</td>
</tr>
<tr>
<td>Preeja</td>
<td>72</td>
<td>B+</td>
</tr>
<tr>
<td>Lijya</td>
<td>46</td>
<td>C</td>
</tr>
<tr>
<td>Reena</td>
<td>61</td>
<td>B</td>
</tr>
<tr>
<td>Shyma</td>
<td>91</td>
<td>A+</td>
</tr>
<tr>
<td>Vineetha</td>
<td>82</td>
<td>A</td>
</tr>
<tr>
<td>Elizabeth</td>
<td>75</td>
<td>B+</td>
</tr>
</tbody>
</table>

(a) Find the grade of Preeja using LOOKUP function.

(b) Find the score of Vineetha using LOOKUP function.

(c) Find the Grade of Score 91 using LOOKUP function.

You can arrive at the result shown below using the LOOKUP function. (See Fig. 2.31)

![Fig. 2.31 Result of Lookup function](image)

Alternatively, we can arrive at the same result with the help of function wizard.

Select the category as 'Spreadsheet' and function as 'LOOKUP' from the left pane of the wizard.

Enter the values in the following fields.

a. Search Criterion - "Preeja"

b. Search Vector - A2:C9
Here Array A2:C9 has 3 columns and 9 rows. Automatically formula will be displayed in
the formula field and its function result will come up in the result field. See Fig. 2.32.

![Lookup Function Wizard](image)

**Fig. 2.32 Lookup Function Wizard**

The array form of LOOKUP is very similar to the HLOOKUP and VLOOKUP
functions. The difference is that HLOOKUP searches for the value of
lookup_value in the first row, VLOOKUP searches in the first column, and
LOOKUP searches according to the Dimensions of array.

- **VLOOKUP**

VLOOKUP stands for Vertical LOOKUP. This will simply look for something in a range
of cells and returns something that is in the same row.

VLOOKUP searches the first column (leftmost column) of a block of data and return the
value from another column in the same row. The column containing search criterion must
be in ascending order.

**SYNTAX**: =VLOOKUP(SearchCriterion,Array,Index,SortOrder)

Where,

- **SearchCriterion** - The value you are looking for.
- **Array** - Where you are looking.
- **Index** - The column number in the table (array) from which matching value to
  be returned. (Index no. 1 for column A, 2 for Column B, 3 for Column
  C and so on...)
- **Sort order** - Precise or approximate values will be returned. Give '0' for Precise
  value and '1' stands for approximate value.
Enter the Boolean value FALSE or 0 (Zero) if the first column is not sorted in ascending order. In unsorted lists, the search value must be matched exactly. Otherwise the function will return this message: \#N/A (Error: Value Not Available).

Enter the Boolean value TRUE or 1 (One) if the first column is sorted in ascending order. Sorted columns can be searched much faster and the function always returns a value, even if the search value was not matched exactly, if it is between the lowest and highest value of the sorted list.

Let us do some practice. The details of some employees in an organisation are given in the following table:

<table>
<thead>
<tr>
<th>Employee No</th>
<th>Name</th>
<th>Date of Birth</th>
<th>Designation</th>
<th>Basic Pay</th>
</tr>
</thead>
<tbody>
<tr>
<td>1001</td>
<td>Priyanka</td>
<td>14-02-1988</td>
<td>Manager</td>
<td>50000</td>
</tr>
<tr>
<td>1002</td>
<td>Suhail</td>
<td>15-08-1986</td>
<td>Asst. Manager</td>
<td>38000</td>
</tr>
<tr>
<td>1003</td>
<td>Preeja</td>
<td>16-04-1979</td>
<td>Cashier</td>
<td>25000</td>
</tr>
<tr>
<td>1004</td>
<td>Malavika</td>
<td>25-07-1984</td>
<td>Accountant</td>
<td>46000</td>
</tr>
<tr>
<td>1006</td>
<td>Midhun</td>
<td>18-02-1983</td>
<td>Clerk</td>
<td>18000</td>
</tr>
<tr>
<td>1007</td>
<td>Shyma</td>
<td>19-02-1990</td>
<td>Clerk</td>
<td>20000</td>
</tr>
<tr>
<td>1008</td>
<td>Vineetha</td>
<td>20-02-1987</td>
<td>Clerk</td>
<td>16000</td>
</tr>
<tr>
<td>1010</td>
<td>Elizabeth</td>
<td>21-02-1988</td>
<td>Peon</td>
<td>14000</td>
</tr>
</tbody>
</table>

You are required to search the following:
(a) Name of employee having employee code 1007
(b) Date of birth of employee whose code is 1004
(c) Basic pay of employee number 1009 if data is not in ascending order.
(d) Basic pay of employee number 1009 if data is given in ascending order.
(e) Basic pay of employee number 1001.
(f) Name of employee number 1000.
(g) Name of employee number 1001.
(h) Designation of employee number 1001.

The following steps are required for getting the lookup values:
1. Enter the given data in the same format from cell A1 to E9 as shown below.
2. Select Cells where the result is required and enter VLOOKUP Function.
   Relevant formulae are given in column F (See figure 2.33)
The details of books available in a school library are given below:

<table>
<thead>
<tr>
<th>Book No</th>
<th>Name</th>
<th>Author</th>
<th>Category</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>1001</td>
<td>Veenapoovu</td>
<td>Kumaranasan</td>
<td>Poem</td>
<td>50</td>
</tr>
<tr>
<td>1007</td>
<td>Randamoozham</td>
<td>M.T Vasudevan Nair</td>
<td>Novel</td>
<td>250</td>
</tr>
<tr>
<td>1004</td>
<td>My Experiments with Truth</td>
<td>M K Gandhi</td>
<td>Autobiography</td>
<td>100</td>
</tr>
<tr>
<td>1008</td>
<td>Uppu</td>
<td>ONV Kurup</td>
<td>Poem</td>
<td>120</td>
</tr>
<tr>
<td>1005</td>
<td>Othello</td>
<td>Shakespeare</td>
<td>Drama</td>
<td>200</td>
</tr>
</tbody>
</table>

Arrange them in book number order and use VLOOKUP function to:

(a) Search the name of book number 1004.
(b) Search the author of book number 1007.
(c) Search the category of book number 1005.
(d) Search the price of the book number 1008.

- **HLOOKUP**

HLOOKUP stands for horizontal lookup. It searches for values from top to bottom horizontally. This function searches for a value in the first row of an array and returns the corresponding value in a row of the array, named in the Index, in the same column. HLOOKUP supports the same form and arguments as VLOOKUP.

Syntax: HLOOKUP (SearchCriterion, Array, Index, Sorted)

Where,

SearchCriterion - Value searched for in the first row of the array.
Array - The range or range name containing the table of data
Index - The row number in a table_array from which you return corresponding matching value. (Index 1 for Row 1, 2 for Row 2, 3 for Row 3 and so on...)
Sorted - Indicates whether to find an exact match. True or 1 gives closest match and False or 0 returns exact match.

Example:
The number of units of each home appliances sold by Marvel Trade Links during the last four years are given:

<table>
<thead>
<tr>
<th>Products</th>
<th>2014</th>
<th>2015</th>
<th>2016</th>
<th>2017</th>
</tr>
</thead>
<tbody>
<tr>
<td>Smart TV</td>
<td>513</td>
<td>675</td>
<td>674</td>
<td>715</td>
</tr>
<tr>
<td>Smart Phones</td>
<td>1567</td>
<td>1659</td>
<td>1589</td>
<td>2004</td>
</tr>
<tr>
<td>Washing Machine</td>
<td>420</td>
<td>365</td>
<td>312</td>
<td>345</td>
</tr>
<tr>
<td>Fridges</td>
<td>640</td>
<td>574</td>
<td>543</td>
<td>366</td>
</tr>
<tr>
<td>Electric Oven</td>
<td>215</td>
<td>317</td>
<td>239</td>
<td>284</td>
</tr>
</tbody>
</table>

You are required to find the following by using HLOOKUP function.
(a) Number of smart TV sold during the year 2014
(b) Number of Fridges sold during the year 2015
(c) Name of the product in the fourth row.

The table given below shows how to deal with HLOOKUP (See figure 2.34).

![Fig. 2.34 Result of HLOOKUP function](image)

- **ROWS**
The function returns the row number of a reference or array. It also gives back the number of rows when this function is used on a range of cells.
Syntax:   =ROWS(Array)
'Array' - is the reference or named area whose total number of rows is to be determined
Example - =ROWS(C1:H4).
See Fig. 2.35.

- **COLUMNS**
This function returns the number of columns in an array or reference
Syntax: =COLUMNS(array)
=array is the reference to a cell range whose total number of columns is to be found.
Example: =COLUMNS(C1:H4). See Fig. 2.36.

### Let's assess

1. **IF function comes under ...............**
   (a) Logical  (b) Statistical  (c) Text Manipulation  (d) Spreadsheet
2. **AND function return True if ............... (all/any) arguments are true.**
3. **A function inside another function is called ____**
   (a) Nested Function  (b) Round function
   (c) Sum function  (d) Text function
4. **Which function is used while combining more than one test condition and the result will be true if any of the condition is True?**
5. **Which function returns True if all the conditions are true?**
6. **Find the Odd one out - (a) AND (b) OR (c) IF (d) SUM.**
7. **The function which returns the number of rows in a reference or array is ____**

### 2.6.7 Financial Functions

Imagine that you need some cash urgently and approach a bank for a loan of ₹ 2,00,000.
The bank provides the loan for 3 years with a fixed rate of interest @ 10% per annum.

- How much do you have to pay back per month?
- Suppose, if the bank enhances the interest rate to 12%, what increase will have to be made in the EMI?

Such calculations are quite difficult to be carried out manually. Calc offers lot of financial functions to deal with such situations easily. Spreadsheet helps to perform many common financial calculations for finding out accrued interest, monthly payment of an annuity etc. very easily. Let us discuss some of the common financial functions.
ACCINT

You know what accrued interest is. Here the spreadsheet has a built-in function - ACCINT to calculate interest accrued on securities and bonds which carries periodic interest.

ACCINT is the abbreviation used for accrued interest.

Accrued interest is interest due but not received / paid. Companies may pay interest on debentures or bonds periodically (quarterly, half yearly or yearly). If holder of a security sells it before the next interest due date, the buyer has to pay its market value plus interest earned up to the settlement date. In such cases the calculation of interest is very difficult. Spreadsheet helps to calculate such interest easily.

Syntax: =ACCINT(Issue, First interest, Settlement, Rate, Par, Frequency, Basis)

Where,

Issue - The date on which security was issued.
First Interest - The date that the first interest will be paid.
Settlement - The settlement date of the security. (i.e. sold or purchased)
Rate - Annual interest rate of security (coupon interest rate)
Par - Par value of the security.
Frequency - Number of interest payments per year
   (1 for annual, 2 for half-yearly and 4 for quarterly).
Basis - (optional) The type of day count. (If basis not given it is automatically counted as 0)

<table>
<thead>
<tr>
<th>Basis</th>
<th>Calculation (Type of day count)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 or missing</td>
<td>US method (NASD), 12 months of 30 days each</td>
</tr>
<tr>
<td>1</td>
<td>Exact number of days in months, exact number of days in year</td>
</tr>
<tr>
<td>2</td>
<td>Exact number of days in month, year has 360 days</td>
</tr>
<tr>
<td>3</td>
<td>Exact number of days in month, year has 365 days</td>
</tr>
<tr>
<td>4</td>
<td>European method, 12 months of 30 days each</td>
</tr>
</tbody>
</table>

Consider the following example:

Mr. Anoop is holding 10% Debentures of M/s Hi-Tech Ltd worth ₹ 1,00,000 issued on 01/04/2016. The interest due every half-year and first interest due on 30/09/2016. Anoop sold this debentures to Mr. Shafeek on 01/07/2016. Calculate the amount of interest accrued using ACCINT function.

In this case,

Issue (issue date of the security) - 01/04/2016
First Interest (first interest date of the security) - 30/09/2016
Settlement date on which the security is traded - 01/07/2016
Rate (annual interest rate) - 10%
Par (par value of the security) - 1,00,000
Frequency (number of interest payments per year) - 2
Basis (type of day count) - 0
This can be worked out in two methods.

**Method 1**: Select Cell A1 and enter the ACCRINT function in that cell

\[ = \text{ACCRINT}("01/04/2016","30/09/2016","01/07/2016", 10\%, 100000, 2, 0) \]

gives a result of ₹2500.

The amount of interest payable by Shafeek to Anoop along with the value of debentures is ₹2,500.

\[ (\text{ie, } 1,00,000 \times \frac{10}{100} \times \frac{3}{12} = 2,500) \]

**Method 2**: Enter the above values from Cell B1 to B7 in the order shown in syntax.

Select Cell B8 and use function wizard to enter the formula

\[ =\text{ACCRINT}(B1,B2,B3,B4,B5,B6,B7) \]

(See Fig. 2.37)

![Fig. 2.37 Using ACCRINT Function Wizard](image)

- **RATE**

Think that you have taken the risk of investing ₹ 5,00,000 and will receive ₹5,000 per month for the next 10 years. What is the rate of return for the above investment?

The RATE function is primarily used to evaluate the rate of return on investment. It helps us to calculate the rate of interest on a loan taken from a bank or other financial institution or the rate of return on an investment, over a given period of time.

Syntax : \[ =\text{RATE}(\text{NPer},\text{Pmt},\text{PV},\text{FV},\text{Type},\text{Guess}) \]

Where,

\[ \text{NPer} \quad - \quad \text{Total number of payment periods in an annuity. (payment period)} \]
Spreadsheet

Pmt  - Fixed amount paid during each period. Given as minus figure
      - (PMT includes principal and interest but no other fees or taxes. If Pmt is
        omitted then include the fv as argument.)

PV   - Present value of loan/investment

FV   - (optional) Future value of the loan/investment at the end of Nper payments.
      If omitted, FV takes on the default value being 0 (Zero)

Type - (optional) is the due date of the periodic payment, either at the beginning or
      at the end of a period.
      The type argument can have the value 0 or 1. Zero is used when the payment
      is made at the end of the period and '1' is used if the payment is made at the
      beginning of the period.

Guess - (optional) determines the estimated value of the interest with iterative
        calculation.

In the LibreOffice Calc functions, parameters marked as "optional" can be left
out only when no parameter follows. For example, in a function with four
parameters, and last two parameters are marked as "optional". Here we can
leave out parameter 3 and 4. Parameter 4 can also be omitted but we cannot
leave out parameter 3 alone.

Consider the following example:

Sukanya traders took a loan of ₹ 5,00,000 from Canara Bank for a period of 5 years
and agreed to repay ₹ 11,500 at the end of each month.

(a) Compute the rate of interest using RATE function. Also calculate the Annual interest.

(b) Calculate the rate of interest if the repayment is made at the beginning of each month.

In this case,

(a) Nper  =  60 (5 x 12)
Pmt  =  -11500 (Minus is given to denote repayment)
PV  =  5,00,000
FV  =  0
Type  =  0 (payment at the end of each month)
Guess  =  (Not required)

(b) As compared to option (a) above the only change lies in the parameter 'Type' to '1'
since the payment is made at the beginning of each month.

Enter the values from cells C1 to C6 and D1 to D6 as shown in figure 2.38. Then type
the formula in cell C7 as =RATE (C1, C2, C3, C4, C5, C6) to get the monthly interest
rate. For getting the annual interest rate use the formula in C8 as = C7 * 12.
Copy and paste the formula from cells D7 to D8 for getting result of option (b). You can also use the function wizard for the RATE function.

![Image of a table showing financial calculations](image)

Fig. 2.38 Result of Rate Function

To set the cell format to percent (if necessary): Select the Cells → Format → Cells → Numbers → Percent

Try Yourself

Alankar Ltd took a loan of ₹10,00,000 from SBI for a period of 10 years and agreed to repay ₹20,000 at the beginning of each month.

(a) Compute the rate of interest using RATE Function. Calculate the Annual interest also.

(b) Compute the rate of interest assuming that after the payment of ₹20,000 per month at the end of every month for a period of 10 years, the remaining balance will be ₹1,00,000.

- **CUMIPMT**

CUMIPMT function is used to calculate the cumulative interest payments. This function returns the cumulative interest on a loan or investment, based on a constant interest rate between start period and end period.

**Syntax:** =CUMIPMT(Rate,NPer,PV,S,E,Type)
Where,

Rate – Periodic interest rate. (if annual rate is given, find monthly rate)

NPer – Length of the loan in months (if given in years to be converted into months)

PV – Present value of loan/investment

S – Start period. (For 1st year -1, 2nd Year -13, 3rd year - 25, 4th year - 37 and so on....)

E – Last period. (For 1st year -12, 2nd Year - 24, 3rd year - 36 4th year - 48 and so on....)

Type – Due date of the payment, either at the beginning or at the end of a period. This can be 0 or 1. Zero is used when the payment is due at the end of the period. 1 is for payment due at beginning of the period.

Let us illustrate:

Mrs. Manju availed a loan of ₹ 50000 from Punjab National Bank for a period of 3 years at a yearly interest rate of 8.5%.

1. Compute the following assuming that the payment is made at the end of each period.
   
   (a) Total interest paid for the first year
   
   (b) Total interest paid for the second year
   
   (c) Total interest paid for the first 2 year
   
   (d) Total interest paid for the third year
   
   (e) Total interest paid for all the 3 years

2. Also compute the following assuming that the payment is made at the beginning of each period.

   (i) Total interest paid for the first six months
   
   (ii) Total interest paid for the last 30 months
   
   (iii) Total interest paid for the entire period of 36 months

The steps to calculate cumulative interest using CUMIPMT function is as follows:

Enter the data as shown in figure 2.39, from cell A2 to I8.

*Rate (8.5% per annum, hence monthly rate) = .007 (8.5%/12)

Select the cell B9 and enter the formula =CUMIPMT(B3,B4,B5,B6,B7,B8) to calculate the cumulative interest of 1st year. Apply the same function in respective cells to find the remaining year's cumulative interest as shown in Fig. 2.39.
Mr. Jayaram took a loan of ₹5,00,000 from Vijaya Bank on 1st Jan 2017 for a period of 4 years at 8% interest per annum. As per agreement, the payment is given at the beginning of each month. Compute the cumulative interest payable at the end of each year and also the total interest of the entire loan period by using CUMIPMT function.

- **PV**

Suppose you win a prize and you are offered ₹50,000 or equal payments of ₹1000 per month for 5 years at an annual interest rate of 8% compounded annually. Which one would you choose?

The PV function can tell you whether you accept the money in lump sum or take this in 60 instalments.

PV function relates to Present Value. It is based on the concept that one rupee earned today is worth more than a rupee received on a future date. If we invest ₹100 today at 10% interest per annum, after one year ₹100 become ₹110 (₹100 principal + ₹10 interest)

Do you think that ₹100 received today is equal to ₹100 received after one year? Answer is evidently “No”.

PV function returns the present value of an investment resulting from a series of regular payments. This function is used to calculate the amount of money needed to be invested at a fixed rate today, to receive a specific amount, over a specified number of periods.

Syntax : =PV(Rate,Nper,Pmt,FV,Type)

Where,

- **Rate** - Periodic interest rate. (if annual rate is given, find monthly rate)
- **NPer** - Total number of payment periods in months
Spreadsheet

Pmt - Fixed amount paid during each period. (Pmt should be given as negative as it is payment)

FV - (optional) Future value, or a cash balance to attain after the last payment is made.

Type - (optional) is the due date of the periodic payment, either at the beginning or at the end of a period.

(The type argument can have the value 0 or 1. '0' is used when the payment is made at the end of the period and '1' for the beginning of the period.)

Consider the following example:

Amit Gupta opened a Recurring Deposit Scheme paying ₹2500 per month for a period of 4 years with an interest rate of 8% per annum. Calculate the present value by using PV function if:

(a) the payments are made at the end of the month.
(b) the payments are made at the beginning of the month.
(c) amount to be invested to get a future value of ₹1,00,000.

Rate = 8% per annum and instalments are made monthly, hence, the interest rate per month is 8%/12.

Nper = 4 years, hence Nper in months is 48 (ie 4*12)

Pmt = -2500 (Pmt must be negative to get positive PV of future earnings)

Fv = Future value, or a cash balance to attain after the last payment is made. (if Fv is omitted, it is assumed to be 0)

Type = 1 means due at the beginning of a month and Type = 0 (default) means due at the end of the month.

Syntax for (a) =PV(8%/12,48,-2500,0,0) Returns ₹102404.78
Syntax for (b) =PV(8%/12,48,-2500,0,1) Returns ₹103087.48 (See Fig. 2.40)
Syntax for (c) =PV(8%/12,48,0,100000,0)

![Fig. 2.40 - Result of PV function](image-url)
- **PMT**

You want to borrow money to buy a car, and you know the principal amount, interest rate and the term of the loan or say you intend to borrow ₹2,00,000 at 10% interest and pay off this loan in 5 years, in such cases PMT function will easily calculate the monthly payment for you.

The PMT function calculates the periodic payment for an annuity assuming equal payments and a constant rate of interest.

PMT refers to payment which has to be paid periodically for a loan or investment. This function helps to calculate the instalment amount including part of principal amount and monthly interest. The amount of instalment is called EMI (Equated Monthly Instalment.). It can be calculated with the help of the PMT function.

Syntax =PMT(Rate,Nper,PV,FV,Type)

Where,

- **Rate** - The periodic interest rate.
  
  (If annual rate is given calculate monthly rate by dividing rate by 12)

- **NPer** - The number of periods over which the loan or investment is to be paid

- **PV** - The present value of loan or investment

- **FV** - (optional) The desired value (future value) to be reached at the end of the periodic payments.

- **Type** - (optional) The due date for the periodic payments.
  
  (Type = 0 for due date at the end of each period
  Type =1 for beginning of each period)

Consider the given example:

Calculate the Monthly payment for a Loan of ₹25,000 availed by Mr. Philip from Bank of Baroda @ 8% per annum for a period of 3 years, assuming that :

(a) payment is made at the end of each month.
(b) payment is made at the beginning of each month.
(c) Also calculate EMI, if the repayment is made at the end of each month for a period of 4 years

The following steps are to be followed.

1. Enter the values Rate,Nper,PV,FV and Type as shown in Fig. 2.41.
2. Enter the formula as shown below. (We can also use the function wizard to insert the PMT function in the cell where output is required.)

Syntax for (a) =PMT(8%/12,36,25000,0,0) or =PMT(B2, B3, B4, B5, B6)
Syntax for (b) =PMT(8%/12,36,25000,0,1) or =PMT(C2, C3, C4, C5, C6)
Syntax for (b) =PMT(8%/12,36,25000,0,0) or =PMT(D2, D3, D4, D5, D6)
The result is displayed in figure 2.41.

![Fig. 2.41 Result of PMT Function](image)

**Try Yourself**

Mr. Rejith took a car loan of ₹4,50,000 from Dena Bank at 9% interest per annum for a period of 7 years. The repayment should be made in equated monthly instalments, payable at the end of each month. Calculate the Monthly instalment using PMT function in LibreOffice Calc.

- **FV**

Suppose, ₹10,00,000 is invested for a period of 5 years at an interest rate of 8% per annum. How much would you get back at the end of the period?

To find an answer you can right away open a worksheet and look for FV function. This function calculates the future value of an investment based on a constant interest rate. You can use FV with either periodic constant payment or on single lump sum payment.

Syntax: `=FV(Rate,Nper,Pmt,PV,Type)`

Where,

- **Rate** - Periodic interest rate.
- **NPer** - Total number of periods (payment period).
- **Pmt** - The annuity paid regularly per period.
- **PV** - (optional) Present cash value of an investment.
- **Type** - (optional) Defines whether the payment is due at the beginning or the end of a period.

Consider the given example:

Amit Gupta opened a Recurring Deposit Scheme paying ₹2500 per month for a period of 4 years with an interest rate of 8% per annum. Calculate the future value of RD by using FV function if:
(a) the payments are made at the end of the month.
(b) the payments are made at the beginning of the month.
(c) Find the future value if the amount invested is ₹ 72692.06 in lump sum instead of monthly instalments with the same interest rate for 4 years.

Figure 2.42 clearly explains the parameters to be given in different cells to arrive at the results:

![Fig. 2.42 Result of FV Function](image)

**Try Yourself**

Mrs. Santhi has a postal life insurance policy, to which she deposits ₹ 750 per month for 5 years. The interest rate is 10% p.a. Calculate the amount she gets at the end using FV function in LibreOffice Calc if:

(a) the payments are made at the end of the month.
(b) the payments are made at the beginning of the month.

- **NPV**

Net present value (NPV) is the present value of an investment's expected cash inflows minus the costs of acquiring the investment.

$$\text{NPV} = (\text{Present value of Cash inflows from investment}) - (\text{cash outflows or costs of investment or project}).$$

NPV function returns the present value of a series of periodic cash inflows at a discount rate. To get the net present value, subtract the cost of the project (the initial cash outflow) from the present value of future cash inflows.

Syntax : = NPV(Rate, Value1, Value2, Value3 ....)

Where,

- Rate : The discount rate for a period.
- Value1, Value2, Value3 .... : Cash inflows (limited up to 30 values)
Consider the following example:

Calculate the present value of annual cash inflows of ₹10, ₹20 and ₹30 with a discount rate of 8.75%. If the initial investment is ₹40, what will be the net present value of future cash inflows:

\[=\text{NPV}(8.75\%, 10, 20, 30) \text{ returns } ₹49.43\]

The net present value is the returned value (₹49.43) minus the initial costs of ₹40. Therefore, the net present value is ₹9.43 as shown below:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Initial investment / Cash outflow</td>
<td>Rate</td>
<td>Cash inflow year 1</td>
<td>Cash inflow year 2</td>
<td>Cash inflow year 3</td>
<td>Present value of future cash inflows</td>
<td>NPV</td>
</tr>
<tr>
<td>2</td>
<td>40</td>
<td>8.75%</td>
<td>10</td>
<td>20</td>
<td>30</td>
<td>₹49.43</td>
<td>₹9.43</td>
</tr>
</tbody>
</table>

Let us consider another example

Manav traders think of buying the business of Lavanya stores. It takes a careful look at Lavanya stores projections for the next 5 years. It discounts those projected cash inflows back to the present value using its weighted average cost of capital at 6%.

Cost of acquiring Lavanya Stores: ₹5,00,000

Cash inflows from Lavanya stores is

Year 1: ₹1,70,000; Year 2: ₹1,30,000; Year 3: ₹1,25,000;
Year 4: ₹1,00,000; Year 5: ₹75,000

(a) Calculate the present value of cash inflows and net present value of above proposal.
(b) Calculate NPV if cost capital is 8%.
(c) Calculate NPV if the initial investment is ₹5,50,000 and cost of capital is 6%
(d) Calculate NPV if the initial investment is ₹5,50,000 and cost of capital is 8%
(e) Evaluate the above proposals based on the calculated NPV.

Steps to calculate the present value of future cash inflows and NPV is illustrated below:

Step 1: Enter the details from cell A3 to F9 as shown in figure 2.43
Step 2: Enter the formula =NPV(C4,C5,C6,C7,C8,C9) in cell C10.
Step 3: Enter the formula = NPV(C4,C5,C6,C7,C8,C9) - C3 in cell C11.
Step 4: Select Cell C10 and drag and fill cells D10 to F10.
Step 5: Select Cell C11 and drag and fill Cells D11 to F11.
The final output will be displayed as shown in figure 2.43.
Periyar Exporters invested ₹8,00,000 in a project. Cash inflows from the project will be ₹2,50,000, ₹300,000, ₹50,000, ₹150,000 and ₹220000 over the next 5 years. Projects cost of capital is 5%

Calculate the Net present value and say whether the project is acceptable or not.

Let’s assess

1. The financial function used to calculate accrued interest of a security in the case of periodic payments is _________
2. The function which calculates the future value of an investment based on periodic, constant payment and a constant interest rate is called _______
3. Which function calculates the constant interest rate per period of an annuity?
4. NPV returns the _________ of an investment based on a series of periodic cash flows and a discount rate.

Let’s know more ...

Calculation of Present Value
The first thing to remember is that present value (PV) of a single amount is the exact opposite of future value (FV). Here is the formula:

\[ PV = \frac{FV}{1 + r} \]

Consider this problem:
Let’s say that you have been promised ₹1464 after 4 years from today at an interest of 10%. Here, \( t \) (term/period) is 4 years. We want to know what is the worth of ₹1464 today (i.e., present value)
Spreadsheet

We can calculate the present value of ₹1464 if the interest rate is 10% at the end of 4 years using the formula:

\[ PV = 1464 \times \frac{1}{(1 + 0.10)^4} = 1,000 \]

The process of calculating present value is called discounting.

2.7 Data Entry, Text Management and Cell Formatting

To generate useful information, data entered in a spreadsheet should be reliable, accurate and in proper format. This means that data should be validated, corrected and displayed in proper format. Thus, data entry, data validation and data formatting are three important concerns in spreadsheet data handling.

2.7.1 Data Entry

If you are asked to collect details of students of your class which include Class number, Name of student, Date of birth, Fees remitted, Days present etc., how do you enter these data in a worksheet?

- Using keyboard is one option.
- Data fill option is another option.
- You can even import data from other software.

Let us discuss the above methods in detail.

(a) Direct data entry

More often, we use the keyboards to input the data. Labels, values and formulas can be entered using alphabets, numbers and special characters in the keyboard. By default the values are right aligned and labels are left aligned. The spreadsheet can distinguish between different types of values; recognise a date, a currency, a percentage etc. For example, if we type 20/10/1980 in a cell, spreadsheet will recognise it as a date and act accordingly. The spreadsheet also processes given formulas and generates the output; which should be in specific format. See the student details entered in the worksheet and the default alignment of each type of data (Fig 2.44).

![Fig. 2.44 Default alignment in cells](image-url)
You may change the default alignment to right or left or centre aligned by selecting the cells and click on appropriate icons in the formatting toolbar, as shown in figure 2.45.

(b) Data fill options

Suppose, if there are '60' students in your class and you need to enter the class number 1 to 60 continuously in the first column.

Instead of entering all the 60 numbers one by one, this can be done very easily using a short cut method. You can automatically fill cells with data with the Auto Fill command or the Series command.

(i) Auto Fill

LibreOffice Calc provides an option for entering data automatically with a series of numbers, text and number combinations, dates, time periods, based on any pattern that we require. Auto Fill automatically generates a data series based on a defined pattern. The steps to auto fill the data are:

- Enter the first number in a cell, and press enter.
- Move the cursor to the bottom right corner so that it will change to a small black cross which is called fill handle (+ symbol). Click on the mouse and by holding the button drag the fill handle of the cell across the cells that you want to fill, and release the mouse button. Then, all the cells are filled with the same data. But in case of numeric data, the cells are filled with consecutive numbers.
- If you select two or more adjacent cells that contain different numbers and drag, then the remaining cells are filled with the desired arithmetic pattern. For eg. Making a series of values 10, 20, 30, 40, 50 and so on, using fill handle is shown in fig 2.46.

Try Yourself

- Fill days of week in first row-(Enter Monday in cell A1 and try to fill till end of the week using fill handle)
(ii) Defined Series

We can also fill the active cell with the contents of an adjacent cell through the 'Fill Series Window'. This fill option is available in the Edit menu. The following steps are involved in filling a series.

- Enter the first value of the series in a cell
- Select the cell range in the sheet that you want to fill.
- Choose Edit → Fill → Series

The Fill series window appears in the screen as shown in Fig. 2.47.

Set the parameters for the series.

Select the direction to which data is to be flowed.

- If you select a linear series, the increment that you enter is added to each consecutive number in the series to create the next value. (Eg: 50, 100, 150, 200............)

- If you select a growth series, the increment that you enter is multiplied by each consecutive number to create the next value. (Eg: 3, 9, 27, 81, 243........)

- If you select a date series, the increment that you enter is added to the time unit that you specify. (Eg: 31/03/2001, 31/03/2002, 31/03/2003.............)

Give the Start value, End value and Increment. Click ‘OK’ to fill the series. Observe how this is filled in figure 2.48.

(c) Import Data from other sources

LibreOffice Calc permits transfer of data into required cells by importing an external file to a work sheet. These data files may be either in text files or non-text files format. Text files can be directly read using a text editor. These files often have extension ‘.txt’. They may also have other extensions like ‘.csv’ (Comma Separated Values), and are easily transferred to a worksheet.
How to create a file Text Editor software?

Create data file using Text Editor, by the following steps:-

- The path to get Text Editor software is:
  
  Applications → Accessories → Text Editor

- A comma-separated data values in one line of this text file is a row in a spreadsheet and each entry, separated by a comma, is a column entry for that row.

- In the first line give the titles of the columns needed in the spreadsheet.

- In the next line onwards, start entering the data separated by comma in the same order of the column headings. It may be noted that every data may not be of similar length but each data (even a blank data) should be separated by comma. See the example given below.

- Save the created text file in a convenient location in the computer.

To import the data from a text file, following steps are to be initiated:-

1. Open a new LibreOffice Calc worksheet.
2. Click on 'Sheet from File' option from Insert menu. Select the text file with the help of dialogue box that appears and press 'Open' button.
3. Then, the 'Text Import' window appears as shown in Fig 2.49.
4. Click 'OK' in the Text Import window.
5. Then, the 'Insert Sheet' window appears in the screen.

   Again click 'OK' on the Insert Sheet window. Then, the text data will be placed in the relevant columns of the spreadsheet. Save the worksheet by giving suitable name.

Fig. 2.49 Text import window

Alternative method to import file to LibreOffice Calc

Save the text file 'Asset_Details.txt', in 'csv' format in the desktop. Open the file by clicking on it. 'Text Insert' window appears in the screen, click on 'OK' button. The file will be automatically displayed in a spreadsheet. Since the file is in 'csv' format, importing is not necessary in Calc. Open the text file to display the data in columnar form.
2.7.2 Data Validation

Sometimes, it is possible that we may enter wrong data in a cell by mistake, due to negligence or ignorance in a spreadsheet. How can we prevent such mistakes?

During data entry, accuracy and validity of data are ensured in two ways:-

(a) Using validation option  (b) Using Data form

- **Validation option**

Data validation guarantees that each data that you enter will be correct and accurate. By using this function, we can define entries to be valid for one or more cells. Thus, invalid entries to a cell will be rejected. This feature imposes restrictions on the type of data entered into a cell. A warning message for wrong data will be displayed in the cell. We can set a message to inform the users about the type of data to be entered in the cells. It is also possible to give instructions to correct errors by setting 'Error Alert' option in the validity window.

To validate data entry in a particular column, the following steps are to be initiated:-

1. Select the range in which the required data is to be entered.
2. Select 'Data' Menu and choose 'Validity' option, then, the Validity window appears as shown in figure. 2.50

![Fig. 2.50 List entries in Validity Window](image)

3. Select the criteria to allow whole numbers, Decimal, Date, Time, Cell range, List etc.

- Select 'List', from the 'Allow' field. Now the 'entries' field appears. Here, enter the possible values one after another in separate line as shown in figure 2.50 and click 'OK'.

- In the field 'Allow', if we select 'Cell Range', the 'Source' option appears in the window. You can insert the specific sheet and provide range address and click
'OK'. (You may toggle between shrink and expand the validity window by clicking on the arrow icon right to source field). This criterion setting is shown in figure 2.51.

![Fig. 2.51 Cell range entries in validity window](image)

4. Set the 'Input Help' in the validity window. Give suitable 'title' and 'Input Help' message as shown in figure 2.52. This setting will display the given input help message at the time of data entry.

![Fig. 2.52 Setting input help in validity window](image)

5. Set 'Error Alert' in the validity window. The character of the field can be specified in the 'Action' field as 'Stop', 'Warning', 'Information' etc. Also give the 'Title' and the 'Error Message'. This settings will display the given Error message when an invalid value is entered in the column. The figure 2.53 depicts the stages of error alert setting.

![Fig. 2.53 Setting error alert in validity window](image)
Spreadsheet

- **Data Form**

We can also enter data into cells using 'Data Input Form'. It helps in data validation by reducing the chances of errors in data entry. Using a data form, we can make data entry more easy and accurate, especially when we have more columns for data entry, which cannot be viewed on a screen at a time. For getting the data form, enter the column headings and select cells. Then select 'Form...' option from Data menu. In the displayed 'Data form' window we can fill all the details. Click on 'New' button to get the blank form and the filled data is placed to the respective columns in the table. Click 'Close' button on completing the data entry. Use the tab key for moving to the next field in the data form. Figure 2.54 shows how to prepare the list of students participating in a school level competition with the help of the 'Data Form'.

![Data Entry Through Form](image)

**Fig. 2.54 Data entry through form**

**Try Yourself**

Collect the details of all teachers in your school like Name, Sex, Designation, Subject, Age, Conveyance used, Place of residence etc. Perform the data entry in a worksheet with the help of a Data Form. From the created table find out:

- Number of teachers retiring within 5 years.
- Number of teachers using public conveyance.
- Number of teachers residing within 8 Kilometres from the school.
- Number of Male teachers in the school.

### Let's assess

1. In spreadsheets, Fill Handle is a small.........................
   (a) Black square  (b) Arrow mark  (c) Cross mark  (d) Plus symbol
2. 'Fill Series' option is available in ............... menu of Calc spread sheet.
3. In 'Fill Series' window ............. Series Type is selected to get next value as multiplied by the previous value with the given increment.
4. The full form of 'CSV' used in file extension is ..........
5. The data 'Validity' option is available in ............. menu of spreadsheet.
6. In data validity window, Error Alert Action can be set to-
   (a) Warning  (b) Information  (c) Stop  (d) Any of these
7. In spreadsheet, data input 'Form' is available in -
   (a) Edit Menu  (b) Data Menu  (c) Insert Menu  (d) Tools Menu
2.7.3 Data Formatting

What do formatting does to a spreadsheet?

It makes a worksheet more attractive, easier to read, and emphasises key data. Different formatting attributes like colour, font styles, font size can be applied to cell contents, you can adjust the size of cells, spacing etc.

Formatting means the arrangement of data for computer input or output, in terms of number and size of fields in a record or the spacing and punctuation of information in a report. By using formatting options we can present the worksheet data in an effective manner. We can present some data in bold or rotated form or in different colours to indicate its priority and importance. The worksheet data formatting may be in the following form.

(a) Number Formatting  
(b) Text formatting  
(c) Conditional formatting  
(d) Table formatting

- Number formatting

Numbers are formatted to change their appearance. Number formatting includes adding percent symbol (%), comma (,), decimal places, and currency sign (₹), date, time, scientific values etc. to a spreadsheet. The number format applied will not affect the actual cell value.

Number formatting takes the following steps:

- Select the cell or range to be formatted.
- Go to ‘Format’ menu and choose ‘Number Format’ to set values as number, percent, currency, date, time etc.

- For advanced formatting, choose ‘Cells’ from Format menu instead of Number Format. The window pops up allows setting different categories of data with varied features. (The ‘Format Cells’ option is also possible with the right click of your mouse on the respective cell)
- Set the details like Decimal places, Leading zeros, Thousand separator etc. and confirm the window.

The Format Cells window appears as in figure 2.55.
**Text Formatting**

The text formatting is mostly required for presentation of final output. It can be used to display the text in different fonts, align the cells, change colour of fonts, merge cells etc.

Text data has default settings in respect of font type, size, colour etc. We can change these features using the options from the formatting toolbar. These tools allow us to add decorative and explanatory material to worksheet and chart. Text formatting can also be done through the 'Format Cells' window. The major option available in Formatting Toolbar are shown in figure 2.56.

![Fig: 2.56 Formatting tools in toolbar](image)

**Conditional formatting**

The conditional formatting changes the appearance of a cell range based on a condition or criteria. If the specified condition is true, the cell range is formatted automatically. This formatting helps to highlight relevant cells, emphasise unusual values, and visualise data using Colour Scale, Data Bar and Icon Set. Conditional formatting option is available in the 'Conditional Formatting' option in the 'Format' menu.

Using the menu command **Format → Conditional formatting**, the dialogue allows you to define conditions in a cell, which must be met in order for the selected cells to have a particular format. (To apply conditional formatting, 'Auto Calculate' must be enabled. For this, choose **Tools → Cell Contents → Auto Calculate**. You see a check mark next to the command when Auto Calculate is enabled). Conditional formatting has also recalculation facility. If the values in any cell changes, the formatting respond correspondingly, without selecting the format styles again manually.

Consider the example given below to understand the steps in Conditional Formatting.

There are ‘8’ salesman in your business. You have to identify the salesmen who attained the quarterly sales target of ₹ 20,000 from the quarterly sales data. It is easily possible through using special colours to highlight the amounts above the target sales. The sales data of 2017 is shown in figure 2.57.

![Fig. 2.57 Sales Data](image)
Follow the given steps:
- Select the cells to which you want to apply a conditional style.
- Choose **Format → Conditional Formatting → Condition** ....
- Enter the condition(s) into the appeared windows, as shown Fig 2.58.

![Fig. 2.58 Setting conditions in formatting](image)

Then, the outcome of the above is shown in figure 2.59.

![Fig. 2.59 Formatted sales data](image)

- **Table formatting**

  Spreadsheet has predefined style options to format a table quickly.

  This option formats a range of cells and converts it into a table by choosing a predefined table style. The table formatting steps are as follows:
  - Select the range of cells that is to be formatted.
  - Select 'Format' menu followed by 'Auto format' in the drop down menu.
  - Select predefined Table format, from the appeared Auto Format window.

![Fig. 2.60 Auto format window](image)
Compare the two tables given in figure 2.61 to find the amazing aspect of formatting:

![Fig. 2.61 Comparison of raw table and formatted table](image)

### Let's know more ...

#### Merging Cells

Merging cells is often used when a title is to be centred over a particular range of cells in a spreadsheet. For this you have to combine the adjacent cells at the top row of the table. Combining of two or more selected cells to form a single cell is called 'Merging Cells'. The cell reference for a merged cell is the upper-left cell in the original selected range. When two or more adjacent horizontal or vertical cells are merged, the cells become one large cell and they are displayed across multiple columns or rows. Then, the cell contents appear in the centre of the merged cell.

To merge a group of cells:

1. Select two or more adjacent cells that we want to merge.
2. Click 'Merge and Centre' icon. This icon will be activated only when two or more cells are selected.

#### 2.8 Output Reports

Unless you communicate effectively, the knowledge you mastered and the skills you have shown in spreadsheet application is of little use to others. Report is a document that conveys specific information to others. So it should be attractive, legible and systematically presented for which formatting has a lot to do.
Aligning the margin, adding headers and footers etc., before taking printout will give more readability to the report. The page style can be defined by choosing the 'Page' option of 'Format' menu. Then the default 'Page Style' window appears as in figure 2.62.

In the window you may set the following:

- The type of paper from the 'Format' option - A4, A3, Legal, Letter etc.
- Set the Width and Height of the print out.
- Set the orientation as Portrait or Landscape. (See figure 2.63).
- Set left, right, top and bottom margins.
- Text direction Left to Right or Right to Left.

These optional settings allow us to adjust the final appearance of the printed page to suit our needs.

We can print entire or partial worksheets and workbooks. LibreOffice Calc provides the following print options:

(a) Print a partial or entire worksheet or workbook.
(b) Print several worksheets at once.
(c) Print several workbooks at once.
(d) Print a LibreOffice Calc table.
(e) Print a workbook to a file.
(f) Print a graphic Charts and Pivot Tables.

The print option is available in the 'File' Menu.

The options Print Preview and Printer Settings are also available in the File Menu as shown in figure 2.64. Before printing we have to verify print preview which gives an idea about how the printout may come. The required modifications can be carried out before taking the print out.

2.8.1 Defining the Print Area

By default, LibreOffice Calc prints all data on the current worksheet. But we can define print area for specific and formatted print. This print option is available in the 'File' Menu. Follow the steps for defining the Print Area using Print window

(a) Select the range of cells to print.
(b) In the File Menu click on 'Print' option or click on the Print icon from toolbar.
(c) The Print window appears in the screen, as shown in Fig 2.65.

(d) Select the printer for printing.
(e) In 'Range and Copies' field choose the option 'Selected Cells'.
(f) Enter the number of copies required, then press OK.

2.8.2 Print non-contiguous ranges

You can also print non-contiguous cells (cells which do not touch each other) in a single sheet. For this the following steps are to be followed:

(a) Select the first range to be printed.
(b) Press down the control key and then select the other ranges to be printed simultaneously.
(c) From the File Menu click on 'Print' option or click the Print icon on the tool bar.
(d) In the 'Print' window appeared, select the option 'Selected Cells'.
(e) Click ‘Ok’

2.8.3 Preparation of Reports using Data Tables

A data table is a range of cells that shows the results by substituting different values in one or more formulae. They allow you to see the results of many possible inputs at the same time.

The ‘Data → Multiple Operations’ command provides a planning tool for "what if" questions. In your spreadsheet, enter a formula to calculate a result from values that are stored in other cells. Then, set up a cell range where you enter some fixed values, and the Multiple Operations command will calculate the results depending on the formula.

There are two types of data tables:
1. One-variable data table and
2. Two-variable data table.

- One-variable Data Table

A one-variable data table is simply a table that shows multiple results, based on different source data. Suppose you have taken a loan of ₹ 2,00,000 and wanted to know the amount of interest payable, if rate of interest is flexible say, 8%, 9% and 10% for a period of 5 years. How can we do this?

The One-Variable Data Table allows you to do this, by changing one variable and will show its effect on the other variable. The Multiple Operations command is used to calculate One-Variable Data Table.

Consider the following example to illustrate the construction of a one-variable table:

The selling cost of a toy is ₹ 100 each. The material cost (Direct cost) of each toy is ₹ 20 and in addition to which you have fixed costs of ₹ 1,00,000 per year. How much profit will you make in a year if you sell a particular number of toys?

You can easily calculate the amount of profit earned from different sales units by preparing a one-variable table. In this case, the quantity sold is the variable, but the selling price is constant. Its steps are given below:-

(a) To calculate the profit, first enter the selling quantity of toys, for example, 2000. The profit can be calculated using the formula:
   Profit = Quantity x (Selling price - Direct costs) - Fixed costs.
   Use this formula to calculate the amount of profit in B6.
(b) In column 'C' enter given annual sales, one below the other; for example, 500 to 5000, in steps of 500.
(c) Select the range C3:D12, and thus the values in column C and the empty cells alongside in column D.
(d) Choose **Data → Multiple operations**.
(e) With the cursor in the Formulas field, click cell B6.
(f) Set the cursor in the Column input cell field and click cell B2. This means that B2, the quantity, is the variable in the formula, which is replaced by the selected column values.
(g) Close the dialogue box with OK. You see the profits for the different quantities in column D, as shown in Fig 2.66

![One-variable Table](image)

**Fig. 2.66 Construction of One-variable Table** *(Negative amount denotes loss)*

---

**One variable data table may be:-**

1. **Column-oriented:** If your variable values are in column, type the cell reference for the input cell in the Column input cell box. The input cell is B2 in the above illustration
2. **Row-oriented:** If your variable values are in row, type the cell reference for the input cell in the Row input cell box.

---

**Try Yourself**

Your friend is planning to take a loan from a bank for a period of 10 years to construct a new house. The current rate of interest of housing loan is 9.5% per annum. Help him to construct a data table showing the monthly instalment amount, if the loan amount vary from ₹15,00,000 to ₹20,00,000 in multiples of 50,000.

*(Hint: Here loan amount is the variable. Use the **PMT** function to calculate the loan EMI)*

- **Two-variable Data Table**

Let us recall the example cited in the one variable table where we analysed the effect on the amount of profit at different sales volume. But two variable tables are used to analyse
the effect on the amount of profit when two variables are changed i.e., quantity sold as well as selling price per unit.

Two-Variable Data Table works similar to the One-Variable Data Table. A two-variable data table is a data table with two input values (Two Variables) and a single result.

LibreOffice Calc allows you to carry out joint multiple operations for columns and rows in so-called cross-tables. The formula cell has to refer to both the data range - row and column. Select the range defined by both data ranges and use the multiple operations option. Enter the reference to the formula in the Formulas field. The Row input cell and the Column input cell fields are used to enter the reference to the corresponding cells of the formula.

Taking the illustration of toys in the one variable table, let us see what changes can be effected when it is converted into two variable table.

Here, both the quantity and the selling price vary. Let us see what impact this will have in the profit of the toys. This two variable table helps to estimate the amount of profit at different sales quantities under various selling prices. (Assume that the selling prices under consideration are 80 to 180 in multiples of 20). Its steps are given below:-

(a) Follow the first two steps, as explained in the one variable table. Calculate the amount of profit in B5 at selling price of ₹100 and quantity sold as 2000 units. Also enter in column 'C' the annual sales volume from 500 to 5000, in steps of 500.

(b) In D2 : I2 enter the numbers from 80 to 180, in multiples of 20.

(c) Select the range C2 : I12.

(d) Choose Data → Multiple Operations.

(e) With the cursor in the Formulas field, click cell B5.

(f) Set the cursor in the Row input cell field and click cell B2. This means that B2, the selling price, is the horizontally entered variable (with the values 80 to 180).

(g) Set the cursor in the Column input cell field and click in B1. This means that B1, the quantity, is the vertically entered variable.

(h) Close the Multiple Operations window by pressing OK. You see the profits for the different selling prices in the range C2:I12 as shown in figure 2.67.

![Fig. 2.67 Construction of Two - variable data Table](image_url)
**Try Yourself**

A firm proposes to purchase a machinery costing ₹1,00,000 having scrap value of ₹5,000, with an economic life of 10 years. Construct a two-variable table showing the amounts of annual depreciation based on the following information.

- Cost of machinery ranging from ₹50,000 to ₹5,00,000 in multiples of ₹50,000
- Useful life ranges from 5 to 10 years.
- Provide depreciation under Straight Line Method.

*Hint: use multiple operations; the two variables are cost of asset and life of asset*

### 2.8.4 Preparation of Reports using Pivot Table

Have you ever viewed an object through a kaleidoscope in your primary classes?

When you look at an object through a kaleidoscope, you can see the object in different ways. You can turn the instrument to move the details of the object around.

Think of a Pivot table as a kaleidoscope that is pointed to your dataset. When you look your data through a Pivot table it provides an opportunity to see your data in different perspective.

Pivot Table is a tool for combining, comparing, and analysing large amounts of data easily. It is a table that summarizes source data in another table, displays the details of areas of interest and creates reports. A Pivot table allows you to create an interactive view to your dataset.

A pivot table report provides enhanced layout, attractive and formatted report with improved readability. It enables us to arrange and summarise complicated data easily and drill down on details. This help to analyze numerical data in depth and to answer unanticipated questions about the collected data.

The construction of a pivot table can be illustrated with the help of an example.

You are given ledger account balances under different groups of a business firm in a spreadsheet (See figure 2.68). Can you show group wise summary?

![Fig. 2.68 Spread Sheet Data](image_url)
The procedure for pivot table creation is given below:-

1. Enter the data in to spread sheet and select the data range. (A1 : C10)
2. On Data Menu Click Pivot Table and then Click on Create to get Pivot table layout.

\[ \text{Data} \rightarrow \text{Pivot Table} \rightarrow \text{Create.} \]

The Table Lay out dialog box is shown in figure 2.69.

![Fig. 2.69 Pivot table layout](image)

The fields which are included in the 'Pivot Table Layout' window are explained below:-

- **Available Data Fields**: Column heads of the Table such as 'Ledger Accounts', 'Groups', and 'Amount' are displayed in this area.
- **Page Fields**: This area is used to create a button and a list box on top of the generated pivot table.
- **Column Fields**: It indicates the field on the basis of which the result will be sorted in various columns (eg: Groups)
- **Data Fields**: It must contain at least one field. Only the numerical data which are to be added together is given in this field.
- **Row Fields**: It indicates the field on the basis of which the result will be sorted in various rows (eg: Ledger Accounts).

3. Drag and drop the field buttons into the white areas of Pivot Table Dialogue Box, i.e. 'Ledger Accounts' to Row fields, 'Groups' to Column fields, 'Amount' to Data Field, as shown in figure 2.70.

![Fig. 2.70 Drag the fields to Pivot Table layout](image)
4. Click on OK button to get Pivot Table Report as shown in figure 2.71.

![Fig. 2.71 Pivot table Report](image)

- **Uses of Pivot Table**

A pivot table report is designed for:

(a) Sub totalling and aggregating numeric data, summarising data by categories and sub categories, and creating custom calculations and formulae.

(b) Summarising the data according to the areas of interest from the given dataset.

(c) Moving rows to columns or columns to rows to show different summaries of the source data.

(d) Filtering, sorting, grouping, and conditionally formatting the most useful and the interesting subset of data to enable us to focus on the information that we want.

(e) Presenting concise, attractive, and annotated online or printed reports.

---

**Try Yourself**

Take your household expenses for the last three months, and make a Pivot table showing the month wise house hold expenses.

**Let’s assess**

1. ................. command is used to construct a One-Variable/Two variable Data Table.

2. The key used to select non-contiguous cells is-
   (a) Alt        (b) Ctrl        (c) Shift        (d) Tab

3. 'Multiple Operations' option is available in ..................tab.
   (a) File       (b) Insert      (c) Table       (d) Data

4. The spreadsheet feature that allows creating a cross tabulation summary of data is ............... 

5. Pivot Table option is available in ..................tab of LibreOffice Calc.

6. In a pivot table, the data which require aggregation are drag and drop to:
   (a) Page fields  (b) Column fields  (c) Row fields  (d) Data fields
2.9 Common Error Codes (Messages) in LibreOffice Calc

Consider the case given below:

Take a worksheet and type the name and score as shown in the table given below. Also try to enter the formula as it is shown in C2 to C5.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Name</td>
<td>Economics</td>
<td>Formula/Functions</td>
</tr>
<tr>
<td>2</td>
<td>Abdulla</td>
<td>45</td>
<td>=B2+B3+B4+B5</td>
</tr>
<tr>
<td>3</td>
<td>Alex</td>
<td>Ab</td>
<td>=SU(B2:B5)</td>
</tr>
<tr>
<td>4</td>
<td>Basil</td>
<td>0</td>
<td>=B2/B4</td>
</tr>
<tr>
<td>5</td>
<td>Devan</td>
<td>45</td>
<td>=7899^7E+123</td>
</tr>
</tbody>
</table>

- Have you encountered any problem while entering the formula?
- What is the result obtained?
- Is there any mistakes in the given formula or function?

At the time of entering the above formula you might have received some error messages. For rectifying the mistakes occurred in a formula, it is essential to understand the common error messages very well.

Observe the error messages in cell C2:C5 shown in figure 2.72.

![Figure 2.72 Error message](image)

LibreOffice Calc provides some messages for errors of miscalculations, incorrect use of functions, invalid cell references and values and other mistakes committed by users.

2.9.1 ### Error

This error occurs when a numerical value entered in a column is not enough to display the contents. This is not really an error value, so there is no corresponding numerical error code. It happens when the columns are too narrow for holding the data.

Solution to this problem is -

1) Increase the width of the column.
2) Select the column, then go to **Format → Cells → Alignment** and click Shrink to fit cell size.
3) Select the Column, then go to Format → Column → Optimal width and Click Ok button

2.9.2 #DIV/0! Error (Error code - 532)

#DIV/0! error is displayed, when a number is divided by zero (0). It happens when you enter a simple formula like =5/0, or when a formula refers to a cell that has zero value or the cell is blank.

Solution to this problem is:

a) Change the cell reference to another cell.
b) Enter a value other than zero in the cell used as a divisor
c) Prevent the error message by using the logical function IF.

For Example =IF(B1=0,"","A1/B1"). Here cell B1 equals 0, an empty string (" ") is displayed. If not, the result of the formula A1/B1 is displayed as shown in figure 2.73.

![Fig. 2.73 Prevent #DIV! Error using the logical function IF](image)

2.9.3 #NAME Error (Error code - 525)

This error occurs when LibreOffice Calc does not recognise the Text in formula. This may occur with misspelled formula or named range. The error also occurs if we forget to close a text in double quotes or omit the range operator in formula as shown in figure 2.74. So enter proper formula name, named range, range operator to avoid these types of errors.

![Fig 2.74 Examples of #NAME! error](image)

2.9.4 #REF! Error (Error code - 524)

The #REF! Error shows up when a formula referred to a cell that is not valid. This happens most often when cells that were referred by formulas get deleted. For example, enter the formula

= A1+B1+C1 in Cell D1, then delete the Column C1, immediately the formula return #REF!
To fix the errors, you can either delete +REF!, in the formula or you can undo your action by pressing Ctrl+Z.

2.9.5 #VALUE! Error

This error occurs when a wrong argument is given in a formula. For example, if cell A1 contains a number 25 and cell A2 contain the text 'commerce'. The formula =A1+A2 return an error message #VALUE! This type of error is generated when one of the variables in the formula is of the wrong type (e.g.: cell referred by the formula contains text instead of a number).

2.9.6 #NUM! Error (Error code - 503)

The #NUM! Error occurs when a calculation resulted in an overflow of the defined value range. For example, while filling data by using Fill series option [ Edit -- Fill -- Series ], the selected range to display the content is more than the required cell, the #NUM! Error will be displayed after the end value in the selected range as shown in figure 2.75.

![Fig. 2.75 Example of #Num! Error.](image)

It also appears when a function argument is inappropriate or formula produces a number too larger/small to be represented. Example, if we enter the formula =78999^7E+123 in a cell, the result will be a '#NUM! Error'.

**Summary of Common errors in LibreOffice Calc**

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Error Code</th>
<th>Explanation of the error</th>
</tr>
</thead>
<tbody>
<tr>
<td>###</td>
<td>N/A</td>
<td>When a numerical value entered in a column is not enough to display the contents</td>
</tr>
<tr>
<td>#DIV/0!</td>
<td>532</td>
<td>When a number is divided by zero (0)</td>
</tr>
<tr>
<td>#NAME</td>
<td>525</td>
<td>When a Calc does not recognise the Text in formula</td>
</tr>
<tr>
<td>#REF!</td>
<td>524</td>
<td>When a formula refers to a cell that is not valid</td>
</tr>
<tr>
<td>#VALUE!</td>
<td>519</td>
<td>When a wrong argument is given in a formula</td>
</tr>
<tr>
<td>#NUM!</td>
<td>503</td>
<td>When a calculation resulted in an overflow of the defined value range</td>
</tr>
</tbody>
</table>
Summary

- Electronic spreadsheet: It is a worksheet consisting of several rows and columns used to store and manipulate large volume of data through computers.
- LibreOffice Calc: It is a spreadsheet application that you can use to calculate, analyse, and manage data.
- Features of LibreOffice Calc: Easy calculations, What-if calculations, Database functions, Arranging data, Dynamic charts, Opening and saving Microsoft files.
- Components LibreOffice Calc: Rows and Columns, Cell and Ranges.
- Naming Ranges: Use special name to refer the range in a formula.
- Spreadsheet Operations: Open Worksheet, Save Worksheet, Close worksheet, Quit LibreOffice Calc, Add worksheet, Delete worksheet and Rename worksheet.
- Spreadsheet Navigation: Using Mouse, Using a cell reference and Using the Navigator.
- Worksheet Data: Spreadsheets usually have three types of data to be entered in a cell such as Value, Label and Formula.
- Cell References: It identifies the location of a cell or group of cells in the spreadsheet. A cell reference may be relative, absolute and mixed.
- Mathematical operators: A spreadsheet usually uses three types of operators or symbols: Arithmetic, Comparison and Reference.
- Functions: They are the pre-defined formulae in spreadsheets.
- Date & time functions: TODAY, NOW, YEAR, MONTH, DAY, DATEVALUE and DATE
- Statistical Functions: COUNT, COUNTA, COUNTBLANK and COUNTIF.
- Mathematical functions: SUM, SUMIF, ROUND, ROUNDUP and ROUNDDOWN.
- Text functions: TEXT and CONCATENATE.
- Logical functions: IF, NESTED IF, AND and OR.
- Spreadsheet Functions: LOOKUP (Vector form), LOOKUP (Array form), VLOOKUP and HLOOKUP, ROWS and COLUMNS.
- Financial functions: ACCRINT, RATE, CUMIPMT, PV, PMT, FV and NPV.
• Data entry: The three options for attaining input are Direct data entry, Data fill options and Import data from other sources.

• Data fill options: You can automatically fill cells with data with the Auto Fill command or the Series command.

• Data validation: We can prevent the wrong data to be entered in a cell by validation process. During data entry accuracy and validity of data can be ensured in two ways: Using validation option and Using Data form.

• Data formatting: It means the arrangement of data for computer input or output, such as the number and size of fields in a record or the spacing and punctuation of information in a report. The worksheet data formatting involves the following aspects - Number formatting, Text formatting, Conditional formatting, and Table formatting.

• Output reports: Before printing the final report, we should adjust it for better readability. We can change the margin of sheets, add headers and footers etc, before taking the printout.

• One-variable Data Table: This Data Table allows you to get multiple results by changing anyone of the given variables. The Multiple Operations command is used to calculate One-Variable Data Table.

• Two-variable Data Table: A two-variable data table is a data table with two input values (Two variables) and a single result.

• Pivot Table: It is a tool for combining, comparing, and analysing a large amount of data easily. It is a table that summarizes source data in another table, displays the details of areas of interest and creates reports.

• Common error messages in LibreOffice Calc: ### Error, #DIV/0! Error, #NAME Error, #REF! Error, #VALUE! Error, and #NUM! Error.

---

**I can**

- outline the concept of spreadsheet and its basic features
- state how to use a spreadsheet for various purposes
- explain the use of various output reports and equip them to prepare reports using spreadsheet
- check various errors while working with formulae and functions and apply the knowledge in error handling
TE QUESTIONS

1. A spreadsheet file that contains one or more worksheets is called a
   ..........(a) Database (b) Workbook (c) Range (d) Cell reference

2. Which of the following component displays the contents of active cell?
   a. Name box b. Formula bar c. Menu bar d. Status bar

3. Identify the function which helps to convert a date in the form of text to a number.
   (a) DATE (b) DAY (c) DATEVALUE (d) NOW

4. Which function is used to count the number of empty cell in the given range?

5. Write the formula for displaying the number 89.5796 as 89.57.

6. Explain the features of LibreOffice Calc.

7. Describe different ways of cell referencing in Calc.

8. Explain different statistical functions available in LibreOffice Calc.

9. What are the different types of data that can be entered into cells?

10. Differentiate function and formula in spreadsheet with a suitable example.

11. Explain the merits of naming ranges in a spreadsheet.

12. Explain different logical functions of LibreOffice Calc.

13. Explain the various data fill option available in Calc.

14. Name the function and give its syntax for calculating the present value of an investment resulting from a series of regular payments.

15. Identify the relevant functions used for the following purposes.
   (a) To count all types of data in a range of cells.
   (b) To join several text strings in different cells into one string.
   (c) To calculate the constant interest rate per period of an annuity.

16. On 01/01/2017 Aswathy took a Car Loan of ₹7,00,000 from Canara Bank at 12% interest per annum. The period of Loan is 10 years and payment is to be made at the end of every month.
   (a) Identify the function to calculate the EMI of Car Loan in LibreOffice Calc.
   (b) Give its syntax and explain its parameters.
17. What is Pivot Table? List out its advantages.
18. Mr. Babulal faced the following error while work in spreadsheet. State the reason for each error.
   (a) ### (b) #DIV/0! (c) #NAME (d) #VALUE!
19. Name the functions used to display the following results in LibreOffice Calc.
   (a) Current System Date (b) Current date with time
20. Explain the purpose of the following functions.
    (a) COUNTIF (b) SUMIF
21. Write two text manipulation functions in Libreoffice Calc.
22. Write down the syntax of the following functions.
    (a) VLOOKUP (b) HLOOKUP

**PE QUESTIONS**

1. Given below is a table showing the Name, Designation and Net Salary paid to the 10 employees in Goodluck Traders for January 2018

<table>
<thead>
<tr>
<th>Emp. No.</th>
<th>Name</th>
<th>Designation</th>
<th>Net Pay (₹)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Anumol</td>
<td>Manager</td>
<td>40000</td>
</tr>
<tr>
<td>2</td>
<td>Shinoj</td>
<td>Accountant</td>
<td>35000</td>
</tr>
<tr>
<td>3</td>
<td>Prakashan</td>
<td>Supervisor</td>
<td>22000</td>
</tr>
<tr>
<td>4</td>
<td>Rajesh</td>
<td>Salesman</td>
<td>14000</td>
</tr>
<tr>
<td>5</td>
<td>Subhramaniyan</td>
<td>Salesman</td>
<td>12000</td>
</tr>
<tr>
<td>6</td>
<td>Jobish</td>
<td>Salesman</td>
<td>11500</td>
</tr>
<tr>
<td>7</td>
<td>Jayesh</td>
<td>Salesman</td>
<td>10000</td>
</tr>
<tr>
<td>8</td>
<td>Valsamma</td>
<td>Clerk</td>
<td>8000</td>
</tr>
<tr>
<td>9</td>
<td>Shaju</td>
<td>Clerk</td>
<td>7000</td>
</tr>
<tr>
<td>10</td>
<td>Joseph</td>
<td>Peon</td>
<td>6500</td>
</tr>
</tbody>
</table>

Find out the following using appropriate spreadsheet operations:-
(a) The Total Salary payable in the month of January 2018 by Naming the concerned range as 'TOTAL_PAY'.
(b) The total monthly salary paid to the Salesmen in the firm.
(c) Display Name of employee with Net Pay of ₹ 10,000 by using 'LOOKUP' Function.

2. Following are the scores obtained by Sumisha, the top scorer in Humanities class, for the Higher Secondary Examinations-March 2017.(Maximum score for TE is 80 and CE is 20)

<table>
<thead>
<tr>
<th>SUBJECT</th>
<th>TE</th>
<th>CE</th>
</tr>
</thead>
<tbody>
<tr>
<td>English</td>
<td>78</td>
<td>16</td>
</tr>
<tr>
<td>Malayalam</td>
<td>59</td>
<td>18</td>
</tr>
<tr>
<td>History</td>
<td>65</td>
<td>20</td>
</tr>
<tr>
<td>Sociology</td>
<td>51</td>
<td>17</td>
</tr>
<tr>
<td>Economics</td>
<td>67</td>
<td>18</td>
</tr>
</tbody>
</table>

Find out her total score in each subject and the corresponding grades assigned, on the basis of the given criteria:

(Hint: Use Nested IF Function to assign the Grades)

<table>
<thead>
<tr>
<th>Scores</th>
<th>Grades</th>
</tr>
</thead>
<tbody>
<tr>
<td>90 - 100</td>
<td>A+</td>
</tr>
<tr>
<td>80 - 89</td>
<td>A</td>
</tr>
<tr>
<td>70 - 79</td>
<td>B+</td>
</tr>
<tr>
<td>60 - 69</td>
<td>B</td>
</tr>
<tr>
<td>50 - 59</td>
<td>C+</td>
</tr>
<tr>
<td>40 - 49</td>
<td>C</td>
</tr>
<tr>
<td>30 - 39</td>
<td>D+</td>
</tr>
<tr>
<td>20 - 29</td>
<td>D</td>
</tr>
<tr>
<td>Below 20</td>
<td>E</td>
</tr>
</tbody>
</table>

3. Create the given table in a spreadsheet:-

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>100000</td>
<td>34000</td>
<td></td>
</tr>
<tr>
<td>Assets</td>
<td>16000</td>
<td>Stock</td>
</tr>
<tr>
<td>50000</td>
<td>12000</td>
<td>45000</td>
</tr>
<tr>
<td>Debtors</td>
<td>22000</td>
<td>76000</td>
</tr>
</tbody>
</table>

Find the answers to the following questions using appropriate spreadsheet functions:

(a) How many cells contain amounts only?
(b) Count the Number of cells containing any value.
(c) How many empty cells are there in the given table?
(d) Count the Number of cells containing values exceeding 50000.
4. Following table shows the details of students admitted in Plus One classes:

<table>
<thead>
<tr>
<th>Ad. No.</th>
<th>Name of Student</th>
<th>Course Code</th>
<th>Second Language</th>
<th>Sex</th>
<th>Date Of Birth</th>
<th>Date of Admission</th>
</tr>
</thead>
<tbody>
<tr>
<td>13041</td>
<td>Arunkumar C. P.</td>
<td>11</td>
<td>Malayalam</td>
<td>Male</td>
<td>05/02/2002</td>
<td>12/06/2017</td>
</tr>
<tr>
<td>13042</td>
<td>Suresh Babu K.</td>
<td>5</td>
<td>Hindi</td>
<td>Male</td>
<td>12/09/2001</td>
<td>12/06/2017</td>
</tr>
<tr>
<td>13043</td>
<td>Anwar Ali C. K.</td>
<td>38</td>
<td>Hindi</td>
<td>Male</td>
<td>07/03/2002</td>
<td>18/06/2017</td>
</tr>
<tr>
<td>13044</td>
<td>Maheswari. S.</td>
<td>1</td>
<td>Malayalam</td>
<td>Female</td>
<td>12/1/2013</td>
<td>19/06/2017</td>
</tr>
</tbody>
</table>

Enter the details into a Text Editor software and import the same to a spreadsheet.

5. The following table shows the amounts of Net Sales, Cost of Goods Sold and Indirect Expenses of last 5 years of Arun Traders:-

<table>
<thead>
<tr>
<th>Items</th>
<th>2013</th>
<th>2014</th>
<th>2015</th>
<th>2016</th>
<th>2017</th>
</tr>
</thead>
<tbody>
<tr>
<td>Net Sales</td>
<td>200000</td>
<td>240000</td>
<td>320000</td>
<td>340000</td>
<td>520000</td>
</tr>
<tr>
<td>Cost of Goods Sold</td>
<td>124000</td>
<td>165000</td>
<td>224000</td>
<td>259000</td>
<td>442000</td>
</tr>
<tr>
<td>Indirect Expenses</td>
<td>32000</td>
<td>34000</td>
<td>41000</td>
<td>38000</td>
<td>39000</td>
</tr>
</tbody>
</table>

(a) Calculate the Gross Profit and Net Profit of all the 5 years using the appropriate formula.
(b) Display the 'Net Profit' of 2017 using VLOOKUP Function.

6. Following table comprises of the salary details of 8 employees in Kumar Associates for the year 2016-'17.

<table>
<thead>
<tr>
<th>Name of Employee</th>
<th>Gross Salary (₹)</th>
<th>Eligible Deductions (₹)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amal</td>
<td>438000</td>
<td>65400</td>
</tr>
<tr>
<td>Balu</td>
<td>567000</td>
<td>63200</td>
</tr>
<tr>
<td>Chandran</td>
<td>645000</td>
<td>49500</td>
</tr>
<tr>
<td>Devasia</td>
<td>760000</td>
<td>98500</td>
</tr>
<tr>
<td>Filsy</td>
<td>743000</td>
<td>65800</td>
</tr>
<tr>
<td>George</td>
<td>787000</td>
<td>112000</td>
</tr>
<tr>
<td>Haridas</td>
<td>812000</td>
<td>97600</td>
</tr>
<tr>
<td>Ismayil</td>
<td>817000</td>
<td>67900</td>
</tr>
</tbody>
</table>

(a) Calculate the Taxable Income of each employee, by deducting Eligible Deduction from the Gross salary.
(b) Compute the income tax liability of each employee based on the following criteria, by using appropriate function in spreadsheet, if taxable income is:
   (i) below 250,000, No tax.
   (ii) ₹ 250,000 to ₹ 500,000 Tax rate is 10%
   (iii) Above ₹500,000 Tax rate is 20%
7. The loan information provided by a bank are shown below:
   Loan amount - ₹ 200,000
   No. of Payments - 60 months
   Annual Rate of interest - 12%
   (a) Calculate the yearly instalments of loan repayment using the
       PMT Function.
   (b) Prepare a one variable table to show the yearly instalments of
       the above loan if the number of payment varies from 1 to 6 years.

8. Mr. Biju Lucka took a loan of ₹ 400,000 from Union Bank of India,
   Kannur and repayable in 72 monthly instalments. Calculate the
   rate assuming payment is ₹ 6500 per month using appropriate
   Spreadsheet Function.

9. As a Financial Manager, you are considering the investment
   proposal to purchase a Plant and Machinery costing ₹ 25,00,000.
   The expected future cash inflows during the next 5 years were
   ₹8,00,000, ₹ 7,60,000, ₹ 7,40,000, ₹ 7,00,000 and ₹ 6,60,000.
   The cost of capital of the industry is 12% p. a. Calculate NPV and
   evaluate the investment proposal.

10. The scores of 10 students in a class test for Accountancy are given:

<table>
<thead>
<tr>
<th>Name of Students</th>
<th>Scores(out of 20)</th>
</tr>
</thead>
<tbody>
<tr>
<td>James</td>
<td>9</td>
</tr>
<tr>
<td>Jexin</td>
<td>12</td>
</tr>
<tr>
<td>Selastin</td>
<td>8</td>
</tr>
<tr>
<td>Melvin</td>
<td>19</td>
</tr>
<tr>
<td>Tomy</td>
<td>13</td>
</tr>
<tr>
<td>Beena</td>
<td>18</td>
</tr>
<tr>
<td>Seena</td>
<td>7</td>
</tr>
<tr>
<td>Agnes</td>
<td>20</td>
</tr>
<tr>
<td>Daphy</td>
<td>14</td>
</tr>
<tr>
<td>Anila</td>
<td>17</td>
</tr>
</tbody>
</table>

   (a) Assign Grade to the students based on the following criteria,
       using Nested IF Function:-
       Scores above 15 to be graded as 'A'.
       Scores between 10 to 15 to be graded as 'B'.
       Scores below 10 to be graded as 'C'.
   (b) Highlight the scores below '10' in 'red' background, using
       Conditional Formatting.
APPENDIX

Lab Work 1 (Naming the ranges)

The cash receipts and cash payments of a trader during the month of January 2017 are given below:

2017 January

1. Cash in hand ₹ 12,000.
2. Cash sales ₹ 6700.
4. Paid rent ₹ 4300.
9. Cash purchases ₹ 8,300.
12. Cash withdrawn for personal purpose ₹ 4500.
15. Paid wages ₹ 600.
22. Cash Sales ₹ 15,000.
30. Paid to Creditor, Sunil ₹ 3000.

Prepare a Cash Book using the spreadsheet. Find the closing balance by naming respective ranges as 'Cash_Debits', and 'Cash_Credits'

Process:

Step-1: Enter the title as 'Cash Book' in the first row.

Step-2: Enter column headings as Date ,Receipts, Amount, Date, Payments, Amount in second row.

Step-3: Enter the items of cash receipts-Date in column A, Name of account in column B and its respective amounts in Column C. Similarly, enter the items of cash payments-Date in column D, Name of account in column E and its respective amounts in Column F.

Step-4: Select the Receipts Side amounts and name the range as 'Cash_Debits'.
Similarly, Select the Payments Side amounts and name the range as 'Cash_Credits'. (Insert → Names → Define...)

Step-5: In C9, give the formula ' =SUM(Cash_Debits)' to find the debit total. Choose the 'Cash_Debits' from the 'Paste Name' window. (Insert → Names → Insert....)

Step-6: In F9 give the formula ' =C9' to enter the same total on payments side.

Step-7: In D8, enter the date as '31/01/17'. In E8, enter 'Balance c/d'. In F8, enter the formula as ' =C9 - SUM(Cash_Credits)' to calculate the amount of closing balance.
Lab Work 2 (Datevalue & Round functions)

For applying for the post of an accountant, the minimum and maximum age is fixed at 18 years and 38 years respectively. The following list gives the date of birth of few candidates. The cut-off date for calculating age is 01/01/2018. Calculate the age of the candidates as on cut-off date.

**Process:**

The following steps are required for finding out the result.

Step 1. Enter the data given above in a worksheet in the same format as seen above.

Step 2. Enter the cut-off date from cells D2:D6

Step 3. Select Cell E2 and enter the formula, =D2-C2 and press Enter Key (Now ‘Age in days’ will be displayed in cell E2)

Step 4. Copy the formula in Cell E2, by clicking on and dragging the fill handle downwards to the required cells (E3:E6). (Now ‘Age in days’ will be displayed in cell E3:E6)

Step 5. Select Cell F2 and enter the formula, =ROUND(E3/365.25,0) and press Enter Key (Now Age rounded-off to year will be displayed in cell F2. If not round-off it will be displayed as 16.3887748118, hence we round-off)

Step 6. Copy the formula in Cell F2, by clicking on and dragging the fill handle downwards to the required cells (F3:F6). (Now ‘Age rounded-off to year will be displayed in cell F3:F6)
Lab Work 3 (SUM and SUMIF Functions)

The list of various Assets in Modern Traders is given below. By using SUMIF function compute:

(a) Total value of Current Assets  
(b) Total Value of Fixed Assets  
(c) Also calculate the Value of Total Assets by using SUM Function

Process:

The following steps are required.

Step 1. Enter the data given above in a worksheet in the same format as seen above.  
Step 2. Select Cell E2 and enter the formula, =SUMIF(B2:B8,"CA",C2:C8) and press Enter Key  
(Now Total value of Current Assets will be displayed in E2)  
Step 3. Select Cell E4 and enter the formula, =SUMIF(B2:B8,"FA",C2:C8) and press Enter Key  
(Now Total value of Fixed Assets will be displayed in E4)  
Step 4. Select Cell E6 and enter the formula, =SUM(C2:C8) and press Enter Key  
(Alternatively select C2:C8 and use Sum (Σ) key)  
(Now Value of Total Assets will be displayed in cell E6)

Output

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Name of Asset</td>
<td>Fixed / Current</td>
<td>Amount</td>
<td></td>
<td>RESULT</td>
<td>Function used</td>
</tr>
<tr>
<td>2</td>
<td>Land and Buildings</td>
<td>FA</td>
<td>75000</td>
<td>Total Current</td>
<td>54500</td>
<td>=SUMIF(B2:B8,&quot;CA&quot;,C2:C8)</td>
</tr>
<tr>
<td>3</td>
<td>Cash in Hand</td>
<td>CA</td>
<td>6000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Plant and Machinery</td>
<td>FA</td>
<td>60000</td>
<td>Total Fixed</td>
<td>16000</td>
<td>=SUMIF(B2:B8,&quot;FA&quot;,C2:C8)</td>
</tr>
<tr>
<td>5</td>
<td>Sundry Debtors</td>
<td>CA</td>
<td>12500</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Furniture</td>
<td>FA</td>
<td>25000</td>
<td></td>
<td>214500</td>
<td>=SUM(C2:C8)</td>
</tr>
<tr>
<td>7</td>
<td>Stock of goods</td>
<td>CA</td>
<td>15000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Cash at Bank</td>
<td>CA</td>
<td>21000</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Lab Work 4 (COUNT, COUNTA, COUNTBLANK and COUNTIF Functions)

From the given table find out:

(a) Number of cells containing numbers only.  
(b) Number of cells containing any value.  
(c) Number of cells having no values
(d) Count the number of cells have value more than 2000

<table>
<thead>
<tr>
<th></th>
<th>1220</th>
<th>1208/17</th>
<th>1856</th>
<th>2365</th>
<th>125R</th>
<th>Cash</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Buildings</td>
<td>4565</td>
<td>1317</td>
<td>Land</td>
<td>“13/10/2017”</td>
<td>R145</td>
</tr>
</tbody>
</table>

**Process:**

Step 1  Open LibreOffice Calc.
Step 2  Enter the data in cells from A1 to G2 as in the question
Step 3  To get the Number of cells contains Numbers only, Set the formula in E3 =COUNT(A1:G2)
Step 4  To get Number of cells that contains any value, Set the formula in E4 =COUNTA(A1:G2)
Step 5  To get Number of cells that contains no values (or blank cells), set the formula in E5 =COUNTBLANK(A1:G2)
Step 6  To get the Number of cells having values exceeding 2000, Set the formula in E5 =COUNTIF(A1:G2,”>2000”)

**Output**

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1220</td>
<td>12-08-17</td>
<td>1856</td>
<td>2365</td>
<td>125R</td>
<td>Cash</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Buildings</td>
<td>4565</td>
<td>1317</td>
<td>Land</td>
<td>“13/10/2017”</td>
<td>R145</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>(a) Number of cells containing numbers only</td>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>(b) Number of cells containing any value.</td>
<td>12</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>(c) Number of cells having no values</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>(d) Number of cells have value more than 2000</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Lab Work 5 (COLUMNS and ROWS Functions)**

From the following array find the number of columns and number of rows by using COLUMNS and ROWS function.

**Process:**

Step 1  Open LibreOffice Calc.
Step 2  Select the cell where number of columns are required (Here BJ74) and set the formula =COLUMNS(BF68:BP73) which will return number of columns in the array
Step 3  Select the cell where number of rows are required (Here BJ75) and set the formula =ROWS(BF68:BP73) which will return number of columns in the array.
Output

<table>
<thead>
<tr>
<th>BE</th>
<th>BF</th>
<th>BG</th>
<th>BH</th>
<th>BI</th>
<th>BJ</th>
<th>BK</th>
<th>BL</th>
<th>BM</th>
<th>BN</th>
<th>BO</th>
<th>BP</th>
</tr>
</thead>
<tbody>
<tr>
<td>68</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
<td>9</td>
<td>10</td>
<td>11</td>
</tr>
<tr>
<td>69</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>70</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>71</td>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>72</td>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>73</td>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>74</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>75</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Formula used:
- =COLUMNS(BF68:BP73) 11
- =ROWS(BF68:BP73) 6

Lab Work 6 (IF, NESTED IF, AND and OR Functions)

The following list shows the details of candidates for the selection of Accountants in Star Ltd.

<table>
<thead>
<tr>
<th>Application No.</th>
<th>Name</th>
<th>Sex</th>
<th>Age</th>
<th>Score Written test (out of 80)</th>
<th>Score Interview (Out of 20)</th>
</tr>
</thead>
<tbody>
<tr>
<td>101</td>
<td>Manoj</td>
<td>Male</td>
<td>25</td>
<td>65</td>
<td>18</td>
</tr>
<tr>
<td>102</td>
<td>Dejesh</td>
<td>Male</td>
<td>27</td>
<td>61</td>
<td>16</td>
</tr>
<tr>
<td>103</td>
<td>Manju</td>
<td>Female</td>
<td>21</td>
<td>70</td>
<td>17</td>
</tr>
<tr>
<td>104</td>
<td>Krishna</td>
<td>Female</td>
<td>26</td>
<td>59</td>
<td>15</td>
</tr>
<tr>
<td>105</td>
<td>Kannan</td>
<td>Male</td>
<td>31</td>
<td>69</td>
<td>14</td>
</tr>
<tr>
<td>106</td>
<td>Asha</td>
<td>Female</td>
<td>29</td>
<td>63</td>
<td>16</td>
</tr>
<tr>
<td>107</td>
<td>Anjana</td>
<td>Female</td>
<td>25</td>
<td>76</td>
<td>17</td>
</tr>
<tr>
<td>108</td>
<td>Unni</td>
<td>Male</td>
<td>26</td>
<td>73</td>
<td>18</td>
</tr>
<tr>
<td>109</td>
<td>Lechu</td>
<td>Female</td>
<td>30</td>
<td>61</td>
<td>17</td>
</tr>
<tr>
<td>110</td>
<td>Deepa</td>
<td>Female</td>
<td>22</td>
<td>66</td>
<td>18</td>
</tr>
</tbody>
</table>

By using suitable function in Calc,
(a) Find the total Score of candidates.
(b) Find the candidates who are below 25 years old and whose total score is more than 80.
(c) Find the candidates who are below 30 years old and whose, total score is more than 80 and written test score is more than 70. Those who satisfy these conditions should be displayed as "Selected" and others as "Rejected".
(d) Find the candidates who are below 25 years old or total score is more than 90 or written test score is more than 75. Those who satisfy any of these conditions should be displayed as "Eligible" and others as Not Eligible.
(e) Grade the candidates on the following basis their total score:
    - More than 90 - Outstanding
    - 85 to 89 - Excellent
    - 80 to 84 - Good
    - Less than 80 - Average
**Process:**

Step 1  Open LibreOffice Calc.

Step 2  Enter the data in cells from A1 to F11 as in the question.

Step 3  Select Cell G2 and enter the formula =SUM(E2,F2) to get the total of Written test and interview. Use drag and fill handle to fill the cells G3 to G11

Step 4  Select Cell H2 and enter the formula =AND(D2<25,G2>80). Use drag and fill handle to fill the cells H3 to H11

Step 5  Select Cell I2 and enter the formula =IF(AND(D2<30, G2>80, E2>70),"Selected","Rejected"). Use drag and fill handle to fill the cells I3 to I11

Step 6  Select Cell J2 and enter the formula  

=IF(OR(D2<25,G2>90,F2>75),"Eligible","Not Eligible"). Use drag and fill handle to fill the cells J3 to J11

Step 6  Select Cell K2 and enter the formula  

=IF(G2>90,"Outstanding",IF(G2>85,"Excellent",IF(G2>80,"Good","Average"))). Use drag and fill handle to fill the cells K3 to K11

**Output**

<table>
<thead>
<tr>
<th>Application No.</th>
<th>Name</th>
<th>Sex</th>
<th>Age</th>
<th>Score Written test (out of 80)</th>
<th>Score Interview (Out of 20)</th>
<th>Total Score (a)</th>
<th>(b)</th>
<th>(c)</th>
<th>(d)</th>
<th>(e)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Manoj</td>
<td>Male</td>
<td>25</td>
<td>65</td>
<td>18</td>
<td>83</td>
<td>FALSE</td>
<td>Rejected</td>
<td>Good</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Dejohn</td>
<td>Male</td>
<td>27</td>
<td>61</td>
<td>17</td>
<td>77</td>
<td>FALSE</td>
<td>Rejected</td>
<td>Good</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Manuj</td>
<td>Male</td>
<td>21</td>
<td>70</td>
<td>17</td>
<td>87</td>
<td>TRUE</td>
<td>Rejected</td>
<td>Excellent</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Krishna</td>
<td>Female</td>
<td>26</td>
<td>59</td>
<td>15</td>
<td>74</td>
<td>FALSE</td>
<td>Rejected</td>
<td>Good</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Kannan</td>
<td>Male</td>
<td>31</td>
<td>69</td>
<td>14</td>
<td>83</td>
<td>FALSE</td>
<td>Rejected</td>
<td>Good</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Asha</td>
<td>Female</td>
<td>29</td>
<td>63</td>
<td>16</td>
<td>79</td>
<td>FALSE</td>
<td>Rejected</td>
<td>Average</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Anjana</td>
<td>Female</td>
<td>25</td>
<td>76</td>
<td>17</td>
<td>93</td>
<td>FALSE</td>
<td>Selected</td>
<td>Excellent</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Unni</td>
<td>Male</td>
<td>26</td>
<td>73</td>
<td>18</td>
<td>91</td>
<td>FALSE</td>
<td>Selected</td>
<td>Excellent</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Lechu</td>
<td>Female</td>
<td>22</td>
<td>66</td>
<td>18</td>
<td>84</td>
<td>FALSE</td>
<td>Rejected</td>
<td>Average</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Deepa</td>
<td>Female</td>
<td>22</td>
<td>66</td>
<td>18</td>
<td>84</td>
<td>TRUE</td>
<td>Good</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Lab Work 7 (VLOOKUP)**

The following table shows stock of various fabric items dealt by Minnu's Textiles.

<table>
<thead>
<tr>
<th>Product No</th>
<th>Brand Name</th>
<th>Product item</th>
<th>Stock (Nos.)</th>
<th>Price Per Unit (₹)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1100</td>
<td>Queen</td>
<td>Sarees</td>
<td>125</td>
<td>1500</td>
</tr>
<tr>
<td>1101</td>
<td>Lotus</td>
<td>Sarees</td>
<td>200</td>
<td>1800</td>
</tr>
<tr>
<td>1201</td>
<td>Rajas</td>
<td>Pants</td>
<td>200</td>
<td>2500</td>
</tr>
<tr>
<td>1202</td>
<td>Handsome</td>
<td>Pants</td>
<td>150</td>
<td>1700</td>
</tr>
<tr>
<td>1301</td>
<td>King</td>
<td>Shirt</td>
<td>300</td>
<td>2200</td>
</tr>
<tr>
<td>1302</td>
<td>Topper</td>
<td>Shirt</td>
<td>200</td>
<td>1200</td>
</tr>
<tr>
<td>1303</td>
<td>Jasmine</td>
<td>Churidar</td>
<td>150</td>
<td>1000</td>
</tr>
</tbody>
</table>

Find out the following using VLOOKUP Function
a) Brand name of product No. 1101  
b) Product item of product No. 1302  
c) Stock of product No. 1201  
d) Price of product No. 1303

**Process:**

Step-1: Open a blank worksheet in Libre Office Calc  
Step-2: Enter the table headings in different cells as follows  

<table>
<thead>
<tr>
<th>Cell</th>
<th>Cell Headings</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
<td>Product No.</td>
</tr>
<tr>
<td>B1</td>
<td>Brand Name</td>
</tr>
<tr>
<td>C1</td>
<td>Product item</td>
</tr>
<tr>
<td>D1</td>
<td>Stock (Nos.)</td>
</tr>
<tr>
<td>E1</td>
<td>Price Per Unit (₹)</td>
</tr>
</tbody>
</table>

Step-3: Enter the product details in the table from Cells A2 to E8  
Step-4: Enter the following labels in various cells  

| B9   | Brand name of product No. 1101 |
| B10  | Product item of product No. 1302 |
| B11  | Stock of product No. 1201 |
| B12  | Price of product No. 1303 |

Enter the following formulae in various cells against the labels  

<table>
<thead>
<tr>
<th>Cell</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>E9</td>
<td>=VLOOKUP(1101,A2:E8,2,0)</td>
</tr>
<tr>
<td>E10</td>
<td>=VLOOKUP(1302,A2:E8,3,0)</td>
</tr>
<tr>
<td>E11</td>
<td>=VLOOKUP(1201,A2:E8,4,0)</td>
</tr>
<tr>
<td>E12</td>
<td>=VLOOKUP(1303,A2:E8,5,0)</td>
</tr>
</tbody>
</table>

**Output**

![Spreadsheet image]
**Spreadsheet**

**Lab Work 8 (CUMIPMT Function)**

Minnu Pharmaceuticals took a loan of ₹3,00,000 from Syndicate Bank on 1st Jan 2011 for a period of 5 years at 6% interest per annum. As per agreement, the payment is given at the end of each month. Compute the cumulative interest payable at the end of each year and also the total interest of the entire loan period by using CUMIPMT Function.

Here,

- **Rate** = (6% per annum, hence monthly rate) = 0.005 (6%/12)
- **NPer** (length of the loan in months) = 60 (5 x 12)
- **PV** (present value of loan) = 3,00,000
- **S** is the first period. = 1 (For 1st Year)
- **E** is the last period. = 12 (For 1nd Year)
- **Type** (payment at the end of a period) = 0

**Process**:

The steps to calculate cumulative interest using CUMIPMT function is as follows:

Select the cell B8 and enter the formula =CUMIPMT(B2,B3,B4,B5,B6,B7) to calculate the cumulative interest of 1st year. Apply the same function in respective cells to find the remaining years cumulative interest.

**Output**

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Year</td>
<td>Year 1</td>
<td>Year 2</td>
<td>Year 3</td>
<td>Year 4</td>
<td>Year 5</td>
<td>For 5 Years</td>
</tr>
<tr>
<td>2</td>
<td>Rate</td>
<td>0.005</td>
<td>0.005</td>
<td>0.005</td>
<td>0.005</td>
<td>0.005</td>
<td>0.005</td>
</tr>
<tr>
<td>3</td>
<td>Nper</td>
<td>60</td>
<td>60</td>
<td>60</td>
<td>60</td>
<td>60</td>
<td>60</td>
</tr>
<tr>
<td>4</td>
<td>PV</td>
<td>300000</td>
<td>300000</td>
<td>300000</td>
<td>300000</td>
<td>300000</td>
<td>300000</td>
</tr>
<tr>
<td>5</td>
<td>S</td>
<td>1</td>
<td>13</td>
<td>25</td>
<td>37</td>
<td>49</td>
<td>1</td>
</tr>
<tr>
<td>6</td>
<td>E</td>
<td>12</td>
<td>24</td>
<td>36</td>
<td>48</td>
<td>60</td>
<td>60</td>
</tr>
<tr>
<td>7</td>
<td>Type</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>8</td>
<td>Interest payable</td>
<td>₹16,557.14</td>
<td>₹13,285.69</td>
<td>₹9,812.46</td>
<td>₹6,125.01</td>
<td>₹2,210.13</td>
<td>₹47,990.43</td>
</tr>
</tbody>
</table>

**Lab Work 9 (PMT Function)**

Mrs. Meera is planning to take a housing loan of ₹10,00,000 from Indian overseas bank. Annual interest rate is 7% and repayment period is 15 years. She wishes to know the amount required for payment of monthly instalment. Help her to calculate the monthly instalment using PMT function in LibreOffice Calc.

**Process**:

Steps for the calculation of monthly instalment are shown below:

The parameters are
Rate = 7% (the monthly rate is 7%/12)
Nper = 180 (15 x 12)
PV = 10,00,000  FV = 0

Enter the values Rate, Nper, PV, FV and Type into respective cells
Then select the cells to which the result is required and enter the syntax of PMT Function as shows below.

=PMT(7%/12, 180, 1000000, 0, 0) or =PMT(B2, B3, B4, B5)

should be entered in the cell B7, which will return monthly instalment of -₹8988.28

**Output**

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Annual Rate</td>
<td>7.00%</td>
</tr>
<tr>
<td>2</td>
<td>Rate (Annual rate /12)</td>
<td>0.006</td>
</tr>
<tr>
<td>3</td>
<td>Nper</td>
<td>180</td>
</tr>
<tr>
<td>4</td>
<td>PV</td>
<td>1000000</td>
</tr>
<tr>
<td>5</td>
<td>FV</td>
<td>0</td>
</tr>
<tr>
<td>6</td>
<td>Type</td>
<td>0</td>
</tr>
<tr>
<td>7</td>
<td>Monthly instalment</td>
<td>-₹8,988.28</td>
</tr>
</tbody>
</table>

(Negative figure is shown because it is payment.)

**Lab Work 10 (Data Series)**

Construct data series using appropriate Edit menu options in the following cases-
(a) 10 to 120 with increment of 10 in A1:A12, using the Linear series option
(b) Number series 2, 4, 8 ...........................from B1 to B12, using the Growth series option
(c) First day of every month in an year from C1 to C12, using the Date series option.

**Process:**

(a) **Making Linear data series**

Step-1: Enter the value 10 in cell A1.
Step-2: Select the range A1:A12.
Step-3: Click 'Edit' tab and choose 'Series' from 'Fill' option.
Step-4: In the 'Fill Series' window on display select Series Type as 'Linear'.
Step-5: Give the start value as 10, Increment as 10 and click 'OK'.

(b) **Making Growth data series**

Step-1: Enter the value 2 in cell B1.
Step-2: Select the range B1:B12.
Step-3: Click 'Edit' tab and choose 'Series' from 'Fill' option.
Step-4: In the 'Fill Series' window on display select Series Type as 'Growth'.
Step-5: Give the start value as 2, Increment as 2 and click 'OK'.

(c) Making Linear data series
Step-1: Enter the date 1/01/2017 in cell C1.
Step-2: Select the range C1:C12.
Step-3: Click 'Edit' tab and choose 'Series' from 'Fill' option.
Step-4: In the 'Fill Series' window on display select Series Type as 'Date'. Also select 'Month' in the 'Time Unit' section of the window.
Step-5: Give the start value as 1/01/2017, Increment as 1 and click 'OK'.

Output
The final output is shown below:

Lab Work 11 (Importing data to Calc)
Create a data file using Text Editor by entering the following 'Asset Details'. Also import the details by opening a worksheet in LibreOffice Calc.

<table>
<thead>
<tr>
<th>Asset Name</th>
<th>Purchase Date</th>
<th>Cost price</th>
<th>Brokerage</th>
<th>Transportation</th>
<th>Installation charges</th>
<th>Scrap value</th>
<th>Life (years)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Machinery</td>
<td>01/01/2013</td>
<td>1200000</td>
<td>15000</td>
<td>0</td>
<td>2500</td>
<td>20000</td>
<td>8</td>
</tr>
<tr>
<td>Plant</td>
<td>31/03/2013</td>
<td>2500000</td>
<td>20000</td>
<td>12000</td>
<td>40000</td>
<td>500000</td>
<td>12</td>
</tr>
<tr>
<td>Motor car</td>
<td>01/08/2013</td>
<td>140000</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>200000</td>
<td>7</td>
</tr>
<tr>
<td>Furniture</td>
<td>31/10/2013</td>
<td>85000</td>
<td>0</td>
<td>3000</td>
<td>0</td>
<td>5000</td>
<td>10</td>
</tr>
</tbody>
</table>

Process:
Step-1: Open a new Text Editor file From Accessories in Applications.
Step-2: In the first line give the titles of the columns such as Name of Asset, Date of Purchase, Purchase price, Brokerage, Transportation, Installation charges,
Scrap value and life in years, in the same sequence by separating each heading using comma.

**Step-3:** In the next four lines, enter the details of each asset, separated by comma in the same order of the column headings.

**Step-4:** Save the text file in 'Documents' or 'Desktop' by giving the name 'Asset_Details'.

**Step-5:** Open a new LibreOffice Calc worksheet.

**Step-6:** Click on 'Sheet from File' option from Insert menu. Select the text file named 'Asset_Details' with the help of dialogue box appeared and press 'Open' button.

**Step-7:** Click 'OK' in the Text Import -{Asset_Details} window. Also click 'OK' on the 'Insert Sheet' window appeared in the screen.

**Step-8:** The details of assets are then placed from A1:H5 in the worksheet. Then save the worksheet by giving the name 'Details of Students'.

**Output**

![Worksheet Image]

**Lab Work 12 (Data Validation)**

Construct a spreadsheet table showing the following details of 10 students participating in an inter-class debate competition.

(a) Serial Number  
(b) Name (assume the names of 10 students)  
(c) Sex  
(d) Batch (Science, Commerce, Humanities)

Use data validation option for filling the 'sex' from the list and 'Batch', from the cell range. Also set appropriate 'Input help' and 'Error alert' to be displayed at the time of data entry.

**Process:**

**Step-1:** Open a new LibreOffice Calc worksheet and give the title 'List of students for debate' in A1.

**Step-2:** Give the column headings as 'Sl. No.' in A2, 'Name' in B2, 'Sex' in C2, 'Batch' in D2.

**Step-3:** Enter the Serial Number 1 to 10 in A3:A12 using the fill handle.
Step-4: Enter the names of 10 students as per your choice (Both male and Female) from B3 to B12.

Step-5: To enter the sex of students, select the area C3:C12, Then go to 'Data' & choose 'Validity' option. In the appeared 'Validity' window, in 'Allow' field select 'List', and in 'Entries' field give the values 'Male', 'Female' and 'Transgender' one after another in separate line and click 'OK'. (You may set the 'Input Help' in the validity window, by giving title as 'Sex' and 'Input help' message as 'Give sex of students'. You may also set Error Alert in the validity window. The Action may be selected to 'Warning', give the Title as 'Sex' and the Error Message as 'wrong data' and click 'OK'.) Click on the arrow shown right to the validated cell for selecting the sex of each student.

Step-6: To enter batch of students, prepare a list of batches (Science, Commerce, Humanities) anywhere in the spreadsheets (for eg, in sheet 1, B13:B15), select the area D3:D12, go to 'Data' & choose 'Validity' option. In the appeared 'Validity' window, in 'Allow' field select 'Cell range', and in 'Source' field insert the specific sheet and range address in which required values are available. (Eg. $Sheet!$B$13:$B$15) (You may also set the 'Input Help' in the validity window, by giving title as 'Batch' and Input help message as 'Give group of study'. You may also set Error Alert in the validity window. The Action may be selected to 'Warning', give the Title as 'Batch' and the Error Message as 'wrong entry, Correct it' and click 'OK'.) Click on the arrow shown right to the validated cell for selecting the batch of each student.

Step-7: Save the workbook by giving appropriate name.

Output

<table>
<thead>
<tr>
<th>Sl. No.</th>
<th>Name</th>
<th>Sex</th>
<th>Batch</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Ashokan</td>
<td>Male</td>
<td>Commerce</td>
</tr>
<tr>
<td>2</td>
<td>Benny Thomas</td>
<td>Male</td>
<td>Humanities</td>
</tr>
<tr>
<td>3</td>
<td>Gineesh</td>
<td>Male</td>
<td>Science</td>
</tr>
<tr>
<td>4</td>
<td>Sundas</td>
<td>Female</td>
<td>Humanities</td>
</tr>
<tr>
<td>5</td>
<td>Sareesh</td>
<td>Male</td>
<td>Science</td>
</tr>
<tr>
<td>6</td>
<td>Bindsee</td>
<td>Female</td>
<td>Humanities</td>
</tr>
<tr>
<td>7</td>
<td>Roy Joseph</td>
<td>Male</td>
<td>Humanities</td>
</tr>
<tr>
<td>8</td>
<td>Shija Babu</td>
<td>Female</td>
<td>Humanities</td>
</tr>
<tr>
<td>9</td>
<td>Rajesh Babu</td>
<td>Male</td>
<td>Commerce</td>
</tr>
<tr>
<td>10</td>
<td>Ramees</td>
<td>Male</td>
<td>Science</td>
</tr>
</tbody>
</table>
Lab Work 13 (Conditional Formatting)

The stock of some medicines in a Medical Shop are listed below:

**STOCK OF MEDICINES – KRISHNA MEDICALS**

<table>
<thead>
<tr>
<th>SL. NO.</th>
<th>NAME OF MEDICINE</th>
<th>NAME OF COMPANY</th>
<th>QUANTITY</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Gluciphage Tab 250</td>
<td>Franco India</td>
<td>230</td>
</tr>
<tr>
<td>2</td>
<td>Gluciphage Tab 500</td>
<td>Franco India</td>
<td>45</td>
</tr>
<tr>
<td>3</td>
<td>Ecosprin Tab 75</td>
<td>USV</td>
<td>110</td>
</tr>
<tr>
<td>4</td>
<td>Ecosprin Tab 150</td>
<td>USV</td>
<td>240</td>
</tr>
<tr>
<td>5</td>
<td>Calpol Tab 500</td>
<td>Welcome</td>
<td>20</td>
</tr>
<tr>
<td>6</td>
<td>Calpol Tab 650</td>
<td>Welcome</td>
<td>40</td>
</tr>
<tr>
<td>7</td>
<td>Mox Cap 250</td>
<td>Rexel</td>
<td>160</td>
</tr>
<tr>
<td>8</td>
<td>Mox Cap 500</td>
<td>Rexel</td>
<td>25</td>
</tr>
<tr>
<td>9</td>
<td>Amlodac Tab 10</td>
<td>Cadila</td>
<td>320</td>
</tr>
<tr>
<td>10</td>
<td>Amlodac Tab 20</td>
<td>Cadila</td>
<td>46</td>
</tr>
<tr>
<td>11</td>
<td>Roscillin Cap 250</td>
<td>Ranbaxy</td>
<td>170</td>
</tr>
<tr>
<td>12</td>
<td>Roscillin Cap 500</td>
<td>Ranbaxy</td>
<td>165</td>
</tr>
<tr>
<td>13</td>
<td>Topcid Tab 20</td>
<td>Torrent</td>
<td>24</td>
</tr>
<tr>
<td>14</td>
<td>Topcid Tab 40</td>
<td>Torrent</td>
<td>48</td>
</tr>
</tbody>
</table>

This firm has the practice of placing new orders for medicines, when the stock quantity falls below 50 units. Identify the medicines which are in the re-order level and highlight them using red colour.

*(Hint: Use conditional formatting option available in LibreOffice Calc.)*

**Process:**

Step-1, Open a LibreOffice Calc worksheet and enter the given data in A1:D16

Step-2, Select the cells to which you want to apply a conditional style (i.e. D3:D16)

Step-3, Choose, **Format → Conditional Formatting → Condition**

Step-4, Enter the condition into the appeared windows. In the option 'Cell Value is' select 'Less than' and in 'Apply Style' select 'New style'.

Step-5, In the appeared window, 'Cell Style', click on the menu item 'Back ground' and select the background colour as red. Confirm both the screens by click 'OK'.

108
Output

The formatted table will be shown as follows:

<table>
<thead>
<tr>
<th>SL. NO.</th>
<th>NAME OF MEDICINE</th>
<th>NAME OF COMPANY</th>
<th>QUANTITY</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Gluciphage Tab 250</td>
<td>Franco India</td>
<td>230</td>
</tr>
<tr>
<td>4</td>
<td>Gluciphage Tab500</td>
<td>Franco India</td>
<td>45</td>
</tr>
<tr>
<td>5</td>
<td>Ecosprin Tab 75</td>
<td>USV</td>
<td>110</td>
</tr>
<tr>
<td>6</td>
<td>Ecosprin Tab 150</td>
<td>USV</td>
<td>240</td>
</tr>
<tr>
<td>7</td>
<td>Calpol Tab 500</td>
<td>Welcome</td>
<td>20</td>
</tr>
<tr>
<td>8</td>
<td>Calpol Tab 650</td>
<td>Welcome</td>
<td>40</td>
</tr>
<tr>
<td>9</td>
<td>Mox Cap 250</td>
<td>Rexel</td>
<td>160</td>
</tr>
<tr>
<td>10</td>
<td>Mox Cap 500</td>
<td>Rexel</td>
<td>25</td>
</tr>
<tr>
<td>11</td>
<td>Amlodac Tab 10</td>
<td>Cadila</td>
<td>320</td>
</tr>
<tr>
<td>12</td>
<td>Amlodac Tab 20</td>
<td>Cadila</td>
<td>46</td>
</tr>
<tr>
<td>13</td>
<td>Roscollin Cap 250</td>
<td>Ranbaxy</td>
<td>170</td>
</tr>
<tr>
<td>14</td>
<td>Roscollin Cap 500</td>
<td>Ranbaxy</td>
<td>165</td>
</tr>
<tr>
<td>15</td>
<td>Topcid Tab 20</td>
<td>Torrent</td>
<td>24</td>
</tr>
<tr>
<td>16</td>
<td>Topcid Tab 40</td>
<td>Torrent</td>
<td>48</td>
</tr>
</tbody>
</table>

Lab Work 14 (One-variable Data Table)

Mr. Sukumar, a Medical representative working in a pharmaceutical company, is drawing a fixed monthly salary of ₹10,000. He is also entitled to 12% commission on sales achieved during the month. He attained the sales volume of ₹20,000 during the previous month. Make a One Variable Table showing his salary if monthly sales varies from ₹10,000 to ₹50,000 in multiples of ₹5000.

Process:

Step-1: Enter the following details in a worksheet.

- Commission (in A1) - 12% (in B1)
- Monthly Sales (in A2) - 20000 (in B2)
- Salary Amount (in A3) = 10000 + B2 x B1

Step-2: In column 'C' enter given monthly sales from 10,000 to 50,000, in steps of 5000.

Step-3: Select the range C2:D10.

Step-4: Choose Data - Multiple operations. In the Formulas field give B3. In Column input cell give B2, because Monthly sales is the variable here.

Step-5: Close the dialogue box with OK.
Output

The One-variable data table appears as follows:-

![Data Table Image]

Lab Work 15 (Two-variable Data Table)

An insurance company introduced a new insurance policy to the public sector employees in the age group of 20 to 30 years. The premium should be paid up to the age of 50 years. On the date of retirement or death of the insured, the insurance company will pay double the amount of sum assured. The minimum sum assured is ₹ 50,000, policies can be taken in multiples of ₹ 10,000 and the maximum ceiling is ₹ 2,00,000. An employee with the age of 25 years taking a policy of ₹ 1,00,000 should pay yearly premium of ₹ 4,000. (The premium calculation formula being 'Sum assured /50 - Age of Employee'.)

Construct a two-variable table showing the yearly premium to be paid by employees of different age groups for varying policy amounts.

Process:

Step-1: Enter the following details in a worksheet.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Insured Sum</td>
<td>100000</td>
</tr>
<tr>
<td>2</td>
<td>Age of employee</td>
<td>25</td>
</tr>
<tr>
<td>3</td>
<td>Yearly Premium</td>
<td>=B1/(50-B2)</td>
</tr>
</tbody>
</table>

Step-2: In column 'C' enter sum assured from 50,000 to 2,00,000, in steps of 10,000.
Step-3: From D2:N2, enter the age of employees from 20 to 30.
Step-4: select the area C2:N18.
Step-5: Choose Data - Multiple operations. In the Formulae field give B3.In the Row input cell give B2. In Column input cell give B1, Here, both the sum assured and age of employees are variables.
Step-6: Close the dialogue box with OK, then the two-variable data table will be formed.
Step-7: Round off the amounts to '0' decimal places by number formatting.
Output

The Two-variable data table appears as follows:

<table>
<thead>
<tr>
<th>Sum insured</th>
<th>Age of employees</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>20</td>
</tr>
<tr>
<td>50000</td>
<td>1667</td>
</tr>
<tr>
<td>60000</td>
<td>2000</td>
</tr>
<tr>
<td>70000</td>
<td>2333</td>
</tr>
<tr>
<td>80000</td>
<td>2667</td>
</tr>
<tr>
<td>90000</td>
<td>3000</td>
</tr>
<tr>
<td>100000</td>
<td>3333</td>
</tr>
<tr>
<td>110000</td>
<td>3667</td>
</tr>
<tr>
<td>120000</td>
<td>4000</td>
</tr>
<tr>
<td>130000</td>
<td>4333</td>
</tr>
<tr>
<td>140000</td>
<td>4667</td>
</tr>
<tr>
<td>150000</td>
<td>5000</td>
</tr>
<tr>
<td>160000</td>
<td>5333</td>
</tr>
<tr>
<td>170000</td>
<td>5667</td>
</tr>
<tr>
<td>180000</td>
<td>6000</td>
</tr>
<tr>
<td>190000</td>
<td>6333</td>
</tr>
<tr>
<td>200000</td>
<td>6667</td>
</tr>
</tbody>
</table>

Lab Work 16 (Pivot Table)

You are given the sales details of a supermarket dealing with different types of consumer products. Make a Pivot table showing category wise sales amount.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Bill No</td>
<td>Name of product</td>
<td>Category</td>
</tr>
<tr>
<td>2</td>
<td>A1</td>
<td>Rose</td>
<td>Soap</td>
</tr>
<tr>
<td>3</td>
<td>A2</td>
<td>Lilly</td>
<td>Soap</td>
</tr>
<tr>
<td>4</td>
<td>A3</td>
<td>Shine teeth</td>
<td>Tooth paste</td>
</tr>
<tr>
<td>5</td>
<td>A4</td>
<td>Smile</td>
<td>Tooth paste</td>
</tr>
<tr>
<td>6</td>
<td>A5</td>
<td>Flowers</td>
<td>Soap</td>
</tr>
<tr>
<td>7</td>
<td>A6</td>
<td>Lotus</td>
<td>Soap</td>
</tr>
<tr>
<td>8</td>
<td>A7</td>
<td>Maasivila</td>
<td>Tooth paste</td>
</tr>
<tr>
<td>9</td>
<td>A8</td>
<td>Magic</td>
<td>Soap</td>
</tr>
<tr>
<td>10</td>
<td>A9</td>
<td>Beauty</td>
<td>Talcum powder</td>
</tr>
<tr>
<td>11</td>
<td>A10</td>
<td>Fresh</td>
<td>Tooth paste</td>
</tr>
</tbody>
</table>

Process:

Step-1: Enter the data into spread sheet and select the data range. (A1: D11)

Step -2: Data → Pivot Table → Create

Step:3: Drag and drop the field buttons into the white areas of Pivot Table Dialogue Box as given below:
Column Fields - Category  
Row Fields - Bill No. & Name of Product  
Data fields - Sales (Rs.)  

Step 4: Specify the range of cells in the current worksheet to set the destination of the pivot table.  
(Say, E1:J13) and confirm the pivot table layout window.

**Output**

The pivot table appears as follows:-

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Sum - Sales (₹)</td>
<td>Data</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Bill No</td>
<td>Name of product</td>
<td>Soap</td>
<td>Talcum powder</td>
<td>Tooth paste</td>
<td>Total Result</td>
</tr>
<tr>
<td>3</td>
<td>A1</td>
<td>Rose</td>
<td>1300</td>
<td></td>
<td></td>
<td>1300</td>
</tr>
<tr>
<td>4</td>
<td>A10</td>
<td>Fresh</td>
<td></td>
<td></td>
<td></td>
<td>3000</td>
</tr>
<tr>
<td>5</td>
<td>A2</td>
<td>Lilly</td>
<td>2500</td>
<td></td>
<td></td>
<td>2500</td>
</tr>
<tr>
<td>6</td>
<td>A3</td>
<td>Shine teeth</td>
<td></td>
<td>3500</td>
<td></td>
<td>3500</td>
</tr>
<tr>
<td>7</td>
<td>A4</td>
<td>Smile</td>
<td></td>
<td></td>
<td></td>
<td>4500</td>
</tr>
<tr>
<td>8</td>
<td>A5</td>
<td>Flowers</td>
<td>7500</td>
<td></td>
<td></td>
<td>7500</td>
</tr>
<tr>
<td>9</td>
<td>A6</td>
<td>Lotus</td>
<td>4000</td>
<td></td>
<td></td>
<td>4000</td>
</tr>
<tr>
<td>10</td>
<td>A7</td>
<td>Maavila</td>
<td></td>
<td>5500</td>
<td></td>
<td>5500</td>
</tr>
<tr>
<td>11</td>
<td>A8</td>
<td>Magic</td>
<td>3500</td>
<td></td>
<td></td>
<td>3500</td>
</tr>
<tr>
<td>12</td>
<td>A9</td>
<td>Beauty</td>
<td>2500</td>
<td></td>
<td></td>
<td>2500</td>
</tr>
<tr>
<td>13</td>
<td>Total Result</td>
<td></td>
<td>18000</td>
<td>2500</td>
<td>16500</td>
<td>37800</td>
</tr>
</tbody>
</table>
Key Concepts

3.1 Payroll accounting
3.2 Asset accounting
3.3 Loan repayment schedule

Introduction

We have already seen that spreadsheet has numerous possibilities in the business world due to its easy manipulation and analysis of data. It also provides built-in functions for various financial and statistical operations besides basic arithmetical functions. Spreadsheets are put to use by business firms and the corporate world for varied purposes ranging from accounting to presentation of data in the form of graphs and charts for decision making.

Both large and small scale business firms use spreadsheet for the preparation of payroll, asset accounting and loan repayment schedule. Let us discuss how the above areas will come handy for the students of commerce, who can apply these skills in business.

3.1 Payroll Accounting

- The payroll accounting involves all aspects of paying compensation and benefits to employees. Let’s examine the various components of pay with the help of the example given below.

Mr. Alen is employed as a clerk in Viswas Ltd. His Basic Pay is ₹ 23,000. His other allowances include:

Dearness Allowance - 15% of Basic Pay
House Rent Allowance - ₹ 1,500 per month

Deductions:
Life Insurance Premium - ₹ 1,000 per month
Provident Fund - 8% of Basic Pay
From the example given above, can you list out the various components of salary?

- Basic Pay
- Dearness Allowance
- HRA

Let us discuss the components of payroll in detail.

3.1.1. Payroll Components

**Earnings**

- **Basic Pay (BP)**: It is the pay in the pay scale. It is the fixed amount paid to the employees by their employers based on their work. It is the core of salary and many other components are computed based on this amount.

- **Grade Pay (GP)**: It is the pay to be added to the basic pay according to the category/designation of the employee.

- **Dearness Pay (DP)**: It is that portion of dearness allowance, which has been declared and deemed to have been merged with the basic pay.

- **Dearness Allowance (DA)**: It is a compensation to make up the purchasing power of employees due to price rise. It is granted by the Government periodically as a percentage of basic pay.

- **House Rent Allowance (HRA)**: It is an amount paid to facilitate an employee to enjoy the benefit of a residential accommodation.

- **Transport Allowance (TA)**: It is an amount paid to facilitate an employee to travel between his home and place of work.

- **Other earnings**: It may include any other earnings or allowances such as education allowance, medical allowance, washing allowance, hill tract allowance etc.

**Deductions**

- **Professional Tax (PT)**: It is the tax levied by the State on the income earned by way of profession, trade or employment. Normally it is collected by the Local Self Government Institutions under which the place of employment falls.

- ** Provident Fund (PF)**: It is a statutory deduction made as part of social security. It is decided by the Government under the Employees’ Provident Fund Act and is computed as a percentage of basic pay + DA.

- **Tax Deduction at Source (TDS)**: A statutory deduction made on a monthly basis towards income tax liability of an employee.

- **Recovery of Loan Instalment**: Amount of deduction on account of any loan taken by the employee such as PF loan, house loan etc. It may include interest as well as repayment of principal amount.

- **Other deductions**: It may include other deductions not included above such as recovery of advance against salary, deductions on account of festival advance, etc.
The above explanation will light up on the various components of payroll. Now we can proceed with the calculation of Gross Pay (Gross Salary) and Net Pay (Net Salary)

- **Gross Pay** = The total earnings of an employee before making any deductions.
  = Basic pay + Grade pay + DA + HRA + TA + Other Allowances.

- **Net Pay** = Amount payable to the employee after subtracting all deductions from Gross Pay
  = Gross Pay – Total deductions

Total deductions = PF + PT + TDS + Loans + other deductions

Now let us compute the Gross Pay and Net Pay of Mr. Alen, in the example given at the beginning of our discussion.

The Gross Pay of Mr. Alen will be 23000+3450(i.e. 23000 x 15%) + 1500 = ₹ 27,950

Total deductions = 1,000 +1,840 (23,000 x \(\frac{8}{100}\))
  = ₹ 2,840

The Net Pay of Mr. Alen will be 27,950 – 2,840
  = ₹ 25,110

Here, we have seen the Salary/Pay details of an employee. Thus, the Salary/Pay details of all employees of an organisation need to be prepared in the form of a statement. Such a statement is called Payroll and the process of preparing the payroll is called Payroll Accounting.

### 3.1.2 Template Design in Spread Sheet

Business firms normally use designed templates of spreadsheets for payroll accounting.

- What is a template and why is it designed?

It is a predefined spreadsheet having cells or columns with integrated formulae and customised formats that works according to the instructions provided. The input and output will be consistent because of pre-programming.

Templates are very useful for repetitive tasks where we can save a lot of time. It also helps to input data with better accuracy and sharing of consistent output.

### Preparation of Payroll Statement

Let us consider the following example.

Toms Ltd. intends to prepare payroll statement of its employees for August 2017. The table 3.1 shows the details of salary and deductions of each employee under various categories.
Table 3.1 Details of Salary

<table>
<thead>
<tr>
<th>Sl. No</th>
<th>Name</th>
<th>Post</th>
<th>Basic pay (BP)</th>
<th>HRA</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>IRSHAD</td>
<td>Manager</td>
<td>40000</td>
<td>3% of BP</td>
</tr>
<tr>
<td>2</td>
<td>BASIL</td>
<td>Technician</td>
<td>30000</td>
<td>2% of BP</td>
</tr>
<tr>
<td>3</td>
<td>ASWIN</td>
<td>Driver</td>
<td>25000</td>
<td>Nil</td>
</tr>
</tbody>
</table>

Dearness Allowance is 20% of basic pay

Deductions:

Provident Fund (PF) is 10% of Basic Pay

State Life Insurance (SLI) is ₹ 500 for all employees

Compute Gross Salary and Net Salary payable to the employees during August 2017 using spreadsheet.

Follow the given steps for the preparation of payroll statement.

1. Open a spreadsheet and enter headings in the cells A1 and A2 as shown in figure 3.1.

2. Give the column headings as Sl. No, Name, Post, BP, DA, HRA, Gross Salary, PF, SLI, Total deductions and Net from cells A9 to K9. Input the given data in the respective cells as shown in figure 3.1.

Fig 3.1 Payroll
3. Enter the following formulae in the respective cells as per the template given below.

<table>
<thead>
<tr>
<th>Column heading</th>
<th>Cells</th>
<th>Equation</th>
<th>Formulas (syntax) to be enter in the cells</th>
</tr>
</thead>
<tbody>
<tr>
<td>DA</td>
<td>E10</td>
<td>(=BP \times 20%)</td>
<td>(=D10\times E53)</td>
</tr>
<tr>
<td>HRA</td>
<td>F10</td>
<td>(\text{If (Post= &quot;Manager&quot;, BP+3%, IF(Post= &quot;Technician&quot;, BP+2%, 0))})</td>
<td>(\text{IF(C10=&quot;Manager&quot;, D10\times E54, IF(C10=&quot;Technician&quot;, D10\times E55, 0))})</td>
</tr>
<tr>
<td>Gross Salary</td>
<td>G10</td>
<td>(=BP+DA+HRA)</td>
<td>(=\text{SUM}(D10:F10))</td>
</tr>
<tr>
<td>PF</td>
<td>H10</td>
<td>(=BP\times 10%)</td>
<td>(=D10\times E56)</td>
</tr>
<tr>
<td>SLI</td>
<td>I10</td>
<td>(=500)</td>
<td>(=E57)</td>
</tr>
<tr>
<td>Total deduction</td>
<td>J10</td>
<td>(=PF+SLI)</td>
<td>(=H10+I10)</td>
</tr>
<tr>
<td>Net</td>
<td>K10</td>
<td>\text{Gross Salary}-Total Deduction}</td>
<td>(=G10-J10)</td>
</tr>
<tr>
<td>Total</td>
<td>K13</td>
<td>\text{sum(net)}</td>
<td>(=\text{SUM}(K10:K12))</td>
</tr>
</tbody>
</table>

4. Select the Range E10:K12 and press Ctrl + D or select E10:K10, and drag and fill the cells E11:K12. Then findout the total values in the 13th row and save the file. See the Payroll statement given in figure 3.2.

Output

![Fig 3.2 Payroll Statement](image)

Let us see another example.

PQR Ltd., a computer distribution company wants to prepare Payroll Statement for the month of November 2017. Various components of salary for different category of employees are given in table 3.2.
<table>
<thead>
<tr>
<th>Sl No</th>
<th>Name</th>
<th>Post</th>
<th>Basic pay (BP)</th>
<th>Grade pay</th>
<th>HRA</th>
<th>TRA</th>
<th>TDS</th>
<th>Loan recovery</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Archana</td>
<td>Manager</td>
<td>30000</td>
<td>1000</td>
<td>3% of BP</td>
<td>150 pm</td>
<td>1000</td>
<td>3000</td>
</tr>
<tr>
<td>2</td>
<td>Naseem</td>
<td>Accountant</td>
<td>20000</td>
<td>500</td>
<td>2% of BP</td>
<td>Nil</td>
<td>300</td>
<td>1000</td>
</tr>
<tr>
<td>3</td>
<td>Jubna</td>
<td>Supervisor</td>
<td>16000</td>
<td>Nil</td>
<td>Nil</td>
<td>Nil</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

Table 3.2 Various components of Salary

DA is 80% of Basic Pay

Deductions:
- Professional Tax (PT): 1% of gross salary for all employees
- Provident Fund (PF): 10% of basic pay for all employees

Compute Gross Salary and Net Salary payable to employees for the month of November 2017 using spreadsheet.

Follow the given procedure to prepare the Payroll Statement of the company.

1. Open a new spreadsheet and enter table headings in the cells A1 and A2.
2. Enter the column heading and input data directly in the respective cells as shown in figure 3.3.

Fig 3.3 Payroll

3. Enter the following formulae in the respective cells as per the template given below.

<table>
<thead>
<tr>
<th>Column heading</th>
<th>Cells</th>
<th>Equation</th>
<th>Formulas (syntax) to be enter in the cells</th>
</tr>
</thead>
<tbody>
<tr>
<td>DA</td>
<td>F12</td>
<td>=BP * 80%</td>
<td>=D12*$F$4</td>
</tr>
<tr>
<td>HRA</td>
<td>G12</td>
<td>If (Post= &quot;Manager&quot;,BP*3%,IF(Post= &quot;Accountant&quot;,BP *2%,0))</td>
<td>=IF(C12=&quot;Manager&quot;,D12*$F$5 ,IF(C12=&quot;Accountant&quot;,D12*$F$6,0))</td>
</tr>
<tr>
<td>TRA</td>
<td>H12</td>
<td>If (Post= &quot;Manager&quot;,150.0)</td>
<td>=IF(C12=&quot;Manager&quot;,$F$7,0)</td>
</tr>
<tr>
<td>TE(Total Earning)</td>
<td>I12</td>
<td>=BPE+Grade pay+DA+HRA+TRA</td>
<td>=SUM(D12:H12)</td>
</tr>
<tr>
<td>PT</td>
<td>J12</td>
<td>=TE*1%</td>
<td>=I12*$F$8</td>
</tr>
<tr>
<td>PF</td>
<td>K12</td>
<td>=BP*10%</td>
<td>=D12*$F$9</td>
</tr>
<tr>
<td>TD total deduction</td>
<td>N12</td>
<td>=PT+PF+TDS+LOAN</td>
<td>=SUM(J12:M12)</td>
</tr>
<tr>
<td>NS</td>
<td>O12</td>
<td>=TE-TD</td>
<td>=I12-N12</td>
</tr>
<tr>
<td>Sum of Net salary for the month</td>
<td>O15</td>
<td>=SUM(net salary of all employees)</td>
<td>=SUM(O12:O14)</td>
</tr>
</tbody>
</table>
4. Select the cells F12, G12, H12, I12, J12 and K12 together and drag and fill up to 14th row for relative cell reference. Then select the cells N12 and O12 together and drag and fill up to 14th row (drag the formulae in unfilled area only of the given table). Ascertain the total values in the 15th row and save the file. The output of payroll will look like as seen in figure 3.4.

Output

![Payroll Statement](image)

**Fig 3.4 Payroll Statement**

---

**Let’s assess**

1. **Gross Pay (Total Earnings) includes ….**
   a. BP b. DP c. DA d. All of these

2. **DA is 14% of Basic pay. The amount of Basic pay is entered in cell D2. Write the formula to be entered in cell D3 to calculate DA.**

3. **Gross salary and Total Deductions are shown in D8 and G8 respectively. Write the formula to calculate Net Salary in cell H8.**

4. **Shaft is working as a Manager in Sudo Services Ltd. His basic pay is ₹ 25000/- DA is @ 20% of basic pay and HRA is ₹ 1000/-. He is on Leave Without Allowance for 3 days during the month of August 2017. Calculate his BPE for the month of August 2017.**
Try yourself

VISHAL Ltd. has 10 employees. The salary details of the employees are entered in a spreadsheet (figure 3.5). You are required to fill in the missing columns of this payroll statement.

![Payroll Statement](image)

Fig 3.5 Payroll Statement

While giving a formula for the above illustration, keep in mind the following:

- TE = BPE + All Allowances (DA, HRA, TRA, etc.)
- NS = TE - Deductions (PF, TDS, Loan, etc.)

### 3.2 Accounting of Assets

Accounting of assets covers the complete life cycle of an asset. Hence records relating to assets are to be maintained right from the acquisition of asset till its disposal. It involves computation of depreciation, maintenance of asset register and preparation of fixed asset schedule for reporting in the Balance Sheet.

We are familiar with the calculation of depreciation in manual accounting. When there are different classes of assets to which rates of depreciation are varying [as per Companies Act/Income Tax Act], you can imagine how complex the calculation is.

The inbuilt functions of LibreOffice Calc makes the asset accounting process more easier.

Among the different methods of calculating depreciation, Straight Line Method and Written Down Value Method are two popularly used methods. Let us discuss about these methods.

#### 3.2.1. Straight line method (Fixed Installment Method)

Here, depreciation is calculated based on the original cost of the asset using the formula;
Depreciation = \frac{\text{Acquisition cost} - \text{Scrap Value}}{\text{Estimated working Life}}

\textbf{Acquisition cost (Cost to use)} = \text{Purchase cost} + \text{Installation expenses} + \text{other expenses till the date of installation.}

\textbf{Scrap Value} – It is the value which is realisable at the end of its useful life.

\textbf{Estimated working life} – The period for which the asset can be effectively put to use.

\textbf{SLN} function is used for finding out the amount of annual depreciation under straight line method.

\textbf{Syntax} : = \text{SLN(Cost, Salvage, Life)}

Where,

\text{Cost} = \text{Acquisition cost}
\text{Salvage} = \text{Scrap value}
\text{Life} = \text{Total life period of an asset}

Consider the following example,

The cost of machinery is ₹ 10,000 and installation charges ₹ 1000/-. The salvage value after 5 years is ₹ 2,000/-. See how depreciation is calculated using SLN function in LibreOffice Calc.

Total cost of the asset = \text{Procurement cost} + \text{installation charges}
= 10000 + 1000 = ₹ 11,000/-

The amount of depreciation can be calculated easily by using SLN function in LibreOffice Calc in cell B2 as =\text{SLN(10000,2000,5)}. The above function returns the annual depreciation amount as ₹ 1,800 (See figure 3.6).
Let us consider another example.

Roopam Ltd. purchased various assets on 01/04/2016. Calculate the amount of depreciation and Written Down Value of assets at the end of the year, under Straight Line Method of charging depreciation (Table 3.3).

<table>
<thead>
<tr>
<th>Sl. No</th>
<th>Asset name</th>
<th>Asset ID</th>
<th>Purchase cost</th>
<th>Installation expense</th>
<th>Pre-operation expense</th>
<th>Salvage value</th>
<th>Life in years</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Machinery</td>
<td>101</td>
<td>600000</td>
<td>20000</td>
<td>10000</td>
<td>70000</td>
<td>10</td>
</tr>
<tr>
<td>2</td>
<td>Furniture</td>
<td>102</td>
<td>100000</td>
<td>0</td>
<td>0</td>
<td>10000</td>
<td>15</td>
</tr>
<tr>
<td>3</td>
<td>Fixtures</td>
<td>103</td>
<td>50000</td>
<td>30000</td>
<td>10000</td>
<td>5000</td>
<td>20</td>
</tr>
<tr>
<td>4</td>
<td>Vehicles</td>
<td>104</td>
<td>200000</td>
<td>0</td>
<td>0</td>
<td>20000</td>
<td>10</td>
</tr>
</tbody>
</table>

The following steps are required for finding the result as shown in figure 3.7.
1. Enter table heading in the cells A1 and A2 in a worksheet
2. Input the necessary data in the respective cells as given in the figure 3.7

3. Enter the following formulas in the respective cells as per template given below.

<table>
<thead>
<tr>
<th>Column heading</th>
<th>Cell Address</th>
<th>Equation used</th>
<th>Formula in cell</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost to use</td>
<td>G4</td>
<td>Purchase cost + Installation expense + Pre-operation expense</td>
<td>=D4+E4+F4</td>
</tr>
<tr>
<td>Amount of depreciation</td>
<td>J4</td>
<td>SLN(Cost, Salvage, Life)</td>
<td>=SLN(G4,H4,I4)</td>
</tr>
<tr>
<td>Closing balance of assets</td>
<td>K4</td>
<td>Cost to use - Amount of depreciation</td>
<td>=G4 - J4</td>
</tr>
<tr>
<td>Total depreciation during 2016-17 (for all assets)</td>
<td>J8</td>
<td>SUM(Amount of depreciation)</td>
<td>=SUM(J4:J7)</td>
</tr>
<tr>
<td>Net Block (Total closing balance of all asset)</td>
<td>K8</td>
<td>SUM(Closing balance of asset)</td>
<td>=SUM(K4:K7)</td>
</tr>
</tbody>
</table>

4. Use fill handle to copy the formula to other cells or Drag the cell G4 up to G7 and J4 : K4 up to J7 : K7.
5. The formula when applied in J8 will give us total depreciation. Similarly values of net block can be derived in K8 when the above formula is given and save the file (Figure 3.8).

Output

![Spreadsheet Screenshot]

Fig - 3.8 - Asset Accounting

**Try yourself**

1. ABC Ltd. purchased a machine on 01-01-2017 for ₹ 2,00,000 and spends ₹ 10,000 for its installation. The machinery was installed on 10-01-2017. The expected salvage value is ₹ 8,000 at the end of its useful life of 10 years. Calculate annual depreciation under Straight Line Method (SLM) using spreadsheet.

2. Given below are the details of various assets of a firm. Calculate depreciation under Straight Line Method using spreadsheet.

<table>
<thead>
<tr>
<th>Asset</th>
<th>Cost of Purchase</th>
<th>Installation charges</th>
<th>Transportation charges</th>
<th>Pre-operating expense</th>
<th>Salvage value</th>
<th>Life in years</th>
</tr>
</thead>
<tbody>
<tr>
<td>Machinery</td>
<td>20000</td>
<td>2000</td>
<td>4600</td>
<td>1200</td>
<td>2000</td>
<td>10</td>
</tr>
<tr>
<td>Furniture</td>
<td>40000</td>
<td>3500</td>
<td>1500</td>
<td>500</td>
<td>3000</td>
<td>8</td>
</tr>
</tbody>
</table>

**3.2.2. Written Down Value (WDV) Method**

It is also called Reducing Balance Method or Declining Balance (DB) Method or Diminishing Balance Method. This method uses current book value as the base for computing the depreciation for the next period. Under this method depreciation is calculated on opening balance of asset each year. DB function is used for calculating depreciation under this method.

Syntax: =DB(Cost, Salvage, Life, Period, month)
Where,

Cost = Acquisition cost  
Salvage = Scrap value  
Life = Life (in years) of the asset.  
Period = Period (year) for which depreciation is calculated.  
Month = number of months in the first year. (It is required only if the asset is put to use during part of an year in the first year of its commissioning.)

Consider the following example:

A machinery is purchased on 1st August 2014 for ₹ 40,000 and installation charges is ₹ 2,000. The salvage value after 5 years will be ₹ 3,000. Ascertain the amount of depreciation of third year using DB function in Calc., assuming that the books are closed on 31st March every year.

Cost - ₹ 42,000 (₹ 40,000 + ₹ 2,000)  
Salvage - ₹ 3,000  
Life - 5  
Period - 3  
Months - 8 (from 1/8/2014 to 31/3/2015)  
Enter the formula in cell B2 = DB(42000, 3000, 5, 3, 8).

On applying this function, the cell will return the amount of depreciation as ₹ 7,382.79 (Figure 3.9)

Let us see one more example:

The table 3.4 shows the details of fixed assets purchased by Gayathri Ltd. Calculate the amount of depreciation and the Written down value of assets at the end of the year 2016-17 (i.e. after 2 years of purchase).
Table 3.4 Details of fixed assets

<table>
<thead>
<tr>
<th>Sl. No</th>
<th>Asset name</th>
<th>Purchase date</th>
<th>Purchase cost</th>
<th>Installation expense</th>
<th>Pre-operation expense</th>
<th>Salvage value</th>
<th>Life in years</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Machinery</td>
<td>1/5/2015</td>
<td>600000</td>
<td>20000</td>
<td>10000</td>
<td>70000</td>
<td>10</td>
</tr>
<tr>
<td>2</td>
<td>Furniture</td>
<td>1/6/2015</td>
<td>100000</td>
<td>0</td>
<td>0</td>
<td>10000</td>
<td>15</td>
</tr>
<tr>
<td>3</td>
<td>Fixtures</td>
<td>1/4/2015</td>
<td>50000</td>
<td>30000</td>
<td>10000</td>
<td>5000</td>
<td>20</td>
</tr>
<tr>
<td>4</td>
<td>Vehicles</td>
<td>1/7/2015</td>
<td>200000</td>
<td>0</td>
<td>0</td>
<td>20000</td>
<td>10</td>
</tr>
</tbody>
</table>

The following steps are required for preparing the statement showing depreciation.

1. Enter table heading in the cells A1 and A2 by merging the cells of a worksheet.

2. Enter the column headings and input the given data as shown in figure 3.10.

Fig 3.10 Asset Accounting

(Note: column “I” and “K” can be calculated by using IF & AND function but here it is directly entered in to the respective columns.)

* The Value of column ‘J’ indicate the period of depreciation to be computed, say 1 year, 2 year, etc.

* Column ‘K’ indicates the number of months the asset was actually held in that year.

3. Enter the following formulae in the respective cells as per the template given below:

<table>
<thead>
<tr>
<th>Column heading</th>
<th>Cell Address</th>
<th>Equation used</th>
<th>Formula in cell</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost to use</td>
<td>G4</td>
<td>Purchase cost + Installation expense + Pre-operation expense</td>
<td>=D4+E4+F4</td>
</tr>
<tr>
<td>Amount of depreciation</td>
<td>L4</td>
<td>DB(Cost, Salvage, Life, Period, month)</td>
<td>=DB(G4,H4,I4,J4,K4)</td>
</tr>
<tr>
<td>Closing balance of assets</td>
<td>M4</td>
<td>Cost to use - Amount of depreciation</td>
<td>=G4 - L4</td>
</tr>
<tr>
<td>Total depreciation during 2016-17 (for all assets)</td>
<td>L8</td>
<td>SUM(Amount of depreciation)</td>
<td>=SUM(L4:L7)</td>
</tr>
<tr>
<td>Net Block (Total closing balance of all asset)</td>
<td>M8</td>
<td>SUM(Closing balance of asset)</td>
<td>=SUM(M4:M7)</td>
</tr>
</tbody>
</table>
4. For copying the formula to other cells use fill handle or drag the cell from G4 to G7. Select L4 : M4 and drag to L7:M7. Ascertain the total depreciation and total value of all assets in the respective columns as per the formula given above and save the file. (See figure 3.11)

![Output](image)

**Fig 3.11 Asset accounting**

### 3.2.3. Schedule forming part of the Balance Sheet

As part of balance sheet we have to prepare a schedule showing gross block, accumulated depreciation and net block.

The following was extracted from the books of Ragam Ltd. The rate of depreciation is 10% per annum. Prepare a schedule showing gross block, accumulated depreciation and net block as on 31st March 2017.

<table>
<thead>
<tr>
<th>SL No.</th>
<th>Asset name</th>
<th>as on 1-04-2016</th>
<th>Additions on Sept 30th</th>
<th>Deductions on Sept 30th</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Machinery</td>
<td>100000</td>
<td>20000</td>
<td>5000</td>
</tr>
<tr>
<td>2</td>
<td>Furniture</td>
<td>50000</td>
<td>5000</td>
<td>2000</td>
</tr>
<tr>
<td>3</td>
<td>Fixtures</td>
<td>20000</td>
<td>6000</td>
<td>3000</td>
</tr>
<tr>
<td>4</td>
<td>Building</td>
<td>200000</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>5</td>
<td>Vehicles</td>
<td>40000</td>
<td>3000</td>
<td>1000</td>
</tr>
</tbody>
</table>

The following steps are required to prepare the schedule:

1. Enter table heading in the cells A1 and A2.
2. Label the column headings and input the data as shown in the figure 3.12.
3. Enter the following formulae in the respective cells as per table given below:

<table>
<thead>
<tr>
<th>Column heading</th>
<th>Cells</th>
<th>Required Equation</th>
<th>Formulas in cells</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gross Block As on 31/03/17</td>
<td>F5</td>
<td>Block assets as on 1-04-2016+ Additions on Sept 30th – Deductions</td>
<td>=C5+D5-E5</td>
</tr>
<tr>
<td>Depreciation as on 1-04-2016</td>
<td>G5</td>
<td>Gross Block As on 1-04-2016 date*10%</td>
<td>=C5 * 0.1</td>
</tr>
<tr>
<td>Depreciation of Additions on Sept 30th</td>
<td>H5</td>
<td>Additions on Sept 30th * 10% * 6/12</td>
<td>=D5 * .1 * 6/12</td>
</tr>
<tr>
<td>Depreciation on Deductions as on Sept 30th</td>
<td>I5</td>
<td>Deduction as Sept 30th * 10% * 6/12</td>
<td>=E5*0.1 *6/12</td>
</tr>
<tr>
<td>Total depreciation as on 31/03/17</td>
<td>J5</td>
<td>Depreciation as on 1-04-2016 + Depreciation for Additions on Sept 30th – Depreciation for Deductions on Sept 30th</td>
<td>=G5+H5-I5</td>
</tr>
<tr>
<td>Net Block As on 31/03/17</td>
<td>K5</td>
<td>Gross Block As on 31/03/2017 - Depreciation as on 31/03/2017</td>
<td>=F5 - J5</td>
</tr>
</tbody>
</table>

4. Select the cells F5 to K9, click fill down from edit tab or use <CTRL> + D button. Use SUM function to arrive at the totals in cells C10 to K10 and save the file. (See figure 3.13)

**Output**

![Fig 3.13 Schedule of Assets](image-url)
Acquisition cost (Cost to use) = Purchase cost + Installation expenses + pre-operation expenses.

SLN function used for calculating depreciation under the Straight Line Method.

Syntax of SLN: \( \text{SLN} \) (Cost, Salvage, Life)

DB function used for calculating depreciation under the Diminishing Balance Method

Syntax of DB: \( \text{DB} \) (Cost, Salvage, Life, Period, Month)

Net Block = Gross block - Accumulated depreciation

---

**Try yourself**

1. A machinery was purchased on 1st April 2013 for ₹ 2,00,000. Its estimated life is 10 years with a salvage value of ₹ 20,000. Accounting year is 1st April to 31st March every year. Calculate depreciation under the Diminishing Balance method for 5 years in spreadsheet.

2. The following are the details of plant and machinery. Ascertain depreciation under the Written Down Value method using spreadsheet.

<table>
<thead>
<tr>
<th>Name of Asset</th>
<th>PLANT &amp; MACHINERY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date of Purchase</td>
<td>10/07/2012</td>
</tr>
<tr>
<td>Date of installation</td>
<td>20/07/2012</td>
</tr>
<tr>
<td>Cost</td>
<td>₹ 4,00,000</td>
</tr>
<tr>
<td>Installation Cost</td>
<td>₹ 50,000</td>
</tr>
<tr>
<td>Pre-operating cost</td>
<td>₹ 20,000</td>
</tr>
<tr>
<td>Salvage Value</td>
<td>₹ 10,000</td>
</tr>
<tr>
<td>Expected Life of Asset</td>
<td>10 years</td>
</tr>
<tr>
<td>Closure of Accounts</td>
<td>31/03/2013</td>
</tr>
<tr>
<td>Period</td>
<td>1st year</td>
</tr>
</tbody>
</table>

---

**3.3. Loan Repayment Schedule**

In order to tide over the financial constraints, individuals, may depend on loans from banks or other financial institutions. Similar situation may arise in business also. Loan is a sum of money borrowed for a specific period. This liability will carry interest at a prescribed rate. These loans are to be repaid either in lump sum or in instalments along with interest over the loan repayment period.

- How can we compute the total liability including interest on a loan?
- How can we fix the Equated Monthly Instalments (EMI)?
EQUATED MONTHLY INSTALMENT (EMI) CALCULATION

Equated monthly instalment is a fixed amount payable by a borrower to a lender at a specified date of each calendar month. The EMI of a loan is determined by factors like, principal amount (actual sum of money borrowed), rate of interest, loan tenure and method of computation.

Let us see the procedure for preparing an EMI calculation statement showing interest, installment amount, period of loan, etc.

PMT function available in Calc can be used for calculating periodic instalments.

Let us go through an example.

Punjab National Bank has given loans to their customers for diverse needs. Loan amount, date of loan and rate of interest is given in the following table. Compute monthly installment amount on each loan given by the bank.

<table>
<thead>
<tr>
<th>Name of customer</th>
<th>Date of loan</th>
<th>Loan amount</th>
<th>Rate of interest</th>
</tr>
</thead>
<tbody>
<tr>
<td>SARATH</td>
<td>1/4/2013</td>
<td>₹500000</td>
<td>11%</td>
</tr>
<tr>
<td>NANDAN</td>
<td>1/1/2012</td>
<td>₹800000</td>
<td>12%</td>
</tr>
<tr>
<td>SRIDYA</td>
<td>1/7/2011</td>
<td>₹400000</td>
<td>09%</td>
</tr>
<tr>
<td>NIMNA</td>
<td>1/5/2014</td>
<td>₹300000</td>
<td>13%</td>
</tr>
<tr>
<td>ROBIN</td>
<td>1/9/2013</td>
<td>₹100000</td>
<td>12%</td>
</tr>
</tbody>
</table>

The following steps will lead you to the preparation of a loan repayment schedule.

1. Assign suitable headings in cells A1 and A2 and merge and center cells A1 to H1 and A2 to H2.
2. Enter the column labels and input the data in the respective cells as shown in figure 3.14.

Fig 3.14 Loan Repayment Schedule - EMI Calculation
3. Enter the following formulae in the respective cells as per the table given below:

<table>
<thead>
<tr>
<th>Column heading</th>
<th>Cells</th>
<th>Equation</th>
<th>Formulas in cells</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yearly installment</td>
<td>G5</td>
<td>=PMT(rate,Nper,PV,FV,Type)</td>
<td>=PMT(E4:D4,C4:F4,0)</td>
</tr>
<tr>
<td>Monthly installment</td>
<td>H5</td>
<td>=PMT(rate/12,Nper*12,PV,FV,Type)</td>
<td>=PMT(E4/12,D4*12,C4:F4,0)</td>
</tr>
</tbody>
</table>

4. Select cells G4 : H4 and drag and fill the cells G5:H8 and save the file. (See figure 3.15)

Output

![Loan Repayment Schedule](image)

Fig - 3.15 - Loan Repayment Schedule

Try yourself

Mr. Lalu took a loan of ₹ 2,00,000 from a Indian bank, at an interest of 10% per annum. The loan is repayable over a period of 10 years in equated monthly installments. Prepare a loan repayment schedule by showing outstanding balances for the first year.

Preparation of Loan Repayment Schedule

The Loan Repayment Schedule is a complete table of periodic loan repayments, showing the amount of principal and interest components in each instalment until the loan is fully paid off. This schedule also shows the outstanding balance of loan amount after the payment of each instalment. It is also called Loan Amortization Schedule. The payment will be made in Equated Monthly Instalments (EMI), the interest component forms the major portion in initial periods and the principal component forms major portion in later periods. The totals of interest, principal and amount paid are also depicted in this schedule.

For splitting the instalment into the interest and principal, we may use IPMT and PPMT functions respectively. The principal amount in the periodic instalment is deducted from the opening balance for arriving at the closing balance. The opening balance of each month will be the closing balance of the previous month.
**Points to Remember**

Functions used for the preparation of Loan Repayment Schedule.

- **PMT** function used for calculating equated monthly instalment
  
  \[ \text{PMT}(\text{Rate}, \text{Nper}, \text{PV}, \text{FV}, \text{Type}) \]

- **PPMT** function used for calculating Principal portion in the instalment
  
  \[ \text{PPMT}(\text{Rate}, \text{Period}, \text{Nper}, \text{PV}, \text{FV}, \text{Type}) \]

- **IPMT** function used for calculating Interest portion in the instalment
  
  \[ \text{IPMT}(\text{Rate}, \text{Period}, \text{Nper}, \text{PV}, \text{FV}, \text{Type}) \]

Consider the following example:

Vanastree Agencies took an advance of ₹60,000 for 6 months from Indian Bank @ 14% interest for that period. Prepare a Loan Repayment Schedule.

Steps for the preparation of Loan repayment schedule is given below:

1. Enter the headings in cells A1 and A7 as shown in figure 3.16.
2. Enter the details in respective cells as shown in figure 3.16.

![Fig 3.16 Loan Repayment Schedule](image)

3. Enter the formulae in respective cells as shown below:

<table>
<thead>
<tr>
<th>A9:A14</th>
<th>=SUM(D9:D14)</th>
<th>B9</th>
<th>=B2</th>
</tr>
</thead>
<tbody>
<tr>
<td>C9</td>
<td>=PPMT($B$3/$B$5,$A$9,$B$4,$B$2,0,0)</td>
<td>D9</td>
<td>=IPMT($B$3/$B$5,$A$9,$B$4,$B$2,0,0)</td>
</tr>
<tr>
<td>E9</td>
<td>=PMT($B$3/$B$5,$B$4,$B$2)</td>
<td>F9</td>
<td>=B9+C9</td>
</tr>
<tr>
<td>B10</td>
<td>=F9</td>
<td>C15</td>
<td>=SUM(C9:C14)</td>
</tr>
<tr>
<td>D15</td>
<td></td>
<td>E15</td>
<td>=SUM(E9:E14)</td>
</tr>
</tbody>
</table>
4. Select B10 and drag up to B 14
5. Select cells C9:F9 and drag up to the cells C14:F14 and save the file. The output will be as shown in the figure 3.17.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Vanasree Agencies</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Loan amount</td>
<td>60000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Rate</td>
<td>14.00%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Period in months</td>
<td>6</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>No of instalments</td>
<td>6</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Loan Repayment Schedule</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Month</td>
<td>Opening Balance</td>
<td>Principal</td>
<td>Interest</td>
<td>Instalment</td>
</tr>
<tr>
<td>8</td>
<td>9</td>
<td>1</td>
<td>60000</td>
<td>-₹9,432.36</td>
<td>-₹1,400.00</td>
</tr>
<tr>
<td>9</td>
<td>2</td>
<td>50,567.64</td>
<td>-₹9,652.45</td>
<td>-₹1,179.91</td>
<td>-₹10,832.36</td>
</tr>
<tr>
<td>10</td>
<td>3</td>
<td>40,915.19</td>
<td>-₹9,877.67</td>
<td>-₹954.69</td>
<td>-₹10,832.36</td>
</tr>
<tr>
<td>11</td>
<td>4</td>
<td>31,037.52</td>
<td>-₹10,108.15</td>
<td>-₹724.21</td>
<td>-₹10,832.36</td>
</tr>
<tr>
<td>12</td>
<td>5</td>
<td>20,929.37</td>
<td>-₹10,344.01</td>
<td>-₹488.35</td>
<td>-₹10,832.36</td>
</tr>
<tr>
<td>13</td>
<td>6</td>
<td>10,585.37</td>
<td>-₹10,585.37</td>
<td>-₹246.99</td>
<td>-₹10,832.36</td>
</tr>
<tr>
<td>14</td>
<td>Total</td>
<td>₹60,000.00</td>
<td>-₹60,000.00</td>
<td>-₹4,994.15</td>
<td>-₹64,994.15</td>
</tr>
</tbody>
</table>

Fig 3.17 Loan Repayment Schedule

Output

Try yourself

DC industries took a 6 months advance of ₹ 30,000/- @ 15% for the period and repayable in 6 equal instalments. Prepare the Loan Repayment Schedule.
Summary

- Payroll is a statement or schedule showing various components and various deductions of salary of all employees in a business organization. DA, HRA, TA, etc., are earnings and PF, Loan, GIS etc., are deductions. Net pay can be calculated by subtracting total deductions from Gross earnings.
- Depreciation accounting is used to estimate the amount of depreciation charged to an asset and closing balance of asset. The two important methods for calculating depreciation are Straight Line Method and Diminishing Balance Method. The financial function used for this purpose is SLN and DB respectively.
- Loan Repayment schedule is the schedule showing interest, total liability, instalment, etc. This schedule is prepared with the help of PMT function.

I can

- describe the concept of payroll accounting and apply the knowledge in the development of spreadsheet application for computing employee's gross pay and net pay.
- narrate the concept of Computerised Asset Accounting and apply the knowledge in the development of Spread sheet application for computing depreciation under Straight Line Method and Written Down Value method.
- describe the concept of calculating interest and repayment of loan and apply the knowledge in the development of Loan Repayment Schedule using spreadsheet.

TE QUESTIONS

1. Which financial function is used for preparing a loan repayment schedule?
2. State the financial function used for calculating Straight Line method of depreciation?
3. Write the equation used for finding gross salary and net salary, if Basic pay, DA, HRA, PF and SLI are given as salary components and deductions.
4. Write the syntax for following functions
   SLN, DB, PMT
5. Describe various components of salary and deductions in relation to payroll accounting.
1. Salary details of Vertex Ltd, a bag manufacturing company is given below. Prepare payroll statement for the month of Aug 2017. Also ascertain total net salary payable for this month.

<table>
<thead>
<tr>
<th>Sl No</th>
<th>Name</th>
<th>Post</th>
<th>Basic pay (BP)</th>
<th>Grade pay</th>
<th>HRA</th>
<th>TA</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Kareeb</td>
<td>CEO</td>
<td>50000</td>
<td>2000</td>
<td>3% of BP</td>
<td>200 PM</td>
</tr>
<tr>
<td>2</td>
<td>Bhama</td>
<td>Manager</td>
<td>40000</td>
<td>1500</td>
<td>2% of BP</td>
<td>100 PM</td>
</tr>
<tr>
<td>3</td>
<td>Jinu</td>
<td>Foreman</td>
<td>22000</td>
<td>Nil</td>
<td>1% of BP</td>
<td>Nil</td>
</tr>
<tr>
<td>4</td>
<td>Panchani</td>
<td>Manager</td>
<td>38000</td>
<td>2000</td>
<td>2% of BP</td>
<td>100 PM</td>
</tr>
<tr>
<td>5</td>
<td>Harshad</td>
<td>Foreman</td>
<td>20000</td>
<td>1000</td>
<td>1% of BP</td>
<td>Nil</td>
</tr>
<tr>
<td>6</td>
<td>Shahsin</td>
<td>Foreman</td>
<td>15000</td>
<td>Nil</td>
<td>1% of BP</td>
<td>Nil</td>
</tr>
</tbody>
</table>

DA is 20% of basic pay.
Deduction from salary are :-
- Professional tax (PT)- 1% of gross salary for all employees.
- Provident Fund (PF) -10% of basic pay for all employees.

2. Viswas Ltd. purchased various assets. Calculate the amount of depreciation at the end of the year 2016-17 as per the details below under Straight Line Method and Diminishing Balance Method.

<table>
<thead>
<tr>
<th>Sl No</th>
<th>Asset Name</th>
<th>Purchase date</th>
<th>Purchase cost</th>
<th>Installation expense</th>
<th>Pre-operation expense</th>
<th>Salvage value</th>
<th>Life in years</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Machinery</td>
<td>1/1/2015</td>
<td>800000</td>
<td>30000</td>
<td>50000</td>
<td>100000</td>
<td>12</td>
</tr>
<tr>
<td>2</td>
<td>Furniture</td>
<td>1/1/2015</td>
<td>500000</td>
<td>0</td>
<td>0</td>
<td>20000</td>
<td>14</td>
</tr>
<tr>
<td>3</td>
<td>Fixtures</td>
<td>1/1/2015</td>
<td>100000</td>
<td>10000</td>
<td>20000</td>
<td>10000</td>
<td>8</td>
</tr>
<tr>
<td>4</td>
<td>Vehicles</td>
<td>1/1/2015</td>
<td>300000</td>
<td>0</td>
<td>0</td>
<td>40000</td>
<td>15</td>
</tr>
<tr>
<td>5</td>
<td>Loose tools</td>
<td>1/1/2015</td>
<td>20000</td>
<td>0</td>
<td>0</td>
<td>10000</td>
<td>5</td>
</tr>
</tbody>
</table>

3. The following details are taken from the books of SBT, Kalpetta regarding an outstanding loan. Compute monthly installment on each loan given by the bank.

<table>
<thead>
<tr>
<th>Name of customer</th>
<th>Date of loan</th>
<th>Loan amount</th>
<th>Period of loan</th>
<th>Rate of interest</th>
</tr>
</thead>
<tbody>
<tr>
<td>Harsha Vardhan</td>
<td>1/1/2011</td>
<td>700000</td>
<td>5</td>
<td>0.09</td>
</tr>
<tr>
<td>Shairy</td>
<td>1/1/2013</td>
<td>50000</td>
<td>3</td>
<td>0.11</td>
</tr>
<tr>
<td>Abin L</td>
<td>1/9/2010</td>
<td>350000</td>
<td>6</td>
<td>0.14</td>
</tr>
<tr>
<td>Ajeesh Billy</td>
<td>1/12/2009</td>
<td>520000</td>
<td>7</td>
<td>0.13</td>
</tr>
<tr>
<td>Clenz Geoge</td>
<td>1/11/2012</td>
<td>250000</td>
<td>4</td>
<td>0.15</td>
</tr>
</tbody>
</table>
APPENDIX

Lab work - 1 (Payroll Accounting)

Wale Ltd. wants to prepare payroll of its employees for the month of November 2017. The details of salary and deductions of each employee under various categories are given in the table.

<table>
<thead>
<tr>
<th>Sl. No.</th>
<th>Name</th>
<th>Post</th>
<th>Basic pay (BP)</th>
<th>Grade pay</th>
<th>HRA</th>
<th>TA</th>
<th>No. of days not worked</th>
<th>Deduction -TDS</th>
<th>Deduction -Loan recovery</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Remesh</td>
<td>Manager</td>
<td>30000</td>
<td>1000</td>
<td>3% of BP</td>
<td>150 pm</td>
<td>2</td>
<td>1000</td>
<td>3000</td>
</tr>
<tr>
<td>2</td>
<td>Joseph</td>
<td>Accountant</td>
<td>20000</td>
<td>500</td>
<td>2% of BP</td>
<td>Nil</td>
<td>3</td>
<td>300</td>
<td>1000</td>
</tr>
<tr>
<td>3</td>
<td>Hisham</td>
<td>Supervisor</td>
<td>16000</td>
<td>Nil</td>
<td>Nil</td>
<td>Nil</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

DA is 80% of basic pay earned (BPE)

Other deduction from salary is given below:

Professional tax (PT) - 1% of gross salary for all employees.

Provident Fund (PF) - 10% of basic pay earned (BPE) for all employees.

Compute gross salary and net salary payable by Wale Ltd. for each employee in for the month of November 2017 using spreadsheet.

Procedure:

Follow the steps given below.

2. Provide column headings and input the given data directly in the respective cells (see figure 3.18)

Fig 3.18 Payroll
3. Enter the following formulae in the respective cells as per template given below.

<table>
<thead>
<tr>
<th>Column heading</th>
<th>Cells</th>
<th>Required Equation</th>
<th>Formulas (syntax) to be enter in the cells</th>
</tr>
</thead>
<tbody>
<tr>
<td>NOEDP (No of Effective days present)</td>
<td>F12</td>
<td>NODM- Deduction days (NODM means Number Of Days in the Month)</td>
<td>=S$3-D12</td>
</tr>
<tr>
<td>BP Earned (BPE)</td>
<td>G12</td>
<td>BP*NOEDP/NODM</td>
<td>=E12*F12/$F$3</td>
</tr>
<tr>
<td>DA</td>
<td>I12</td>
<td>BPE * 80%</td>
<td>=G12*$F$4</td>
</tr>
<tr>
<td>HRA</td>
<td>J12</td>
<td>IF (Post= “Manager”, BPE*3%, IF(Post= “Accountant”, BPE * 2%, 0))</td>
<td>=IF(C12=&quot;Manager&quot;,G12*$F$5,IF(C12=&quot;Accountant&quot;,G12*$F$6,0))</td>
</tr>
<tr>
<td>TA</td>
<td>K12</td>
<td>IF (Post= &quot;Manager&quot;, 150.0)</td>
<td>=IF(C12=&quot;Manager&quot;,F$7,0)</td>
</tr>
<tr>
<td>Gross Salary</td>
<td>L12</td>
<td>BPE+Grade pay+DA+HRA+TA</td>
<td>=SUM(G12:K12)</td>
</tr>
<tr>
<td>PT</td>
<td>M12</td>
<td>Gross Salary *1%</td>
<td>=L12*$F$8</td>
</tr>
<tr>
<td>PF</td>
<td>N12</td>
<td>BPE*10%</td>
<td>=G12*$F$9</td>
</tr>
<tr>
<td>Total deductions</td>
<td>Q12</td>
<td>PT+PF+TDS+LOAN</td>
<td>=SUM(M12:P12)</td>
</tr>
<tr>
<td>Net Salary</td>
<td>R12</td>
<td>Gross Salary - Total Deductions</td>
<td>=Round(L12-Q12,0)</td>
</tr>
<tr>
<td>Sum of Net salary for the month</td>
<td>R15</td>
<td>Sum net salary of all employees</td>
<td>=SUM(R12:R14)</td>
</tr>
</tbody>
</table>

4. Select and drag the cells F12,G12,I12,J12,K12,L12,M12,N12,Q12 and R12. Up to 14th row (drag the formulae in Unfilled area only of the given table). Then find out the total values in the 15th row and save the file. The output is shown in figure 3.19.

![Fig 3.19 Payroll Statement](image)

**Lab work 2 (Depreciation - SLN Function)**

Calculate depreciation of the assets given below for the financial year 2016-17 under Straight Line Method.

<table>
<thead>
<tr>
<th>Sl No</th>
<th>Asset name</th>
<th>Purchase cost</th>
<th>Installation expenses</th>
<th>Salvage value</th>
<th>Life in years</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Mounting Machine</td>
<td>12,00,000</td>
<td>20,000</td>
<td>30,000</td>
<td>10</td>
</tr>
<tr>
<td>2</td>
<td>Assembling Machine</td>
<td>7,50,000</td>
<td>5,000</td>
<td>15,000</td>
<td>7</td>
</tr>
</tbody>
</table>
Procedure

Follow the steps mentioned below.

1. Enter column heading and insert values directly in the respective cells as given in figure 3.20.

Fig 3.20 Depreciation Statement

2. Following formulae are to be entered in the respective cells as per template given below. Calculate total cost and amount of depreciation.

<table>
<thead>
<tr>
<th>Column heading</th>
<th>Cells</th>
<th>Equation</th>
<th>Formulas to be entered in the cells</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total cost</td>
<td>E2</td>
<td>Purchase cost + Installation Expenses</td>
<td>= C2+D2</td>
</tr>
<tr>
<td>Depreciation</td>
<td>H2</td>
<td>SLN(Cost,Salvage,Life)</td>
<td>=SLN(E2,F2,G2)</td>
</tr>
</tbody>
</table>

3. Copy cell E2 to E3 and Cell H2 to H3. The output will be as shown in figure 3.21.

Output

Fig 3.21 Depreciation Statement
**Lab work 3 (Depreciation - DB function)**

Calculate depreciation for the following assets for the financial year ending 31st March 2018 under Diminishing Balance Method using spreadsheet.

<table>
<thead>
<tr>
<th>SL No</th>
<th>Asset Name</th>
<th>Purchase date</th>
<th>Installation Date</th>
<th>Purchase cost</th>
<th>Pre-operating expenses</th>
<th>Installation Expenses</th>
<th>Salvage value</th>
<th>Life in years</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Machinery</td>
<td>19-01-2014</td>
<td>21-01-2014</td>
<td>8,00,000</td>
<td>30,000</td>
<td>20,000</td>
<td>25,000</td>
<td>10</td>
</tr>
<tr>
<td>2</td>
<td>Plant</td>
<td>06-05-2015</td>
<td>15-05-2015</td>
<td>5,00,000</td>
<td>20,000</td>
<td>5,000</td>
<td>15,000</td>
<td>6</td>
</tr>
</tbody>
</table>

**Procedure**

Follow the given steps for calculating depreciation under WDV Method

1. Open a spreadsheet and enter table heading in the cells A1 and A2.
2. Enter the column heading from A3 to L3 and input values directly in the respective cells. (See figure 3.22)

![Figure 3.22 Depreciation Statement](image)

3. Enter the following formulae in the respective cells as per table given below.

<table>
<thead>
<tr>
<th>Column heading</th>
<th>Cells</th>
<th>Equation</th>
<th>Formulae to be entered in the cells</th>
</tr>
</thead>
<tbody>
<tr>
<td>Financial year ending date</td>
<td>E2</td>
<td>31/03/2018</td>
<td>=E2</td>
</tr>
<tr>
<td>Cost to use</td>
<td>F4</td>
<td>Purchase cost + Installation Expenses + Pre-operating Expenses</td>
<td>=C4+D4+E4</td>
</tr>
<tr>
<td>Period</td>
<td>J4</td>
<td>Closing financial year – Installation Year</td>
<td>=YEAR(SE$2)-YEAR(I4)</td>
</tr>
<tr>
<td>Months in 1st Year</td>
<td>K4</td>
<td>Total months used in first year</td>
<td>=IF(MONTH(I4)&gt;=3,12-MONTH(I4)+4,4-MONTH(I4))</td>
</tr>
<tr>
<td>Depreciation</td>
<td>L4</td>
<td>= DB(Cost, Salvage, Life, Period, Month)</td>
<td>=DB(F4,G4,H4,J4,K4)</td>
</tr>
</tbody>
</table>
4. Copy the cell F4 to F5 and cells J4:J4 to J5:J5 (drag the formulae in unfilled area only of the given table) and save the file. The output will be as shown in figure 3.23.

**Output**

![Figure 3.23 Depreciation statement](image)

**Lab work 4 (Loan Repayment Schedule)**

Krishna Associates Ltd. took the following loans for the acquisition of different assets. Prepare a loan repayment schedule for the company.

<table>
<thead>
<tr>
<th>Loan amount (₹)</th>
<th>Date of Loan</th>
<th>Period of Loan</th>
<th>Rate of Interest</th>
</tr>
</thead>
<tbody>
<tr>
<td>₹ 2,00,000</td>
<td>12/8/2015</td>
<td>3</td>
<td>12%</td>
</tr>
<tr>
<td>₹ 12,00,000</td>
<td>01/10/2016</td>
<td>5</td>
<td>10%</td>
</tr>
<tr>
<td>₹ 8,00,000</td>
<td>01/01/2017</td>
<td>8</td>
<td>14%</td>
</tr>
<tr>
<td>₹ 5,00,000</td>
<td>19/01/2017</td>
<td>2</td>
<td>15%</td>
</tr>
</tbody>
</table>

**Procedure**

The steps given are to be followed:

1. Open a spreadsheet and enter headings in cells A1 and A2.
2. Give column heading and enter values directly in the respective cells. (See figure 3.24)

![Figure 3.24 Loan Repayment Schedule](image)
3. Enter the following formulae in the respective cells as per the given table.

<table>
<thead>
<tr>
<th>Column heading</th>
<th>Cells</th>
<th>Equation</th>
<th>Formulae to be entered in the cells</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yearly Installment</td>
<td>F4</td>
<td>= PMT(Rate, Nper, PV, FV,</td>
<td>=PMT(D4,C4,-A4,E4,1)</td>
</tr>
<tr>
<td>Amount</td>
<td></td>
<td>Type)</td>
<td></td>
</tr>
<tr>
<td>Monthly Installment</td>
<td>G4</td>
<td>= Yearly Installment</td>
<td>=F4/12</td>
</tr>
<tr>
<td>Amount/12</td>
<td></td>
<td>Amount/12</td>
<td></td>
</tr>
</tbody>
</table>

4. Drag the cells F4 : G4 to F7 : G7 (drag the formulae only in the Unfilled area of the given table). Now loan repayment schedule will be displayed in figure 3.25.

**Output**

![Loan Repayment Schedule](image)

Fig 3.25 Loan Repayment Schedule

**Lab work 5**

Vinayaka Saree Designers took a loan amounting to ₹ 1,00,000/- from SBI for a period of 1 year with an interest @ 12% p.a. and repaid in 12 equal monthly instalments. Prepare Loan Repayment Schedule.

1. Enter the details in a Spreadsheet as shown in figure 3.26.
Fig 3.26 Loan Repayment Schedule

2. Enter the formula in respective cells as per template given below.

<table>
<thead>
<tr>
<th>Cell Address</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>A9:A20</td>
<td>1 to 12</td>
</tr>
<tr>
<td>B9</td>
<td>=B2</td>
</tr>
<tr>
<td>C9</td>
<td>=PPMT($B$3/$B$5,A9,$B$4*$B$5,$B$2,0,0)</td>
</tr>
<tr>
<td>D9</td>
<td>=IPMT($B$3/$B$5,A9,$B$4*$B$5,$B$2,0,0)</td>
</tr>
<tr>
<td>E9</td>
<td>=PMT($B$3/$B$5,$B$4*$B$5,$B$2)</td>
</tr>
<tr>
<td>F9</td>
<td>=B9+C9</td>
</tr>
<tr>
<td>B10</td>
<td>=F9</td>
</tr>
<tr>
<td>C21</td>
<td>=SUM(C9:C20)</td>
</tr>
<tr>
<td>D21</td>
<td>=SUM(D9:D20)</td>
</tr>
<tr>
<td>E21</td>
<td>=SUM(E9:E20)</td>
</tr>
</tbody>
</table>


Save the file. The output will be as shown in figure 3.27.
Output

Vinayaka Saree Designers

<table>
<thead>
<tr>
<th>Month</th>
<th>Opening Balance</th>
<th>Principal</th>
<th>Interest</th>
<th>Total Amount</th>
<th>Closing Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>100000</td>
<td>-7,884.88</td>
<td>-1,000.00</td>
<td>-8,884.88</td>
<td>92,115.12</td>
</tr>
<tr>
<td>2</td>
<td>92,115.12</td>
<td>-7,963.73</td>
<td>-921.15</td>
<td>-8,884.88</td>
<td>84,151.39</td>
</tr>
<tr>
<td>3</td>
<td>84,151.39</td>
<td>-8,043.39</td>
<td>-841.51</td>
<td>-8,884.88</td>
<td>76,269.88</td>
</tr>
<tr>
<td>4</td>
<td>76,269.88</td>
<td>-8,123.80</td>
<td>-761.80</td>
<td>-8,884.88</td>
<td>68,388.08</td>
</tr>
<tr>
<td>5</td>
<td>68,388.08</td>
<td>-8,205.04</td>
<td>-679.84</td>
<td>-8,884.88</td>
<td>60,502.24</td>
</tr>
<tr>
<td>6</td>
<td>60,502.24</td>
<td>-8,287.09</td>
<td>-597.76</td>
<td>-8,884.88</td>
<td>52,614.48</td>
</tr>
<tr>
<td>7</td>
<td>52,614.48</td>
<td>-8,369.96</td>
<td>-514.92</td>
<td>-8,884.88</td>
<td>44,729.56</td>
</tr>
<tr>
<td>8</td>
<td>44,729.56</td>
<td>-8,432.15</td>
<td>-431.22</td>
<td>-8,863.37</td>
<td>36,836.19</td>
</tr>
<tr>
<td>9</td>
<td>36,836.19</td>
<td>-8,506.49</td>
<td>-348.64</td>
<td>-8,855.13</td>
<td>28,930.76</td>
</tr>
<tr>
<td>10</td>
<td>28,930.76</td>
<td>-8,580.98</td>
<td>-266.32</td>
<td>-8,847.30</td>
<td>21,023.46</td>
</tr>
<tr>
<td>11</td>
<td>21,023.46</td>
<td>-8,656.59</td>
<td>-182.97</td>
<td>-8,839.56</td>
<td>13,116.89</td>
</tr>
<tr>
<td>12</td>
<td>13,116.89</td>
<td>-8,734.91</td>
<td>-97.98</td>
<td>-8,831.89</td>
<td>0.00</td>
</tr>
</tbody>
</table>

Total

Fig 3.27 Loan Repayment Schedule
**4.1 Graphs and Charts**

The term graphs and charts are often used synonymously. Let us try to bring some clarity on this. Graphs are mainly used to represent variation in values over a period of time, e.g., movement of stock market index say, NIFTY from the year 2000 to...
2017. Here time (year) is represented on X axis and value (NIFTY) is represented in Y axis. Charts are used to give information about the frequency of different quantities in a single pictorial representation, for instance, budget allocation to different heads. See figure 4.1. The figure given in the left represents graph and that given in the right is chart.

![Figure 4.1: Graphs and Charts](image)

**Types of Graphs and Charts**

LibreOffice Calc provides various types of charts to display data in different ways as per the need of the users. We can create a new chart or change the existing chart from the wide range of chart types. The chart types are illustrated with the help of given example.

The sales figure of different products of an electronic goods manufacturing firm for a particular month is given below:

- Laptop - 12,000
- Desktop - 10,000
- Tablets - 14,000
- Mobile phones - 4,000

- **Column Chart**

  Column charts are used to compare several items in a specific range of values. Column charts are ideal if you need to compare a single category of data (sales) among individual sub-items (products). Data is represented through bar diagrams with vertical bars. The height of each bar is proportional to its value. The X-axis shows categories of products and the Y-axis shows the value for each category, i.e., in column chart, categories are displayed horizontally and values are displayed vertically, as can be seen in figure 4.2.

![Figure 4.2: Column Chart](image)

- **Bar Chart**

  Bar charts are ideal for visualising the distribution or proportion of data items when there are different categories. Bar charts with horizontal bars are the most suitable form to visualise these data. The length of each bar is proportional to its value. The Y-axis shows
categories of products. The X-axis shows the value for each category (figure 4.3). Both the Bar and the Column charts display data using rectangular bars where the length of the bar is proportional to the data value. Both are used to compare two or more values. However, their difference lies in their orientation. A Bar Chart is oriented horizontally whereas the Column chart is oriented vertically.

- **Line Chart / Graph**
  It is used to display trends over a period of time which can be used as a vertical analysis tool. The values of each data series can be connected by a line as shown in figure 4.4. It is also called a ‘run chart’.

- **Pie Chart**
  Pie charts are generally used to show percentage or proportional data when one element of data is having more significance (compositional importance) than the other and usually the percentage represented by each category is provided next to the corresponding slice of pie. It contains only one data series. A pie chart shows values as circular sectors of the total circle. The length of the arc or the area of each sector is proportional to its value. The pie chart has the following chart sub types:

  a) **Normal Pie Chart**: This sub type of pie chart shows sectors as coloured areas of the total pie for one data column only (Figure 4.5).
b) **Exploded Pie Chart** : It is a kind of pie chart in which one or several slices are separated from the other. It is useful because it makes the highlighted portion more visible (Figure 4.6).

![Exploded Pie Chart](image)

**Fig 4.6 Exploded pie Chart**

c) **Donut Chart** : A Donut or Doughnut chart is a pie chart, with two exceptions: It has a hole in the middle and it can display more than one series of data. Doughnut charts display data in rings, where each ring represents a data series. The first data series is displayed in the centre of the chart (Figure 4.7).

![Donut Chart](image)

**Fig 4.7 Donut Chart**

d) **Exploded Donut Chart** : It is a Donut chart with all slices exploded. It shows the outer sectors already separated from the remaining Donut (Figure 4.8)

![Exploded Donut Chart](image)

**Fig 4.8 Exploded Donut Chart**
• **Area Chart**

Area chart shows values as points on the Y axis. The X axis shows categories. The values of each data series are connected by a line. The area bounded by the lines is filled with a colour. The area chart's focus is to emphasise the changes from one category to the next. Area Charts are like Line Charts except that the area below the plot line is solid (Figure 4.9).

• **XY (Scatter) Chart**

XY charts are also known as Scatter charts. The point of difference between XY charts and other types of charts is that in XY charts both axis display values. Such type of charts is generally used to show the relationship among two variables. It is commonly used for scientific, statistical, and engineering data. A typical XY chart is presented in figure 4.10.

• **Radar Chart**

A Radar chart is a two dimensional chart showing three or more variables in the form of a cobweb. It is also known as net chart, web chart, spider chart, star chart, polar chart etc. It has a separate axis for each variable, and the axes extend outward from the centre of the chart. The value of each data point is plotted on the corresponding axis as shown in figure 4.11.
Utility of different types of charts

<table>
<thead>
<tr>
<th>Area Chart</th>
<th>An area chart is generally used to highlight the proportion of individual items over total items.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column Chart</td>
<td>A column chart is used to emphasise comparison of data items within a specified time period.</td>
</tr>
<tr>
<td>Line Chart</td>
<td>A line chart is a type of graph that displays data trends at regular intervals</td>
</tr>
<tr>
<td>Scatter Chart</td>
<td>It depicts the relationship among numerical values across different data series.</td>
</tr>
<tr>
<td>Pie Chart</td>
<td>The main purpose of the pie chart is to show part-whole relationships.</td>
</tr>
<tr>
<td>Bar Chart</td>
<td>A bar chart is used to demonstrate comparison among individual items.</td>
</tr>
<tr>
<td>Net Chart</td>
<td>A net chart is used for comparing the actual with standards and to analyse the degree of variances.</td>
</tr>
</tbody>
</table>

Let’s assess

Select the chart type that best suits for the data given below:

<table>
<thead>
<tr>
<th>Nature of Data</th>
<th>Chart/Diagram that best suits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales performance of Product ‘A’ against Product ‘B’ in 5 regions</td>
<td>?</td>
</tr>
<tr>
<td>Individual product sales as a percentage of whole revenue.</td>
<td>?</td>
</tr>
<tr>
<td>Total sales of the company over a period of 15 years</td>
<td>?</td>
</tr>
<tr>
<td>Relation between advertisement and sales</td>
<td>?</td>
</tr>
</tbody>
</table>

4.2. Steps to Create Graph / Chart

As we discussed earlier, data when visually presented enables clear understanding and is more appealing. Creating charts/graphs is not a cumbersome task in LibreOffice Calc. Navigating through the steps given, you can easily master this skill.

1. Open LibreOffice Calc
   Applications → Office → LibreOffice Calc.

2. Data entry
   Input the necessary data into spreadsheet manually or we can import the data from other sources.

3. Data selection
   Select the cells which contain the data where chart is to be prepared. Here we can
select the entire data or a part of the data as per our requirement by using ‘Ctrl key’ and ‘the mouse’.

4. **Plotting the chart**

To plot the chart in a spreadsheet, click on Insert menu, select the Chart option from the menu, choose a chart type from the chart wizard. Select ‘finish’ button. (Figure 4.12)

**Insert → Chart → Chart Wizard → Chart Type → Finish**

![Chart Wizard - Chart Type](image1)

**Procedure for plotting charts**

To plot a chart in LibreOffice Calc you have to follow the sequence on the left pane of the Chart Wizard window.

a) **Chart Types:** Here the user can select the desired chart type from ‘Choose a Chart Type’ list (Figure 4.12).

b) **Data Range:** This option is useful for selecting and changing the data ranges and axes labels (Figure 4.13).

![Chart Wizard - Data Range](image2)
c) **Data Series**: By using this option, we can add new data series to an existing chart or remove existing data series in edit mode, if required. For example, the sale of different products for the month of February is a new data series. (Figure 4.14).

![Chart Wizard - Data Series](image)

**Fig 4.14 Chart Wizard - Data Series**

d) **Chart Elements**: The title of chart, legend and grid settings are available on this page (Figure 4.15). After entering the above details, press 'Finish' button, and resulting output is shown in figure 4.16.

![Chart Wizard - Chart Elements](image)

**Fig 4.15 Chart Wizard - Chart Elements**
4.3. **Elements of A Chart/Graph**

There are different elements in a chart/graph that give more clarity to the data. These parts that make up a chart are referred as chart elements. Figure 4.17 shows different elements of a chart.

1. **The chart area**: The entire area of a chart, including all elements is called the chart area. In other words, the chart area is bounded by the outer border.

2. **The plot area**: In a 2-D chart, the area is bounded by the X and Y axes. In a 3-D chart, the area is bounded by the three (X, Y and Z) axes. It is also called chart wall. This area can have its own border as well as a background colour.

3. **Chart floor**: The chart floor is the lower area on which the data points are placed. It can be seen only in 3D charts.

4. **Chart main title**: This is the explanatory heading at the top of the chart.

5. **Chart subtitle**: This title identifies the purpose of a chart.

6. **X axis**: Horizontal axis in a chart is called X axis. It is also called Category axis.

7. **Y axis**: This is the vertical axis of a chart. It is also called Value axis.

8. **Z axis**: In case of 3D chart Z axis will also be there, which represent the depth.

9. **Axis Titles**: This mention the name or title for X, Y and Z axes. See ‘9A’ and ‘9B’ marked in figure 4.17.
10. **Data points**: The individual values plotted in a chart and represented by bars, columns, lines, pies or various other shapes are called Data point or Data marker. It is a symbol on the chart that represents one value of data series.

11. **Data series**: Data markers of the same colour or pattern are called data series. The data series are related data points that are plotted in the chart/graph. It is a collection of data points or markers and normally corresponds to the data within a single row or column.

12. **Legend**: It is an identifier of a piece of information shown in the chart/graph. Generally, these legends are attached to a symbol or colour or pattern that is associated with data series of the chart. It is used to distinguish one data series from the another.

13. **Data Label**: The value of the data series plotted in a chart is known as data label. This provides additional information about a data marker to identify the details of data point in a data series - either values as a number or percentage.

14. **Grid lines**: These are the vertical and horizontal lines that appear in a chart. They are displayed in the chart wall. It increases the readability of a chart.

### 4.4. Formatting Charts

Why formatting is significant in charts and graphs?

Charts and graphs not only provide a visual delight but also it exemplifies the trends and patterns that the viewers can pick up. Here our intention is to enhance the appearance of a chart which is already created.

The format menu is used for making changes in the chart. Double-click the chart so that it is enclosed by a gray border indicating edit mode; then, select the chart element that we want to format. Choose Format from the menu bar, or right-click to display a context menu relevant to the selected element (Figure 4.18).
The following changes can be made in a chart with the help of Format menu:

1. **Format Selection**: It opens a dialog box in which we can specify the area fill, borders, transparency, characters, font effects, and other attributes of the selected element of the chart. This option will be enabled only when we select the chart wall.

2. **Position and Size**: It opens a dialog box by which we can rearrange the position and size of the graph. This option will be activated only when the chart wall is selected.

3. **Title**: This option is active only when there is a title on the chart and it helps to format the title of the chart and its axes.

4. **Legend**: This option allows us to format the location, borders, background, and type of the legend.

5. **Axis**: It allows us to format the lines that create the chart as well as the font of the text that appears on both the X and Y axis.

6. **Grid**: Here we can make changes in the lines that create a grid for the chart.

7. **Chart Type**: This facility enables us to change the type of chart to two dimensional or three dimensional.

8. **Data Ranges**: This option helps us to change the data range of a chart according to the need of the user.

9. **3D View**: This option is active only on 3D charts. Here necessary changes to the perspective, appearance and illumination of the chart can be done using the option.

### 4.5 Moving Chart Elements

If we want to move or resize individual chart element, follow the steps given below:

1) Double-click the chart.
2) Click on any of the elements - e.g., the title, the legend, etc.
3) Click and drag the element to be moved to the desired location.

**Changing the Chart Type**

The chart type can be changed using 'Format' menu as and when the situation demands. Suppose if we want to change a bar chart to a column chart, this can be done with the following steps.

1. Select the chart by double-click.
2. Then do any of the following alternatives
   - Format - Chart Type from the menu bar.
   - Click the Chart Type icon on the Formatting toolbar.
   - Right-click on the chart and choose Chart Type.
3. Select the new chart type and click OK.

Let us see an example

Prepare a column chart showing the sales report from the following details of M/s Arya Agencies by using spreadsheet.

<table>
<thead>
<tr>
<th>Year</th>
<th>2012</th>
<th>2013</th>
<th>2014</th>
<th>2015</th>
<th>2016</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales in (₹)</td>
<td>25000</td>
<td>37000</td>
<td>40000</td>
<td>35000</td>
<td>30000</td>
</tr>
</tbody>
</table>

In order to create a column chart, the steps mentioned under are to be followed:

1. Open spreadsheet.
2. Enter the details given in appropriate cells.
3. Select the cells containing the data.
4. Select the option Chart from Insert menu.
5. Choose the Chart Type from chart wizard and click 'Next'.
6. In Data Range option enable the radio button Data series in rows; check the boxes for **First row as label** and **First column as label**.
7. Go to Chart Elements option in Chart Wizard, give appropriate title for chart (Arya Agencies), sub title (Sales Report), X axis (Year) and Y axis (Sales in Rupees) Labels and click Finish button.
8. Save the spreadsheet by clicking on the 'Save' icon or press Ctrl+S keys and the resulting output is shown in figure 4.19.
### 4.6. 2D-3D Charts/Graphs

- Have you experienced watching a 3D movie with 3D glasses on?
- How was it different from 2D film that you regularly watch in theatres?

The term 2D and 3D are used to indicate dimensions. 2D stands for Two-Dimensional, whereas 3D stands for Three-Dimensional. 2D represents an object in just two dimensions in X and Y axes as shown in figure 4.20 while 3D represents it in three dimensions in X, Y and Z axes as shown in figure 4.21.
4.7. Advantages of Charts and Graphs

You have come across various components of graphs/charts in the previous sections. The concepts you have learnt so far help you to list the advantages of graphs/charts like:

- The message conveyed visually can be easily grasped by the audience
- A great deal of details that can be easily incorporated within a short span of time

To conclude, charts and graphs help to draw quicker and easier conclusions and to identify the relationships of variables among one another rather than paging through raw data. The following are its advantages:

It helps to:

- create visual appeal
- read the data easy
- analyse and interact the data quickly
- know the trends easily
- grasp the data quickly
- present huge volumes of data easily and within limited space

Summary

- Graph is a pictorial representation of data. Graphs are usually two-dimensional. Sometimes three-dimensional graphs are also used.
- Commonly used charts are Column chart, Bar chart, Pie chart, Line chart, Area chart, etc.
- Each and every element of chart such as plot area, axes, data, titles, labels, legends, grid lines, etc. can be formatted using format menu or format tool bar.
- The size of chart can be changed as per our requirements.
- Graphs and charts help to visualise the trends in presented data than textual information, so that they can be comprehended more easily.
I can

- illustrate the data in graphical form in charts and diagrams using spread sheet
- state and apply the techniques of changing lay out, types and models of graphs and charts for representing business data using spread sheet
- describe the use of accounting / business data for graphical representation

TE QUESTIONS

1. Line chart is used to display:
   a. information about the frequency of different quantities
   b. trends over a period of time
   c. percentage of data
   d. data in vertical bars

2. To fill the chart area, double-click the chart and select:
   a. Chart wall
   b. Data Range
   c. Chart area
   d. Titles

3. Find the odd one out:
   a. Normal pie chart
   b. Donut chart
   c. Exploded donut chart
   d. Bar chart

4. Explain the suitability of a column chart.
5. Show the steps for creating a chart.
6. Illustrate and explain the elements of a chart.
7. Compare 2D chart and 3D chart.
8. List out the advantages of charts and graphs in business applications.
9. Mr. Abhijith wants to move the title of a chart to a new location, can you help him in this regard.
1. Total sales of Kiran Shoe Mart and Afsal Footwears for the year 2013 to 2017 are given below:

<table>
<thead>
<tr>
<th>Year</th>
<th>Kiran Shoe Mart</th>
<th>Afsal Footwears</th>
</tr>
</thead>
<tbody>
<tr>
<td>2013</td>
<td>120000</td>
<td>140000</td>
</tr>
<tr>
<td>2014</td>
<td>140000</td>
<td>130000</td>
</tr>
<tr>
<td>2015</td>
<td>125000</td>
<td>135000</td>
</tr>
<tr>
<td>2016</td>
<td>110000</td>
<td>117000</td>
</tr>
<tr>
<td>2017</td>
<td>140000</td>
<td>150000</td>
</tr>
</tbody>
</table>

a) Present the data in a column chart.

b) Change the chart type to a line chart.

2. Prepare a pie chart from the following data of family expenditure for the month of January 2018:

<table>
<thead>
<tr>
<th>Vegetables</th>
<th>Fish and Meat</th>
<th>Telephone</th>
<th>Electricity</th>
<th>Grocery</th>
<th>Others</th>
</tr>
</thead>
<tbody>
<tr>
<td>5000</td>
<td>12000</td>
<td>2000</td>
<td>1500</td>
<td>8000</td>
<td>6000</td>
</tr>
</tbody>
</table>

3. Draw a column chart for the following data and give a title "Age wise details".

<table>
<thead>
<tr>
<th>Age</th>
<th>12</th>
<th>13</th>
<th>14</th>
<th>15</th>
<th>16</th>
<th>17</th>
</tr>
</thead>
<tbody>
<tr>
<td>No. of students</td>
<td>50</td>
<td>60</td>
<td>70</td>
<td>90</td>
<td>150</td>
<td>160</td>
</tr>
</tbody>
</table>
Lab work-1

Total sales of XY Agencies and Ready Bros for the year 2011 to 2015 are given below: (Sales in ₹)

<table>
<thead>
<tr>
<th>Year</th>
<th>XY Agencies</th>
<th>Ready Bros</th>
</tr>
</thead>
<tbody>
<tr>
<td>2011</td>
<td>40000</td>
<td>38000</td>
</tr>
<tr>
<td>2012</td>
<td>32000</td>
<td>48000</td>
</tr>
<tr>
<td>2013</td>
<td>51000</td>
<td>42000</td>
</tr>
<tr>
<td>2014</td>
<td>72000</td>
<td>81000</td>
</tr>
<tr>
<td>2015</td>
<td>60000</td>
<td>58000</td>
</tr>
</tbody>
</table>

a) Present the data in a column chart.

Procedure

In order to create a column chart the steps mentioned under are to be followed:

1. Open spreadsheet.
2. Enter the details given in appropriate cells.
3. Select the cells containing the data.
4. Select the option Chart from Insert tab.
5. Choose the Chart Type from chart wizard and click 'Next'.
6. In Data Range option enable the radio button Data series in columns; check the boxes for First row as label and First column as label.
7. Go to Chart Elements option in Chart Wizard, give appropriate title for chart (Sales Report), X axis (Year) and Y axis (Sales in Rupees) Labels and click Finish button.
8. Save the spreadsheet by clicking on the 'Save' icon or press Ctrl+S keys.

Output:

Fig 4.22 - Column Chart
Lab work-2

2. Prepare a pie chart from the following data of PTA expenditure for the month of December 2017: (Amount in ₹)

<table>
<thead>
<tr>
<th>Repairs &amp; Maintenance</th>
<th>Lab Items</th>
<th>Library</th>
<th>Electricity</th>
<th>Telephone</th>
<th>Others</th>
</tr>
</thead>
<tbody>
<tr>
<td>5000</td>
<td>12000</td>
<td>2000</td>
<td>1500</td>
<td>8000</td>
<td>6000</td>
</tr>
</tbody>
</table>

Procedure

In order to create a column charts the steps mentioned under are to be followed:

1. Open spreadsheet.
2. Enter the details given in appropriate cells.
3. Select the cells containing the data.
4. Select the option Chart from Insert tab.
5. Choose the Chart Type from chart wizard and click 'Next'.
6. In Data Range option enable the radio button Data series in rows; check the boxes for First row as label and First column as label.
7. Go to Chart Elements option in Chart Wizard, give appropriate title for chart (PTA Expenditure), sub title (December 2017), X axis (Year) and Y axis (Sales in Rupees) Labels and click Finish button.
8. Save the spreadsheet by clicking on the 'Save' icon or press Ctrl+S keys.

Output

Fig 4.23 Pie Chart
Key Concepts

5.1 GNUKhata - Accounting Software
5.2 Features of GNUKhata
5.3 Create Organisation
5.4 Groups and Sub-groups
5.5 System generated Ledger Accounts
5.6 GNUKhata Menu Bar
5.7 Ledger Creation
5.8 Sub-group Creation
5.9 Voucher Entry
5.10 Reports
5.11 Bank Reconciliation Statement

Introduction

We are already aware of the preparation of financial statements under manual accounting system. The use of computers in the field of accounting has made the job of accountants much easier. As of now, we have seen the enormous possibilities of spreadsheet application in various fields of accounting. Even though creation of journal, ledger and other task are tenable in a spreadsheet, most accountants prefer to use exclusive accounting software due to:

- instant processing of huge volume of transactions
- accomplishing the preparation of final accounts automatically and concurrently
- reducing the likelihood of errors
- enhancing security features which prevents frauds and misappropriation

All these have led to the enhanced role of computer assisted accounting software in the field of accounting and business. Nowadays irrespective of the scale of operation, all types of business organisations make the most of it from accounting software.

Commonly used Accounting Software

There is innumerable accounting software packages available in the market like GNUKhata, SAP, Tata Ex, Peachtree, DacEasy, Tally, Fresh books, Quick books,
Zoho books, Wave, etc. The selection of software depends, primarily on the need, use and size of business organisations.

Among the above, GNUKhata is a Free and Open Source Software (FOSS) and the rest are proprietary software. FOSS can be legally downloaded and customised without paying any fees. In this unit, the focus of our discussion is centred on GNUKhata which functions in Linux platform.

5.1 GNUKhata - Accounting Software

GNUKhata (pronounced as jee_new_khata) was developed by Digital Freedom Foundation, a public charitable trust, in association with International Centre for Free and Open Source Software (ICFOSS). It supports wide range of applications related with accounting and inventory management.

5.2 Features of GNUKhata

a) It is a free and open source accounting software

b) It is based on double entry book keeping

c) Comprehensive financial reports like Ledgers, Trial balance, Profit and loss Account, Balance sheet etc. are available

d) Source document can be attached along with the voucher entry

e) Export and import of data from Spreadsheet is possible

f) Password security and data audit facility provided

Let’s know more ...

Installation of GNUKhata

To install the software in linux platform, download Offline installer from the website www.gnukhata.in. Extract the downloaded file and refer README file for the installation process.

Steps for installing GNUKhata

Certain steps are to be followed to install GNUKhata just like installing any other software in a computer. They are as follows:

1. Double click on ‘installer’ file from the extracted ‘offline installer’ folder.

2. Click on ‘Proceed’ button.

3. Check (✓) the licence agreement and click on ‘OK’ button.

4. Enter the system password.

5. The system will respond with a message 'Installation Finished' and click on 'OK' button.
How to run GNUKhata?

To run GNUKhata, the following path is to be used:

Applications → Office → GNUKhata.

Now the Home Screen of GNUKhata appears as shown in figure 5.1.

![GNUKhata Home Screen]

**Fig 5.1 Home Screen of GNUKhata**

### 5.3 CREATE ORGANISATION

The first step in operating GNUKhata is to create an organisation. It may be either profit or non-profit organisation.

Create organisation → Enter the name and other details → Proceed

While creating an organisation the following details are required.

1. **Organisation Name**: Type the name of organisation to be created and press Enter key or Tab key to reach the next field.

2. **Case**: To change the appearance of the name of organisation, available options are illustrated with the help of an example of Royal Traders
   a. As-is : Royal traders ('As-is' stands for as it is entered)
   b. Upper Case : ROYAL TRADERS
   c. Lower Case : royal traders
   d. Title Case : Royal Traders

3. **Organisation Type**: Organisation may be either 'Profit Making' or 'Not for Profit'. Select the suitable organisation.

4. **Financial Year**: Enter the opening date of financial year or date of commencement of the organisation. Press enter key, then closing date will show up automatically which can be edited. Once organisation is created, the financial year cannot be changed.

5. **Select mode of accounting**: GNUKhata 4.25 version offers four options to maintain the books of accounts. They are:
Accounting only. Accounting with invoicing. Invoicing with bill wise accounting, Inventory with invoicing and bill wise accounting. Here the scope of our discussion is confined to 'Accounting only'.

The Create Organisation screen is shown in figure. 5.2.

![Image of Create Organisation screen]

**Fig 5.2 Create Organisation**

**Creating Admin**

Accounting software collects a lot of confidential data. If this information is tampered by unauthorised persons, it could create chaos in the business.

As part of providing security to the accounting information we have to set up the administrative features. It is mandatory to create ‘Admin’. For this fill in the fields User name, Password, Confirm password, Security question and Answer to security question. Then click on ‘Create & Login’ to save the admin details. The Create Admin screen is shown in figure. 5.3.

![Image of Create Admin screen]

**Fig 5.3 Create Admin**
Let's assess

1. From the following, identify the Free and Open Source Accounting software
   
   (a) Peachtree  (b) Daceasy  (c) GNUKhata  (d) Tally
2. GNUKhata was developed by ........................................in association with ICFOSS
3. List out any two proprietary accounting software.
4. Which tab is used to create a new organisation in the home screen of GNUKhata?

5.4 Groups and Sub-Groups

GNUKhata has 13 predetermined account groups, of which 9 relates to the Balance Sheet and the other 4 to the Profit & Loss Account or Income & Expenditure Account. It is available in ‘Create Account’ menu as detailed below:

Master → Create Account → Group → Select a group (Eg: Current Asset) → Sub-group (Eg: Bank)

Profit & Loss or Income & Expenditure Account Groups

We are already aware that, all direct incomes are credited and direct expenses are debited to the trading account. Likewise all indirect incomes are credited and indirect expenses are debited to profit and loss account. A list of Profit & Loss or Income & Expenditure account groups and sub groups are given in table 5.1

<table>
<thead>
<tr>
<th>Sl.No.</th>
<th>Group Name</th>
<th>Sub-group Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Direct Income</td>
<td>None</td>
</tr>
<tr>
<td>2</td>
<td>Direct Expense</td>
<td>None</td>
</tr>
<tr>
<td>3</td>
<td>Indirect Income</td>
<td>None</td>
</tr>
<tr>
<td>4</td>
<td>Indirect Expense</td>
<td>None</td>
</tr>
</tbody>
</table>

Balance Sheet Groups

Similarly, all assets and liabilities are arranged in a systematic manner in order to prepare the Balance sheet. They belong to different groups and subgroups which are as given in table 5.2.
Table 5.2 Balance Sheet Groups

<table>
<thead>
<tr>
<th>Sl.No.</th>
<th>Group Name</th>
<th>Sub-Group Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Fixed Assets</td>
<td>Building, Furniture, Land, Plant &amp; Machinery</td>
</tr>
<tr>
<td>2</td>
<td>Investments</td>
<td>Investment in Bank Fixed Deposits, Investment in Shares &amp; Debentures</td>
</tr>
<tr>
<td>3</td>
<td>Loans (Asset)</td>
<td>None</td>
</tr>
<tr>
<td>4</td>
<td>Current Assets</td>
<td>Bank, Cash, Inventory, Loans &amp; Advances, Sundry Debtors</td>
</tr>
<tr>
<td>5</td>
<td>Miscellaneous Expenses (Assets)</td>
<td>None</td>
</tr>
<tr>
<td>6</td>
<td>Capital/Corpus</td>
<td>None</td>
</tr>
<tr>
<td>7</td>
<td>Loans (Liability)</td>
<td>Secured, Unsecured</td>
</tr>
<tr>
<td>8</td>
<td>Reserves</td>
<td>None</td>
</tr>
<tr>
<td>9</td>
<td>Current Liability</td>
<td>Provisions, Sundry Creditors for Expenses, Sundry Creditors for Purchases</td>
</tr>
</tbody>
</table>

Description of the Groups and Sub-Groups

We have seen the composition of group and sub-group items that will appear in Profit and Loss Account and Balance sheet. Now we shall discuss about these groups and sub-group items.

1. **Direct Income:** Income from operating activities comes under this group. For eg., Sale of goods. Income such as fees from clients or professional fees relating to service organisation will also be treated as direct income. These items will affect the Gross Profit of the organisation. GNUKhata opens a Profit & Loss Account or Income & Expenditure Account under this group.

2. **Direct Expense:** Expenses which are mainly related with purchase or manufacturing of goods. For eg., Purchases, wages, factory lighting, carriage inwards, consumables, etc. These expenses will affect the Gross Profit. By default opening stock comes under this group.

3. **Indirect Income:** It includes rent received, interest received, discount received, commission received, dividend received etc. These items will affect the Net Profit.

4. **Indirect Expense:** All office, administration, selling and distribution expenses such as salary, office telephone, electricity charges, maintenance of vehicles, interest on loan, rent, depreciation etc. are included in this group. You know that these items will affect the net profit of the organisation.
5. **Fixed Assets**: Accounts of all fixed assets are opened under this group. Predefined Sub-Groups under this group are Building, Furniture, Land and Plant & Machinery.

6. **Investments**: It includes accounts of investments made by the organisation. The predefined Sub-Groups are Investments in Bank Deposits, and Investments in Shares & Debentures.

7. **Loans (Asset)**: All long term loans issued by the organisation come under this group.

8. **Current Assets**: The amount invested in stock, debtors etc. are included in this category. The sub groups of Current Assets are:
   - Bank
   - Cash
   - Inventory
   - Loans and Advances (Prepaid expenses, short term loan issued by the organisation etc.)
   - Sundry Debtors

9. **Miscellaneous Expenses (Assets)**: Preliminary expenditure which are not written off, huge advertisement expenditure etc. come under this group.

10. **Capital / Corpus**: Capital in case of business organisations and Corpus in case of not for profit organisations are included here.

11. **Loans (Liability)**: This includes accounts of loans taken by the organization from banks and other financial institutions. The two sub-groups under this group are as follows:
    - Secured (Loan) : accounts of loans taken against the security.
    - Unsecured (Loan) : accounts of loans taken from partners, Directors, Office Bearers or others having no security.

12. **Reserves**: It involves retained earnings, reserves and surplus.

13. **Current Liabilities**:

    The sub groups of Current Liabilities are:
    - Provisions: Accounts of PF, ESI and TDS dues, etc.
    - Sundry Creditors for Expenses: Accounts of outstanding expenses, such as Salary Payable, Audit Fees Payable etc.
    - Sundry Creditors for Purchases

Suppose a firm has to create an account – Vehicles. Under which sub group would you place this? In GNUKhata, only four sub groups are available under Fixed Assets group of which vehicle cannot be included.

To resolve the issue, a new sub-group ‘Vehicle’ is to be created under the group Fixed Assets.
You can create any new sub-group in the same way as explained earlier.

5.5 **System Generated Ledger Accounts**

When an organisation is created the software automatically creates the following ledgers (Table 5.3). These accounts can neither be modified nor deleted.

<table>
<thead>
<tr>
<th>Sl. No.</th>
<th>Account Name</th>
<th>Group Name</th>
<th>Sub-Group Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Closing Stock</td>
<td>Current Assets</td>
<td>Inventory</td>
</tr>
<tr>
<td>2</td>
<td>Opening Stock</td>
<td>Direct Expenses</td>
<td>None</td>
</tr>
<tr>
<td>3</td>
<td>Profit &amp; Loss Account (For Profit Making Organizations:)</td>
<td>Direct Income</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>Or Income &amp; Expenditure Account (For Not for Profit Organizations )</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Stock at the Beginning</td>
<td>Current Assets</td>
<td>Inventory</td>
</tr>
</tbody>
</table>

---

**Let's assess**

1. What are the accounting groups related to Profit & Loss Account?
2. The subgroup of Sundry Creditors for Expenses come under the group ............
3. GNUKhata opens Opening Stock Account under ............... group.
4. Opening stock by default is created under ............... group.
5. Identify the System Generated Ledger account from the following.
   (a) Closing Stock   (b) Cash Account   (c) Bank Account
   (d) Prepaid Expenses

**Treatment of specific items**

Let us discuss the treatment of following items in GNUKhata.

**Closing stock**

You are familiar with the term ‘stock’ or ‘inventory’. Goods lying unsold with the business at the end of the accounting year are termed as closing stock. It is treated as current asset and included in the asset side of Balance Sheet. At the same time it will appear in the credit side of Profit and Loss Account.

For entering Closing Stock:

*Step 1*: Open Journal voucher → Enter Voucher Number and Closing date → Debit Closing Stock and credit Profit & Loss account.
To carry over the closing stock as the opening stock of next year, use the option Administration → Close Books/Roll Over. The closing stock is converted to opening stock through a temporary account ‘Stock at the beginning’.

**Opening Stock**

The stock of goods lying with the business in the previous year (as closing stock) will be made available for sale in the next year and is regarded as opening stock. It is treated as direct expense and appears in the debit side of Profit and Loss Account.

If the accounts of business are computerised for the first time, the amount of opening stock can be inserted through the following steps:

1. **Step 1 : Edit the Stock at the Beginning Account**
   Master → Edit Account → Select Stock at the Beginning Account → Click on Edit → Enter Opening Balance

2. **Step 2 : Voucher → Select Journal voucher → Enter Voucher No. & Opening date → Debit Opening Stock** and credit Stock at the Beginning.

**Sales Returns & Purchase Returns**

In this software **Sales Returns** comes under the sub-group ‘Direct Expense’ while **Purchase Returns** are treated as ‘Direct Income’. This is done for making necessary adjustments and to arrive at the true operating results.

The profit and loss account groups and their sub groups are given in table 5.4 and the Balance sheet groups and their sub group are given in table 5.5.

<table>
<thead>
<tr>
<th>Group Name</th>
<th>Sub-group Name</th>
<th>Ledger Account</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) Direct Income</td>
<td>None</td>
<td>• Sales&lt;br&gt;• Professional Fees&lt;br&gt;• Purchase Return&lt;br&gt;• Profit and Loss Account or Income &amp; Expenditure Account <em>(System Generated Ledger Account)</em></td>
</tr>
<tr>
<td>(2) Direct Expense</td>
<td>None</td>
<td>• Wages&lt;br&gt;• Carriage Inward&lt;br&gt;• Coal, Gas &amp; Water of Factory&lt;br&gt;• Factory Expenses( Lighting, Power, etc)&lt;br&gt;• Freight&lt;br&gt;• Import Duty</td>
</tr>
<tr>
<td>Group Name</td>
<td>Sub-group Name</td>
<td>Ledger Account</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------</td>
<td>----------------------------------------------------</td>
</tr>
<tr>
<td>1. Fixed Assets</td>
<td>1. Building</td>
<td>Building Account&lt;br&gt;Office Building Account&lt;br&gt;Factory Building Account</td>
</tr>
<tr>
<td>2. Furniture</td>
<td></td>
<td>Furniture Account&lt;br&gt;Office Furniture Account</td>
</tr>
<tr>
<td>3. Land</td>
<td></td>
<td>Land Account&lt;br&gt;Land &amp; Building Account&lt;br&gt;Premises Account</td>
</tr>
</tbody>
</table>

**Table 5.5 Groups, Sub-Groups and Ledger Accounts in Balance Sheet**

- Octroi
- Opening Stock Account *(System Generated Ledger Account)*
- Purchases
- Sales Return

(3) Indirect Income  None
- Bad debt received
- Commission Received
- Discount Received
- Income from Investment
- Rent Received
- Interest Received

(4) Indirect Expense None
- Office Expenses
- Salary
- Rent
- Insurance
- Audit Fee
- Electricity
- Depreciation
- Bad debt
- Telephone Charge
- Commission Allowed
- Discount Allowed
- Export Duty
- Interest on Loan
- Legal Expenses
- Postage and Telegram
- Printing and stationery
<table>
<thead>
<tr>
<th>Category</th>
<th>Account Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4. Plant &amp; Machinery</td>
<td>Machinery Account&lt;br&gt;Plant Account&lt;br&gt;Plant &amp; Machinery Account</td>
</tr>
<tr>
<td>2. Investments</td>
<td>5. Investment in Bank Deposits Fixed Deposits in Bank</td>
</tr>
<tr>
<td>6. Investment in Shares &amp; Debentures</td>
<td>Investment in Shares&lt;br&gt;Investment in Debentures</td>
</tr>
<tr>
<td>3. Loans (Asset)</td>
<td>None Accounts of all long term loans given by the organisation</td>
</tr>
<tr>
<td>8. Cash</td>
<td>Cash in Hand&lt;br&gt;Cash Account&lt;br&gt;Petty Cash Account</td>
</tr>
<tr>
<td>9. Inventory</td>
<td>Closing Stock (System Generated Ledger Account)</td>
</tr>
<tr>
<td>10. Loans and Advances</td>
<td>Short term loans and advances given to the employees&lt;br&gt;Prepaid Expenses</td>
</tr>
<tr>
<td>11. Sundry Debtors</td>
<td>All Debtors / Customers Account</td>
</tr>
<tr>
<td>5. Miscellaneous Expenses (Asset)</td>
<td>None Preliminary Expenses</td>
</tr>
<tr>
<td>6. Capital / Corpus</td>
<td>None Capital Account&lt;br&gt;Partner’s Capital Account&lt;br&gt;Share Capital Accounts&lt;br&gt;Capital Fund</td>
</tr>
<tr>
<td>7. Loans (Liability)</td>
<td>12. Secured Bank Loan&lt;br&gt;Other secured loans</td>
</tr>
<tr>
<td>13. Unsecured</td>
<td>Loan from Partners&lt;br&gt;Loan from Manager(s) etc.</td>
</tr>
<tr>
<td>8. Reserves</td>
<td>None Retained Earnings&lt;br&gt;General Reserves&lt;br&gt;Reserves and Surplus</td>
</tr>
<tr>
<td>15. Sundry Creditors for Expenses</td>
<td>Outstanding Expenses</td>
</tr>
<tr>
<td>16. Sundry Creditors for Purchases</td>
<td>All Suppliers / Creditors Account</td>
</tr>
</tbody>
</table>
Let’s assess

1. Purchase return and Sales return account, comes under ............ and .............. groups respectively.

2. In GNUKhata system generated ledger accounts are neither to be ............... nor to be .................

3. The temporary account used to convert (roll over) closing stock of the previous year to current year is .................

4. Identify the group under which the following ledgers are to be created.
   (i) Depreciation  (ii) Sales Return
   (iii) Preliminary Expenses  (iv) Drawings

5.6 Options on Menu Bar in GNUKhata

For interacting with the application, menu options are made available to the users. GNUKhata too gives out a control element in the form of main menu, and on clicking main menu a sub menu drops down. For mastering the skill in using the accounting software, learners need to be enlightened on each and every option available in the menu bar. Let us discuss this one by one.

1. Master

The figure adjoining highlights the drop down menu available in the Master menu:

Create Account – This option is taken to create ledger accounts.

Edit Account – Already created ledger accounts can be edited here.

(See Figure 5.4)
Edit Organisation Particulars – The organisational details can be edited with this option Cost Center – Organisational unit to which cost or expenses can be allocated in a transaction.

Bank Reconciliation Statement – This option is used to prepare BRS.

2. **Vouchers**

This menu is essential for recording transactions. Different vouchers like Receipt, Payment, Sales, Purchase, Contra, Journal, Sales Return, Purchase Return, Credit Note and Debit Note are available under this main menu. Besides this, option for Find/Edit Voucher is also available.

3. **Report**

How do you know that everything in your business is alright?

Only way, you can truly know this is to sail through your reports to find your key performance indicators. Not only generating a true and fair report but also interpreting it, helps you to run the business in a better manner.

Generating reports are very well carried out by this menu. This includes Ledger, Trial Balance, Cost Center Statement, Cash Flow, Balance Sheet, Consolidated Final Accounts, Profit & Loss Account, List of Accounts, List of Deleted Vouchers, List of Users and Activity Log.

4. **Administration**

For protecting your data, GNUKhata provides certain security measures. Privileges are given to the administrator by which he can control the operations of this accounting package. Authenticating users and granting privileges are given to new users with password, so that who can do what, when and under which conditions can be well defined. Moreover this option allows for export and import of data also.

The drop down menu includes - New User, Remove User, Change Password, Close Books/Roll Over, Organisation Preferences, Export Data, Delete Organisation and Import Data.

5. **Help**

Most applications will have ‘Help’ options. What is the utility of this option? This option explains the features of the software and helps the user to understand its operation. Help menu is meant for supporting the users on this accounting software. This menu is empowered with GNUKhata Manual, Short cut keys etc.
5.7 Ledger Creation

You know the process of manual accounting where we record all transactions relating to various accounts using journal. Later, all these accounts are classified in the secondary books called ledger.

In GNUKhata an account itself is called ledger. For eg. Sales ledger, capital ledger, purchases ledger etc. These accounts need to be created first and we should be able to define the group under which this ledger should be placed. An accounting software itself cannot identify that wages is direct expense and should come up in the debit side of ‘Trading account’. If you group ‘wages’ under ‘indirect expense’, then GNUKhata promptly recognises it and shows this item in the profit and loss account. From this you might have understood how important is the grouping process.

So, the balance of Ledger account will appear either in Balance sheet or in Profit & Loss Account depending upon the group under which it is created.

To create a Ledger account, select ‘Create Account’ option from ‘Master menu’.

As we have discussed earlier, only accounts of assets and liabilities have opening balances. Incomes and expenses are closed by transferring to Trading and Profit and Loss Account. Keeping this in mind, while creating a ledger account only accounts relating to Balance Sheet group will have opening balances. The software never asks for opening balances of income and expense account.

One more aspect needs clarity at this point of time. Suppose, if a firm commenced its business on 1st January 2018 and accounts were maintained manually till 1st March 2018. Hereafter, the firm decides to computerise the accounting system using GNUKhata. How will you enter the income and expenses from 1st January 2018 to 28th February 2018.

The software takes an assumption that if a firm switch over from manual to computerised accounting, then they will process the accounts till 28th February 2018 and prepare a Balance Sheet manually. Then the balances of assets and liabilities are brought into the software package as opening balance. The alternate option is to take the ledger balances till 28th February 2018 and pass an entry using appropriate voucher. For example, if Wages Account shows a ledger balance of ₹ 3,000 till 28th February 2018, pass a journal entry by debiting Wages a/c and crediting Cash a/c using ‘Payment Voucher’.

Now let us see how a ledger is created in GNUKhata.

Master → Create Accounts
The screen appears as given in figure 5.5

![Fig 5.5 Create Account](image)

The ledger account creation screen has two sides. The left side of the screen shows the following.

a. **Group Name** – Select the group to which the account belongs.
b. **Sub group Name** – Select the sub group from the drop down option.
c. **Account Name** – Enter the name of the account for example, Capital, Purchases, wages, etc.
d. **Opening Balance** – Enter the opening balance of assets and liabilities if any.

Click the ‘Save’ button to save your ledger ‘Reset’ option gives the freedom to start the ledger creation process once again.

Multiple ledger accounts can be created by checking into ‘Create Multiple Accounts’ check box. In the ensuing dialogue box, enter the names of all accounts to be created under that particular group.

On the right side of the screen, you can see a vertical format of a Balance Sheet. This part will appear only when ledger accounts relating to assets and liabilities are created. The number of accounts opened in each group and the total opening balances of accounts are also displayed here. The difference in balances if any, will also shown on the bottom of this side.

The right side of the screen will go blank if ledger accounts relating to income and liabilities are selected since it has no balance.
Display Ledger Accounts

To view the ledger already created, use the following path.

Report → Ledger → Account Name → Select the name of ledger → Check or uncheck the option Monthly Ledger → View

The option ‘Monthly Ledger’ if checked (✓) the system will show monthwise ledger and if it is unchecked it will display the balance of respective ledger accounts for the whole period.

Editing Ledger Accounts

To edit a ledger account, select Edit Account from Master menu. Here we can change Account Name and Opening Balance, if any, but cannot change the name of Group and Sub-Group.

Deleting Ledger Accounts

You can definitely delete a ledger by selecting ‘Edit Account’ from Master menu. Select the ledger Account to be deleted, click on Delete Button and confirm the deletion. System generated account and the ledger account already used in voucher cannot be deleted.

Master → Edit Account → Select Ledger → Delete

5.8 Creation of new sub-group

As we have seen earlier, you can create new sub-groups under a pre-defined group. It is to be remembered that we cannot create a new account group. For example, a new sub-group named ‘Purchases’ can be created under the main group ‘Direct Expenses’ and various accounts can be opened under this sub-group such as ‘Purchase of Raw Materials’, ‘Purchase of Finished Goods’, etc. Once a sub-group is created it cannot be deleted.

Let’s assess

1. In GNUKhata, ‘Edit Account’ option is available in ....................menu.

2. Which menu is used to generate reports in GNUKhata?

3. Identify the menu used for deleting ledger from the following.
   (a) Create Account  (b) Edit Account  (c) List of Accounts

4. Write the path to create ledger account in GNUKhata ?

5.9 Voucher Entry

Now you know how to create, display, edit and delete a ledger. It’s time for us to think in terms of recording a transaction in this software. Through ‘Voucher entry’ we can record transactions. So, recording a transaction through voucher interface is called voucher entry. The voucher entries are made on the basis of
concerned source documents. While recording a transaction through the voucher, we have to enter the voucher number, date, amount to be debited / credited along with its narration. We can add any number of debits and credits in a voucher entry. Before proceeding further let us discuss the different types of vouchers that are available for recording various transactions.

**Types of Vouchers**

GNUKhata offers the following pre-defined voucher types given in table 5.6. You cannot have a new voucher type other than those offered by the package.

<table>
<thead>
<tr>
<th>Voucher Type</th>
<th>Used To Record</th>
<th>Short cutKeys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receipts</td>
<td>To record all receipts of cash or cheque</td>
<td>F4</td>
</tr>
<tr>
<td>Payments</td>
<td>All payments made by cash or cheque</td>
<td>F5</td>
</tr>
<tr>
<td>Sales</td>
<td>Cash and credit sales of goods</td>
<td>F6</td>
</tr>
<tr>
<td>Purchase</td>
<td>Cash and credit purchase of goods or raw materials</td>
<td>F7</td>
</tr>
<tr>
<td>Contra</td>
<td>Deposits or withdrawals of cash from bank or transfer of funds from one bank to another and transfer of cash to petty cash</td>
<td>F8</td>
</tr>
<tr>
<td>Journal</td>
<td>Rectification entries or transfer or adjustment entries purchase or sale of fixed assets on credit</td>
<td>F9</td>
</tr>
<tr>
<td>Sales Return</td>
<td>Return of goods by a customer</td>
<td>Ctrl+1</td>
</tr>
<tr>
<td>Purchase Return</td>
<td>Return of goods to supplier</td>
<td>Ctrl+2</td>
</tr>
<tr>
<td>Credit Note</td>
<td>Reduction in the amount due from a customer or for allowances</td>
<td>Ctrl+3</td>
</tr>
<tr>
<td>Debit Note</td>
<td>Reduction in the amount payable to a supplier or for allowances</td>
<td>Ctrl+4</td>
</tr>
</tbody>
</table>

Now let us examine how the following transactions of Star Traders are entered through appropriate vouchers.

01-2-17    Started business with cash ₹ 2,00,000  
04-2-17    Opened a bank account ₹ 40,000  
09-2-17    Purchased goods for cash ₹ 10,000  
11-2-17    Cash sales ₹ 20,000  
17-2-17    Paid wages ₹ 1,000  
20-2-17    Received commission ₹ 500  
26-2-17    Purchased machinery from Beena ₹ 12,000
27-2-17  Purchased furniture ₹ 6,000
28-2-17  Paid salary ₹ 2,000

To record the transactions through the vouchers, steps mentioned below are to be followed:

1. Open GNUKhata -
   Applications →Office → GNUKhata

2. Create Organisation -
   Click on ‘Create Organisation’→ Enter the necessary details → Proceed

3. Create Admin → Enter the details→ Create & Login

4. Create appropriate ledger account with the help of table given below:

   Master → Create account → Select Group→Sub group→ Enter the Account name→Save

<table>
<thead>
<tr>
<th>Sl No</th>
<th>Group</th>
<th>Sub-group</th>
<th>Name of Account</th>
<th>Opening Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Current Assets</td>
<td>Cash</td>
<td>Cash</td>
<td>______</td>
</tr>
<tr>
<td>2</td>
<td>Capital</td>
<td>None</td>
<td>Capital</td>
<td>______</td>
</tr>
<tr>
<td>3</td>
<td>Current Assets</td>
<td>Bank</td>
<td>Bank</td>
<td>______</td>
</tr>
<tr>
<td>4</td>
<td>Direct Expenses</td>
<td>None</td>
<td>Purchases</td>
<td>______</td>
</tr>
<tr>
<td>5</td>
<td>Direct Income</td>
<td>None</td>
<td>Sales</td>
<td>______</td>
</tr>
<tr>
<td>6</td>
<td>Direct Expenses</td>
<td>None</td>
<td>Wages</td>
<td>______</td>
</tr>
<tr>
<td>7</td>
<td>Indirect Income</td>
<td>None</td>
<td>Commission</td>
<td>______</td>
</tr>
<tr>
<td>8</td>
<td>Fixed Asset</td>
<td>Plant &amp; Machinery</td>
<td>Machinery</td>
<td>______</td>
</tr>
<tr>
<td>9</td>
<td>Current Liability</td>
<td>Sundry Creditors for fixed assets (create new sub group)</td>
<td>Beena</td>
<td>______</td>
</tr>
<tr>
<td>10</td>
<td>Fixed Asset</td>
<td>Furniture</td>
<td>Furniture</td>
<td>______</td>
</tr>
<tr>
<td>11</td>
<td>Indirect Expenses</td>
<td>None</td>
<td>Salary</td>
<td>______</td>
</tr>
</tbody>
</table>

Step 5: After creating the necessary ledger accounts, proceed with voucher entry.

The path mentioned below is to be followed.
Voucher → Select appropriate voucher.

Then enter the details as follows.

- Enter voucher number and date
- Select the debit account name and enter the amount. Press enter key
- Similarly give credit account and amount
- Enter narration and press save button
Now the voucher creation screen appears as shown in figure 5.6.

![Voucher creation screen](image)

**Fig 5.6 Voucher creation**

The ‘Add Account’ menu available in the voucher creation screen allows for creation of new ledger account, as can be seen in figure 5.6. Similarly ‘Attach’ tab provides an opportunity to attach a source document of various transactions at the time of voucher entry. Reset tab will reset the entire data already entered in that particular voucher.

Enter the details of vouchers based on the details shown in table 5.7.

**Table 5.7 Details of vouchers.**

<table>
<thead>
<tr>
<th>Date</th>
<th>Account name</th>
<th>Voucher</th>
<th>Function Key</th>
<th>Dr/Cr</th>
<th>Amount (₹)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-2-17</td>
<td>Cash Capital</td>
<td>Receipt</td>
<td>F4</td>
<td>Dr</td>
<td>2,00,000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
<td>2,00,000</td>
</tr>
<tr>
<td>4-2-17</td>
<td>Bank Cash</td>
<td>Contra</td>
<td>F8</td>
<td>Dr</td>
<td>40,000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
<td>40,000</td>
</tr>
<tr>
<td>9-2-15</td>
<td>Purchases Cash</td>
<td>Purchase</td>
<td>F7</td>
<td>Dr</td>
<td>30,000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
<td>30,000</td>
</tr>
<tr>
<td>11-2-17</td>
<td>Cash Sales</td>
<td>Sale</td>
<td>F6</td>
<td>Dr</td>
<td>2,500</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
<td>2,500</td>
</tr>
<tr>
<td>17-2-17</td>
<td>Wages Cash</td>
<td>Payment</td>
<td>F5</td>
<td>Dr</td>
<td>1,000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
<td>1,000</td>
</tr>
<tr>
<td>20-2-17</td>
<td>Cash Commission</td>
<td>Receipt</td>
<td>F4</td>
<td>Dr</td>
<td>500</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
<td>500</td>
</tr>
<tr>
<td>26-2-17</td>
<td>Machinery Beena</td>
<td>Journal</td>
<td>F9</td>
<td>Dr</td>
<td>12,000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
<td>12,000</td>
</tr>
<tr>
<td>27-2-17</td>
<td>Furniture Cash</td>
<td>Payment</td>
<td>F5</td>
<td>Dr</td>
<td>6,000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
<td>6,000</td>
</tr>
<tr>
<td>28-2-17</td>
<td>Salary Cash</td>
<td>Payment</td>
<td>F5</td>
<td>Dr</td>
<td>2,000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
<td>2,000</td>
</tr>
</tbody>
</table>
Step 6: Display the list of transactions.
Vouchers → Find/Edit → Voucher → Select criteria as time interval → Search → View printable version.

Finding and Editing a Voucher

In order to make necessary changes in a voucher entry that we have already entered, Find/Edit option is available in GNUKhata. For this select ‘Find/Edit Voucher’ from Voucher menu. Select Criteria to search the required voucher. All transactions fulfilling that criterion will be displayed. Select the transaction that we want to edit and press Enter Key. The voucher will appear and click on Edit button. Make necessary changes in the record and save.

Cloning a Voucher

Clone a voucher means to copy a voucher. Where a number of similar entries are to be made Cloning module is used. To apply this facility find the voucher through ‘Find/Edit Voucher’ option from Voucher menu. Open the voucher to be copied and click on Clone button. Thereby a new voucher with similar details will be generated automatically and save it.

Deleting a Voucher

Voucher deletion is used when there is a duplicate entry is made. In order to delete a voucher find the voucher from Find/Edit option and press the ‘delete button’. After that there will be a confirmation window, and press ‘yes’ if you want to delete the voucher. Deleted vouchers cannot be restored, we can view a List of Deleted Vouchers through Report menu. (See Figure 5.7)

```
<table>
<thead>
<tr>
<th>Voucher No</th>
<th>Cr/Dr</th>
<th>Account Name</th>
<th>Dr Amount</th>
<th>Date</th>
<th>Cr Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Dr</td>
<td>Purchase</td>
<td>10000.00</td>
<td>02</td>
<td>01</td>
</tr>
<tr>
<td></td>
<td>Cr</td>
<td>Cash</td>
<td>19999.99</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>10000.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Narration:</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

Fig 5.7 Voucher Deletion
**Attach Document**

This unique feature enables the user to attach scanned copies of the supporting documents to the record of a transaction. The attachments can be viewed, deleted and replaced. This unique feature is most useful while auditing, which enables a scanned copy of a supporting document to be viewed instantly.

**5.10 Reports**

Report menu is used to view reports such as Ledger, Trial Balance, Balance Sheet, Profit & Loss Account, List of Accounts, List of Deleted Vouchers, etc. according to the needs and requirements of the users (See the figure 5.8)

![Fig 5.8 Reports](image)

To generate reports in GNUKhata, select suitable option from the Report Menu as detailed below:

1. **Ledger Account**: Report → Ledger → Select Account → Set the Date → View
2. **Trial Balance**: Report → Trial Balance → Set the Date → View (See figure 5.9)
3. **Profit & Loss Account**: Report → Profit & Loss → Set the Date → View (See figure 5.10)
4. **Balance Sheet**: Report → Balance Sheet → Set the Date → View (See figure 5.11)
Fig 5.9 Trial Balance

Fig 5.10 Profit & Loss Account

Fig 5.11 Balance Sheet
5.11 **Bank Reconciliation Statement (BRS)**

You may recall how we have prepared Bank Reconciliation Statement manually in order to list out the reasons for disagreement between the balances as per pass book and cash book on a particular date. The statement has to be prepared at the time of finalisation of accounts or periodically.

The Bank Reconciliation Statement is used to compare transactions on two dates. The first one is the date of transaction and the second one is the date of the same transaction which appears in the bank passbook or bank statement, otherwise known as the ‘Clearance Date’. Now we will see how a BRS can be prepared through GNUKhata.

Select Bank Reconciliation Statement from the Master menu and follow the steps given below:

Master → Bank Reconciliation Statement → Select Account Name → Set the Reconciliation Period (From Date and To date) → Click on view → Enter Clearance Date.

**Let’s assess**

1. *The short cut key of Contra Voucher is ....................
2. *Which voucher is used to make rectification entries ?
3. *Bank Reconciliation statement is available in ....................Menu
4. *Write the path to display Trial Balance.*

**Illustration:**


1-11-2017 Purchased goods and paid by cheque (Ch No. 231) ₹ 10000

1-11-2017 Deposited into PNB Saving Bank Account ₹ 16000

2-11-2017 Paid rent by cheque( Ch No. 232) ₹ 10000

2-11-2017 Paid salaries by cheque (Ch No. 233) ₹ 6000

30-11-2017 Interest credited in the passbook ₹ 600

30-11-2017 Bank charges debited in passbook ₹ 150

Cheque No. 231 was presented with the bank on 30-11-2017. Cheque No. 232 was presented with the bank on 1-12-2017. But Cheque No. 233 is not presented to the bank till the date. All other transactions were entered in the pass on the same day itself.
Procedure

Steps:
1: Open GNUKhata -
   Applications→ Office → GNUKhata
2: Create Organisation -
   Click on ‘Create Organisation’→ Enter the necessary details
3: Create Admin → Enter the details
4: Create appropriate ledger accounts -
   Click on Master → Create account→ Select Group→Sub group→Enter
   the Account name→ Save

<table>
<thead>
<tr>
<th>Sl No</th>
<th>Group</th>
<th>Sub group</th>
<th>Name of ledger</th>
<th>Opening Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Current Asset</td>
<td>Bank</td>
<td>PNB</td>
<td>40000</td>
</tr>
<tr>
<td>2</td>
<td>Current Asset</td>
<td>Cash</td>
<td>Cash</td>
<td>-</td>
</tr>
<tr>
<td>3</td>
<td>Direct expense</td>
<td>None</td>
<td>Purchases</td>
<td>-</td>
</tr>
<tr>
<td>4</td>
<td>Indirect expense</td>
<td>None</td>
<td>Rent</td>
<td>-</td>
</tr>
<tr>
<td>5</td>
<td>Indirect expense</td>
<td>None</td>
<td>Salary</td>
<td>-</td>
</tr>
<tr>
<td>6</td>
<td>Indirect Income</td>
<td>None</td>
<td>Interest received</td>
<td>-</td>
</tr>
<tr>
<td>7</td>
<td>Indirect expense</td>
<td>None</td>
<td>Bank charges</td>
<td>-</td>
</tr>
</tbody>
</table>

5. Enter Vouchers (based on the table 5.8).
   Voucher → Select appropriate voucher → Enter details

Table 5.8 Details of vouchers

<table>
<thead>
<tr>
<th>Date</th>
<th>Account name</th>
<th>Voucher</th>
<th>Function Key</th>
<th>Dr/Cr</th>
<th>Amount (₹)</th>
</tr>
</thead>
<tbody>
<tr>
<td>01/11/17</td>
<td>Purchase PNB</td>
<td>Purchase</td>
<td>F7</td>
<td>Dr Cr</td>
<td>10000 10000</td>
</tr>
<tr>
<td>01/11/17</td>
<td>PNB Cash</td>
<td>Contra</td>
<td>F8</td>
<td>Dr Cr</td>
<td>16000 16000</td>
</tr>
<tr>
<td>02/11/17</td>
<td>Rent PNB</td>
<td>Payment</td>
<td>F5</td>
<td>Dr Cr</td>
<td>10000 10000</td>
</tr>
<tr>
<td>02/11/17</td>
<td>Salary PNB</td>
<td>Payment</td>
<td>F5</td>
<td>Dr Cr</td>
<td>6000 6000</td>
</tr>
<tr>
<td>30/11/17</td>
<td>PNB Interest</td>
<td>Receipt</td>
<td>F4</td>
<td>Dr Cr</td>
<td>600 600</td>
</tr>
<tr>
<td>30/11/17</td>
<td>Bank charges PNB</td>
<td>Payment</td>
<td>F5</td>
<td>Dr Cr</td>
<td>150 150</td>
</tr>
</tbody>
</table>

6. Enter Clearance Date :-
   Master→Bank Reconciliation Statement→Select Account Name (PNB)
Set the Reconciliation Period (From Date and To date) → Click on view → Enter Clearance Date. See the figure 5.12

Fig 5.12 Transactions while entering clearance date

7. To show the Bank Reconciliation Statement
   Click on ‘View Statement’ (See the figure 5.13)

Fig 5.13 Bank Reconciliation Statement

If we want to see the Cleared Transactions, Click on Cleared Items (See the figure 5.14)

If we want to see the Uncleared Transactions,
Click on Uncleared Items.
Summary

- GNUKhata is a free and open source accounting software in Linux platform.
- To install GNUKhata extract the downloaded file and follow the instructions in Read me file.
- To create a new organisation, click on Create Organisation tab and enter the details such as Organisation Name, Type, Financial year etc.
- GNUKhata has 13 groups and 16 subgroups, 4 groups are related with the Profit & Loss account and 9 are related with the Balance Sheet.
- There are 4 system generated ledger accounts in GNUKhata. They are Closing stock, Opening Stock, Profit & Loss Account and Stock at the beginning.
- The important options in Menu Bar are Master, Voucher, Report, Administration and Help.
- To create a ledger account, select Create Account option from the Master Menu.
- Ledger accounts created can be displayed, edited and deleted.
- Recording a transaction through a voucher interface is known as voucher entry. Important Vouchers are Receipts, Payment, Sale, Purchase, Contra, Journal etc.
- Report menu is used to view reports such as Ledger, Trial Balance, Profit & Loss Account, Balance Sheet etc.
- Bank Reconciliation Statement is prepared by an account holder to reconcile Cash Book balance and Pass Book balance on a particular date.
- To open Bank Reconciliation Statement, select the option Bank Reconciliation Statement from the Master Menu.

I can

- describe and demonstrate the installation of Computerised Accounting System
- describe the features of GNUKhata as an accounting software such as grouping of accounts, codification, Account Masters and Voucher entry etc.
- create Organisation and books of accounts
- construct Trial balance, Trading and Profit & Loss account and a Balance sheet and other reports
- prepare bank Reconciliation Statement on a particular date
TE QUESTIONS

1. List out the features of GNUKhata.
2. Specify the path to create an Organisation in GNUKhata.
3. Name the System Generated Ledger Accounts.
4. Name the different ways of maintaining books of accounts in GNUKhata.
5. “GNUKhata has many security features.” Explain.
6. Write a brief note on different account groups in GNUKhata.
7. List out the subgroups under Fixed Asset.
8. Name the account group instead of capital in case of not for profit organisation.
9. Name the options in menu bar in GNUKhata.
10. Describe the steps in Ledger Creation.
11. Write the path to display the ledger account.
12. Complete the following table:

<table>
<thead>
<tr>
<th>Voucher Type</th>
<th>Used To Record</th>
<th>Short cutKeys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receipts</td>
<td>?</td>
<td>F4</td>
</tr>
<tr>
<td>Payments</td>
<td>Payment by cash or cheque</td>
<td>?</td>
</tr>
<tr>
<td>?</td>
<td>Cash and credit sales of goods</td>
<td>F6</td>
</tr>
<tr>
<td>Purchase</td>
<td>?</td>
<td>F7</td>
</tr>
<tr>
<td>?</td>
<td>Deposits or withdrawals of cash from bank</td>
<td>F8</td>
</tr>
<tr>
<td>Journal</td>
<td>Adjustment entries</td>
<td>?</td>
</tr>
</tbody>
</table>

14. Describe the path to display the list of transactions in a period.
15. Show the steps to display the Profit and Loss Account.
16. Write the procedure to show Bank Reconciliation Statement.
1. Enter the following transactions of Avinash Enterprises and Display Trial Balance, Profit and Loss account and Balance sheet:

<table>
<thead>
<tr>
<th>Date</th>
<th>Transaction</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-1- 2015</td>
<td>Commenced business with cash</td>
<td>2,00,000</td>
</tr>
<tr>
<td>5-1- 2015</td>
<td>Purchased Furniture</td>
<td>30,000</td>
</tr>
<tr>
<td>13-1- 2015</td>
<td>Opened Bank account</td>
<td>5,000</td>
</tr>
<tr>
<td>17-1- 2015</td>
<td>Purchased goods from Jaison</td>
<td>15,000</td>
</tr>
<tr>
<td>25-1- 2015</td>
<td>Sold goods</td>
<td>18,000</td>
</tr>
<tr>
<td>27-1- 2015</td>
<td>Paid rent</td>
<td>2,000</td>
</tr>
<tr>
<td>31-1-2015</td>
<td>Received interest</td>
<td>6,000</td>
</tr>
</tbody>
</table>

2. Enter the following transactions of Nature Enterprises Vallappuzha and Display Trial Balance, Profit and Loss account and Balance sheet:

<table>
<thead>
<tr>
<th>Date</th>
<th>Transaction</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-1- 2017</td>
<td>Started business with cash</td>
<td>5,00,000</td>
</tr>
<tr>
<td>3-1- 2017</td>
<td>Opened Bank account</td>
<td>10,000</td>
</tr>
<tr>
<td>5-1- 2017</td>
<td>Purchased Machinery</td>
<td>1,00,000</td>
</tr>
<tr>
<td>8-1- 2017</td>
<td>Purchased goods from Fadwa Traders</td>
<td>30,000</td>
</tr>
<tr>
<td>10-1-2017</td>
<td>Cash deposited in to bank</td>
<td>2,00,000</td>
</tr>
<tr>
<td>12-1-2017</td>
<td>Paid Wages</td>
<td>2,000</td>
</tr>
<tr>
<td>15-1-2017</td>
<td>Sold goods to Rincy</td>
<td>28,000</td>
</tr>
<tr>
<td>17-1-2017</td>
<td>Purchased goods</td>
<td>20,000</td>
</tr>
<tr>
<td>18-1-2017</td>
<td>Received Commission</td>
<td>4,000</td>
</tr>
<tr>
<td>22-1-2017</td>
<td>Returned goods to Fadwa Traders</td>
<td>2,500</td>
</tr>
<tr>
<td>25-1-2017</td>
<td>Sold goods</td>
<td>32,000</td>
</tr>
<tr>
<td>28-1-2017</td>
<td>Goods returned by Rincy</td>
<td>900</td>
</tr>
<tr>
<td>31-1-2017</td>
<td>Paid salary</td>
<td>8,000</td>
</tr>
</tbody>
</table>

Adjustment:

1. Closing stock was valued at ₹ 10,000 as on 31-12-2017.
3. Ascertain the cash balance from the following transactions of Tom and Brothers for the month of January 2016 using GNUKhata Accounting Software.

<table>
<thead>
<tr>
<th>Date</th>
<th>Transaction</th>
<th>Amount (₹)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jan 1</td>
<td>Started business with cash</td>
<td>70000</td>
</tr>
<tr>
<td>Jan 4</td>
<td>Bought office furniture</td>
<td>10000</td>
</tr>
<tr>
<td>Jan 7</td>
<td>Cash purchases</td>
<td>35000</td>
</tr>
<tr>
<td>Jan 9</td>
<td>Credit sales to Ajith</td>
<td>20000</td>
</tr>
<tr>
<td>Jan 9</td>
<td>Salary to staff</td>
<td>8000</td>
</tr>
<tr>
<td>Jan 9</td>
<td>Received cash from Ajith</td>
<td>12000</td>
</tr>
</tbody>
</table>

4. Show Purchase Account and Sales Account from the following transactions of Sindhu Metals for the month of January 2016.

<table>
<thead>
<tr>
<th>Date</th>
<th>Transaction Description</th>
<th>Amount (₹)</th>
</tr>
</thead>
<tbody>
<tr>
<td>01/01/2016</td>
<td>Commenced business with cash</td>
<td>100000</td>
</tr>
<tr>
<td>05/01/2016</td>
<td>Deposited in to SBI R</td>
<td>50000</td>
</tr>
<tr>
<td>08/01/2016</td>
<td>Purchased goods from KiranTraders</td>
<td>35000</td>
</tr>
<tr>
<td>10/01/2016</td>
<td>Purchased goods</td>
<td>7000</td>
</tr>
<tr>
<td>13/01/2016</td>
<td>Sold goods</td>
<td>10000</td>
</tr>
<tr>
<td>16/01/2016</td>
<td>Purchased goods by cheque</td>
<td>20000</td>
</tr>
<tr>
<td>25/01/2016</td>
<td>Sold goods on credit to Abhijith for</td>
<td>15000</td>
</tr>
</tbody>
</table>

5. Show the final accounts of Golden Stores Kozhikode from the following transactions.

<table>
<thead>
<tr>
<th>Date</th>
<th>Description</th>
<th>Amount (₹)</th>
</tr>
</thead>
<tbody>
<tr>
<td>01/06/2016</td>
<td>Commenced business with cash</td>
<td>60000</td>
</tr>
<tr>
<td>02/06/2016</td>
<td>Purchased machinery</td>
<td>20000</td>
</tr>
<tr>
<td>03/06/2016</td>
<td>Paid rent</td>
<td>5000</td>
</tr>
<tr>
<td>04/06/2016</td>
<td>Cash deposited with State bank</td>
<td>20000</td>
</tr>
<tr>
<td>05/06/2016</td>
<td>Purchased goods for</td>
<td>9500</td>
</tr>
<tr>
<td>06/06/2016</td>
<td>Sold goods for cash</td>
<td>4700</td>
</tr>
<tr>
<td>07/06/2016</td>
<td>Sold goods on credit to Mr. Suresh</td>
<td>12000</td>
</tr>
</tbody>
</table>


- Opening balance of SBI Bank Account (1-04-2016) Rs. 60000
- 1-04-2016 Purchased goods and paid by cheque (Ch No. 411) Rs. 30000
- 2-04-2016 Deposited into SBI Bank Account Rs. 40000
3-04-2016 Cheque received (Ch No. 7531) was deposited ₹ 30000
4-04-2016 Paid salaries by cheque (Ch No. 413) ₹ 15000
12-04-2016 Interest credited in the passbook ₹ 900
15-04-2016 Bank charges debited in passbook ₹ 350

Cheque No. 411 was presented in the bank on 30-04-2016. Cheque No. 7531 was cleared on 05-05-2016. But Cheque No. 413 is not yet presented to the bank.

7. Prepare a Bank reconciliation statement of Hrithika Traders, Karimpuzha, as on 30th June 2017

1-06-2017 Started business with cash ₹ 50000
Cash Deposited into Canara Bank ₹ 20000
Issued cheque No 12345 to Vincent ₹ 3000
Received a cheque (No 56789) from Abhijith ₹ 1000

5-06-2017 Cheque received from Abhijith Sent for collection
Paid rent by cheque (No 12346) ₹ 6000

On verification of cash book with passbook, it is found that cheque No 56789 was collected on 2-07-2017 and cheque no 12345 collected by Vincent on 1-08-2017.

8. Enter the given transactions in appropriate accounting vouchers and prepare the Bank Reconciliation Statement of M/s Vivekananda Stores Kalpetta as on 31/01/2017

01/01/2017 Capital introduced by the proprietor ₹ 100000
01/01/2017 Opened a bank Account with Federal Bank ₹ 50000
02/01/2017 Purchased goods by cheque (No. 1001) ₹ 15000
02/01/2017 Received cheque (No. 5001) from Sunita Traders ₹ 25000
02/01/2017 Issued a cheque (No. 1002) to Prasad and Co. ₹ 8000
02/01/2017 Withdrawn from bank for office use ₹ 22000

On comparison of cash book with the passbook the following details were obtained.

a) Cheque No. 1001 was encashed on 08/01/2017.
b) Cheque No. 1002 was encashed on 02/02/2017.
c) Cheque received from Sunitha Traders collected on 10/02/2017.
d) All other transactions effected in the Bank on the same date.
9. Create the following ledgers in an accounting software and display the balance sheet as on 01/04/2017.

<table>
<thead>
<tr>
<th>Description</th>
<th>Amount (₹)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capital</td>
<td>90000</td>
</tr>
<tr>
<td>Tools and equipments</td>
<td>40000</td>
</tr>
<tr>
<td>Sundry Creditors</td>
<td>50000</td>
</tr>
<tr>
<td>Bank Loan</td>
<td>55000</td>
</tr>
<tr>
<td>Land and Buildings</td>
<td>70000</td>
</tr>
<tr>
<td>Plant and Machinery</td>
<td>40000</td>
</tr>
<tr>
<td>Motor vehicle</td>
<td>75000</td>
</tr>
<tr>
<td>Sundry Debtors</td>
<td>50000</td>
</tr>
<tr>
<td>Outstanding Rent</td>
<td>3000</td>
</tr>
<tr>
<td>Cash in hand</td>
<td>30000</td>
</tr>
</tbody>
</table>
## APPENDIX

### Lab work-1

Create ledger accounts from the following transactions.

1-1-2017 Commenced business with cash ₹ 100000
3-1-2017 Purchased goods from Ayyoob on credit ₹ 20000
6-1-2017 Sold goods to Adwaith ₹ 10000

**Procedure:**

1. Open GNUKhata -
   - Applications → Office → GNUKhata
2. Create Organisation -
   - Click on ‘Create Organisation’ → Enter the necessary details → Proceed
3. Create Admin → Enter the details → Create & Login
4. Create appropriate ledger account as given in the table.
   - Master → Create account → Select Group → Sub group → Enter the Account name → Save

<table>
<thead>
<tr>
<th>Sl No</th>
<th>Group</th>
<th>Sub group</th>
<th>Name of Account</th>
<th>Opening Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Current Assets</td>
<td>Cash</td>
<td>Cash</td>
<td>----</td>
</tr>
<tr>
<td>2</td>
<td>Capital</td>
<td>None</td>
<td>Capital</td>
<td>----</td>
</tr>
<tr>
<td>3</td>
<td>Direct Expenses</td>
<td>None</td>
<td>Purchases</td>
<td>----</td>
</tr>
<tr>
<td>4</td>
<td>Current liabilities</td>
<td>Sundry Creditors</td>
<td>Ayyoob</td>
<td>----</td>
</tr>
<tr>
<td></td>
<td></td>
<td>for purchases</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Current Assets</td>
<td>Sundry Debtors</td>
<td>Adwaith</td>
<td>----</td>
</tr>
<tr>
<td>6</td>
<td>Direct Income</td>
<td>None</td>
<td>Sales</td>
<td>----</td>
</tr>
<tr>
<td>7</td>
<td>Indirect Expenses</td>
<td>None</td>
<td>Salary</td>
<td>----</td>
</tr>
</tbody>
</table>

5. Display Ledger Account
   - Report → List of Accounts

### Lab work-2

Following are the transactions extracted from the books of Hima Agencies, Elamkulam as on 31-12-2016.

2016 Jan 1 Started Business with Rs.1,00,000.
  Opened a bank account with Federal bank ₹ 50,000.
Jan 2 Purchased machinery of ₹ 20,000.
Jan 31 Purchased goods from Vincent Ltd. Rs.₹ 15,000.
Feb 1 Sold goods to Naseem ₹ 35,000.
Feb 2 Returned goods to Vincent Ltd. ₹ 1000
  Cash Sales ₹ 5,400
Feb 28 Returned goods by Naseem ₹ 500
Mar 1 Paid wages ₹ 2000
  Paid Rent ₹ 3,000
Mar 2 Commission Received ₹ 1500
Mar 3 Purchased goods for ₹ 15,000 and paid cheque for the same.
Mar 4 Withdrew cash from bank for office use ₹ 10000

1. Display the Trial Balance.
2. Show the cash balance.
3. Display the list of transactions by using ’Find/Edit Voucher’

Procedure :

1. Open GNUKhata
   Applications → Office → GNUKhata
2. Create Organisation
   Click on ‘Create Organisation’ → Enter the necessary details
3. Create Admin → Enter the details
4. Create appropriate ledger account
   Master → Create account → Select Group →Sub group →Enter the Account name → Save

<table>
<thead>
<tr>
<th>Sl No</th>
<th>Group</th>
<th>Sub group</th>
<th>Name of ledger</th>
<th>Opening Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Capital</td>
<td>None</td>
<td>Capital</td>
<td>-</td>
</tr>
<tr>
<td>2</td>
<td>Current Assets</td>
<td>Cash</td>
<td>Cash</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Current Assets</td>
<td>Bank</td>
<td>Federal Bank</td>
<td>-</td>
</tr>
<tr>
<td>4</td>
<td>Fixed asset</td>
<td>Plant &amp; Machinery</td>
<td>Machinery</td>
<td>-</td>
</tr>
<tr>
<td>5</td>
<td>Direct Expense</td>
<td>None</td>
<td>Purchases</td>
<td>-</td>
</tr>
<tr>
<td>6</td>
<td>Current liabilities</td>
<td>Sundry creditors for purchase</td>
<td>Vincent Ltd</td>
<td>-</td>
</tr>
<tr>
<td>7</td>
<td>Direct Income</td>
<td>None</td>
<td>Sales</td>
<td>-</td>
</tr>
<tr>
<td>8</td>
<td>Current Assets</td>
<td>Sundry Debtors</td>
<td>Naseem</td>
<td>-</td>
</tr>
<tr>
<td>Date</td>
<td>Account name</td>
<td>Voucher</td>
<td>Function Key</td>
<td>Dr/Cr</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------------------</td>
<td>---------</td>
<td>--------------</td>
<td>-------</td>
</tr>
<tr>
<td>01-01-2016</td>
<td>Cash Capital</td>
<td>Receipt</td>
<td>F4</td>
<td>Dr</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
</tr>
<tr>
<td>01-01-2016</td>
<td>Federal Bank Cash</td>
<td>Contra</td>
<td>F8</td>
<td>Dr</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
</tr>
<tr>
<td>02-01-2016</td>
<td>Machinery Cash</td>
<td>Payment</td>
<td>F5</td>
<td>Dr</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
</tr>
<tr>
<td>31-01-2016</td>
<td>Purchases Vincent Ltd</td>
<td>Purchase</td>
<td>F7</td>
<td>Dr</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
</tr>
<tr>
<td>01-02-2016</td>
<td>Naseem Sales</td>
<td>Sales</td>
<td>F6</td>
<td>Dr</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
</tr>
<tr>
<td>02-02-2016</td>
<td>Vincent Ltd. Purchase Return Cash</td>
<td>Purchase returns</td>
<td>Ctrl+2</td>
<td>Dr</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Sales</td>
<td></td>
<td>Cr</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>28-02-2016</td>
<td>Sales Return Naseem</td>
<td>Sales Return</td>
<td>Ctrl+1</td>
<td>Dr</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
</tr>
<tr>
<td>01-03-2016</td>
<td>Wages Cash</td>
<td>Payment</td>
<td>F5</td>
<td>Dr</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
</tr>
<tr>
<td>01-03-2016</td>
<td>Rent Cash</td>
<td>Payment</td>
<td>F5</td>
<td>Dr</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
</tr>
<tr>
<td>02-03-2016</td>
<td>Cash Commission</td>
<td>Receipts</td>
<td>F4</td>
<td>Dr</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
</tr>
<tr>
<td>03-03-2016</td>
<td>Purchase Federal Bank</td>
<td>Purchase</td>
<td>F7</td>
<td>Dr</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
</tr>
<tr>
<td>04-03-2016</td>
<td>Cash Federal Bank</td>
<td>Contra</td>
<td>F8</td>
<td>Dr</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
</tr>
</tbody>
</table>

5. Enter Vouchers (based on the table 5.9)

Voucher → Select appropriate voucher → Enter details

**Table 5.9 Details of Voucher**
6. Display Trial Balance
   Report → Trial Balance → Set date from & to date → Net Trial Balance → View

7. Display Cash Balance
   Report → Ledger → Cash → Uncheck Monthly Ledger (optional) → View

8. Display the list of transactions. (see figure 5.15)
   Voucher → Find/Edit Voucher → Select Criteria as Time Interval → Set from & to date → Search → View Printable Version

![List of Transactions for Period: 01-01-2016 to 31-12-2016](image)

Fig 5.15 Output

**Lab work - 3**

Prepare Profit and Loss Account and the Balance Sheet of Fidha Traders, Edappalam as on 31-03-2017 from the details given below:

**Balance Sheet as on 01-4-2016**

<table>
<thead>
<tr>
<th>Liabilities</th>
<th>Rs</th>
<th>Assets</th>
<th>Rs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creditors</td>
<td>24000</td>
<td>Cash</td>
<td>30000</td>
</tr>
<tr>
<td>Capital</td>
<td>150000</td>
<td>SBI</td>
<td>25000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Debtors</td>
<td>9000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Stock</td>
<td>10000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Furniture</td>
<td>30000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Machinery</td>
<td>70000</td>
</tr>
<tr>
<td><strong>Total Liabilities</strong></td>
<td><strong>174000</strong></td>
<td><strong>Total Assets</strong></td>
<td><strong>174000</strong></td>
</tr>
</tbody>
</table>
Summary of transactions for the year ending 31-03-2017 are given below:

1. Rent paid 5000
2. Salaries 3000
3. Wages 3000
4. Purchases 80000
5. Sales 100000
6. Interest received 1000
7. Closing stock 30000

**Procedure**

Steps:

1. Open GNUKhat - Applications → Office → GNUKhat
2. Create Organisation - Click on ‘Create Organisation’ → Enter the details
3. Create Admin - Enter the details
4. Create appropriate ledger account (except Opening Stock) - Master → create account → Select Group → Sub group → Enter the Account name → Save

<table>
<thead>
<tr>
<th>Sl No</th>
<th>Group</th>
<th>Sub Group</th>
<th>Name of ledger</th>
<th>Opening Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Capital</td>
<td>None</td>
<td>Capital</td>
<td>150000</td>
</tr>
<tr>
<td>2</td>
<td>Current Assets</td>
<td>Bank</td>
<td>SBI</td>
<td>25000</td>
</tr>
<tr>
<td>3</td>
<td>Current Assets</td>
<td>Sundry Debtors</td>
<td>Debtors</td>
<td>9000</td>
</tr>
<tr>
<td>4</td>
<td>Current Assets</td>
<td>Cash</td>
<td>Cash</td>
<td>30000</td>
</tr>
<tr>
<td>5</td>
<td>Fixed Assets</td>
<td>Plant &amp; Machinery</td>
<td>Machinery</td>
<td>70000</td>
</tr>
<tr>
<td>6</td>
<td>Fixed Assets</td>
<td>Furniture</td>
<td>Furniture</td>
<td>30000</td>
</tr>
<tr>
<td>7</td>
<td>Current liabilities</td>
<td>Sundry creditors for purchase</td>
<td>Creditors</td>
<td>24000</td>
</tr>
<tr>
<td>8</td>
<td>Indirect Expenses</td>
<td>None</td>
<td>Rent</td>
<td>--</td>
</tr>
<tr>
<td>9</td>
<td>Indirect Expenses</td>
<td>None</td>
<td>Salaries</td>
<td>--</td>
</tr>
<tr>
<td>10</td>
<td>Direct Expenses</td>
<td>None</td>
<td>Wages</td>
<td>--</td>
</tr>
<tr>
<td>11</td>
<td>Direct Expenses</td>
<td>None</td>
<td>Purchases</td>
<td>--</td>
</tr>
<tr>
<td>12</td>
<td>Direct Income</td>
<td>None</td>
<td>Sales</td>
<td>--</td>
</tr>
<tr>
<td>13</td>
<td>Indirect Income</td>
<td>None</td>
<td>Commission Received</td>
<td>--</td>
</tr>
</tbody>
</table>
5. Enter the amount of Opening Stock.
   a. Master → Edit Account → Stock at the Beginning → Click on Edit → Enter the amount of Opening Stock
   
   b. To transfer the amount of Stock at the Beginning as Opening Stock
      
      Click on F9 (Journal Voucher) and enter the details given below:

<table>
<thead>
<tr>
<th>Date</th>
<th>Account name</th>
<th>Voucher</th>
<th>Function Key</th>
<th>Dr/Cr</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>01-04-2016</td>
<td>Opening Stock Stock at the Beginning</td>
<td>Journal</td>
<td>F9</td>
<td>Dr</td>
<td>10000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
<td>10000</td>
</tr>
</tbody>
</table>

6. Enter Vouchers (based on the table given below) -

   Voucher → Select Appropriate Voucher → Enter the details

<table>
<thead>
<tr>
<th>Date</th>
<th>Account name</th>
<th>Voucher</th>
<th>Function Key</th>
<th>Dr/Cr</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>31-03-2017</td>
<td>Rent Cash</td>
<td>Payment</td>
<td>F5</td>
<td>Dr</td>
<td>5000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
<td>5000</td>
</tr>
<tr>
<td>31-03-2017</td>
<td>Salary Cash</td>
<td>Payment</td>
<td>F5</td>
<td>Dr</td>
<td>3000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
<td>3000</td>
</tr>
<tr>
<td>31-03-2017</td>
<td>Wages Cash</td>
<td>Payment</td>
<td>F5</td>
<td>Dr</td>
<td>3000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
<td>3000</td>
</tr>
<tr>
<td>31-03-2017</td>
<td>Purchase Cash</td>
<td>Purchase</td>
<td>F7</td>
<td>Dr</td>
<td>80000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
<td>80000</td>
</tr>
<tr>
<td>31-03-2017</td>
<td>Cash Sales</td>
<td>Sales</td>
<td>F6</td>
<td>Dr</td>
<td>100000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
<td>100000</td>
</tr>
<tr>
<td>31-03-2017</td>
<td>Cash Interest Received</td>
<td>Receipt</td>
<td>F4</td>
<td>Dr</td>
<td>1000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
<td>1000</td>
</tr>
<tr>
<td>31-03-2017</td>
<td>Closing Stock P &amp; L Account</td>
<td>Journal</td>
<td>F9</td>
<td>Dr</td>
<td>30000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
<td>30000</td>
</tr>
</tbody>
</table>
7. **Display Profit and Loss Account**
   Reports → Profit & Loss → Set From Date and To Date → View

8. **Display Balance Sheet**
   Reports → Balance Sheet → Set From Date and To Date → View → Show All Accounts

**Lab work - 4**

Prepare Profit and Loss Account and the Balance Sheet of Meenangadi Traders, Wayanad as on 31-12-2016 from the details given below:
Balance Sheet as on 01-01-2016

<table>
<thead>
<tr>
<th>Liabilities</th>
<th>Rs</th>
<th>Assets</th>
<th>Rs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capital</td>
<td>10000</td>
<td>Vijaya bank</td>
<td>30000</td>
</tr>
<tr>
<td>Irshad</td>
<td>10000</td>
<td>Robin</td>
<td>16000</td>
</tr>
<tr>
<td>Long term Loan</td>
<td>15000</td>
<td>Cash</td>
<td>20000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Machinery</td>
<td>20000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Furniture</td>
<td>8000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Building</td>
<td>31000</td>
</tr>
</tbody>
</table>

**Summary of transactions for the year ending 31-12-2016 are given below:**

1. Rent paid         8000
2. Salaries           4000
3. Wages              2000
4. Purchases          50000
5. Sales              75000
6. commission received 500

**Following Adjustments are to be made after closing the accounts.**

1. Closing stock     Rs.7600
2. Depreciate machinery @10%
3. Outstanding Wages Rs.500
4. Prepaid rent       Rs. 1000

**Procedure**

1. Open GNUKhata -
   Applications → Office → GNUKhata
2. Create Organisation -
   Click on ‘Create Organisation’ → Enter the details
3. Create Admin - Enter the details
4. Create appropriate ledger account (except Opening Stock) -
   Master → create account → Select Group →Sub group → Enter the Account name → Save
<table>
<thead>
<tr>
<th>Sl No</th>
<th>Group</th>
<th>Sub Group</th>
<th>Name of ledger</th>
<th>Opening Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Capital</td>
<td>None</td>
<td>Capital</td>
<td>100000</td>
</tr>
<tr>
<td>2</td>
<td>Current Assets</td>
<td>Bank</td>
<td>Vijaya Bank</td>
<td>30000</td>
</tr>
<tr>
<td>3</td>
<td>Current Assets</td>
<td>Sundry Debtors</td>
<td>Robin</td>
<td>16000</td>
</tr>
<tr>
<td>4</td>
<td>Current Assets</td>
<td>Cash</td>
<td>Cash</td>
<td>20000</td>
</tr>
<tr>
<td>5</td>
<td>Fixed Assets</td>
<td>Plant &amp; Machinery</td>
<td>Machinery</td>
<td>20000</td>
</tr>
<tr>
<td>6</td>
<td>Fixed Assets</td>
<td>Building</td>
<td>Building</td>
<td>31000</td>
</tr>
<tr>
<td>7</td>
<td>Fixed Assets</td>
<td>Furniture</td>
<td>Furniture</td>
<td>8000</td>
</tr>
<tr>
<td>8</td>
<td>Current Liabilities</td>
<td>Sundry creditors for purchase</td>
<td>Irshad</td>
<td>10000</td>
</tr>
<tr>
<td>9</td>
<td>Loans (Liability)</td>
<td>Unsecured</td>
<td>Long term loan</td>
<td>15000</td>
</tr>
<tr>
<td>10</td>
<td>Indirect Expenses</td>
<td>None</td>
<td>Rent</td>
<td>--</td>
</tr>
<tr>
<td>11</td>
<td>Indirect Expenses</td>
<td>None</td>
<td>Salaries</td>
<td>--</td>
</tr>
<tr>
<td>12</td>
<td>Direct Expenses</td>
<td>None</td>
<td>Wages</td>
<td>--</td>
</tr>
<tr>
<td>13</td>
<td>Direct Expenses</td>
<td>None</td>
<td>Purchases</td>
<td>--</td>
</tr>
<tr>
<td>14</td>
<td>Direct Income</td>
<td>None</td>
<td>Sales</td>
<td>--</td>
</tr>
<tr>
<td>15</td>
<td>Indirect Income</td>
<td>None</td>
<td>Commission Received</td>
<td>--</td>
</tr>
<tr>
<td>16</td>
<td>Indirect Expenses</td>
<td>None</td>
<td>Depreciation</td>
<td>--</td>
</tr>
<tr>
<td>17</td>
<td>Current Liabilities</td>
<td>Sundry creditors for Expenses</td>
<td>Outstanding wages</td>
<td>--</td>
</tr>
<tr>
<td>18</td>
<td>Current Assets</td>
<td>Loans &amp; Advances</td>
<td>Prepaid Rent</td>
<td>--</td>
</tr>
</tbody>
</table>

5. Enter Vouchers (based on the table given below) -
Voucher → Select Appropriate Voucher → Enter the details

<table>
<thead>
<tr>
<th>Date</th>
<th>Account name</th>
<th>Voucher</th>
<th>Function Key</th>
<th>Dr/Cr</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>31-12-2016</td>
<td>Rent Cash</td>
<td>Payment</td>
<td>F5</td>
<td>Dr Cr</td>
<td>8000</td>
</tr>
<tr>
<td>31-12-2016</td>
<td>Salary Cash</td>
<td>Payment</td>
<td>F5</td>
<td>Dr Cr</td>
<td>4000</td>
</tr>
<tr>
<td>31-12-2016</td>
<td>Wages Cash</td>
<td>Payment</td>
<td>F5</td>
<td>Dr Cr</td>
<td>2000</td>
</tr>
<tr>
<td>31-12-2016</td>
<td>Purchases Cash</td>
<td>Purchase</td>
<td>F7</td>
<td>Dr Cr</td>
<td>50000</td>
</tr>
<tr>
<td>31-12-2016</td>
<td>Cash Sales</td>
<td>Sales</td>
<td>F6</td>
<td>Dr Cr</td>
<td>75000</td>
</tr>
<tr>
<td>31-12-2016</td>
<td>Cash Commission Received</td>
<td>Receipt</td>
<td>F4</td>
<td>Dr Cr</td>
<td>500</td>
</tr>
</tbody>
</table>

199
6. Display Profit and Loss Account
   Reports \(\rightarrow\) Profit & Loss \(\rightarrow\) Set From Date and To Date \(\rightarrow\) View

7. Display Balance Sheet
   Reports \(\rightarrow\) Balance Sheet \(\rightarrow\) Set From Date and To Date \(\rightarrow\) View \(\rightarrow\) Show All Accounts

**Lab work - 5**

From the following, prepare final accounts of Tisha Electronics, Kannur

Balance as on 01-01-2016

<table>
<thead>
<tr>
<th>Name of Accounts</th>
<th>Amount (Dr.)</th>
<th>Amount (Cr.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opening Stock</td>
<td>10,000</td>
<td></td>
</tr>
<tr>
<td>Cash</td>
<td>2,20,000</td>
<td></td>
</tr>
<tr>
<td>Bank</td>
<td>40,000</td>
<td></td>
</tr>
<tr>
<td>Sundry Debtors</td>
<td>35,000</td>
<td></td>
</tr>
<tr>
<td>Bills payable</td>
<td></td>
<td>20,000</td>
</tr>
<tr>
<td>Bills Receivable</td>
<td>15,000</td>
<td></td>
</tr>
<tr>
<td>Sundry Creditors</td>
<td></td>
<td>40,000</td>
</tr>
<tr>
<td>Furniture</td>
<td>40,000</td>
<td></td>
</tr>
<tr>
<td>Land and Buildings</td>
<td>3,50,000</td>
<td></td>
</tr>
<tr>
<td>Capital</td>
<td></td>
<td>8,00,000</td>
</tr>
<tr>
<td>Vehicles</td>
<td>1,50,000</td>
<td></td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>8,60,000</strong></td>
<td><strong>8,60,000</strong></td>
</tr>
</tbody>
</table>

4-1- 2017  Purchased Machinery  60,000
9-1- 2017  Purchased goods     35,000
14-1-2017  Cash withdrawn from bank for office use  4,000
19-1-2017  Paid wages          3,000
22-1-2017  Sold goods Arshad   4,400
28-1-2017  Received rent       1,500
31-1-2017  Paid insurance      7,200
**Adjustment:**
1. Closing stock valued at Rs.22,000 as on 31-12-2017
2. Outstanding wages Rs. 500
3. Prepaid insurance Rs 2,000
4. Provide depreciation @ 10% on furniture.
5. Rent accrued Rs 1,000.

**Solution:**
Step 1: Open GNUKhata 
Applications → Office → GNUKhata
Step 2: Create Organisation 
Click on 'Create Organisation' → Enter the details → Proceed
Step 3: Create Admin 
Enter the details → Create & Login
Step 4: Create appropriate ledger account and enter opening balance 
Master → create account → Select Group → Select Sub group → Type Account name → Opening Balance → Save

<table>
<thead>
<tr>
<th>Group</th>
<th>Sub group</th>
<th>Account name</th>
<th>Opening Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>System generated account</td>
<td>----</td>
<td>Opening stock</td>
<td>---</td>
</tr>
<tr>
<td>Current assets</td>
<td>Cash</td>
<td>Cash</td>
<td>2,20,000</td>
</tr>
<tr>
<td>Current assets</td>
<td>Bank</td>
<td>Bank</td>
<td>40,000</td>
</tr>
<tr>
<td>Current assets</td>
<td>Sundry Debtors</td>
<td>Sundry Debtors</td>
<td>35,000</td>
</tr>
<tr>
<td>Current Liabilities</td>
<td>Bills Payable (Create new sub group)</td>
<td>Bills payable</td>
<td>20,000</td>
</tr>
<tr>
<td>Current assets</td>
<td>Bills Receivable (Create new sub group)</td>
<td>Bills Receivable</td>
<td>15,000</td>
</tr>
<tr>
<td>Current Liabilities</td>
<td>Sundry Creditors for Purchase</td>
<td>Sundry Creditors</td>
<td>40,000</td>
</tr>
<tr>
<td>Fixed Assets</td>
<td>Furniture</td>
<td>Furniture</td>
<td>40,000</td>
</tr>
<tr>
<td>Fixed Assets</td>
<td>Land</td>
<td>Land &amp; Buildings</td>
<td>3,50,000</td>
</tr>
<tr>
<td>Capital</td>
<td>None</td>
<td>Capital</td>
<td>8,00,000</td>
</tr>
<tr>
<td>Fixed Assets</td>
<td>Vehicles (Create new sub group)</td>
<td>Vehicles</td>
<td>1,50,000</td>
</tr>
<tr>
<td>Fixed Assets</td>
<td>Plant &amp; Machinery</td>
<td>Machinery</td>
<td>---</td>
</tr>
<tr>
<td>Direct Expenses</td>
<td>None</td>
<td>Purchases</td>
<td>---</td>
</tr>
<tr>
<td>Direct Expenses</td>
<td>None</td>
<td>Wages</td>
<td>---</td>
</tr>
<tr>
<td>Current Assets</td>
<td>Sundry Debtors</td>
<td>Arshad</td>
<td>---</td>
</tr>
<tr>
<td>Direct Income</td>
<td>None</td>
<td>Sales</td>
<td>---</td>
</tr>
<tr>
<td>Indirect Income</td>
<td>None</td>
<td>Rent Received</td>
<td>---</td>
</tr>
<tr>
<td>Indirect Expenses</td>
<td>None</td>
<td>Insurance</td>
<td>---</td>
</tr>
<tr>
<td>System generated account need not be created</td>
<td>Closing Stock</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>---------------</td>
<td>-----</td>
<td></td>
</tr>
<tr>
<td>Current Liabilities</td>
<td>Sundry Creditors for Expenses</td>
<td>Wages outstanding</td>
<td>---</td>
</tr>
<tr>
<td>Current Assets</td>
<td>Loans and Advance Insurance</td>
<td>Prepaid</td>
<td>---</td>
</tr>
<tr>
<td>Indirect expenses</td>
<td>None</td>
<td>Depreciation</td>
<td>---</td>
</tr>
<tr>
<td>Current Assets</td>
<td>Accrued Income (Create new sub group)</td>
<td>Rent accrued</td>
<td>---</td>
</tr>
</tbody>
</table>

Step 5: Enter Vouchers based on the table given below

Voucher → Select appropriate voucher → Enter details

<table>
<thead>
<tr>
<th>Date</th>
<th>Account name</th>
<th>Voucher</th>
<th>Function Key</th>
<th>Dr/Cr</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-1-16</td>
<td>Opening stock stock at the beginning</td>
<td>Journal</td>
<td>F9</td>
<td>Dr</td>
<td>10000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
<td>10000</td>
</tr>
<tr>
<td>4-1-17</td>
<td>Machinery Cash</td>
<td>Payment</td>
<td>F5</td>
<td>Dr</td>
<td>60000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
<td>60000</td>
</tr>
<tr>
<td>9-1-17</td>
<td>Purchases Cash</td>
<td>Purchase</td>
<td>F7</td>
<td>Dr</td>
<td>35000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
<td>35000</td>
</tr>
<tr>
<td>14-1-17</td>
<td>Cash Bank</td>
<td>Contra</td>
<td>F8</td>
<td>Dr</td>
<td>4000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
<td>4000</td>
</tr>
<tr>
<td>19-1-17</td>
<td>Wages Cash</td>
<td>Payment</td>
<td>F5</td>
<td>Dr</td>
<td>3000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
<td>3000</td>
</tr>
<tr>
<td>22-1-17</td>
<td>Arshad Sales</td>
<td>Sales</td>
<td>F6</td>
<td>Dr</td>
<td>4400</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
<td>4400</td>
</tr>
<tr>
<td>28-1-17</td>
<td>Cash Rent Received</td>
<td>Receipt</td>
<td>F4</td>
<td>Dr</td>
<td>1500</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
<td>1500</td>
</tr>
<tr>
<td>31-1-17</td>
<td>Insurance Cash</td>
<td>Payment</td>
<td>F5</td>
<td>Dr</td>
<td>7200</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
<td>7200</td>
</tr>
<tr>
<td>31-12-17</td>
<td>Closing Stock Profit &amp; Loss a/c</td>
<td>Journal</td>
<td>F9</td>
<td>Dr</td>
<td>22000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
<td>22000</td>
</tr>
<tr>
<td>31-12-17</td>
<td>Wages Wages outstanding</td>
<td>Journal</td>
<td>F9</td>
<td>Dr</td>
<td>500</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
<td>500</td>
</tr>
<tr>
<td>31-12-17</td>
<td>Prepaid Insurance Insurance</td>
<td>Journal</td>
<td>F9</td>
<td>Dr</td>
<td>2000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
<td>2000</td>
</tr>
<tr>
<td>31-12-17</td>
<td>Depreciation Furniture</td>
<td>Journal</td>
<td>F9</td>
<td>Dr</td>
<td>4000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
<td>4000</td>
</tr>
<tr>
<td>31-12-17</td>
<td>Rent accrued Rent Received</td>
<td>Journal</td>
<td>F9</td>
<td>Dr</td>
<td>1000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cr</td>
<td>1000</td>
</tr>
</tbody>
</table>

Step 6: Display Trial Balance
Report → Trial Balance

Step 7: Display Profit and Loss account
Report → profit and Loss account

Step 8: Display Balance Sheet
Report → Balance sheet
Unit 6

Database Management System

Key Concepts

6.1 Understanding and defining Database requirement
6.2 Creation of Database
6.3 Creating Tables
6.4 Creating a Database Form
6.5 Creation of Queries in LibreOffice - Base
6.6 Creating Reports in LibreOffice - Base

Introduction

We have come across the term database in various occasions. The following example will give you more insight on the concept of 'database'.

Your school intends to prepare a new identity card for plus one students.

- What are the particulars to be collected for this purpose?

Name of the student, date of birth, address, course pursued, admission number, so on and so forth.

The task of manual collection of data is lot more easy if 50 students each are enrolled in science, commerce and humanities course. Physical handling of data (addition, deletion and updating) will not be strenuous, since the volume of data is less. If these student data are consolidated, we can call this as data base of students.

Similarly, Government of Kerala is collecting the details of entire students of our State as part of school automation using Sampoorna Software. Such a huge volume of data when manually collected would consume much time, labour, money and storage space. Usage of computer assisted programmes can act as an effective tool to overcome the above limitations.
Application of computer software in storing, processing and retrieving of large quantity of data helps in managing the database effectively and efficiently.

Software packages like 'LibreOffice Base', 'MS Access', 'Oracle' are very popular in handling database. A student of commerce should definitely master the skill of maintaining database software. Here in this unit we learn about the database management using free and open source software tool 'LibreOffice-Base'.

6.1 UNDERSTANDING AND DEFINING THE DATABASE REQUIREMENT

Creation of student database for the purpose of automating the school system using 'Sampoorna Software' is a tedious process involving enormous amount of data. Here we need to address the question of how such a huge volume of data is stored and retrieved for present and future requirements in a desired manner. Creating a good database will fulfil the above requirements permanently. Database can be termed as an organised collection of data with formally structured entity - attribute relationships. While designing this database a clear understanding of the following is required.

- Type of data to be stored
  (Here the consideration is for data types and the kind of operations performed)
- Size and volume of data to be handled
- Type of users and their requirements
  (Users can range from individuals, firms, multinational companies and government organisations)
- Frequency of data mobility (i.e., data capturing, modification & retrieval)
- Type of data network used for data access (LAN/WAN).
- Data security requirements.
- Used as desktop database or server database
  (If volume of data and area of operation are limited then desktop database is preferred. Here the cost of data handling is negligible. Server database is preferred in case of handling data in large scale and which requires simultaneous updating of data by various users in a multiuser environment).

**Database:** A database is an organised collection of data. Data is always organised in data table consisting of rows and columns. It is indexed in such a way that the relevant information can be quickly and easily accessed, managed and updated.

6.1.1 Identification of data to be stored in TABLES

Keeping in view of the above requirements, data is collected and arranged in a logical manner on the basis of their characteristics. Individual data with similar features or characteristics is put in a single field. For example, one field is allotted to store the name of students and another field for his admission no and so on. From the above we can
conclude that a database consists of tables with various records and fields containing individual pieces of data. It is a collection of logically related records and files. This logical connection facilitates the integration of database.

Technological advancement expedited easier data handling, manipulation, storage and retrieval from the database using software. DBMS (Data Base Management System) software will help to organise data into database and facilitates its manipulation. LibreOffice offers very powerful DBMS software namely, Libre Office Base, which is robust and flexible.

Data Management System (DBMS): It is a software application that facilitates interaction with administrators, end users, other applications, and to the database itself to capture and analyse data. Usually DBMS allows the creation, storage, updation, and maintenance and administration of databases.

Try yourself

Your school is operating bus service for students. You are required to collect necessary data and organise them in different fields to take report using LibreOffice Calc.

6.1.2 Logical Structuring of data in TABLES

The above data collected as part of assignment can be arranged in a spreadsheet as shown in figure 6.1.

<table>
<thead>
<tr>
<th>Sl.No</th>
<th>Name of Student</th>
<th>Admn. No</th>
<th>Class</th>
<th>Sex</th>
<th>Place</th>
<th>Q1 Bus fee</th>
<th>Q1 bus fee collected</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Aneesh</td>
<td>3031</td>
<td>C1</td>
<td>M</td>
<td>Palakkad</td>
<td>1300</td>
<td>1300</td>
</tr>
<tr>
<td>2</td>
<td>Sunil</td>
<td>2056</td>
<td>H2</td>
<td>M</td>
<td>Malampuzha</td>
<td>1350</td>
<td>1350</td>
</tr>
<tr>
<td>3</td>
<td>Jaffer</td>
<td>2030</td>
<td>C2</td>
<td>M</td>
<td>Noorani</td>
<td>1250</td>
<td>1250</td>
</tr>
<tr>
<td>4</td>
<td>Simon</td>
<td>3040</td>
<td>S1</td>
<td>M</td>
<td>Kanjikode</td>
<td>1400</td>
<td>1400</td>
</tr>
<tr>
<td>5</td>
<td>Jaya</td>
<td>2035</td>
<td>S2</td>
<td>F</td>
<td>Palakkad town</td>
<td>1280</td>
<td>1280</td>
</tr>
<tr>
<td>6</td>
<td>Malu</td>
<td>3045</td>
<td>C1</td>
<td>F</td>
<td>Malampuzha</td>
<td>1350</td>
<td>1350</td>
</tr>
<tr>
<td>7</td>
<td>Kathu</td>
<td>2050</td>
<td>C2</td>
<td>F</td>
<td>Kanjikode</td>
<td>1400</td>
<td>1400</td>
</tr>
<tr>
<td>8</td>
<td>Sherin</td>
<td>3051</td>
<td>C1</td>
<td>F</td>
<td>Noorani</td>
<td>1250</td>
<td>1250</td>
</tr>
<tr>
<td>9</td>
<td>Lakshmi</td>
<td>2070</td>
<td>S2</td>
<td>F</td>
<td>Town stand</td>
<td>1200</td>
<td>1200</td>
</tr>
</tbody>
</table>

Fig 6.1 School Transport
Here the data is systematically arranged in columns (fields). Each column represents data having same characteristics. Similarly, values from each column corresponding to a particular row together constitute a record. (Figure 6.2)

<table>
<thead>
<tr>
<th>Sl.No</th>
<th>Name of Student</th>
<th>Admn. No</th>
<th>Class</th>
<th>Sex</th>
<th>Place</th>
<th>Q1 Bus fee</th>
<th>Q1 bus fee collected</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Anesh</td>
<td>3031</td>
<td>C1</td>
<td>M</td>
<td>Palakkad town</td>
<td>1300</td>
<td>1300</td>
</tr>
<tr>
<td>2</td>
<td>Sunil</td>
<td>2056</td>
<td>H2</td>
<td>M</td>
<td>Malampuzha</td>
<td>1350</td>
<td>0</td>
</tr>
<tr>
<td>3</td>
<td>Jaffer</td>
<td>2030</td>
<td>C2</td>
<td>M</td>
<td>Noorani</td>
<td>1250</td>
<td>1250</td>
</tr>
</tbody>
</table>

Fig 6.2 Record

In a database management system, the above information is stored in database in the forms of table having data fields and attributes. All details pertaining to an object is known as entity and each entity will have different features called attributes. In the above example, name of students, admission number, class, sex, etc. are the attributes of the entity School Transport. (Figure 6.3)

LibreOffice Calc allows the users to store large amount of data in one spread sheet. Inability to establish relationship between various spreadsheets and data redundancy may limit the scope of this application to serve as a better database when compared to major database applications. Unlike spreadsheet application, data can be swiftly arranged in different tables and relationships can be established between them in database application. Retrieval of information based on the needs and requirements of the end user is easily possible while using such application.

Would it not be convenient to store data in different tables rather than arranging the same in a single table? Let us see the above example. Certain components of the above table do not undergo frequent changes. Say for example, variables like name of the student, admission number, sex, class, etc. will not change intermittently. At the same time Quarter 1 bus fee, Fee collected etc may vary from quarter to quarter. So keeping one single table in a database will result in duplication of information, which may end up in consumption of large storage space inconvenience in handling data and may result in errors.
Instead of that we can design different tables like the one shown as in figure 6.4.

<table>
<thead>
<tr>
<th>Name of Student</th>
<th>Admn. No.</th>
<th>Class</th>
<th>Sex</th>
<th>Place</th>
<th>Fee_tbl (Table 2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aneesh</td>
<td>3031</td>
<td>C1</td>
<td>M</td>
<td>Palakkad</td>
<td>Voucher No. 1</td>
</tr>
<tr>
<td>Suriil</td>
<td>2056</td>
<td>H2</td>
<td>M</td>
<td>Malampuzha</td>
<td>Admn. No. 2056</td>
</tr>
<tr>
<td>Jaffer</td>
<td>2030</td>
<td>C2</td>
<td>M</td>
<td>Noorani</td>
<td>Quarter name 1</td>
</tr>
<tr>
<td>Simon</td>
<td>3040</td>
<td>S1</td>
<td>M</td>
<td>Kanjikode</td>
<td>Quarter fee 1</td>
</tr>
<tr>
<td>Jaya</td>
<td>2035</td>
<td>S2</td>
<td>F</td>
<td>Palakkad Town</td>
<td>1300</td>
</tr>
</tbody>
</table>

Fig 6.4 Student Table and Fee Table

The values in the first table will almost be static but data input is required more frequently in table 2. After creating different tables we can establish meaningful relationship between the above two tables, using a common identifier. In the above instance, Admn No.; can be a common identifier in both the tables. The common fields used to establish relationship between two tables are called the KEY FIELDS/Primary fields.

While observing student_tbl above, you can see that only one field with values are unique throughout this table. This unique value is ‘admission no. of the student’. The entire records can be identified or referred using this particular value. This is known as IDENTIFIER or PRIMARY KEY and each table must have one primary key. This primary key appears in the Fee_tbl also and is a FOREIGN KEY of that table defining the relationship between two tables.

You might have noticed that we have not given any fields for ‘Total dues outstanding’, ‘Total Fee collected in each quarter’ etc, in any of the tables. Data entry to these attributes is not required since these figures are derived by computing the same. Usually we generate these fields using Query.

Relational database: A relational database refers to a database in which data is stored in multiple tables. These tables are linked to one another through common fields. It consists of collection of schemas, tables, queries, reports, views and other elements. Suppose, a person seeking hotel rooms for stay in Munnar, over internet, gets a list of vacancy position. This is made available through relational data model designed typically to organise the data spread across at various locations in to a reality model that supports the process of seeking information.

Try yourself

(1) Design a database with necessary tables for preparing progress report of students in commerce.

(2) Design a database with necessary tables for household receipts & payments.
From the above example, you might be familiar in designing database structure. It’s time for us think in terms of integration of accounting information and computer database technology. Accounting can often use database for numerous processes like creating database of employees, payroll preparations, generating invoices, recording accounts receivables and payables as well as for tracking inventory.

"Is it possible to bring the example of student_transport mentioned above to an accounting perspective"?

There may be the following receipts and payments.

- Receipts - Bus fees collection, donations, contribution from PTA, teachers contributions etc.
- Payments may include repairs, wages to driver and other staff, fuel, insurance and tax, stationery, permit and fitness charges and consumable stores.

Considering all the above elements, the following tables are designed to suit our database requirements.

<table>
<thead>
<tr>
<th>Table Payment (table 3)</th>
<th>Total Receipts (table 4)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account code</td>
<td>Expense Name</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Fig 6.5 Receipts and Payments Table

After completing table designing, relationship between various tables has to be clearly defined.

6.2Creation of Database

Now let us see how this can be applied in a database application – LibreOffice Base.

The following path can be used to open the data base application

Applications → Office → LibreOffice Base

The ensuing screen will look like as follows. (Figure 6.6)

Fig 6.6 Database wizard window
1. This button is selected if the user intends to create a new database.
2. For opening an already created database, this option is useful.
3. This option is made use of to establish a Java Database Connectivity in an application programming interface.

“Create a new database” is the option for the user to create a new database and select “Next>>” button and subsequent screen will appear as shown in figure 6.7.

![Database Wizard](image)

**Fig 6.7 Creating a New Database**

Registering the database options and what we intend to do after saving need to be answered here.

1. By default, the radio button will rest upon this option as you can see in figure 6.7. Select this option for registering the database. Registering enables the user to avail this database in other applications like spreadsheet.
2. The database, if created only for one time purpose, then this option is more suitable. But user cannot import this database in other applications.
3. This check box will be selected by default. You can customise your database by creating necessary fields in tables.
4. Saving the table with this check box selected will provide access directly to the tables carrying predesigned templates for various database creations.

Now press **Finish** button and the application will take you to the next screen shown in figure 6.8.
Fig 6.8 Saving New Database

Name of the database, storage location, etc., can be specified in the above screen (figure 6.8). Creation of new folder is also possible at this time. Press save and Base application by default, will provide an extension **ODB** to all the files saved.

The above process reaches its culmination on saving the file, resulting in popping up a new screen.

Fig 6.9 Database Objects Window

You can see the objects of base listed on the left pane of the above screen (figure 6.9).
1. Tables: Table is the simplest form of data storage. It consists of data logically arranged in rows and columns.

2. Queries: It is used to extract, append and modify data from a database. SQL (Structured Query Language) is most widely used language to handle queries.

3. Forms: The interface that allows the user to input, retrieve and manipulate data.

4. Reports: Presenting the information stored in a database in the required format using queries.

6.3 Creating Tables

The Table component appears as the first option on the database panel on the left hand side of the base window as seen in figure 6.10.

![Fig 6.10 Table Component Panel](image)

Click on ‘Tables component’ in the panel. This provides three options in the Tasks panel and ‘Description window’ give an explanation for each options when we click on it.

i. Create table in Design View...: This option is used to create a table by specifying the field names and properties, as well as the data types.

ii. Use Wizard to create Table...: This option allows choosing from a selection of business and table samples, which we can customise to create a table.

iii. Create view.....: This option can be selected for creating tables and field names of our choice and the same could be made visible.

6.3.1 Creating Tables in Design View

Here we illustrate how one can create table in Design view.

Click on Create Table in Design View. This opens a Table Design window with four parts as shown in figure 6.11.
a. Field Name: Here enter the name of various fields you wish to create. Better to use standard and easy to catch abbreviations, as these may be very frequently used while querying with database. Example: Student Identity Number may be entered as STUD_ID.

b. Field Type: It describes the nature of data to be included in fields. There are different data types. Example: The field name STUD_ID may be defined in terms of data type as Text[VARCHAR]. (Extreme care should be shown while selecting data types as wrong definition of data types may render the whole data useless at a later stage)

c. Description: A very short description about the field name of data type may be given here, but not mandatory.

d. Field properties: This is used to define the properties or characteristics of field and its data types. If data type is selected then, only field properties will appear. Otherwise this area remains blank.

i. Entry required: Two options available (Yes/No). This field cannot have a Null value. Choosing ‘Yes’ makes input of data to this field mandatory while ‘No’ makes input optional.

ii. Length: Value entered here limits the maximum length/size permitted.

iii. Default value: Enter a default value here. At the time of actual data entry, this value will be automatically appearing in each new record for the field selected.

iv. Format example: It defines the “data display format”, i.e. the format in which the particular data should be entered as the value in the field. E.g. negative number, thousands separator, format code, alignment etc.
**Entering field names and selecting data types**

The figure 6.12 explains the steps to enter field names and data types.

**Fig 6.12 Field Names and Data Types**

Step i. Enter name of the field. E.g. STUD_SNO

Step ii. On entering field name, ‘Field Type’ tab becomes active. Click on navigation pointer of this field to get drop down list. Click to select the relevant data type. E.g. Text [VARCHAR]. At this point the Field properties panel in the bottom will also become active where property values can be changed.

a. Length: By default the format size is 100 for ‘Text’. It may be changed depending upon the field length or width. E.g. 40

b. Default value: If there is no default value for the field, leave it blank. For example, if most of the students are coming from a particular place, we may set default value for STUD-PLACE by giving the name of that place.

c. Format example: Data input format, if any, may be given.

Step iii. The cursor control moves to description field. A short description of the data or field name may be appended, but no matter even if it is left blank. To move next click ‘Enter Key’.

**6.3.2 Connection between Data Types and Field Content**

While entering field names at the time of table creation, we have to define the type of data to be entered in that field. This data type (field type) can be text, number, currency, date and time etc.
The different field types are listed as follows. (Figure 6.13).

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Field Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>STUDADMINNO</td>
<td>Text [ VARCHAR ]</td>
</tr>
<tr>
<td></td>
<td>Text [ fix ] [ CHAR ]</td>
</tr>
<tr>
<td></td>
<td>Number [ NUMERIC ]</td>
</tr>
<tr>
<td></td>
<td>Decimal [ DECIMAL ]</td>
</tr>
<tr>
<td></td>
<td>Integer [ INTEGER ]</td>
</tr>
<tr>
<td></td>
<td>Small Integer [ SMALLINT ]</td>
</tr>
<tr>
<td></td>
<td>Float [ FLOAT ]</td>
</tr>
<tr>
<td></td>
<td>Real [ REAL ]</td>
</tr>
<tr>
<td></td>
<td>Double [ DOUBLE ]</td>
</tr>
<tr>
<td></td>
<td>Text [ VARCHAR ]</td>
</tr>
<tr>
<td></td>
<td>Text [ VARCHAR_IGNORECASE ]</td>
</tr>
<tr>
<td></td>
<td>Yes/No [ BOOLEAN ]</td>
</tr>
<tr>
<td></td>
<td>Date [ DATE ]</td>
</tr>
<tr>
<td></td>
<td>Time [ TIME ]</td>
</tr>
<tr>
<td></td>
<td>Date/Time [ TIMESTAMP ]</td>
</tr>
<tr>
<td></td>
<td>OTHER [ OTHER ]</td>
</tr>
</tbody>
</table>

Fig 6.13 Display Field types

**Data Types in Base**

You might have noticed the following introduction screen when attempting to create a database. (Figure 6.14).

Fig 6.14 LibreOffice Base Introduction Screen

It is seen that the radio button embedded database “**HSQILDB Embedded**” is selected. What do you mean by this?

**HSQILDB (Hyper SQL Database)** is a relational database management system written in **Java**.

HSQILDB provides a rich set of data types to build our database.
### Meaning of Data Types

In Computer Programming, a data type is simply a classification of data. Data types define particular characteristics of data that we intend to store or manipulate. The data will be manipulated according to the type or definition based on its characteristics. For example, if Admission number of students is declared as “Text” type, then even though they are numbers, they cannot be subjected to mathematical calculations. If done so, it will return errors. Thus a clear understanding of various data types is very much essential while creating tables.

The following figure gives the classification of various data types. (Figure 6.15)

<table>
<thead>
<tr>
<th>Category</th>
<th>Data Type</th>
<th>Feature</th>
<th>Positive Numbers</th>
<th>Negative Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TINYINT</td>
<td>Smallest Integer type</td>
<td>1 to 256</td>
<td>-128 to 127</td>
</tr>
<tr>
<td></td>
<td>SMALLINT</td>
<td>up to 65,536</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>INTEGER (INT)</td>
<td>commonly used integer</td>
<td>up to 4,294,967,296</td>
<td>-2,147,483,648 to 2,147,483,647</td>
</tr>
<tr>
<td></td>
<td>BIGINT</td>
<td>rarely used</td>
<td>1,844,674,440,737 X 1019</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>DECIMAL</td>
<td>Unlimited Range</td>
<td>10 places with two decimals</td>
<td></td>
</tr>
<tr>
<td></td>
<td>NUMERIC</td>
<td>A max of 15 decimal places</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>REAL</td>
<td>Accuracy is not so good</td>
<td>more precise calculations and better rounding</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>VARCHAR</td>
<td>Variable or character</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>VARCHAR_IGNORECASE</td>
<td>A case insensitive version of VARCHAR.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>CHAR or CHARACTER</td>
<td>A fixed size text field. If the text does not fill all the space, the text is padded with spaces.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>LONGVARCHAR</td>
<td>Designed for large blocks of text</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>DATE</td>
<td>Format is YYYY-MM-DD</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>TIME</td>
<td>Format is HH:MM:SS</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>TIMESTAMP or DATETIME</td>
<td>A combination of both the date and the time</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>BOOLEAN or BIT</td>
<td>For NULL state, TRUE and FALSE states</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>BINARY, VARBINARY, LONGVARBINARY</td>
<td>For storing binary data like images</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

![Fig 6.15 Classification of Data Types](image)

### 6.3.3 Setting Primary Key

After entering all field names for the table under creation, we have to assign one field as primary or key field. To set primary key, follow the steps described below.

**Step i.** Select and right click on the empty box just to the left of the name of the field you wish to define as primary field. Now a popup menu appears (figure 6.16) with the desired option.

**Step ii.** Select and click on the “Primary Key” option available on the popup menu. Now the primary key symbol will appear in the empty area against the name of the field to which primary key has been set.
Saving the Table

After entering the field names and selecting relevant data types, save the table. To save press Ctrl+S or click on the Save button on the left top corner of the Tool bar.

The default table name in Base is ‘Table1’. You can save the table with another name tblSTUDENT.(Figure 6.17)
Similarly, the next table for bus fare, i.e. ‘tblBUSFEE’ has to be created, with the following fields.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description of the field</th>
</tr>
</thead>
<tbody>
<tr>
<td>FEE_SLNo</td>
<td>Receipt No of fees collected from students</td>
</tr>
<tr>
<td>STUD_ADNO</td>
<td>Admission no of the students</td>
</tr>
<tr>
<td>QUARTER_NAME</td>
<td>Name of each quarter must be specified</td>
</tr>
<tr>
<td></td>
<td>Eg. Quarter1, quarter 2 etc.</td>
</tr>
<tr>
<td>QUARTER_FEE</td>
<td>Amount of fees in each quarter</td>
</tr>
</tbody>
</table>

The field names and corresponding data types must be entered. The primary key is assigned as FEE_SLNO. Now the table will look like as follows (Figure 6.18).

![Fig 6.18 Create Table]

Save the file by giving the name tblBUSFEE. (Figure 6.19).

![Fig 6.19 Saving Fees Table]
After table creation, the table will be listed in the table panel which is shown in Figure 6.20.

![Table Panel](image)

**Fig 6.20 List of Table Created**

You can click on the file name of tables to open table. A table when opened will look like as seen in Figure 6.21.

![Table Data View](image)

**Fig 6.21 Table Data View**

We can enter data directly into the fields of this table. See the figure 6.22.

![Table With One Record](image)

**Fig 6.22 Table With One Record**

### 6.3.4 Defining relationships

Relationship allows database to split and store data in different tables and provides linkage to different data items. **Relationships** (connections) between tables are made through
primary keys and on the principle of field equality. Tables are connected in order to make queries, reports and forms with data located in multiple tables.

How can we create relationship between two tables ‘tblSTUDENT and tblBUSFEE’?

As we know that first table holds student details like name, address, place etc. While the particulars of bus fee are entered in the second table.

- How do we know whether a particular student (first table) has paid the fees (second table) or not?

This question can be answered if relationship between these two tables can be established. How can this be done?

The primary key set for the tblSTUDENT is ‘STUD_ADMNO’ and for tbl BUSFEE is ‘FEE_SLNO’. Another field is created in the tblBUSFEE table as ‘STUD_ADNO’ to hold the values of primary key values of first table. This provides a reference between two tables. In this case the primary key of the first table will be the FOREIGN KEY of second table. Here student admission number is the common identifier used in both the tables. Here it is not necessary to use the same field name in the two tables but ensure that the data type is the same.

The following path allows you to define relationships (Figure 6.23).

Tools > Relationships

![Fig 6.23 Relationship Option](image)

The relationship menu contains the following buttons (Figure 6.24).

![Fig 6.24 Add/Edit Relationship](image)

On clicking the Relationship option, the ‘add tables’ window appears as in figure 6.25. The Add Tables dialogue box will open in which you first select the name of the table and then press the Add button to add the tables which are to be displayed within the Relationship pane.
Fig 6.25 Adding tables to form Relationship

Use any of these ways to add a table to the Relation design window:

- Double-click the name of the table. In our case, do this for both the tblSTUDENT and tblBUSFEE.
- Or, select the name of the table and then click Add for each table.

A relationship can be created via the drag and drop method by following the given steps.

1. Position the cursor over the STUD_ADMNO field, which is the primary key of the tblSTUDENT.
2. Press and hold down the left mouse button, and drag it to the STUD_ADMNO field in the tblBUSFEE table, and then release the mouse button, then a connecting line forms between the two fields.
3. The Relations dialog box will open up;
4. Press the Ok button to create a relation. (Figure 6.26)
6.3.5 Editing and Deleting Relationships

The relationship created can be deleted by taking the 'EDIT' option. The path is  
Tools → Relationship → Edit  
- Right click on the line connecting between STUD_ADMNO and STUD_ADNO resulting to a popup menu.  
- Select 'Edit' option to open 'relation window'  
- Editing is possible in the relation window by changing over to the required fields from the 'fields involved' option.  
- Delete option will permanently erase the relationship by selecting the line and press delete button.

**Let's assess**

1. What do you mean by the term 'objects of database'?
2. List out the attributes of the entity - 'Voucher'.
3. .............. is used to retrieve information from a database.
4. SQL means ............
5. The datatype of 'Age' is .............

6.4 Creating a Database Form

Right now we have created tables and defined their relationships. We have learnt that Databases are used to store data. Tables help in organising the collection of data in a structured manner on the basis of data types. But, how is data, put into the database tables? Forms are used to do this. Forms help us to populate these tables swiftly while minimizing errors in data entry. A form is a front end interface for data entry and editing.

Forms can be simple form as well as complex forms

i) Simple Form is one which consists of fields from a single table.

ii) Complex Forms are those consist of text, graphics, selection boxes and many other elements in addition to fields from many tables.

On the Base document we can see the component “Forms” on the left pane. In order to activate it click on the button “Forms” and task panel brings you two options.

- Create Forms in Design View
- Use Wizard to Create Forms.
Let us discuss these two methods of creating forms.

6.4.1 Use Wizard to Create Form

It is the simplest and user friendly method of creating Forms. Click on the 'Use Wizard to Create Form' in the task pane. A form wizard pops up.

From figure 6.28 we can see the Form Wizard is organized in two columns.

The first column (left panel) is located in the left part which contains eight sequential steps that the wizard will go through. At the same time the second column (right panel) contains list of tables and queries and options from where you can pick available fields.
The following sequence is initiated for form creation.

1. **Field Selection**

   The Field Selection window is given in figure 6.29. The form can be created either with tables or queries.

   ![Fig 6.29 Field Selection Window]

   - Select the table - tblSTUDENT. Now all the fields of this table will be populated in 'Available Fields' option (See (1) above)
   
   - Select the field you intend to have in the form by simply clicking it from the populated list. (See (2) above). Then click 'single right arrow' button to move this field to be the part of form.
   
   - The application provides an option for "select or deselect" arrow buttons (3).
     
     Single right arrow  - Moves fields one by one
     
     Double right arrow - Moves all the fields at once to the form list
     
     The left arrow buttons will reverse the above process.
   
   - Click ‘Next’.

2. **Add Subform**

   A subform is a form used to show or enter data in another tables or queries. Giving affirmation in the check box concerned allows you to add subforms, if any, to be used along with the main form. Click 'Next' button if you don't need subform. If 'Add sub form' check box is not selected then the ensuing steps ( ‘3’ and ‘4’ mentioned below will be skipped).

3. **Add Subform fields**

4. **Get joined fields**

   (Adding a sub form will be discussed later in this unit).
5. **Arrange Controls**

The controls in a form are meant to arrange label and field of the main form and sub forms. How do you want your form to look like and feel will be answered here. Different lay outs are readily available - ‘Columnar: Labels on left’, ‘Columnar: Labels on top’, ‘As Data Sheet’, and ‘In Blocks’. You can make a selection from this layout and proceed to the next screen.

![Arrange Controls Diagram]

**Fig 6.30 Arrange Controls**

In this example, Columnar: Labels Left is selected. Then click 'Next'. See figure 6.30.

6. **Set Data Entry**

See figure 6.31. The mode of data entry is selected here. Two options are available at this point.

- Option for new data entry only. Existing data will not be displayed.
- The second option displays all data.

Depending on whether the boxes are checked or unchecked, it sets privileges to modify, delete or add data.

![Select Data Entry Mode Diagram]

**Fig 6.31 Selecting Data Entry Mode**
If you don't want to create restrictions about the use of data, accept default settings: This form is to display all data, with no restrictions. To move to the next screen click ‘Next’.

7. **Apply Styles**

This step allows choosing the background colour and border for the form, from various colour styles and borders available by default. (Figure 6.32)

Also select the Field border you want (For our form choose the 3-D look.) and click ‘Next’.

8. **Set Name for the Form**

Suitable name can be given to your form in this step. The default name of the form will be same name of the table (tblSTUDENT). Name can be changed by entering a new name- ‘frmSTUDENT’ in the field and click ‘Finish’.

On clicking the ‘Finish’ button the form created will be displayed automatically. See figure 6.33.
6.4.2 Modifying the form

Modifying the form implies changing the styles, appearance, labels or setting field properties, adding fields, buttons, controls, list box, combo box, etc. In the above form, label names displayed will be the same field names given while designing tables. They need to be user friendly or understandably described. For example, the label "STUD_ADMNO" will convey no meaning at all. It will give right sense when label is changed as "Admission No." or "Enter Admission No."

a) Modifying Labels and Fields

See in figure 6.34. In order to modify a form, open it in Design Mode. For this, select the name of the form and right click on it to get the option “Edit...”. Clicking on “Edit” opens the form in Design mode. Modification to forms is permitted only under Design Mode.

Follow the steps given below the figure to modify the labels and fields of a ‘form’.

![Fig 6.34 Selecting labels and fields.](image-url)
• On clicking the label or fields, the entire control is selected.
• A green border appears around the control with eight handles (see fig 6.34).
• We can then drag and drop it anywhere in the form
• Use Ctrl+click to select only the label or field at a time
• Tab key is used to toggle between field or label for selection.
• Use Ctrl+Shift+Click to select more than one labels or fields at a time

To change label name, follow the steps given below the figure. Let us see how the label name STUD_ADMNO is changed to 'Admission No.' (Figure 6.35).

![Figure 6.35 Changing labels using properties window](image)

• Press Ctrl and click on label "STUD_ADMNO" (as seen in (1) above)
• Right click on label to select "Controls" from the pop up menu. (as seen in (2) above)
• A properties window is opened.
• Type "Admission Number" in the text box of label name (as seen in (3) above)
• Similarly all label names can be changed in the same manner narrated above.

Properties window: Properties window provides a set of property values assigned for labels or fields. This can be properties of the form as well as that of its various components. It displays properties of the currently selected individual item or multiple items, as the case may be. For labels it has two Tabs: General and Events. For Fields it will have three Tabs: General, Data and Events.

b) Changing Fonts, Font size, etc.

Font and font size of labels can be altered by changing label properties relating to Font in the Properties window (Figure 6.36).
- Open the 'Property dialogue box' by initiating the earlier steps mentioned in the case of altering label name.
- Move scroll bar down to locate Font properties (see (2) below)
- Click on the box with three dots on the extreme right to the font name to expand "Character" window. (see (3) below)
- Select the required font type (see (4) below) and desired font size (see (5) below)

Fig 6.36 Changing Font and Font Size

c) Align Labels and Fields
Labels and fields in the form can be aligned to right, left or, centre or bottom. For this, use multiple selections for labels or fields (Figure 6.37).
- Select the field or fields to be aligned or arranged
- Keeping selection active, right click to get the option "Align". When mouse pointer moves over "Align", various align options will be visible. Select the desired align option.

Fig 6.37 Align Control
d) Giving Heading to the Form

For making the form meaningful and attractive, suitable 'heading' may be assigned. Let us see how the 'students data entry form' is given as label heading. (Figure 6.38)

- Activate the label field tool from the tool bar by clicking on it.
- Drag and draw a box by clicking and holding down the mouse pointer.
- Right click on the green border and select 'control' option from the popup menu.
- On the General Tab of the label property window, click in the text box against label and type the title "Students Data Entry Form"
- Scroll Down to label Font property. Click to expand font window and select font type and desired font size.

e) Entering Data in to tables through Form

Now let us try to enter data using form.

- Open the form, ‘frmSTUDENT’ and enter the first student's details as shown in the figure 6.39.

![Students Data Entry Form](image)

- After entering details of the first student, we can see that tblSTUDENT contains one record, which is as follows (Figure 6.40)
• When more student details are entered, table tblSTUDENT will get appended.

f) Record Navigating and Editing

We can move through various records saved in the table using Form. Base Form provides record navigation tools with which we can locate any record and make modifications in data. See the figure 6.41.

![Students Data Entry Form]

Fig 6.41 Record Navigation Control

The important controls are described below:

1. Find Record : Searches a record based on criteria
2. First Record : Moves to first record in the table
3. Previous Record : Moves to the just previous record
4. Next Record : Move to the next record
5. Last Record : Moves to the Last record
6. New Record : To enter data for a new record
7. Saving Record : Saves the last changes done in a record
8. Delete Record : Deletes the currently selected records
9. Sort Record : Sorts all records within the data table
10. Filter Record : Used to filter records

6.4.3 Create Form in Design View

Creating a form using design view is discussed here. This method is not easy when compared to Wizard method. Choose the option - 'Create form in Design View' by clicking on it.
Now a form design window appears. Working with form creation under this method is not user friendly. Here we have to add labels and fields by ourselves. Similarly connection between form, tables and fields etc., are to be set carefully using 'Controls'. However this method may be illustrated in the creation of 'tblBUSFEE' table.

A blank Form creation page will come up. Few important 'controls' are familiarised in the given figure 6.42.

![Image of Form Creation Screen Design View](image)

**Fig 6.42 Form Creation Screen Design View**

The following steps will guide you in the process of table creation using design view.

**a) Enter a Title to the Form**

For giving a suitable title to the form - 'Bus Fee Entry Form' the procedure listed below need to be followed.

- Click on Label Field
- Now a green border appears around the control with eight handles.
- Drag and drop at the top of the form
- Right click → 'Select Control' → label properties appear
- Label → "Bus Fee Entry Form"
- Font → Change Font type and size (Broadway, Regular, 20)

**b) Connecting Table with Form**

It should be noted that the form has no connection with the tables so far. Data entered through the form will not be added in the table unless connection between table and form
is established. When connection is successfully established, field names of the table will be available in the form control properties box. To connect a table, follow the procedure described below.

i. Click on the Form Tool

It opens Form Properties Window. (Figure 6.43)

![Fig 6.43 Form Properties Window](image)

It has three Tabs: General, Data and Events.

ii. Click on Data Tab

iii. Content type: Table

iv. Content: Click in the ‘more’ button on the right side of the field box to get list of tables. Select the table - tblBUSFEE

**Adding fields and labels:** As we know tblBUSFEE has four fields. In order to input data in to field some text boxes are to be added to the form.

So these fields are to be added to form. For this we can use different methods such as adding field labels and text boxes or using add field tool, etc. (Figure 6.44). Form creation using the handy method “Add Field” is narrated here. The “Add Field” tool can be seen in the right side of bottom tool bar.

![Fig 6.44 Add Field Button](image)

Click on Add Field tool to open add field window.

To add a field to form select and double click on field name. (Figure 6.45)
Fig 6.45 Field Insertion

If necessary we can change labels, align, resize, font type and size of all labels and fields. Press Ctrl+click to select single label or field to be changed. (Right click → Group → Ungroup). This is an alternate method to select single label or field.

To rename follow the steps given below:

- Right click → Controls → Label → Rename labels as:
  - FEE_SLNO as “Payment Sl.No”
  - STUD_ADNO as “Admission No”
  - QUARTER_NAME as “Name of Quarter”
  - QUARTER_FEE as “Quarter Fee”

(c) Setting Properties for Fields

We have already seen that merely adding data field to form will be of no use as it cannot find the destination field where data has to be saved. This problem can be solved by defining properties of the field. Properties are set in the following manner.

- Press Ctrl+Click to select the field we want to assign properties
- Right click → Controls → Data Tab
- Data Field → FEE_SLNO (Click inside data field to see available fields and select)
- Do the same work for the remaining fields.

Fig 6.46 Connecting Form Field to Table Field
Alternative Method:

Another way to set properties is to use Form Navigator in the Tool bar(Figure 6.47).

Click and select Form Navigator. This will open Form Navigator window as seen below (Figure 6.48).

- Each of these elements are iconised based on their type
- Right click on field name to get properties
- Click on Data Tab
- Data Field: Click inside data field to get available fields and select the one required

d) Adding List Box

A list box helps to select a value from among a list of values, by limiting erroneous entries. The List Box tool can be seen in the tool bar on the left side.

Click on the list box tool. On selection, the mouse pointer changes to plus sign(+), click and drag on the desired place to form a rectangular like area and release the mouse button.
On releasing the mouse button, a "List box Wizard" will pop up (Figure 6.49) and follow the screen instructions.

![List Box Wizard](image)

**Fig 6.49 List Box Wizard**

- Select the display field: The field that contains values to be displayed in the List Box. In our example field STUD_ADMNO of table tblSTUDENT must be selected. This field has admission numbers to be displayed (Figure 6.50).

![Selecting Display Field in List Box](image)

**Fig 6.50 Selecting Display Field in List Box**
The contents of the selected field will be visible in the List Box. Next screen of the wizard asks for field from the Value Table and field from the List Table. Field from the Value table is the field to receive or get value. Field from the List Table is the field that passes value to Value table.

Fig 6.51 Connecting Value Table and List Table
Pressing 'Finish' button will take you to the form you have created. Now the List box will display admission number based on student records, added in the table tblSTUDENT.

Fig 6.52 Selecting from List Box
Creating tables for the list box

Now let us discuss about Simple List Box and its creation. When entering data it is easier to select a value from a list. Here we are trying to enter a fixed value from the list and choices are made from it while entering a particular record using forms. The user is limited to the choices given in list box and it is not possible for him to give a value of his own.

For example, if the list box holds values such as- quarter 1, quarter 2, quarter 3 and quarter 4, then the user is limited to select these four options only. He cannot input data other than what is stated in the box. The process of list box creation is explained below.

- Click on the list box tool. On selection the mouse pointer changes to plus sign (+), click and drag the mouse pointer against the "Name of Quarter" field and release the mouse button.
- A List box wizard will appear prompting to select a table from list of tables. Click cancel. (Do not add any table at this point)
- Now green border appears around the List Box with eight handles.
- Right Click→Control→Data Tab
  - Data Field→Click and select field QUARTER_NAME
  - Input Required→Yes
  - Type of List Contents→Click and select Valuelist.
  - List Content: Click in the box and type Quarter 1 and press Shift+ Enter Key to type other values. Press Enter Key at the end.
  - General tab→List Entries→click and type four options inside. For each option press Shift+Enter key, and for the last option press Enter key only.
  - Save and close the wizard.
  - Switch the design mode off and see the changes reflected.

Try yourself

Create a LibreOffice Base small pro template to Create Account Groups under the following Primary Groups
1. Assets
2. Liabilities
3. Capital
4. Expenses
5. Revenue
(Hint: Current Asset group can be created under the primary Group Assets.) Create necessary table to contain the records added.)
6.4.4 Working with Sub Forms

A sub form is a form inserted into a Main Form, which works together with it. Sub Forms are used to input data into tables or show data from table or queries with one-to-many relationships.

(a) Creating subforms to view / show data

You know that form frmBUSFEE is used to enter receipts of bus fees. While entering details of fees of students in different quarters, we may like to view the details of these students like name, class, place, etc. Sub form provides an opportunity to view such details within the Main Form. The form so inserted is linked with table tblSTUDENT which contains such details. The procedures for sub form creation are illustrated as follows; (Figure 6.53).

- Create a main form
  - Forms → Use Wizard to create Forms
- Select table tblBUSFEE for the Main Form and add fields
  - Table or queries → Available Fields >> ADD fields
    - Fig 6.53 Adding Fields to The Main Form
- Put tick mark in the check box ‘Add Subform’
- Decide the type of selection of fields
  - Select sub form based on existing relation, if you wish to add fields, using wizard
  - Select sub form based on manual selection of fields, if you wish to add fields manually.
- Add sub form field selection
  - Select the table or queries for the subform
  - Select available fields to be included in subform
- Available fields >> ADD fields. See the figure 6.54.
Fig 6.54 Adding fields to the Main subform

- Select joins between sub form and main form
- Connect first joined field of the sub form with first joined field of the Main Form. (Figure 6.55)

Fig 6.55 Joining fields

- Arrange controls: Select Main Form as Columnar-Left and Sub Form as Data Sheet (other controls may also be opted)
- Select the data entry mode: whether the form is to enter new data or display existing data.
- Apply style by selecting any one from the style palate: select Light Gray.
- Set Name: Give a name to the form. Type the name frmBUSFEEsub1 and save. (You may open the form in design mode (Edit Form) and change labels and alter properties for font, size, colour etc.)
- You can use record pointers to move across various records. On selection of a particular record in the main form, its associated data will be displayed in the sub form. This can be seen from the figure 6.56.

Fig 6.56 Working of a Subform to Show Data
Similarly, if we create a form with sub form to display details of fees paid, it may look like the one given below. It may display fees details when name is given.

![Subform to display data](image)

(b) **Subform to Input Data**

Sub form within a main form can be used to input data. Initiate the following steps to input data using a sub form.

- Select 'tblSTUDENT', to set up a subform
- Put a tick (√) mark in the check box "Add Subform", which will activate steps 3 and 4 namely 'Add Sub form fields' and 'Get Joined Fields'
- Select the table 'tblBUSFEE' to make 'field selection' and 'Get joined fields connected'
- Select both the lay out "columnar label on left, fields right" for 'arrangement of the main form' and 'arrangement of sub form'
- Select the option for new data entry
- Apply necessary styles and save the form
- Open the form in Design mode to change labels, align text boxes, etc.
- Switch off 'Design mode'

Now the form will be ready to accept data we input and all tables will be updated instantly.

**Push Buttons**

In the context of LibreOffice form, a push button is a visual representation of a button that executes a task when clicked or pressed. There will be some instructions attached to these buttons. On execution of these instructions it will perform a specific task. For example, to close a file we may press on "Close" button, to save "Save" button and so on.
The Push Button option is available in the tool bar menu as seen below.

![Push Button](image)

In order to select a push button, click on the push button tool, then drag and drop it on the form. Now the mouse pointer turn to a plus sign (+), which allows us to draw required number of buttons in the form (Figure 6.58).

![Fig 6.58 Inserting push button in a form](image)

We can select these push buttons, move and place them on any part of the screen. Right clicking on the selection gives us next level options to align, arrange and wrap them.

You may open, control properties to change label and set properties and assign controls (Figure 6.59).

![Fig 6.59 Changing Labels of Push Buttons](image)

**Defining Action for Push Button**

Once the button is placed on the form screen, we should be able to execute the task when this button is pressed. Let us see how we can make this button work.

- Select a push button
- Right click→Control→General Tab→Action (scroll down to see action in list properties box)
• Click in the ‘v shaped button’ against the action property to get available list of actions to perform and click to select the one we want to assign (Figure 6.60).

![List of Executable Action](image)

**Fig 6.60** List of Executable Action

In this way, we can set or change properties for each button.

![Data Entry Form with Push Button](image)

**Fig 6.61** Data Entry Form with Push Button

**Check Box**

A check box is a small square box that can be placed on a form which allows user to show a choice and input that choice to a data field. It is alternatively called a selection box or a tick box. The check box tool can be picked from tools menu.
Setting properties

- Right click → Control.
  - General Tab → change general properties such as label, font, colour, height etc.
  - Data Tab → set field properties.
- Data Field: specify the name of field which should hold the selected value.
- Input required: Yes
- Reference value (on): If a reference value is given, that value will be displayed at the time when the box is checked, and the value will be transferred to data field. If no reference value is given, the box when checked will return the value "true", and unchecked box will return "false".

Option Buttons/ Radio Buttons

Option buttons offer the user a set of mutually exclusive options. It means that the selection of one option automatically rejects all others. The user can select only one option. The
advantage of using radio button is that the selected option will be entered to the corresponding column of the table. For example radio button may be provided for selecting sex of a student (Male /Female). When several option buttons in the form are linked to the same table field, only one of the options can be selected. The properties are set in the same way we have set properties for a check box.

**Try yourself**

Create a LibreOffice Base Form template to Create Accounting Vouchers (Voucher Entry Forms)
- Sales Voucher
- Payment Voucher
- Purchase Voucher
- Receipt Voucher

The Voucher should contain controls to select date, debit and credit accounts (add list box to pick up account names), and text boxes to enter debit and credit amount, and a field to add narration.

Add Push button in a Main Form to load Voucher Entry Forms.

<table>
<thead>
<tr>
<th>Receip Voucher</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payment Voucher</td>
</tr>
<tr>
<td>Sales Voucher</td>
</tr>
<tr>
<td>Purchase Voucher</td>
</tr>
</tbody>
</table>

**Let's assess**

1. What is a sub form?
2. ............ is used by the front end user to enter data.
3. You can enter data using sub form - (Yes/No)
4. What is a list box?
5. What are the uses of push buttons?

**6.5 Creating queries in LibreOffice Base**

A Query is a question asked or enquiry sent to a data base to bring together data from different tables, calculate results, and quickly filter any mass of data. More often query results can be a data source for forms and reports.

A database query can be either a select query or an action query. A select query is used to retrieve data while an action query is used to do some specific operations on the data, such as arithmetic operations, insertion, updating, deletion etc.
6.5.1 Creation of Queries Using Wizard

Queries can be created with the help of Query Wizard or in Design View. These options can be found in the Database pane on the main window of our database. The procedures for creating query using wizard are illustrated below (We can use the tables we have already created).

- Open the Query Wizard by clicking on "Use Wizard to Create query"

Fig 6.64 Create query options

- Select the table tblSTUDENT and add required fields.

Fig 6.65 Adding Fields to Query

- Select the sorting order: Here the query sorts the data on the basis of the field priority we specify.
Select the search conditions: This window allows you to specify a field to be searched, a search condition and a value.

Specify the type of Query:
- Detailed Query: Show all records of the query
- Summary Query: It will display results of aggregate functions we specify

If Summary Query is opted, then we will get two more options, namely, Grouping and Grouping conditions as the 5th and 6th steps.

Alias: If desired, alias name for each field may be given here.

Overview: This window contains the following:
- Name of the Query: Give a name to save the query.
- It also provides an overview of steps done at this point.
- It also provides options to Display Query or Modify Query
Running Queries

A query is run from the Edit menu by clicking run query option or by selecting ‘Run Query’ button from the tool bar or by pressing the F5 key.

If we opt Display query, the query will run and display the following result. (Figure 6.70).

<table>
<thead>
<tr>
<th>STUD_ADMINO</th>
<th>STUD_NAME</th>
<th>STUD_SEX</th>
<th>STUD_CLASS</th>
<th>STUD_PLACE</th>
</tr>
</thead>
<tbody>
<tr>
<td>2030</td>
<td>JAFFER</td>
<td>MALE</td>
<td>C2</td>
<td>NOORAINI</td>
</tr>
<tr>
<td>2035</td>
<td>JAVA</td>
<td>FEMALE</td>
<td>S2</td>
<td>PALAKKAD TOWN</td>
</tr>
<tr>
<td>2050</td>
<td>KATHU</td>
<td>FEMALE</td>
<td>C2</td>
<td>KANJIKODE</td>
</tr>
<tr>
<td>2056</td>
<td>SUNIL</td>
<td>MALE</td>
<td>H2</td>
<td>MALAMPUZHA</td>
</tr>
<tr>
<td>2070</td>
<td>LAKSHMI</td>
<td>FEMALE</td>
<td>S2</td>
<td>TOWN STAND</td>
</tr>
<tr>
<td>3001</td>
<td>NISHA</td>
<td>FEMALE</td>
<td>H2</td>
<td>TOWN STAND</td>
</tr>
<tr>
<td>3002</td>
<td>ARYA</td>
<td>FEMALE</td>
<td>C2</td>
<td>TOWN STAND</td>
</tr>
<tr>
<td>3031</td>
<td>ANEESH</td>
<td>MALE</td>
<td>C1</td>
<td>PALAKKAD</td>
</tr>
<tr>
<td>3040</td>
<td>SIMON</td>
<td>MALE</td>
<td>S1</td>
<td>KANJIKODE</td>
</tr>
<tr>
<td>3045</td>
<td>MALU</td>
<td>FEMALE</td>
<td>C1</td>
<td>MALAMPUZHA</td>
</tr>
<tr>
<td>3051</td>
<td>SHERIN</td>
<td>FEMALE</td>
<td>C1</td>
<td>NOORAINI</td>
</tr>
<tr>
<td>4001</td>
<td>SREEKALA</td>
<td>FEMALE</td>
<td>H2</td>
<td>GURUVAYOOR</td>
</tr>
<tr>
<td>4002</td>
<td>ADITHVAN</td>
<td>MALE</td>
<td>C1</td>
<td>MALAMPUZHA</td>
</tr>
<tr>
<td>4003</td>
<td>AVINASH</td>
<td>MALE</td>
<td>S1</td>
<td>PALAKKAD</td>
</tr>
<tr>
<td>4010</td>
<td>ARDRA</td>
<td>FEMALE</td>
<td>K1</td>
<td>VENMONY</td>
</tr>
<tr>
<td>4011</td>
<td>ANUPRIYA</td>
<td>FEMALE</td>
<td>K1</td>
<td>VENMONY</td>
</tr>
</tbody>
</table>
6.5.2 Creation of Query in Design View

We have already seen creation of query using wizard using a single table. Now let us see how fields of more than one table are used to build queries.

We can invoke the option "Create Queries in Design view" form the Database pane on the main window of our database. It will give you the following interface. It also contain an "Add Table or Queries box". (Figure 6.71)

![Query in Design View](image)

**Fig 6.71 Query in Design View**

- To select a table, click its name and then click the ‘Add’ button. Alternatively, double-click the table's name. In both the cases the table is added to the graphical area of the Query. (Figure 6.72).

![Adding multiple tables in a query](image)

**Fig 6.72 Adding multiple tables in a query**
All operations are done in the Tabular area. Hence an understanding about the important elements of tabular area is necessary. (Figure 6.73).

![Diagram of query elements]

**Fig 6.73 Elements of a Query**

- To add a field, follow the procedures given below
  - Assume that we want to specify fields of table tblSTUDENT
  - Field: Click inside field box, which is populated with all fields of the above two tables. Select the first field you want to show in query.
  - Alias: Give alias name, if necessary (optional)
  - Table: To select table, the mouse on Table box and a mere strike of the mouse will automatically load the name of the corresponding table.
  - Sort: If you want to sort the field, give criteria.
  - Visible: There will be check boxes for each field, and which is used to show or hide (on or off) field values. (Box checked shows field value, while unchecked hides field values)
  - Function: Few built-in functions are available here. If necessary, select a function, say "SUM", to calculate total of the field.
  - Criterion: In this box we may insert formula or SQL statement to do some specific operations. E.g.: "MALE" - to display all records of male students
- Save the Query giving a suitable name. Default query name is "Query 1"
- Run the Query: We may run the query from the Edit menu by clicking the Run query option, or by pressing the F5 key, or with a click on the Run Query button.

Now the query will produce the results (figure 6.74). By default, all records are listed.
**Fig 6.74 Result of Query Executed / Run**

- Adding Criteria
  - Modifications to query can be done in Design Mode only. To open the query in design mode, right click on file name and click on "Edit".
  - To display records of all of students from a particular place

- Focus on the field "STUDPLACE" and click inside the Criteria column corresponding to it. Now the cursor will prompt for entering criteria. Type "PALAKKAD" and hit Enter Key and run the query (Figure 6.75).

**Fig 6.75 Adding criteria in a Query**
Result will be displayed as follows (Figure 6.76).

<table>
<thead>
<tr>
<th>STUD_ADMIN</th>
<th>STUD_NAME</th>
<th>STUD_CLASS</th>
<th>STUD_PLACE</th>
<th>FEE_SNO</th>
<th>QUARTER_NAME</th>
<th>QUARTER_FEE</th>
</tr>
</thead>
<tbody>
<tr>
<td>1031</td>
<td>ANEESH</td>
<td>C1</td>
<td>PALAKKAD</td>
<td>35</td>
<td>Quarter 1</td>
<td>500</td>
</tr>
<tr>
<td>4023</td>
<td>AVINASH</td>
<td>S1</td>
<td>PALAKKAD</td>
<td>42</td>
<td>Quarter 1</td>
<td>500</td>
</tr>
<tr>
<td>4023</td>
<td>AVINASH</td>
<td>S1</td>
<td>PALAKKAD</td>
<td>44</td>
<td>Quarter 1</td>
<td>500</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Record(s) of 3 of 3

Field   STUD_ADMIN | STUD_NAME | STUD_CLASS | STUD_PLACE | FEE_SNO | QUARTER_NAME | QUARTER_FEE
Alias
Table  tblSTUDENT  tblSTUDENT  tblSTUDENT  tblSTUDENT  tblBUSFEE  tblBUSFEE  tblBUSFEE
Sort
Visible  ✔  ✔  ✔  ✔  ✔  ✔  ✔  ✔
Function
Criterion  PALAKKAD

Fig 6.76  Result of Query with Criteria Changed

- Using NOT operator in criteria.
  - If we want to list all records of students except those coming to the place, say PALAKKAD, then type exactly as 'NOT PALAKKAD' in the criteria box (Figure 6.77).

Field   STUD_ADMIN | STUD_NAME | STUD_CLASS | STUD_PLACE | FEE_SNO | QUARTER_NAME | QUARTER_FEE
Alias
Table  tblSTUDENT  tblSTUDENT  tblSTUDENT  tblSTUDENT  tblBUSFEE  tblBUSFEE  tblBUSFEE
Sort
Visible  ✔  ✔  ✔  ✔  ✔  ✔  ✔  ✔
Function
Criterion  NOT PALAKKAD

Fig 6.77  Query Using ‘NOT’ Operator

6.5.3 Adding Computational Field

- Suppose that the Quarter 1 bus fees is ₹ 750. Students have remitted only ₹ 500 each. To compute the dues, a computational field may be inserted. Here everyone must remember two important aspects:
  - Remember the table name (tblBUSFEE)
• Remember the field name (QUARTER_FEE)
• Every field is referred in SQL statement in association with table name. Thus the field name should be typed as tblBUSFEE.QUARTER_FEE. If quarter fee is ₹ 750, to find dues write statement as: 750 - tblBUSFEE.QUARTER_FEE.

Now let us see how it is written in Query.
• Field: Click in an empty field box
  
  ![Empty Field]

  • Type: 750 - tblBUSFEE.QUARTER_FEE and hit Enter Key
  • Alias: In Alias column type a column heading "Outstanding Fees" and hit enter key
  • Table: Leave the table column blank. Do not make any entry here.
  • Now Run the query. We can see that the balance amount is calculated as shown in a new field as "Outstanding fee"

![Fig 6.78 Result of Computational Field]

To add amount fields, you may use the following syntax

Table1.field1+Table1.field2+Table1.field3

To compute 10% of a field:

    Table1.field*10/100
6.6 Creating reports in LibreOffice Base

The ultimate objective of Data Base Management System is to provide right information at the right time. This purpose is fulfilled at the end through reports. Reports are generated from the database tables or queries. LibreOffice provides lot of tools that help you to quickly build attractive, easy-to-read reports that present the data in a way that best suits the needs of its users.

Reports can be static or dynamic.

6.6.1 Static Reports

Static reports are meant to present information that is not likely to change over time. The system retrieves data from database at the time the report was created, and there after the information in a static report does not get updated.

6.6.2 Dynamic Reports

Dynamic Reports are meant to present information that changes over time. Dynamic reports always get updated to show the latest changes in data. Dynamic reports show the latest data and the system updates the data in a dynamic report when the report is displayed, usually in a Web browser.

It is to be understood that reports can be created using both tables and queries. You may include all fields or just selected fields according to your needs. If the data is spread over across different tables, then it is advisable to create queries based on selected fields of different tables. Later we can use that query for creating reports. From this we can say that a lot of preliminary work is involved to create a report in its designing phase. The designing of reports may go through the following stages.

6.6.3 Steps in designing a Report

i) Assess the requirements expected in the reports.

ii) Decide overall layout.

iii) Determine needed tables and columns to be included.

iv) Compose or build query.

v) Build the report.
6.6.4 Creating Reports

To create reports, click on the ‘Reports icon’ in the Database pane. It will show two sub options (See figure given below). Here the report creation is confined to creating report using wizard only.

<table>
<thead>
<tr>
<th>Tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Create Report in Design View..." /></td>
</tr>
<tr>
<td><img src="image" alt="Use Wizard to Create Report..." /></td>
</tr>
</tbody>
</table>

**Use Wizard to create Report**: In this a wizard will direct you to start and finish report creation in self explanatory and user friendly manner.

When we click on ‘Use Wizard to Create Reports’, a screen similar to the following will appear (Figure 6.79).

![Fig 6.79 Report Wizard Screen](image)

Every report will have its Page Header, Details or Report Body and Page Footer.

- **Page Header**: It appears at the top of the first page of the report. It may contain report title, logo and current date.
- **Header**: It is seen just below Page header. Its main object is to provide field heading or content heading.
- **Details**: It is the place where actual data or field contents are shown.
- **Page Footer**: It is seen at bottom of each page of the report, where current date, page number, etc, are given.

**Report Wizard**: It provides on screen direction to build reports in a professional manner.
Report wizard lets you walk through six steps starting with field selection. These are explained below:

1) **Field Selection**

In field selection, the report wizard provides a list of tables or queries to select from the list with its associated fields. Using add button, we can add all fields or just selected fields which we wish to show in reports (See figure 6.80).

![Fig 6.80 Adding Fields to Reports](image)

2) **Labelling Fields**

In this screen we can decide as to how we want to label the fields (Figure 6.81). Wizard automatically takes all field names from database and assigns them as column headings, which may not be in a quite understandable form. So we may change field labels to make it more meaningful and attractive.

![Fig 6.81 Labelling Fields](image)
It is to be noted that the labels we add above will appear as column or field headings in a report. So care must be taken to give very short labels.

3) **Grouping**

In this step, the wizard asks us to select and assign a field or fields for grouping, if any required. If we select a field, then the entire information in the report will be grouped on the basis of field name we have provided. For example, if we select "QUARTER_FEE" for grouping, then the report will be built on the basis of Fees, say "list of those who paid 500", "list of those who paid 750" "list of those who paid 900" and so and so forth. If we select "STUD_CLASS", then information will be grouped on the basis of students class. Assume that we select "STUD_CLASS" as the field for grouping in our example as shown in figure 6.82. See also figure 6.84.

![Grouping on the basis of selected Fields](image)

**Fig 6.82** Grouping on the basis of selected Fields

4) **Sorting Options**

In this step, the wizard lets us to assign field or fields on the basis of which we wish to sort the data in reports. For example, if we select "STUD_NAME", then the records will be listed in the alphabetical order of students. See figure 6.84.

5) **Choosing Layout**

Choosing layout, determines how we want our reports to look like. The available templates include the following:

- columnar.
- columnar-single-column.
- columnar-two-column.
- columnar-three-column.
- in blocks-labels above.
- in blocks labels -right.

At this stage we can also select orientation Landscape or Portrait.
6) **Create Report**

It is the last stage in building a report. Here the considerations are;

a. **Title of the Report**: You have to give a suitable name for the report, say "List of Bus Fees Collected"

b. **Type of Report**: You may select Static or Dynamic type for the report. If you choose Static, you won’t be able to modify the report. If you select Dynamic option, then Modify or Create report option is available. See figure 6.83.

![Fig 6.83 Type of Report](image)

Upon finishing, the report will be generated and saved (Figure 6.84).

```
<table>
<thead>
<tr>
<th>Class</th>
<th>C1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Admission Number</td>
<td>name of Student</td>
</tr>
<tr>
<td>4002</td>
<td>ADITHYAN</td>
</tr>
<tr>
<td>4002</td>
<td>ADITHYAN</td>
</tr>
<tr>
<td>3031</td>
<td>ANEESH</td>
</tr>
<tr>
<td>3045</td>
<td>MALU</td>
</tr>
<tr>
<td>3051</td>
<td>SHERIN</td>
</tr>
<tr>
<td>3051</td>
<td>SHERIN</td>
</tr>
<tr>
<td>Class</td>
<td>C2</td>
</tr>
<tr>
<td>Admission Number</td>
<td>name of Student</td>
</tr>
<tr>
<td>3002</td>
<td>ARYA</td>
</tr>
<tr>
<td>2030</td>
<td>JAFFER</td>
</tr>
<tr>
<td>2050</td>
<td>KATHU</td>
</tr>
<tr>
<td>Class</td>
<td>H2</td>
</tr>
<tr>
<td>Admission Number</td>
<td>name of Student</td>
</tr>
<tr>
<td>3001</td>
<td>NISHA</td>
</tr>
<tr>
<td>4001</td>
<td>SREEKALA</td>
</tr>
</tbody>
</table>
```

![Fig 6.84 Generated Report](image)
Try yourself

Create a LibreOffice Base Project to automate School Admission Register.
It should contain the following:
• Table/Tables to store data
• Data Entry Form
• Necessary Queries to interact with the database
• Useful reports

The automation of School Bus management system has been discussed so far. What if someone asks us about the net effect of running the school bus?
• How can we ascertain the surplus or deficit of running the school bus?

We all know that since this is a service activity, we need to prepare a Receipts and Payments account for ascertaining the surplus or deficit. Let us now discuss how receipts and payments can be prepared using this DBMS tool.

Receipts and Payments Account shows all cash receipts and payments of a Not for Profit making Institution. The debit side shows all receipts and credit side shows all payments. For catering the above, the following tables needs to be created.

i) A table for storing details of transactions relating to receipts and another for payments. It may have the following structure (Figure 6.85).

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Field Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRANSNO</td>
<td>Integer [ INTEGER ]</td>
</tr>
<tr>
<td>TRANS_DATE</td>
<td>Date [ DATE ]</td>
</tr>
<tr>
<td>DR_ACC_NAME</td>
<td>Text [ VARCHAR ]</td>
</tr>
<tr>
<td>DR_ACC_AMT</td>
<td>Decimal [ DECIMAL ]</td>
</tr>
<tr>
<td>CR_ACC_NAME</td>
<td>Text [ VARCHAR ]</td>
</tr>
<tr>
<td>CR_ACC_AMT</td>
<td>Decimal [ DECIMAL ]</td>
</tr>
<tr>
<td>VCHR_TYPE</td>
<td>Text [ VARCHAR ]</td>
</tr>
</tbody>
</table>

**Fig 6.85 Table 1 with Data Type**
This table may be saved with the name "tblTransactionMaster"

ii) Another table containing name of various debit and credit ledger accounts is also designed (Figure 6.86).

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Field Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACCNT_CODE</td>
<td>Integer [ INTEGER ]</td>
</tr>
<tr>
<td>ACCNT_CAT</td>
<td>Text [ VARCHAR ]</td>
</tr>
<tr>
<td>ACCNT_NAMES</td>
<td>Text [ VARCHAR ]</td>
</tr>
<tr>
<td>ACCNT_TYPE</td>
<td>Text [ VARCHAR ]</td>
</tr>
</tbody>
</table>

**Fig 6.86 Table 2 with Data Type**
This table may be saved with the name "TBLADD_ACCOUNTS"
iii) After creation of the above mentioned tables, a form to suit the requirements may be designed as shown in figure 6.87.

![Ledger Creation Master Form](image)

**Fig 6.87 Ledger Creation Screen**

The various controls in the Accounts Master Form may be set as seen below:

<table>
<thead>
<tr>
<th>Controls</th>
<th>Label</th>
<th>Data Field(Controls)</th>
</tr>
</thead>
<tbody>
<tr>
<td>LABEL</td>
<td>Ledger Creation Master</td>
<td></td>
</tr>
<tr>
<td>LABEL1</td>
<td>CODE</td>
<td>ACCNT_CODE</td>
</tr>
<tr>
<td>TEXT BOX1</td>
<td>Account Number</td>
<td>ACCNT_CODE</td>
</tr>
<tr>
<td>LABEL2</td>
<td>CATEGORY</td>
<td>ACCNT_CODE</td>
</tr>
<tr>
<td>TEXTBOX2</td>
<td>Assets</td>
<td>ACCNTCAT</td>
</tr>
<tr>
<td>Check Box</td>
<td>Liability</td>
<td>ACCNTCAT</td>
</tr>
<tr>
<td>Check Box1</td>
<td>Capital</td>
<td>ACCNTCAT</td>
</tr>
<tr>
<td>Check Box3</td>
<td>Revenue</td>
<td>ACCNTCAT</td>
</tr>
<tr>
<td>Check Box4</td>
<td>Expenses</td>
<td>ACCNTCAT</td>
</tr>
<tr>
<td>LABEL3</td>
<td>ACCOUNT NAME</td>
<td>ACCNT_NAMES</td>
</tr>
<tr>
<td>TEXTBOX3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LABEL4</td>
<td>GROUP</td>
<td>ACCNT_TYPE</td>
</tr>
<tr>
<td>Check Box5</td>
<td>Fixed Assets</td>
<td>ACCNT_TYPE</td>
</tr>
<tr>
<td>Check Box6</td>
<td>Fixed Liability</td>
<td>ACCNT_TYPE</td>
</tr>
<tr>
<td>Check Box7</td>
<td>Current Assets</td>
<td>ACCNT_TYPE</td>
</tr>
<tr>
<td>Check Box8</td>
<td>Current Liability</td>
<td>ACCNT_TYPE</td>
</tr>
<tr>
<td>Check Box9</td>
<td>Direct Income</td>
<td>ACCNT_TYPE</td>
</tr>
<tr>
<td>Check Box10</td>
<td>Indirect Income</td>
<td>ACCNT_TYPE</td>
</tr>
<tr>
<td>Check Box</td>
<td>Direct Expenses</td>
<td>ACCNT_TYPE</td>
</tr>
<tr>
<td>Check Box</td>
<td>Indirect Expenses</td>
<td>ACCNT_TYPE</td>
</tr>
<tr>
<td>Push Button1</td>
<td>Create Ledger</td>
<td>Action-New Record</td>
</tr>
<tr>
<td>Push Button2</td>
<td>Save Ledger</td>
<td>Action-Save Record</td>
</tr>
<tr>
<td>Push Button3</td>
<td>Delete Ledger</td>
<td>Action-Delete Record</td>
</tr>
<tr>
<td>Push Button4</td>
<td>Undo Data Entry</td>
<td>Action-Undo Data Entry</td>
</tr>
</tbody>
</table>
The form may be saved with the name "frmCreateLedger". When we run the form for ledger creation, the following screen will appear (Figure 6.88).

![Ledger Creation Master Form]

**Fig 6.88 Running Ledger Creation Form**

Create as many records as you want. The ledgers created will be added to the table "TBLADD_ACCOUNTS" (Figure 6.89).

<table>
<thead>
<tr>
<th>ACCT_CODE</th>
<th>ACCTCAT</th>
<th>ACCT_NAMES</th>
<th>ACNT_TYPE</th>
</tr>
</thead>
<tbody>
<tr>
<td>103</td>
<td>Assets</td>
<td>Bank a/c</td>
<td>Current Assets</td>
</tr>
<tr>
<td>402</td>
<td>Revenue</td>
<td>Bus fees a/c</td>
<td>Indirect Income</td>
</tr>
<tr>
<td>201</td>
<td>Capital</td>
<td>Capital a/c</td>
<td>Fixed Liability</td>
</tr>
<tr>
<td>401</td>
<td>Assets</td>
<td>Cash a/c</td>
<td>Current Assets</td>
</tr>
<tr>
<td>400</td>
<td>Expenses</td>
<td>Purchase a/c</td>
<td>Direct Expense</td>
</tr>
<tr>
<td>502</td>
<td>Expenses</td>
<td>Rent a/c</td>
<td>Indirect Expense</td>
</tr>
<tr>
<td>501</td>
<td>Expenses</td>
<td>Salary a/c</td>
<td>Indirect Expense</td>
</tr>
<tr>
<td>401</td>
<td>Revenue</td>
<td>Sales a/c</td>
<td>Direct Income</td>
</tr>
<tr>
<td>502</td>
<td>Expenses</td>
<td>Wages a/c</td>
<td>Direct Expense</td>
</tr>
</tbody>
</table>

**Fig 6.89 Display Record in Table**

iv) Create a Voucher Entry Form for entering transactions (Figure 6.90).

![Voucher Entry Screen]

**Fig 6.90 Voucher entry screen**
The various controls relating to the above form may be set as follows:

<table>
<thead>
<tr>
<th>Controls</th>
<th>Label</th>
<th>Data Field(Controls)</th>
</tr>
</thead>
<tbody>
<tr>
<td>LABEL</td>
<td>Voucher Entry Screen</td>
<td></td>
</tr>
<tr>
<td>LABEL1</td>
<td>Select Voucher Type</td>
<td></td>
</tr>
<tr>
<td>COMBO BOX1</td>
<td></td>
<td>VCHR_TYPE</td>
</tr>
<tr>
<td>LABEL2</td>
<td>##NO</td>
<td>TRANSNO</td>
</tr>
<tr>
<td>LABEL3</td>
<td>Date</td>
<td>TRANS_DATE</td>
</tr>
<tr>
<td>LABEL4</td>
<td>Dr</td>
<td></td>
</tr>
<tr>
<td>LABEL5</td>
<td>Cr</td>
<td></td>
</tr>
<tr>
<td>COMBO BOX2</td>
<td></td>
<td>DR_ACC_NAME</td>
</tr>
<tr>
<td>TEXTBOX1</td>
<td></td>
<td>DR_ACC_AMT</td>
</tr>
<tr>
<td>COMBO BOX3</td>
<td></td>
<td>CR_ACC_NAME</td>
</tr>
<tr>
<td>TEXTBOX2</td>
<td></td>
<td>CR_ACC_AMT</td>
</tr>
<tr>
<td>TEXTBOX 3</td>
<td></td>
<td>ACCNT_NAMES</td>
</tr>
<tr>
<td>Push Button1</td>
<td>New</td>
<td>Action-New Record</td>
</tr>
<tr>
<td>Push Button2</td>
<td>Save</td>
<td>Action-Save Record</td>
</tr>
<tr>
<td>Push Button3</td>
<td>Delete</td>
<td>Action-Delete Record</td>
</tr>
</tbody>
</table>

This form may be saved with the name "frmTransactionMaster". When we open the form, it will look like as follows (Figure 6.91).

![Voucher Entry Screen](image)

**Fig 6.91 Running Voucher Entry Form**

Now transactions may be entered through this voucher. After entering few transactions, the table may contain the details of following transitions (Figure 6.92).

<table>
<thead>
<tr>
<th>TRANSNO</th>
<th>TRANS_DATE</th>
<th>DR_ACC_NAME</th>
<th>DR_ACC_AMT</th>
<th>CR_ACC_NAME</th>
<th>CR_ACC_AMT</th>
<th>VCHR_TYPE</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>01/01/17</td>
<td>Cash a/c</td>
<td>50000</td>
<td>Capital a/c</td>
<td>50000</td>
<td>Receipts</td>
</tr>
<tr>
<td>8</td>
<td>01/01/17</td>
<td>Wages a/c</td>
<td>3000</td>
<td>Cash a/c</td>
<td>3000</td>
<td>Payments</td>
</tr>
<tr>
<td>9</td>
<td>02/01/17</td>
<td>Bank a/c</td>
<td>20000</td>
<td>Cash a/c</td>
<td>20000</td>
<td>Contra</td>
</tr>
<tr>
<td>10</td>
<td>03/01/17</td>
<td>Purchase a/c</td>
<td>10000</td>
<td>Cash a/c</td>
<td>10000</td>
<td>Payments</td>
</tr>
<tr>
<td>11</td>
<td>05/01/17</td>
<td>Cash a/c</td>
<td>25000</td>
<td>Sales a/c</td>
<td>25000</td>
<td>Receipts</td>
</tr>
<tr>
<td>12</td>
<td>06/01/17</td>
<td>Salary a/c</td>
<td>5500</td>
<td>Cash a/c</td>
<td>5500</td>
<td>Payments</td>
</tr>
</tbody>
</table>

*Fig 6.92 Table Showing Debit Credit Transaction*

From this table we can create a query to get a list of total cash payments and cash receipts.
1) Payments Query (Figure 6.93).

Create Query→Add Table→tblTransactionMaster.

![Fig 6.93 Payment query](image)

Give the Voucher type criteria as "Payments"

The output will be shown as follows (Figure 6.94).

![Fig 6.94 Payment query output](image)

The report based on this query will be shown as follows (Figure 6.95).

![Fig 6.95 Report based on payment query](image)

To get Total Receipts, create Receipt Query. See figure 6.96.

Create Query→Add Table→tblTransactionMaster.

![Fig 6.96 Receipt Query](image)
The output of the query will be shown as follows (Figure 6.97).

<table>
<thead>
<tr>
<th>TRANSNO</th>
<th>TRANS_DATE</th>
<th>CR_ACC_NAME</th>
<th>CR_ACC_AMT</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>01/01/17</td>
<td>Capital a/c</td>
<td>50000</td>
</tr>
<tr>
<td>11</td>
<td>05/01/17</td>
<td>Sales a/c</td>
<td>25000</td>
</tr>
<tr>
<td>18</td>
<td>31/01/17</td>
<td>Bus Fees a/c</td>
<td>6300</td>
</tr>
</tbody>
</table>

Fig 6.97 Output of Receipt Query

The Report may look like as follows (Figure 6.98).

<table>
<thead>
<tr>
<th>Trans No</th>
<th>Date</th>
<th>Receipts</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>01/01/17</td>
<td>Capital a/c</td>
<td>50000</td>
</tr>
<tr>
<td>11</td>
<td>05/01/17</td>
<td>Sales a/c</td>
<td>25000</td>
</tr>
<tr>
<td>18</td>
<td>31/01/17</td>
<td>Bus Fees a/c</td>
<td>6300</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Total</td>
<td>81300</td>
</tr>
</tbody>
</table>

Fig 6.98 Report Based on Receipt Query

Similarly the payment report can also be made.

**Let's assess**

1. .......... is an enquiry sent to a database to manipulate data
2. Queries can be .......... query and .......... query.
3. A query is run from the .......... Menu.
4. .......... Reports are meant to present information that is not likely to change.
5. .......... reports are meant to present information that change over time.
### Summary

- **Database**: A database is an organised collection of data. Data is always organised in data table consisting of rows and columns in relational model. It is indexed in such a way that the relevant information can be quickly and easily accessed, managed and updated.

- **DBMS**: DBMS is a software application that facilitates interaction with end users, other applications, and to the database itself to capture and analyze data. LibreOffice Base, SQL Server, Oracle, MS Access, etc. are some of the popular DBMS softwares.

- **Objects of LibreOffice Base**: The objects of base consist of tables, forms, queries and reports.

- **In LibreOffice Base**, data is organised in tables. A table is a data structure that organises information in rows (for records) and columns (fields or attributes). They are used to store and display information in a structured format. Tables can be created using Wizard option or by using design view.

- **Steps in table creation**: Select design view, enter the field name, select data type, give description if necessary and define field properties. Enter table name to save by assigning primary key.

- **Relationship** allows database to split and store data in different tables and provides linkage to different data items.

- **Normalisation** is the process of removing data redundancy.

- **Primary Key**: The field that uniquely identifies each record is called a 'Primary Key'.

- **Foreign Key**: Foreign keys are the columns of a table that points to the primary key of another table. They act as a cross reference between tables.

- **Forms** are used to input data into tables. A Form is a front end for data entry and editing. Forms can be simple forms as well as complex forms. Forms can be created using Wizard or in design view.

- **Steps in form creation**: Select create form using wizard, various sequence of steps like Field selection, arrange controls, set data entry, apply styles and defining name for form must be followed in a sequential order.

- **Create Form in Design View**: Under this method, we have to add labels and fields by ourselves. Similarly connection between form, tables, fields, etc. are to be set carefully using Controls.

- **Sub forms**: A sub form is a form used to show data in another table or query while standing in a primary form or main form.
• Push buttons: push button is a visual representation of a button that executes a task when clicked or pressed. There will be some instructions attached to these buttons.

• Check Box: A check box is a small square box that can be placed on a form which allows user to show a choice and input that choice to a data field. It is alternatively called a selection box or a tick box.

• Option Buttons/ Radio Buttons: Option buttons offer the user a set of mutually exclusive options. It means that the selection of one option automatically rejects all others.

• A Query is a question asked or enquiry sent to a database to extract data based on certain criteria. They can bring together data from different tables, calculate results, and quickly filter any mass of data.

• Queries can be created with the help of Query Wizard or in Design View. Open the Query Wizard by clicking on "Use Wizard to Create query.

• Creation of Query in Design View: The option "Create Queries in Design view "can be invoked from the Database pane on the main window of database. It provides "Add Table or Queries box", using which we can add required fields to the query.

• Creating reports in LibreOffice Base: Reports can be static or dynamic. Static reports are meant to present information that is not likely to change over time. Dynamic Reports are meant to present information that changes over time.

• Steps in designing a report:
  i) Assess the requirements expected in the reports.
  ii) Decide overall layout.
  iii) Determine needed tables and columns to be included.
  iv) Compose or build query.
  v) Build the report.

I can

• define the requirements that are expected from database applications
• explain how to identify data to be stored in tables and develop a suitable frame work
• state different ways to structure database as per the requirement
• design and create Libre Office Base components such as tables, forms, queries, and reports
• make use of LibreOffice Base for developing simple data base applications for capturing, storing and retrieving data
1) What do you mean by a database? Give two examples.
2) How will you assess the database requirements?
3) Explain the considerations to be given while assessing database requirements.
4) What is the need for logical structuring of a database?
5) What do you mean by Key Fields?
6) State the importance of Key Field with the help of an example.
7) Briefly explain the procedure for creating a database?
8) List out the commonly available components in LibreOffice Base database panel?
9) What are the objects available in database panel of LibreOffice?
10) Write short notes on:
    a) Tables  b) Forms  c) Queries  c) Reports
11) Briefly explain how a table is created?
12) What do you use for inputting data in to a data table in LibreOffice Base?
13) Data stored in tables are not directly accessible, but through certain objects it is possible. Explain the underlying concept described here.
14) State briefly the various modes available for report generation in LibreOffice Base.
15) What is an identifier? Give an example.
16) What is a foreign key? Give an example.
17) Describe the steps for setting a primary key?
18) What is the use of relationships in LibreOffice Base?
19) Describe briefly the steps for creating and deleting relationships?
20) Explain the steps for creating a student table for storing name, class, sex and marks in 6 subjects.
21) What do you mean by data types? Give examples.
22) Write any five data types and state its suitability.
23) Explain how font and font size of a label can be changed.
24) Explain the procedures for adding a List Box to a form.
25) Explain the procedures for adding a Combo Box to a form.
26) Explain the procedures for adding a Push Buttons to a form.
27) Explain the procedures for adding a Radio Button/option button
to a form.

28) What is the use of option buttons in a form?

29) Explain the steps for adding a Heading to a form.

30) What are sub forms in LibreOffice Base?

31) Distinguish between "select query" and "action query" in LibreOffice Base.

32) Distinguish between static report and dynamic reports in LibreOffice Base.

33) List out the steps in designing a report.

34) Explain the steps for creating a report using Wizard in LibreOffice Base.

35) Write notes on:
   a. Page Header
   b. Details or Report Body
   c. Page Footer
1) Create a table with the following details
   • Name
   • Sex
   • Date of Birth
   • Class
   • Mark 1
   • Mark 2
   • Mark 3
   • Mark 4
   a) Set primary key
   b) Enter two imaginary records and display records.

2) Create two tables

<table>
<thead>
<tr>
<th>Table I</th>
<th>Table 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Admission Number</td>
<td>Admission Number</td>
</tr>
<tr>
<td>Name</td>
<td>Mark1</td>
</tr>
<tr>
<td>Age</td>
<td>Mark2</td>
</tr>
<tr>
<td>Sex</td>
<td>Mark3</td>
</tr>
<tr>
<td>Address1</td>
<td>Mark4</td>
</tr>
<tr>
<td>Address 2</td>
<td>Mark5</td>
</tr>
</tbody>
</table>

b) Create Relationships

3) i) Create a table with the following fields
   a. Account Code
   b. Account Name
   c. Account Group
   (Save table with the name TBLACCOUNTS)

ii) Create a form to add the following records to table TBLACCOUNTS

001 - Salary a/c——Indirect Expenses
002 - Rent paid——Indirect expenses
003 — Building a/c——Fixed Assets
004 — Wages——Direct Expenses
005 — Avinash's a/c——Sundry Debtors

Create a query to display all accounts under the Group "Indirect Expenses".
4) Create a table with the following

<table>
<thead>
<tr>
<th>Admno</th>
<th>studname</th>
<th>studsex</th>
<th>studclass</th>
<th>studage</th>
<th>studplace</th>
<th>studmark</th>
</tr>
</thead>
<tbody>
<tr>
<td>7011</td>
<td>Avinash</td>
<td>M</td>
<td>S2</td>
<td>15</td>
<td>Idukki</td>
<td>67</td>
</tr>
<tr>
<td>7012</td>
<td>Lakshmi</td>
<td>F</td>
<td>C1</td>
<td>15</td>
<td>Palakkad</td>
<td>60</td>
</tr>
<tr>
<td>7013</td>
<td>Arya</td>
<td>F</td>
<td>C2</td>
<td>16</td>
<td>Palakkad</td>
<td>70</td>
</tr>
<tr>
<td>7014</td>
<td>Adithya</td>
<td>M</td>
<td>C2</td>
<td>16</td>
<td>Idukki</td>
<td>45</td>
</tr>
<tr>
<td>7015</td>
<td>Nisha</td>
<td>F</td>
<td>S2</td>
<td>15</td>
<td>Palakkad</td>
<td>69</td>
</tr>
<tr>
<td>7016</td>
<td>Sreekala</td>
<td>F</td>
<td>C2</td>
<td>16</td>
<td>Idukki</td>
<td>50</td>
</tr>
</tbody>
</table>

a. Create a query to display
   i. Number of students coming from "Palakkad"
   ii. Number of students who scored marks greater than 65
   iii. List of pupils whose name starts with "A"
   iv. List of pupils whose class=C2 and sex=F

5) Create a simple form with necessary controls to display the following screen.

![Students Data Entry Screen](image)

*Hint: No need to create table*

6) Prepare Pay Roll of the following employees

<table>
<thead>
<tr>
<th>EmpID</th>
<th>EmpName</th>
<th>Basic Pay</th>
<th>PF Loan</th>
</tr>
</thead>
<tbody>
<tr>
<td>1001</td>
<td>Albin</td>
<td>39500</td>
<td>2500</td>
</tr>
<tr>
<td>1002</td>
<td>Aleena</td>
<td>41500</td>
<td>3000</td>
</tr>
<tr>
<td>1003</td>
<td>Devika</td>
<td>40000</td>
<td>0</td>
</tr>
<tr>
<td>1004</td>
<td>Athul</td>
<td>48000</td>
<td>4000</td>
</tr>
<tr>
<td>1005</td>
<td>Don</td>
<td>36000</td>
<td>1650</td>
</tr>
<tr>
<td>1006</td>
<td>Sreenakshmi</td>
<td>32000</td>
<td>1000</td>
</tr>
<tr>
<td>1006</td>
<td>Bobby</td>
<td>0</td>
<td>1800</td>
</tr>
<tr>
<td>1007</td>
<td>Sufia</td>
<td>49000</td>
<td>1700</td>
</tr>
<tr>
<td>1008</td>
<td>Georgian</td>
<td>25000</td>
<td>0</td>
</tr>
</tbody>
</table>
Additional Information

a) DA is to be provided @ 93% of Basic Pay
b) HRA 1750
c) PF Subscription 20% of Basic Pay
d) TDS is to be deducted @ 10 of Gross Pay

Display Payroll statement

7) Create a table "TBLSALES" with the following fields
   AccountCode, AccountName, AccountCat, AccountType, TrasAmount
   a) Create a simple form and add the following controls
      i. Add a list box to Select Account name "Purchases and Sales"
      ii. Add second list box to select Account category "Income and Expenses"
      iii. Add a check box to select the options "Dr or Cr"
      iv. Insert the following records

<table>
<thead>
<tr>
<th>AccountCode</th>
<th>AccountName</th>
<th>AccountCat</th>
<th>AccountType</th>
<th>TrasAmount</th>
</tr>
</thead>
<tbody>
<tr>
<td>4001</td>
<td>Sales a/c</td>
<td>Income</td>
<td>Cr</td>
<td>40000</td>
</tr>
<tr>
<td>5001</td>
<td>Purchases</td>
<td>Expenses</td>
<td>Dr</td>
<td>35000</td>
</tr>
<tr>
<td>5002</td>
<td>Purchases</td>
<td>Expenses</td>
<td>Dr</td>
<td>55000</td>
</tr>
<tr>
<td>4002</td>
<td>Sales</td>
<td>Income</td>
<td>Cr</td>
<td></td>
</tr>
</tbody>
</table>

b) Open the table and display the records.

8) Create a Form in design view and add the following controls

(No need to create or connect to a table. Only layout is expected)
APPENDIX

Lab Work 1

Enter the following in a LibreOffice Base Table with file name “TBL_EMPLOYEES”

<table>
<thead>
<tr>
<th>EMP_ID</th>
<th>EMP_NAME</th>
<th>EMP_SEX</th>
<th>EMP_BASIC</th>
</tr>
</thead>
<tbody>
<tr>
<td>7010</td>
<td>SINTHARA</td>
<td>FEMALE</td>
<td>58000</td>
</tr>
<tr>
<td>7011</td>
<td>SARVY</td>
<td>MALE</td>
<td>62000</td>
</tr>
<tr>
<td>7012</td>
<td>LIGY</td>
<td>FEMALE</td>
<td>55000</td>
</tr>
<tr>
<td>7013</td>
<td>SIBI</td>
<td>MALE</td>
<td>70000</td>
</tr>
<tr>
<td>7014</td>
<td>PAULRAJ</td>
<td>MALE</td>
<td>65000</td>
</tr>
<tr>
<td>7015</td>
<td>RINCY</td>
<td>FEMALE</td>
<td>49000</td>
</tr>
</tbody>
</table>

a) Display the name of employees drawing Basic pay greater than or equal to 60000

b) Name of employees beginning with “S”

Process:

Step 1 : Create Table: Table → Create Table in Design View

Step 2 : Enter field names and select suitable data types

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Field Type</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>EMP_ID</td>
<td>Integer [INTEGER]</td>
<td>Used for Employee Number</td>
</tr>
<tr>
<td>EMP_NAME</td>
<td>Text [VARCHAR]</td>
<td>Used for Employee Name</td>
</tr>
<tr>
<td>EMP_SEX</td>
<td>Text [VARCHAR]</td>
<td>Used for Employee Sex</td>
</tr>
<tr>
<td>EMP_BASIC</td>
<td>Decimal [DECIMAL]</td>
<td>Used for Employee Basic Pay</td>
</tr>
</tbody>
</table>

Fig. Lab1.1

Step 3 : Set primary key

- Click in the empty box on the right of EMP_ID field and right click.
- Click on the “Primary Key”. Now EMP_ID has been set as Primary field

Step 4 : Save the table with the file name “TBL_EMPLOYEES”

Step 5 : Create a Form Using Wizard.

- Create Form: Use Wizard to create form
- Select table “TBL_EMPLOYEES” and add its fields to the form
- Save the form with a suitable name
- Open the form and input data into tables for six employees

**Step 6**: Create Query
- Create Query: Use Wizard to create Query
- Select table “TBL_EMPLOYEES” and add its fields to the query
- Save the query and give a query name
- Modify the query (Edit) and set criteria

**Step 7**: Criteria (a): employees drawing Basic pay greater than or equal to 60000
  i. Click in the criteria column against the field “EMP_BASIC”.
  ii. Type the criteria: “>=60000”

<table>
<thead>
<tr>
<th>Field</th>
<th>EMP_ID</th>
<th>EMP_NAME</th>
<th>EMP_SEX</th>
<th>EMP_BASIC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alias</td>
<td>EMP_ID</td>
<td>EMP_NAME</td>
<td>EMP_SEX</td>
<td>EMP_BASIC</td>
</tr>
<tr>
<td>Table</td>
<td>tbiemployees</td>
<td>tblemployees</td>
<td>tblemployees</td>
<td>tblemployees</td>
</tr>
<tr>
<td>Sort</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Visible</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Function</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Criterion</td>
<td></td>
<td></td>
<td></td>
<td>&gt;=60000</td>
</tr>
</tbody>
</table>

**Fig. Lab1.2**

iii. Run the query

The output is:

<table>
<thead>
<tr>
<th>EMP_ID</th>
<th>EMP_NAME</th>
<th>EMP_SEX</th>
<th>EMP_BASIC</th>
</tr>
</thead>
<tbody>
<tr>
<td>7011</td>
<td>SARVY</td>
<td>MALE</td>
<td>62000</td>
</tr>
<tr>
<td>7013</td>
<td>SIBI</td>
<td>MALE</td>
<td>70000</td>
</tr>
<tr>
<td>7014</td>
<td>PAULRAJ</td>
<td>MALE</td>
<td>65000</td>
</tr>
</tbody>
</table>

**Fig. Lab1.3**

**Step 8**: Criteria (b) Name of employees beginning with “S”
- Modify the Query (Right Click on query name and Edit)
• Click in the criteria column against the field “EMP_NAME”
• Type criteria “Like S*” and run the query
• The output is:

```
<table>
<thead>
<tr>
<th>EMP_ID</th>
<th>EMP_NAME</th>
<th>EMP SEX</th>
<th>EMP_BASIC</th>
</tr>
</thead>
<tbody>
<tr>
<td>7010</td>
<td>SINTHARA</td>
<td>FEMALE</td>
<td>58000</td>
</tr>
<tr>
<td>7011</td>
<td>SARVY</td>
<td>MALE</td>
<td>62000</td>
</tr>
<tr>
<td>7013</td>
<td>SIBI</td>
<td>MALE</td>
<td>70000</td>
</tr>
</tbody>
</table>
```

Fig. Lab 1.4

**Lab Work 2**

Prepare a Payroll of Employees with the following details:

```
<table>
<thead>
<tr>
<th>EMP_ID</th>
<th>EMP_NAME</th>
<th>EMP BP</th>
<th>EMP_DA</th>
<th>HRA</th>
<th>EMP_GROSS</th>
</tr>
</thead>
<tbody>
<tr>
<td>201</td>
<td>ARYA</td>
<td>40000</td>
<td></td>
<td>250</td>
<td></td>
</tr>
<tr>
<td>201</td>
<td>AMMU</td>
<td>41500</td>
<td></td>
<td>250</td>
<td></td>
</tr>
<tr>
<td>203</td>
<td>ADITHYA</td>
<td>48000</td>
<td></td>
<td>250</td>
<td></td>
</tr>
<tr>
<td>204</td>
<td>AVINASH</td>
<td>54000</td>
<td></td>
<td>250</td>
<td></td>
</tr>
</tbody>
</table>
```

a) Create a Query to compute Gross Salary

**Process:**

Step 1: Create Table: Create Table in Design View
• Enter field names and select suitable data types
• Set primary Key and save table with the name “TBL_SALARY”

```
<table>
<thead>
<tr>
<th>Field Name</th>
<th>Field Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMP_ID</td>
<td>Integer [ INTEGER ]</td>
</tr>
<tr>
<td>EMP_NAME</td>
<td>Text [ VARCHAR ]</td>
</tr>
<tr>
<td>EMP_BP</td>
<td>Decimal [ DECIMAL ]</td>
</tr>
<tr>
<td>EMP_HRA</td>
<td>Integer [ INTEGER ]</td>
</tr>
</tbody>
</table>
```

Fig. Lab 2.1

Step 2: Create Form: Use Wizard to create form
• Open Form and input data
Step 3: Create Query: Use Wizard to create Query

- Select table “SALARY” and add its fields to the query
- Save the query and give a query name
- Right Click on query name àEdit to open the query

Step 4: Add computational field

- Click in the top cell of the first blank field and select “TBL_SALARY.EMP_BP”
- Alter the field name to change it as a formula: “TBL_SALARY.EMP_BP*20/100”
- In the Alias box, type “DA”
- Click in the top cell of the next blank field and type a field parameter as: “TBL_SALARY.EMP_BP+(TBL_SALARY.EMP_BP * 20/100)+TBL_SALARY.EMP_HRA” and type “GROSS” in the Alias column.

Running this query will produce the following output.
Lab Work 3

Create Tables Named ‘TBL_PERSONNEL’ and ‘TBLPAY’ from the following details

<table>
<thead>
<tr>
<th>Table-1</th>
<th>Table-2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>EMP ID</strong></td>
<td><strong>EMPNAME</strong></td>
</tr>
<tr>
<td>2001</td>
<td>JUBI</td>
</tr>
<tr>
<td>2002</td>
<td>NURA</td>
</tr>
<tr>
<td>2003</td>
<td>IVISH</td>
</tr>
</tbody>
</table>

Process:

Step 1: Create two tables, select field types, set primary key and Save file

<table>
<thead>
<tr>
<th>Table Name</th>
<th>Field name</th>
<th>Data Type</th>
<th>Primary Key</th>
<th>Save File Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>tblEmployee</td>
<td>EMPID</td>
<td>TEXT</td>
<td>YES</td>
<td>tblEmployee</td>
</tr>
<tr>
<td>tblEmployee</td>
<td>EMPNAME</td>
<td>TEXT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>tblPay</td>
<td>EMPNO</td>
<td>TEXT</td>
<td>YES</td>
<td>tblPay</td>
</tr>
<tr>
<td>tblPay</td>
<td>BP</td>
<td>DECIMAL</td>
<td></td>
<td></td>
</tr>
<tr>
<td>tblPay</td>
<td>HRA</td>
<td>DECIMAL</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Step 2: Create relationship

- Tools → Relationships → Add Tables
- Join EMPID of tblEmployee and EMPNO of tblPay

Step 3: Create a form

- Forms → Use Wizard to create form

  → Select table tblEmployee and add its field
  → Add Sub Form: Status - Checked (put tick mark)
  → Sub form based on existing relation: Status - selected
  → Select tblPAY
  → Add necessary fields
  → Select data sheet view for both man and sub form.
  → Select Data Entry Mode: The form is used for entering new data only → click to select this option.
→ Apply any styles
→ Give a file name “frmEMPLOYEE”
→ Modify the form to align, change labels etc
→ Make data entry.

Step 4 : Create a Query and add necessary fields
Step 5 : Run the Query to display all records

**Output**

<table>
<thead>
<tr>
<th>EMPID</th>
<th>EMPNAME</th>
<th>BP</th>
<th>HRA</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>JUBI</td>
<td>10000</td>
<td>1500</td>
</tr>
<tr>
<td>2002</td>
<td>NURA</td>
<td>20000</td>
<td>1500</td>
</tr>
<tr>
<td>2003</td>
<td>IVISHI</td>
<td>30000</td>
<td>1500</td>
</tr>
</tbody>
</table>

Fig. Lab 3.1

**Lab Work 4**

Prepare a Payroll statement from the following details

<table>
<thead>
<tr>
<th>EMPID</th>
<th>EMPNAME</th>
<th>BP</th>
<th>DA(10% OF BP)</th>
<th>TOTAL PAY</th>
</tr>
</thead>
<tbody>
<tr>
<td>200</td>
<td>KALA</td>
<td>40000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>201</td>
<td>NISHA</td>
<td>20000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>202</td>
<td>AMMU</td>
<td>30000</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Process:**

Step 1
Create tables, select field types, set primary key and Save file

<table>
<thead>
<tr>
<th>Field name</th>
<th>Data Type</th>
<th>Primary Key</th>
<th>Save File Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMPID</td>
<td>TEXT</td>
<td>YES</td>
<td>tblPAYROLL</td>
</tr>
<tr>
<td>EMPNAME</td>
<td>TEXT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>BP</td>
<td>DECIMAL</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Step 2 : Create a form

o Forms → Use Wizard to create form
  → Select table tblEmployee and add its field
  → Save the form with the name “FRMPAYROLL”
  → Make data entry
Step 3: Create a Query and add necessary fields

Step 4: Open the Query in Design mode

Step 5: Click in the top cell of the first blank field and type “tblPAYROLL.BP*10/100” and also type the a new column heading “DA” in the Alias column

Step 6: Click in the top cell of the next blank field and type “tblPAYROLL.BP+tblPAYROLL.BP*10/100”. Type the a column heading “TOTAL_PAY” in the Alias column

Step 7: Run the Query.

Output

<table>
<thead>
<tr>
<th>EMPID</th>
<th>EMPNAME</th>
<th>BP</th>
<th>DA</th>
<th>TOTAL PAY</th>
</tr>
</thead>
<tbody>
<tr>
<td>200</td>
<td>KALA</td>
<td>40000</td>
<td>4000</td>
<td>44000</td>
</tr>
<tr>
<td>201</td>
<td>NISHA</td>
<td>20000</td>
<td>2000</td>
<td>22000</td>
</tr>
<tr>
<td>202</td>
<td>AMMU</td>
<td>30000</td>
<td>3000</td>
<td>33000</td>
</tr>
</tbody>
</table>

Record 1 of 3

Fig. Lab 4.1
REFERENCES

4. Lalit Mali. LibreOffice 5.1 Base Data base (e-Book), Notion Press, 2017
5. Lalit Mali, Libre office 5.1 Calc Spreadsheet (e-Book), Notion Press, 2017
10. NCERT, Computerised Accounting System Class XII, NCERT Publication, 2010
11. SCERT, Computerised Accounting Class XII, SCERT Publication, 2004
12. www.gnukhata.in
13. www.libreoffice.org